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1Getting Started
Welcome to mySewnet™ Embroidery. mySewnet™ Embroidery helps you to adjust your 
embroideries on the computer before you sew. Personalize your embroideries in true 3D 
in a real hoop, and store the hoop information in your project file. Rotate your 
embroideries to any degree, mirror them from side to side or end to end and scale or 
resize your embroideries. Adjust an unlimited number of designs and lettering ’side by 
side’ in multiple windows. View and change the order of the parts of your design in the 
FilmStrip. Choose from a library of hundreds of SuperDesigns with numerous style 
options.

Adjust the colors to the thread shades from your preferred manufacturer, or even create 
your own threads in mySewnet™ Thread Cache. Add and store Color Effects such as Puffy 
Foam or Dual Threads, or Twin, Wing, Cutwork and Felting Needles. ColorSort to 
intelligently re-sort the color order of a design to reduce the number of thread changes. 
Select multiple designs and align, move, resize or rotate them as a group. Cut, copy or 
paste and duplicate embroideries between mySewnet™ Embroidery Software modules.

Use 'Encore' to repeat embroideries in a circle, in 8 line and 28 shape options, or around 
the hoop. Use the Endless function to make endless embroideries for any hoop.

Add multi-line lettering with your choice of 35 lettering shapes and flexibility to resize and 
space letters individually. Alternatively, use the ExpressMonogram Wizard. Use the 
QuickFont Wizard to create new fonts for mySewnet™ Embroidery from most TrueType® or 
OpenType® fonts on your computer. Select machine motif stitches individually or as lines 
to create new designs or embellish existing ones, or add SuperDesigns. Surround 
monograms, names or any design with frames and flourishes or an automatic border with 
optional appliqué stitching and fabric. Adjust the stitch types and settings for most fonts 
and SuperDesigns.

Use Design Player  to play through all sections of an embroidery. Use Life View  to 
view the embroidery in real-world perspective with the desired export options. Save  
your project with its design sections and groups kept separate and editable (including 
lettering, SuperDesigns and frames) in multipart .vp4 format. Finally, Export  in the 
desired format according to the chosen options to optimize for sewing.

Add ribbon, beads, crystals and other decorations to your project in the Embellish tab.

Create appliqué outlines for cutwork needles or your fabric cutter using File, Export 
Appliqué Pieces, and create placement stitches for decorations when Exporting. 
Alternatively, create crystal transfer templates for decorations using File, Export 
Decoration Template. Create pictures and videos of your projects for your friends using 
Life View and Design Player.

In the Modify tab of mySewnet™ Embroidery, use 2D editing to modify individual stitches 
or whole blocks of stitches, even insert new stitches. Manage colors in your embroideries: 
move colors up or down, merge color blocks and insert color changes and Stop 
Commands with stitchout hints.
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Welcome Screen
The Welcome Screen appears when you open mySewnet™ Embroidery, and when you 
click the File menu.

In the Welcome Screen, start a new design from a blank screen, open an existing design, 
create a design with one of the Wizards, or use the mySewnet™ Cross Stitch, mySewnet™ 
Digitizing or mySewnet™ Sketch modules.

ExpressDesign Wizard
mySewnet™ Embroidery also includes the ExpressDesign Wizard . Use it to 
automatically create embroideries from a picture, either to fit the current hoop or to fit an 
area you select. Choose from three design types:

Name Changer
Use Name Changer  to create a series of embroideries with varied lettering 
automatically from a template that you designed.

Express Embroidery Express Trace Express Border

Create a standard embroidery 
using satin, fill areas and 
outlining.

Trace outlines in a picture to 
create, for example, redwork, 
quilt stencils and so on.

Create satin line, appliqué, 
running stitch, triple stitch or 
motifs around the edges of solid 
color areas in the picture.

Return to work area

Open, save, export
and print projects

Configure your system

Create with a Wizard

Open another module

Start a new design

Open a recent project Access your account
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Spiro Wizard
Use the Spiro Wizard  to create intricate spiral designs in multiple colors, using 
Running, Double or Triple stitch lines.

PhotoStitch Wizard
Use the PhotoStitch Wizard  to create unique embroideries automatically from your 
own photos. Generate a linear pattern of stitches, or a Maze or Spiral effect, using one 
thread for a single color result.

Quilt Block Wizard
Use the Quilt Block Wizard  to create a filled or outline quilt block automatically. Place a 
quilting fill around an embroidery!

Family Tree Wizard
Use the Family Tree Wizard  to create an embroidery chart of your family’s history 
quickly and easily.

Color PhotoStitch 
Embroidery

Sepia PhotoStitch 
Embroidery

Monochrome 
PhotoStitch 
Embroidery

Color Tile 
PhotoStitch 
Embroidery

Linear PhotoStitch 
Embroidery

Create an 
embroidery from a 
color photo, using 
multiple threads for 
a full color result.

Create a sepia 
embroidery from a 
photo to give a 
heritage look, 
similar to old 
photos.

Create a grayscale 
embroidery from a 
black and white 
photo.

Create an 
embroidery from a 
color photo, 
generating small 
blocks of stitches 
with a tiled effect.

Create a single 
thread embroidery 
from a photo, 
generating a linear 
pattern of stitches, 
or a Maze or Spiral 
effect.

Filled Quilt Block; 
Inner Embroidery

Outline Quilt Block; 
Filled Inner Shape

Filled Quilt Block; 
Outline Inner Shape

Filled Quilt Block; 
No Inner Shape

Outline Quilt Block; 
No Inner Shape

Create a filled 
quilt block 
surrounding an 
embroidery.

Create an unfilled 
quilt block 
containing a filled 
shape.

Create a quilt block 
with an unfilled 
shape, surrounded 
by a fill.

Fill a quilt block 
with a motif or 
pattern.

Create a quilt block 
without any 
internal shape or fill.
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Background Wizard
Use the Background Wizard  to view your embroideries on real garments, fabrics and 
quilt blocks. Also view, reposition and store an unlimited number of appliqués and 
decorations for your designs.

Split Project Wizard
Use the Split Project Wizard  to split your embroidery automatically for your preferred 
hoop.

Finding Information

Reference Guide
The Reference Guide shows how to start the module and provides a quick tour of the main 
screen. This is followed by information on key features, with short ’How-To’ examples, 
which will help you learn how to use the module. It contains full reference information. 
The Reference Guide is supplied in PDF format , ready for printing.

Tooltips and Online Help
To learn about a function, position the arrow pointer over its icon. A tooltip with the 
function name and some information will appear.

The online help contains the ’How-To’ examples and full reference information. Use the 
Help icon , press F1 or click the Help button. Where available, a help topic will appear 
that is relevant to the item where help was requested.

Sample Guides
The Sample Guides show examples of the Fonts, Motifs, and Stitch Types that are available 
in the mySewnet™ Embroidery Software. The Sample Guides are supplied in PDF 
format , ready for printing.

The Fonts Guide shows the keystrokes used to produce the alternative alphabets used in some fonts in the 
National category.

Viewing and Printing PDF Guides
To find all the Reference and Sample Guides for your mySewnet™ Embroidery Software 
software, in Windows® 10 and 11 select the Desktop tile on the start screen. Then double-
click the mySewnet™ Embroidery Software shortcut on your desktop, and double-click 
Reference Guides or Sample Guides. Select the desired PDF guide.

To view and print the PDF Guides, you will need a PDF reader such as Windows® Reader (included in 
Windows® 10 and 11) or Adobe® Reader (available from adobe.com).

Readme
The most up-to-date details about the mySewnet™ Embroidery Software are in the 
Readme.rtf file . (Double-click on a Readme file to open it in WordPad or Microsoft® 
Word.)
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Sample Files
Samples are provided for your use. Download the sample files from the Downloads page: 
download.mysewnet.com. Copy the samples folder to the folder of your choice. 

For the exercises in this manual, the mySewnet folder is used.

Where to Start
Starting mySewnet™ Embroidery

Windows® 10 & 11
1 At the bottom left of your computer screen, open the Windows® 10 or 11 Start menu.
2 In the Windows Start menu, scroll down to the mySewnet folder.
3 In this section, click on mySewnet™ Embroidery  to launch it.

Shortcuts
An alternative to the Start screen/menu method described previously is to use a Shortcut 
to mySewnet™ Embroidery. This is created automatically during the installation process.

Windows® 10 & 11 (Start Screen) 
1 Click on the mySewnet™ Embroidery  tile in the Start Screen.

Windows® 10 & 11 (Desktop)
1 Close or minimize any programs you have running.
2 Double-click on the Shortcut to the mySewnet™ Embroidery Software folder. A list of the programs 

appears.
3 Double-click on mySewnet™ Embroidery  to launch it.

Closing mySewnet™ Embroidery

Exit
Ends the mySewnet™ Embroidery session. You can also use the Close command on the 
mySewnet™ Embroidery Control menu.

Shortcuts
■ Mouse: Click the Close icon  on the title bar or double-click the Control menu box.
■ Keys: Alt + F4

About mySewnet™ Embroidery
Access via the Help tab. The version number of your mySewnet™ Embroidery module is 
given here. You will need this if you contact technical support at any time.

Shortcut
■ Keys: Alt, P, A
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Parts of the Software Window

Title Bar
The title bar at the top of the window is 
highlighted if mySewnet™ Embroidery is 
active. The Quick Access toolbar gives icons for the following frequently used features: 
Insert, Save, Save As, Export, Print, Change Hoop, Undo, Redo, Life View and Design Player. 

If more than one instance of mySewnet™ Embroidery is open, each open window will 
show the name of the embroidery file.

Ribbon Bar
There are 12 tabs on the ribbon of mySewnet™ Embroidery: File, Home, Create, Encore, 
Letter, SuperDesign, Frame, Appliqué, Embellish, Modify, View and Help.

An alternative way to access ribbon options is to press the Alt key, then the highlighted letter of the tab, 
followed by the highlighted letter of the tab item, e.g. Alt, H, R to change between scale and resize modes. 
Some functions are available by pressing the Ctrl key and another key at the same time. These shortcuts 
are shown in the tooltip for the relevant function.
Use the Home tab to select, copy, group designs, resize, align and rotate, change threads 
with Color Tone, change the hoop and use the multi-hoop Endless  and Split Project  
wizards, and display embroideries with Life View and Design Player.

Create Tab
Use the Create tab to access the wizards. These are: the ExpressMonogram Wizard , the 
ExpressDesign Wizard , the PhotoStitch Wizard , the Word Sculpt Wizard , the 

Title BarRibbon Bar Tabs Ribbon Bar

Design PanelStatus BarWork Area

Quick Access Toolbar

FilmStrip
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Quilt Block Wizard , the Spiro Wizard , the Family Tree Wizard , and the Project-in-
the-Hoop Wizard . You can also access mySewnet™ Digitizing, mySewnet™ Cross 
Stitcher and mySewnet™ Sketch here.

Use the Encore tab to repeat embroideries along 8 different line types, in a circle, around 
one of 28 shapes, or to border your hoop.

Use the Letter tab to add lettering using single or multicolor fonts, fonts using puffy foam 
or special color effects, and fonts with alternative alphabets. Use the font gallery to choose 
a font visually from the font categories. Place characters with 35 different lettering shapes, 
31 of which can be used with multi-line lettering, and 29 can be used with individual 
lettering. Select the size, line formatting and adjust stitch types and settings in most fonts. 
Use the Font Manager to search for fonts by name and size, and to create and delete user 
fonts. Use the QuickFont Wizard  to create new fonts for mySewnet™ Embroidery from 
most TrueType® or OpenType® fonts on your computer, and use Import Font from 
Embroideries  to create a font from embroideries of letters.

Use the SuperDesign tab to add SuperDesigns, and adjust their size and appearance.

Use the Frame tab to surround a design with over 700 beautiful decorative frame and 
flourish options, including frames designed for puffy foam. Place flourishes above, below, 
or as a duo. Create a border automatically (optionally with appliqué fabric and placement 
stitching), or individual decorative motifs, or a motif underline.

Use the Appliqué tab to view and adjust appliqué pieces. The appliqué fabric is shown 
under the embroidery, as it would appear when stitched out. 

Use the Embellish tab to decorate your chosen background and embroidery with beads or 
sequins, and hotfix crystals or nailheads. 

Use the Modify tab to edit and insert stitches, or select a block of stitches for editing. Hide 
stitches by color or by using the draw range, to help with selecting the desired stitches. 
Cut and copy blocks of stitches or whole embroideries and paste to attach them to the last 
visible stitch. Insert new color changes and Stop commands with stitchout hints, change 
the order of colors and merge color blocks.

Use the View tab to adjust the Grid, measure a design, show and create garment, quilt 
block and fabric backgrounds with the Background Wizard , and change the view 
mode or hoop.

Work Area
The work area is the area where embroideries are loaded. The work area includes the area 
surrounding the selected hoop. It is where you make changes to an embroidery. The stitch 
area is the available area inside the selected hoop.

Stitches are drawn in the appropriate colors. The embroideries are shown in either 3D or 
2D. The background color and texture can be changed using mySewnet™ Configure .

A background garment, fabric or quilt block may be displayed.
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In Standard 3D view  the real hoop is shown, with blue corners 
showing the stitch area within the hoop. The background is 
shown.

In Realistic 3D view  the embroidery and background are 
shown without selection boxes, grid or hoop.

In 2D view , the hoop size is shown by a blue outline with bold 
corners. Stitches are drawn in plain colors only, and stitches using 
multicolor threads are drawn using only the first color in the thread definition. The 
background does not use texture in 2D view.

Background Grid
The work area has a grid, which can be turned on or off in the View tab, and the grid size 
changed. Zooming in or out makes the grid squares look bigger or smaller. The grid size 
can be changed from 2mm to 50mm using the View tab.

Design Panel
To the right of the work area is the Design Panel. Use the Design Panel to change colors, 
and to add or edit the Notes and Settings.

Design Information
The Design Information shows the dimensions (Height  and Width ), Stitch Count , 
and number of colors  for the active embroidery.

Color Select
The Color Select area shows the order of the color blocks in the color worksheet and any 
notes that are included in the embroidery. Click on a color block to change thread colors, 
and to add thread effects. In the Modify tab, use the color worksheet to show or hide 
stitches by color block, and move color blocks up  or down  and merge  them. 
Edit or add information to the Notes and Settings as desired.

Color Select is blank if no embroidery is selected.

Clipboard Block
The Clipboard Block shows the embroidery that can be pasted into the work area.

Click in the clipboard to remove the current Clipboard Block.

Overview Window
The overview window gives a small overview of the whole work area for the embroidery.

Status Bar
The status bar is found at the bottom of the window. The status bar shows:

■ The zoom tools and Zoom Bar.

Hoop Corner



mySewnet™ Embroidery   Getting Started              9

mySewnet™ Embroidery Terms and Conventions
On-screen pointers
The mouse pointer is most commonly shown as an arrow  on the screen.

If it is positioned over a text box it changes to an I-bar  and you can type, such as the Edit 
Notes dialog box.

If Zoom To Rectangle , or Zoom In  in a dialog box, is chosen the Zoom In pointer  
appears. If Zoom Out  is chosen in a dialog box, the Zoom Out pointer  appears. 
When zoomed in if the Pan feature is used to move around the screen, the Pan cursor  
appears.

The Box Select pointer , Freehand Select pointer  or Point Select pointer  appears 
when the associated Select function is chosen. Add to a selection with the Add to 
Selection  pointer, and remove items from a selection with the Remove from Selection 

 pointer.

There are several pointers indicating functions in the selection box. The Rotate pointer  
appears when the mouse pointer is over the Rotate handle , or the rounded rotate part 
of the Fabric handle . The cross-hair pointer  appears when the mouse is over the 
center of rotation .

The diagonal double-headed arrow  pointer appears when the mouse pointer is over a 
square corner handle . The horizontal double-headed arrow  pointer appears when 
the mouse pointer is over the Flip Horizontal handle . The vertical double-headed 
arrow  pointer appears when the mouse pointer is over the Flip Vertical handle . The 
pointer becomes a four-headed arrow  when it is over the selection box for one or more 
embroideries, when Move and Rotate Background  is selected, or when the square 
move fabric part of the Fabric handle  is selected.

The selection box handles are blue if in resize mode (density retained when resized), white 
in scale mode (stitch count retained when resized), and green for lettering, SuperDesigns 
and Frames or Flourishes, and light green for Monograms before they are fixed as 
embroideries.

The Measure pointer  appears when the Get Length  function is selected.

The Insert Color Command pointer , the Insert Stop Command pointer  or Insert 
Stitches pointer  appears when the associated Modify function is chosen.

When Fit to Rectangle  is chosen, the Draw Rectangle pointer  appears. In the 
ExpressDesign Wizard Rotate and Crop Picture page, the pointer becomes a double-
headed arrow  when you move the crop lines or a four-headed arrow  when you 
move the crop area. Also, for an Express Embroidery, the pointer becomes an 
eyedropper  to pick colors from a picture for thread colors or pick a background color.

The pointer becomes the Appliqué Fabric pointer  when adjusting appliqué fabric 
pieces.
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Information Symbols
The following information symbols are used.

Touch Gestures
Touch gestures are used when viewing and moving embroideries in the mySewnet™ 
Embroidery Software. They are available when using a touch-sensitive screen. 

General

Select and move
One finger touch and one finger slide are equivalent to click and drag with a mouse. Use 
to move embroideries, select, draw or create stitches with freehand features, and so on.

Autoscroll
When you drag within a document, the autoscroll feature moves the pointer 
automatically, changing the view of the work area. 

This is useful when zoomed in. Use autoscroll while moving or resizing a selected 
embroidery.

■ Use a two finger swipe on the work area.

Pinch to zoom
Pinch two fingers to zoom in, and spread two fingers to zoom out.

Context menu
Press and hold and a context-sensitive menu will appear if available (similar to a right-
click). 

mySewnet™ Embroidery and mySewnet™ Stitch Editor only

Multiple select
Two finger touch will add or remove an embroidery in the current selection (similar to 
Ctrl+click).

Pinch to resize or scale
Pinch two fingers inside the selection box to reduce, and spread two fingers to enlarge the 
selected embroidery, lettering or SuperDesign. 

Pinch outside the selection box to zoom.

Height Rotate

Width Height (percentage)

Number of Stitches Width (percentage)

Number of Colors
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Rotate
Twist your thumb and forefinger to rotate the selected embroidery, lettering or 
SuperDesign.

Embroidery File Formats
mySewnet™ Embroidery can load any of the following embroidery file formats: Bernina 
(.art version 1, 2, 3), Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby Lock/Bernina PES 
(.pes version 2 - 11), Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff (vp4, .vp3 and 
.vip), Husqvarna (.hus, .shv and .dhv), Janome (.jef and .sew), Melco (.exp), Pfaff (.pcs), 
Tajima (.dst) and Toyota (.10*).

mySewnet™ Embroidery saves embroidery files in Husqvarna Viking / Pfaff (.vp4) format.

Embroideries may only be saved in .vp4 format as this will preserve the separate parts of multipart designs. 
It also preserves thread color information and notes.
mySewnet™ Embroidery exports any of the following embroidery file formats: Husqvarna 
Viking / Pfaff (.vp4 and .vp3), Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby Lock/
Bernina PES (.pes version 2 - 11), Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff 
(.vip), Husqvarna (.hus ,.shv), Janome (.jef, .sew), Melco (.exp), Pfaff (.pcs), Tajima (.dst) and 
Toyota (.10*).

Picture Files
mySewnet™ Embroidery can load any of the following picture file formats in the 
ExpressDesign, PhotoStitch or Background Wizard: Windows or OS2 Bitmap (.bmp), JPEG-
JFIF Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), Tagged Image File 
Format uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows Enhanced Meta File 
(.emf) and Windows Icon (.ico). In addition, the ExpressDesign Wizard can load .4dq files 
produced by the Grace Company PatternCAD module.

mySewnet™ Embroidery also includes additional clipart, which may be used in the 
ExpressDesign Wizard.

mySewnet™ Embroidery can create pictures and videos of embroidery designs from 
Design Player and Life View.

Backgrounds
In addition to the basic Backgrounds installed with the software, further Backgrounds can 
be downloaded and installed from the Downloads page: download.mysewnet.com.

The following background file types and formats can be loaded and saved: garment, fabric 
and quilt block (.ebkg).

Fabric backgrounds are stored as .ebkg files. All backgrounds that you add are stored as .ebkg files.
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Hoop Selection
Use Hoop Selection  to choose the hoop size you wish to use in mySewnet™ 
Embroidery. Set the hoop size according to the size of your embroidery or the hoop you 
wish to use for stitching out, or enter any other desired size. The hoop information is 
stored in your .vp4 embroidery file, and used for your initial Export settings.

Shortcuts
■ Quick Access Toolbar, Home Tab, View Tab: 
■ Keys: Ctrl + H; Alt, 6; Alt, H, H; Alt, V, H

Hoop Group
The drop-down list of Hoop Groups shows all the machine Hoop Groups, and the My 
Hoops group, if used.

Hoop Size
The drop-down Hoop Size list shows the hoops in the chosen Hoop Group. Select the 
desired hoop size and a picture of the hoop will be shown in the Preview.

Included in My Hoops
Select (check) Included in My Hoops to add the selected hoop to the My Hoops list. Use 
the My Hoops list to create a list of your favorite hoops.

The selected hoops will be displayed in the My Hoops group in the order that they were selected.

Select the hoop size Choose a machine or hoop group

Enter a size for a custom hoop Select the hoop orientation

Add the hoop
to My Hoops
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Orientation
Select Natural or Rotated orientation according to the shape of the embroidery that is to 
fit in the hoop. Natural orientation is similar to the way the hoop would appear when you 
sit in front of your machine; note the position of the bracket.

It is recomended to use natural hoop orientation for designs with Twin Needle colors.

Enter Size
To enter a hoop size that is not listed in any of the Hoop Groups, click the Enter Hoop Size 
box so that it is selected (checked). The Width and Height boxes will become available. 
You can enter any size from 10mm to 4000mm. The preview shows the shape of the hoop 
you enter.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.
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2Managing Embroideries
Use New Window to create a new blank embroidery work area, Open  to load an 
existing embroidery in a new window, and Insert  to open an embroidery into the 
current window.

New Window
Use File, New Window to open an additional mySewnet™ Embroidery window so that you 
can paste a block to start a new project, or place embroideries, lettering, motifs, 
SuperDesigns or frames to form a project.

To move between open mySewnet™ Embroidery windows, hover over the mySewnet™ Embroidery 

icon  on the taskbar, and select the desired window.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + Shift + N

New
Use New (Ctrl + N) to clear the mySewnet™ Embroidery screen so that you can adjust new 
embroideries or place lettering, motifs, SuperDesigns or frames. If there are any new 
embroideries or embroideries with unsaved changes, you will be asked if you want to save 
them.

To open an existing embroidery, use Insert or Open.

Shortcuts
■ Keys: Ctrl + N

Open Embroideries
■ Use Open  to load individual files by thumbnail image, name or number, replacing the 

current embroidery. 
■ Use Insert  to insert an existing embroidery into your current project. Use Windows® 

Explorer to select an embroidery by key words in the file name or Notes, or to Load 
Embroideries with Drag and Drop. 

■ Use Paste  or Paste into Center  to insert a file from the clipboard. 
■ Open Recently Used Embroideries with File, Recent. 

The following embroidery file formats may be loaded: Bernina (.art version 1, 2, 3), 
Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby Lock/Bernina PES (.pes version 2 - 11), 
Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff (.vp4, .vp3 and .vip), Husqvarna 
(.hus, .shv and .dhv), Janome (.jef and .sew), Melco (.exp), Pfaff (.pcs), Tajima (.dst), and 
Toyota (.10*).
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Only Husqvarna Viking / Pfaff (.vp4, .vp3 and .vip) embroidery files contain full thread 
color information that will be shown in the original thread colors. Other files that hold 
some color information, such as .hus, .shv, .dhv, .pcs, .pes, .sew and .xxx, are shown in the 
nearest match to the colors in which they were created. The shades are converted to the 
Import Thread Range, as selected in mySewnet™ Configure. For files that do not store 
colors, such as .dst, .exp and .10*, the embroidery will be shown in a default color 
sequence, using thread colors from the Import Thread Range.

Open
Use Open  to load an existing embroidery, replacing the project in the current window. 
mySewnet™ Embroidery displays the Open dialog box so you can choose an embroidery 
to open. Files in .vp4 format will be loaded in the correct hoop, with background and 
groups exactly as saved. Alignment stitches will be retained.

Use Insert  to add an existing embroidery to a project.

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open. This box lists files with the extension you 
select in the Files Of Type box.

Files of Type
Select the type of file you want to open.

Look In
Select the drive or folder containing the file that you want to open.

More Options
Switch from list  or details  view to icons with thumbnail images of the embroideries. 
For example, Extra Large icons .

Click Open to load the selected design

Browse to a different folder

Click on a design to preview it

Hover to view the selected design’s details

Previewed design

Search for a design

Change the view or icon size
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Preview Pane
Preview the embroidery before opening .

Shortcuts
■ File Menu: 
■ Keys: Ctrl + O

Insert
Use Insert  to add an existing embroidery into your current project. The Open dialog is 
displayed so that you can choose an embroidery to insert. Multipart designs will be 
grouped automatically. Alignment stitches will be removed.

The hoop and background are not shown when inserting an embroidery. Use Open  to load a design 
with the hoop and background.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + I; Alt, 1

Load an Embroidery
1 Click File at the top left to open the Welcome screen.
2 In the Welcome screen, click Blank Canvas  to start a new project. The Hoop selection dialog 

opens.
3 Click the Hoop icon , and ensure that the hoop is set to 100mm x 100mm - Universal Square 

Hoop 1. Click OK.
4 Click Insert .
5 In the Open dialog box, browse to the folder \mySewnet\Samples\Embroidery\Stitch. The 

embroideries in the folder will be shown.
If desired, click Change Your View  to view icons of the embroideries.

Click Open to load the selected design

Browse to a different folder

Click on a design to preview it

Hover to view the selected design’s details

Previewed design

Search for a design

Change the view or icon size
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6 Scroll down to show the thumbnail of the bells.
If you position the arrow pointer over a thumbnail without clicking, the details about the embroidery will 
be shown.

7 Click the picture of the bells and the embroidery will be selected.
8 Click Open to load the embroidery onto the screen.

Load Embroideries with Drag and Drop
To drag and drop as many embroideries as desired onto the screen, use Windows® 
Explorer. Hold down the Shift key to select a consecutive group of embroideries. Hold 
down the Ctrl key to select individual embroideries.

Drag an Embroidery to the Work Area
1 Open a Windows® Explorer window. If required, resize the Explorer window so you can see both 

Explorer and mySewnet™ Embroidery.
In Windows® 10 & 11 click File Explorer on the Status Bar.

2 Browse through the drives and folders of your computer to find the 
\mySewnet\Samples\Embroidery\Stitch folder.

3 Click on an embroidery icon to highlight it. Hold down the Shift key to select consecutive files or Ctrl 
key to select multiple individual files.

4 Use the mouse to drag and drop the embroideries on the mySewnet™ Embroidery screen. All the 
embroideries will be opened in the same window in mySewnet™ Embroidery.

5 Close Windows® Explorer.

Open Recently Used Embroideries
Use File, Recent to open previously used embroideries via the filenames listed in the 
Recent section of the File menu. Select the name of the desired embroidery.
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Save Embroideries
There are four methods of saving embroideries: Save, Save As, Export and Save On Close 
or Exit.

Use Save or Save As to retain a multipart project file.
Use Export to save an embroidery for stitching out, or to save in a format other than .vp4.

Save
Use Save  to save the active embroidery file as a multipart embroidery in .vp4 format. If 
the embroidery has already been saved, this will save any changes using the existing 
name and folder.

Use Save for projects that you cannot Export, such as multipart embroidery projects with designs that do 
not fit in the selected hoop.
When first saving a new embroidery, this saves the embroidery with the name you give it 
in the Save As dialog.

Save will overwrite the existing embroidery. If you want to change the name and folder of an existing 
embroidery file before you save it, choose the Save As or Export functions.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + S; Alt, 2

Save As
Use Save As  to save the embroidery project in .vp4 format under a new name. For 
instance, you might add some lettering to an embroidery and want to save the changed 
embroidery with a new name.

This displays the Save As dialog box so that you can save the embroidery with a new file 
name.

To save an existing embroidery file without changing its name, use Save .
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Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Shift + S; Alt, 3

Save On Close or Exit
If you make changes to an embroidery, then try to close 
the embroidery before saving the changes, a message 
will appear, asking if you want to save the changed 
embroidery.

Choose between:

Yes Save the changes to the embroidery. If it is a new embroidery, show the Save As dialog 
box.

No Do not save the embroidery and continue. Any changes to the embroidery are lost. If it 
was a new embroidery then it is discarded without being saved.

Cancel Do not save the embroidery, but keep the embroidery open and do not close 
mySewnet™ Embroidery.
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Export
Use Export  to save the embroidery in the current window as a flattened .vp4 file, or in 
an alternative embroidery format. The embroidery must fit in the currently selected hoop. 
Use the Design Player to see how the embroidery will be exported according to the 
current options.

You can customize the initial Export options in mySewnet™ Configure.

The preferred file format for exporting embroideries is Husqvarna Viking / Pfaff .vp4, as 
this will preserve background and appliqué information, thread color information and 
notes.

You can also export embroideries as Brother/Baby Lock/Bernina PEC (.pec), Brother/Baby 
Lock/Bernina PES (.pes), Compucon/Singer PSW (.xxx), Husqvarna (.hus ,.shv), Husqvarna 
Viking /Pfaff (.vp4, .vp3, .vip), Janome (.jef and .sew), Melco Expanded (.exp), Pfaff (.pcs), 
Tajima (.dst) or Toyota (.10o).

The initial name will be the current file name with "Exported" added. The text "Exported" may be changed 
in mySewnet™ Configure.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + E; Alt, 4

Optimize for Sewing Options
All of these options are initially selected when saving as a .vp4 file, or in any other format.
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Combine: Merge the embroideries into a single embroidery during Export.

Combine is not enabled if there is only one design, and for embroidery formats that are automatically 
combined.
Remove Overlap: Prevent areas of stitches building up where embroideries overlap. 
Remove Overlap is not used if any of the designs contain appliqué.

Remove Overlap is not available when Combine is not enabled.
Deselect this option if, for example, your embroideries are low density and you wish to have a blend effect 
where they overlap. Also, some multipart embroideries are created with areas that are designed to overlap 
each other near the mid-section of a turnable hoop. When viewing these designs in mySewnet™ 
Embroidery, deselect Remove Overlap before exporting. Deselect Remove Overlap in mySewnet™ 
Configure, Export, before sending them to the embroidery machine.
ColorSort: Reduce the number of thread colors during Export. See “ColorSort” on 
page 57.

Optimize Stitch Length: Automatically remove small and insignificant stitches. See 
“Stitch Length Optimizer Options” on page 24.

Cutwork Needle lines in the Inspira Cutwork Needle "thread range" and Felting Needle colors in the Inspira 
Felting Needle "thread range" are unaffected by Optimize Stitch Length.

Decoration
Create Center or Line placement stitches for Decorations added in mySewnet™ 
Embroidery, or remove all decorations and their associated placement stitches.

Center or Line placement stitches are created automatically for decorations according to 
the options set in mySewnet™ Configure, which may be altered when you export the 
embroidery. Alternatively, create crystal transfer templates for automated cutters with 
Export Decoration Template.

Center placement stitches are recommended when most decorations are individual and 
symmetrical. Line placement stitches are recommended when most decorations are 
individual and asymmetrical (such as bugle beads) or lines of closely spaced beads or 
sequins.

Create Center placement stitches: Create a small cross shape in stitches to show where 
the decoration is to be placed.

Create Line placement stitches: Create a single stitch that runs along the length of the 
decoration.

Remove all decorations and placement stitches: Remove all decorations and placement 
stitches from the exported version. This may be desired to create an embroidery with a 
complementary crystal transfer template (made using the Export Decoration Template 
dialog box). See “Export Decoration Template” on page 27.

Hoop Orientation
Set the hoop orientation.

Rotate to fit natural hoop position: Rotate the embroidery if needed to fit with the 
default hoop orientation for the machine. This option is only available if the hoop on the 
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main screen is in the rotated orientation. It is useful if you prefer to create a "landscape" 
shaped project in the rotated orientation.

Flip design for felting or reverse embroidery: Flip the embroidery for being stitched in 
reverse. If an embroidery contains a Felting Needle color effect this option is selected 
initially. See “Felting Needle” on page 56.

Splitting options
Click the button to open the splitting options dialog box. See “Splitting for Multipart 
Hoops” on page 22.

Splitting for Multipart Hoops is available if .vp4, .vp3, .pes or .jef is chosen.

Additional Sections
Additional dialog sections are available, depending on the chosen file format.

■ If .vp4, .vp3, .pes or .jef is chosen, Splitting for Multipart Hoops is present. See “Splitting for 
Multipart Hoops” on page 22.

■ If .pes is chosen, you can select your machine type, file version, hoop size and rotation.
■ If .jef is chosen, you can select your machine type, hoop size and rotation.

OK
View the Save, or Saving As dialog, depending on the selected file format.

Export an Embroidery
1 Create an embroidery project.
2 Save  the embroidery. See “Save” on page 18.
3 Click Export . The Export dialog box appears.
4 Select an embroidery format from the drop-down list.
5 Select your optimization options.
6 If you are using a multipart hoop, set Intelligent or Straight Line split.
7 Click OK.
8 The Save As dialog will appear. Save the embroidery as desired. 

When exporting an embroidery, the message 'Design is too large or is not in the hoop.' may appear. This 
means that some part of your embroidery is not entirely within the hoop, as indicated by round resize 
handles on the embroidery. If you have multiple elements that need to be combined, use the Tab key to 
step through the embroideries until you find the item with round resize handles. Move the embroidery so 
that it fits inside the hoop, and the resize handles will change back to squares. If desired, use the arrow keys 
to nudge the embroidery in small steps.

Alternatively, use the Move Into Hoop  feature on the Home tab.

Splitting for Multipart Hoops
This dialog is available if .vp4, .vp3, .pes or .jef is selected as the file format.
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Embroideries for Multipart hoops are split automatically, according to your Export 
settings. Use an Intelligent or Straight Line Split.

There is no need to ensure embroideries are in one stitch area of the hoop; just place your embroideries in 
the most pleasing arrangement. 

Split Method
You can use one of two split methods:

■ Intelligent Split automatically calculates a split line that is routed through gaps or across 
movement stitches, cuts the minimum number of stitches, and minimizes cuts through 
solid sections of embroidery. Where possible, use Intelligent Split.

■ Straight Line Split cuts the embroidery straight across the center line of the overlap zone.

Intelligent with Tolerance
Intelligent Split calculates a split line that cuts the minimum number of stitches, and 
minimizes cuts through solid sections of embroidery. For example, a large embroidery is 
split at a narrow section, and an embroidery that fits in one stitch area of the hoop is left in 
one piece even if it is part of a larger design.

Tolerance ensures that the Intelligent Split line stays a short distance from the edges of 
the overlap. This allows for play in the hoop when going from one hoop area to another, 
such as when aligning a hoop that has been turned to stitch out the other side of an 
embroidery.

You can set Tolerance from 0 to 3mm, in steps of 1mm. The initial setting is 1mm.

To use Intelligent Split with Tolerance, select the "Intelligent with Tolerance" checkbox, then enter a number 
in the Tolerance number box, or use the arrows to increase or decrease the Tolerance.

Straight with Compensation
Straight Line Split cuts straight across the center of the overlap zone. Straight Line Split 
will only split an individual embroidery if, before it is combined with everything else, it 
does not fit entirely into one stitch area of the hoop.

Lettering is split straight down the middle, as with any other type of embroidery. This may cut through 
characters rather than gaps and spaces. In such cases, it is recommended to use Intelligent Split instead.
Compensation adds overlapping stitches along the edges where the embroidery is split. 
This compensates for pull on the fabric.

Alignment Stitch for Turnable Hoops
Select this option to add an alignment cross at the end of each embroidery section when 
using the HUSQVARNA VIKING® Designer Majestic™, PFAFF® creative Grand Dream™, 
Universal Multipart hoop, or Brother Jumbo Frame. A hoop movement to the alignment 

None Use None if you can split an embroidery without cutting through any of the design 
elements. Compensation is initially set to None.

Low Use Low when cutting through a lightly stitched embroidery or when the split lines go 
through only a few stitch areas.

High Use High when the embroidery is dense, when the split lines make long splits through 
stitch areas, or when stitching onto materials such as knitted or stretchy fabric.
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cross is added at the beginning of the next section. The next embroidery section can then 
be correctly aligned, or alignment can be confirmed.

Stitch Length Optimizer Options
Use the Stitch Length Optimizer Options dialog box to automatically remove small and 
insignificant stitches. You can adjust the stitch removal sensitivity, or the minimum 
significant stitch length.

Stitch Length Sensitivity
Adjust the sensitivity of the optimization. Low is set as the default.

■ Choose from Low, Medium or High.

Minimum Significant Stitch Length
Select the shortest stitch length that you consider to be significant. Stitches below this 
length are removed during the optimization process. The default stitch length is 0.8 mm.

Cutwork Needle lines are unaffected by the Minimum Significant Stitch Length.
■ Choose from 0.6 mm, 0.8 mm or 1.0 mm.
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Export Appliqué Pieces
Use Export Appliqué Pieces  to save or print appliqué outlines ready for cutting. Select 
the desired method and options, then click the Export or Print button at the bottom of the 
dialog box.

There are five appliqué piece export methods:

■ Export for Cutter: Save as SVG, DXF or FCM files for use in fabric cutters
■ Export for Cutwork Needles: Save as VP4 or VP3 stitch files that can be used with 

INSPIRA™ Cutwork Needles
■ Print Templates: Print as an outline template to stick or pin to fabric and then cut out
■ Print Appliqué Pictures: Print directly onto printable fabric or an iron-on transfer; this 

also prints the image of the appliqué piece
■ Export for Custom Layout: Save as PNG files with the fabric image placed as the fill for 

each shape. This is designed for use with fully customized layouts.

Export for Cutter
Export the appliqué piece as an SVG, DXF or FCM image file for use in a fabric cutter.

Set the units of measurement (millimeters, inches or points), and select a file type. Click 
Export to save the file.

The maximum size for the Brother ScanNCut FCM format is 12" x 12" (305mm x 305mm).

Export an SVG, DXF or FCM file 

Use 2 or 4 cutwork needles

Add secure points for fabric stability

Export a .vp3 or .vp4 stitch file

Print as an outline template for cutting out

Print onto printable fabric or an iron-on transfer

Save as a PNG custom layout with fabric images

for use in a fabric cutter
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Recommended file formats for cutters:

Export for Cutwork Needles
Export the appliqué piece for cutting with INSPIRA™ Cutwork Needles. Select 2 or 4 
needles, choose whether to use secure points for fabric stability and their length, and use 
a .vp3 or .vp4 stitch file.

Print Templates
Print the appliqué piece as an outline template to stick or pin to fabric and then cut out. 

Select a printer and paper size in the Print Setup dialog box. See “Print Setup” on 
page 508.

Print Appliqué Pictures
Print directly onto printable fabric or an iron-on transfer; this also prints the image of the 
appliqué piece.

Flip the picture for an iron-on transfer, and select a printer and paper size in the Print 
Setup dialog box. See “Print Setup” on page 508.

Export for Custom Layout
Save as PNG files with the fabric image placed as the fill for each appliqué piece shape. 
This is designed for use with fully customized layouts, for example if you wish to arrange 
the shapes in your cutter software or in another graphics package.

Shortcuts
■ File Menu: 
■ Keys: Ctrl + Shift + E

Cutter Software Export Format

Cricut Explore® Cricut Design Space 3.1512 SVG (points)

KNK Zing Air® Make the Cut! 4.6.1 (Zing Plugin 2.1.0) SVG (points)

Silhouette Cameo® Silhouette Studio 3.6.57 ss
(Use "As Is" import settings)

DXF (millimeters)

Brother ScanNCut® (2) Direct to USB stick or machine FCM

Sizzix Eclips2 eCal2 2.203 SVG (points)
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Export Decoration Template
Use Export Decoration Template  to save a template for all your decorations in a format 
for your automated cutter. This can be used to create a crystal transfer template (or 
rhinestone template) for pressing hotfix crystals and nailheads directly onto your work.

Export for Cutter
Export the decorations as an SVG, DXF or FCM image file to create a crystal transfer 
template for use in an automated cutter. 
Set the units of measurement (millimeters, inches or points), and select a file type. 
Recommended file formats for cutters:

Template Options
Select (check) Separate Templates by Color to create a separate template for different 
decoration types, for example if you wish to use the same size of crystal in two different 
color ways.

Alignment Stitches
Add alignment stitches for aligning the decoration subdesign with the embroidery. Select 
from None (the default), Corners and Outline.

Shortcuts

■ File Menu: 
■ Keys: Ctrl + Shift + D

Cutter Software Export Format

Cricut Explore® Cricut Design Space 3.1512 SVG (points)

KNK Zing Air® Make the Cut! 4.6.1 (Zing Plugin 2.1.0) SVG (points)

Silhouette Cameo® Silhouette Studio 3.6.57 ss
(Use "As Is" import settings)

DXF (millimeters)

Brother ScanNCut® (2) Direct to USB stick or machine FCM

Sizzix Eclips2 eCal2 2.203 SVG (points)

Select measurement units for the decoration template

Export decoration template as an SVG, DXF or FCM file

Create separate templates for different decoration types

Add stitches to align the template with the embroidery
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Sending Embroideries 
Send designs to your mySewnet™ enabled embroidery machine via mySewnet™ from 
within the mySewnet™ Embroidery Software, or directly from your mySewnet™ account.

Use mySewnet™ Connect to change your mySewnet™ settings, and to send embroideries 
directly to some HUSQVARNA VIKING® or PFAFF® machines using Direct USB Connection.

Send
Use the Send dialog to send the selected embroidery to the mySewnet™ Cloud, or to your 
machine.

Send to mySewnet™ Cloud
Send the selected embroidery design to the mySewnet™ Cloud.

Send Express to mySewnet™ Device
Send the selected embroidery design direct to the mySewnet™ enabled machine or 
computer.

Select the computer or machine from the list below.

Direct USB Cable
Send or Send Express to a machine with a direct USB connection.

Filename
You can change the name of the design before sending it.

Send the design to the mySewnet™ Cloud 
Send directly to a mySewnet™ device 

Select the machine or computer for sending to

Send to a machine using a Direct USB cable

Start the mySewnet™ Connect utility 

Change the design name before sending
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Sending via mySewnet™

Sending from a Machine to mySewnet™ Embroidery
You can send an embroidery from a mySewnet™ enabled embroidery machine to 
mySewnet™ Embroidery on your computer. Adjust the embroidery, then return it to your 
machine for stitching.

To be able to send from your machine to mySewnet™ Embroidery, and to send to your 
machine with Send Express to mySewnet™ Device:

■ mySewnet™ Connect must be running on the computer
■ You must use a mySewnet™ enabled embroidery machine with the most recent updates 

installed
■ The computer and embroidery machine must be signed in to the same mySewnet™ 

account.

An embroidery moved from a machine to mySewnet™ Embroidery will include no special features from the 
embroidery machine, for example changing the words for lettering. This is also true of designs sent in the 
other direction.

Send from an Embroidery Machine
1 Go to the embroidery machine.
2 Tap the Cloud button at the top and ensure that you are signed in to mySewnet™.
3 Select embroidery mode, and then load an embroidery.
4 In the machine screen, choose the send to software option. 
5 Select the computer to send to, then send the embroidery. 

The embroidery will open in a new mySewnet™ Embroidery window.
6 When you have adjusted the embroidery, save the changes to your computer.

You can name your computer in the mySewnet tab of mySewnet™ Configure.
You can then use Send Express to mySewnet™ Device to return the edited embroidery to 
your machine for stitching out.

When you send from your embroidery machine to mySewnet™ Embroidery, the embroidery may be sent to 
a window beneath the active maximized window. The mySewnet™ button in the taskbar flashes to 
indicate that a design has been sent.

Using Send Express to mySewnet™ Device
1 In the File menu, select Send.
2 In the Send dialog box, select your machine name from the list. 

A message tells you that the design was sent.
3 On the machine, tap to accept the design from your computer.
4 Stitch out the design.

You can use Send to mySewnet™ in the Explorer Plugin to send embroideries to mySewnet™. See the 
mySewnet™ Configure Reference Guide and Help.

Sending to a Machine via Direct USB Connection
Use mySewnet™ Connect to send embroideries directly to your embroidery machine 
screen, or to the embroideries folder on your embroidery machine with Direct USB 
Connection.
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■ mySewnet™ Connect must be open to transfer files directly to and from the embroidery 
machine when it is connected to your computer. 

■ Use the file manager on your embroidery machine to browse your computer and copy 
embroideries to any folder on your machine.

When Direct USB Connection is established, the machine name will be shown in the Machine menu.

Using mySewnet™ Connect with Direct USB Connection
Before using Direct USB Connection, ensure that your drivers are up to date at 
mysewnet.com

1 First, check your Direct USB connection.
Switch off your embroidery machine.

2 Open mySewnet™ Configure , and if the mySewnet™ Connect icon cannot be seen in the system 
tray, click Start mySewnet™ Connect  on the Utilities tab. 
The mySewnet™ Connect icon can be seen in the system tray, however it is flagged as inactive .

3 Switch on your embroidery machine, and wait for it to initialize. The mySewnet™ Connect icon is now 
flagged as active . 
You can now send embroideries to your embroidery machine’s screen or designs folder.
Communication will also be shown as established if  a connection exists with mySewnet™.

4 Open mySewnet™ Embroidery, then use Insert  to load an embroidery design.
5 In the File menu click Send.
6 In the Send dialog box, select Send Express to USB connected machine, then click Send. The 

embroidery appears on the embroidery machine screen.
You can now stitch it on your embroidery machine.

7 In the Send dialog box, select Send to USB connected machine. Then click Send to send the 
embroidery to the MyFiles or Personal Files folder on your embroidery machine.
You can also send embroideries to your directly connected machine via the mySewnet™ Embroidery 
Software Explorer Plugin. See the mySewnet™ Configure Reference Guide and Help.

8 Right-click the mySewnet™ Connect system tray icon. A context menu appears.
9 Ensure that Start Automatically is selected, to start mySewnet™ Connect whenever your computer is 

started.
10 Click About mySewnet™ Connect to view the version number.

You will need this version number if you contact technical support at any time.

mySewnet™ Connect
Use the mySewnet™ Connect module in the mySewnet™ Embroidery Software to access 
your mySewnet™ settings in mySewnet™ Configure, and to send embroideries directly to 
some HUSQVARNA VIKING® or PFAFF® machines using Direct USB Connection.

To change your mySewnet™ settings, see the mySewnet™ Configure Reference Guide and Help.
Use the mySewnet™ Connect menu to check the status of your mySewnet™ or Direct USB 
Connection.

The System Tray Icon
When mySewnet™ Connect is running, it appears as an icon in the system tray  at the 
bottom right of your computer screen. The icon will show whether or not communication 
is established with your machine as follows:

Communication established No communication
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■ Click or right-click the icon to see the mySewnet™ Connect Menu.

Communication is shown as established when a connection exists with either mySewnet™ or with your 
embroidery machine via Direct USB Connection.

Starting mySewnet™ Connect
mySewnet™ Connect is set to start automatically when you restart your computer. If it is 
not open, use the following steps.

1 Open mySewnet™ Configure .
2 On the Utilities tab, click Start mySewnet™ Connect . The mySewnet™ Connect icon  can now 

be seen in the system tray.
3 To close mySewnet™ Connect, click the icon in the system tray and in the mySewnet™ Connect menu 

click Exit.

mySewnet™ Connect Menu
Click the mySewnet™ Connect icon in the system tray to see a menu of options.

The menu tells you whether you are signed in to mySewnet™, and if Direct USB 
connection is active.

For mySewnet™ the current status in mySewnet™ Configure is listed, for Direct USB your machine name or 
Not Connected are present. If you have more than one machine, the first found is used.

■ Select About mySewnet™ Connect to see the version number and copyright.
■ Select Start Automatically to select or deselect the automatic start when Windows® starts.
■ Select mySewnet™ Options to view the mySewnet tab in mySewnet™ Configure.
■ Select Direct USB Settings to view the shared drives list.
■ Select Help to display help pages about mySewnet™ Connect.
■ Select Exit to close mySewnet™ Connect and remove it from the system tray.

Shared Drive Selection
Click the icon in the system tray, and select Direct USB Settings in the popup menu that 
appears.
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The Shared drives list shows all the drives on the computer. Drives that are selected with 
check marks can be browsed from your embroidery machine. All available drives are 
selected when mySewnet™ Connect is installed. If you add new drives after installing 
mySewnet™ Connect, such as a USB stick, you will need to click the drive so it is checked. 
Click the check boxes to uncheck drives that you do not want to browse from your 
embroidery machine.

The mySewnet™ Cloud Sync Tool
Use the mySewnet™ Cloud Sync Tool to manage the content of your mySewnet™ 
compatible embroidery machine from your PC.

The mySewnet™ Cloud Sync Tool is available from: www.mysewnet.com

Select your machine brand, Register or Sign In, and in the Home page select mySewnet™ 
Cloud to download and install the Sync Tool.

The System Tray Icon
When the mySewnet™ Cloud Sync Tool is running, there is an icon on the bottom right of 
your computer screen. The icon will show whether or not the Sync Tool is running:

■ Left-click the icon to view your mySewnet™ folder and the mySewnet™ website.

■ Right-click the icon to see the mySewnet™ Cloud Sync Tool menu.

For more information, click Getting Started in the mySewnet™ Cloud Sync Tool menu.

Sync Tool Active Sync Tool Inactive



mySewnet™ Embroidery   Managing Embroideries              33

Working with Protected Designs
Designs from the mySewnet™ Library are opened in a protected state, as indicated by a 
library design  &  symbol in the FilmStrip.

Any project that includes a mySewnet™ Library design will be saved or exported in a 
protected state.

You can only stitch out protected projects on a mySewnet™ Library enabled embroidery machine.

Opening and Inserting Protected Designs
Protected designs can only be opened in mySewnet™ Embroidery or mySewnet™ Stitch Editor. They cannot 
be opened in any other module.
When you use Open  to load a mySewnet™ Library design, or a project containing a 
Library design, the protected sub-designs are shown in the FilmStrip.

If a project that includes a mySewnet™ Library design is opened with a mySewnet™subscription 
present, the protected parts will no be loaded.

Saving and Exporting Protected Designs
When protected projects are saved with Save  or Save As , a protected format .evp4 
file is created.

When protected projects are Exported , the protected format .evp3 is used.

You can only stitch out protected projects on a mySewnet™ Library enabled embroidery machine.

Working with a Protected Project
Any project that includes a mySewnet™ Library design becomes a partially protected 
project. The protected components can only be stitched out on mySewnet™ Library 
enabled machine with an active mySewnet™ Library subscription.
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Printing a Worksheet
When you print a worksheet for a protected project, the words "Protected file" can been 
seen at the bottom of the worksheet.

Browsing Protected Designs
Designs from the mySewnet™ Library use the file extensions .evp3 and .evp4.

When in Icon view in Explorer, the Protected Design icon  can be seen.

To identify protected designs in thumbnail view, 
ensure that  the ’File name extensions’ option is 
checked. 

To see the design type and details for the design, 
hover over the design to read the tooltip.



mySewnet™ Embroidery   Viewing Embroideries               35

3Viewing Embroideries

3D and 2D View
Use View Mode in the View tab to toggle between 3D View , Realistic 3D , and 2D 
View  stitch display. 

Stitches are automatically displayed in 2D when you select the Modify tab.
Use 2D to see the individual stitches with no shading. Use standard 3D View to see how 
the embroidery will be stitched out with three-dimensional shading. Use Realistic 3D to 
view embroideries and background in 3D without selection boxes, grid or hoop. 

Some functions are not available in Realistic 3D .

3D View
Use 3D View  to view embroideries and background in standard 3D mode. All editing 
functions are available, and the selection box is shown.

Shortcuts

■ View Tab: 
■ Keys: Ctrl + T; Alt, V, 3

Realistic 3D
Use Realistic 3D  to view embroideries and background in 3D without selection boxes, 
grid or hoop. You can use the zoom commands, but some editing functions are not 
available.

3D View Realistic 3D 2D View 

Show and adjust the grid

Open or create a Background
Move or rotate the Background Show and fade the Background

Change the view mode

Choose a different hoop

View the Design PanelRemove the background
Measure a distance

View the FilmStrip
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Shortcuts
■ View Tab: 
■ Keys: Ctrl + R; Alt, V, R

2D View
Use 2D View  to view the individual stitches in embroideries with no shading, or thread 
effects. 

Stitches are automatically displayed in 2D when you select the Modify tab.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, 2

Zoom Commands
A number of functions are available to make it easier to navigate around embroideries, 
including the Zoom functions and Overview Window. By default, the hoop is shown at a 
size so that the hoop fills the window, the same as if you click Zoom To Fit  after 
zooming in or out.

You can also change the view of an embroidery by using the Modify tab to select the colors to see and 
change the range of stitches that are displayed.

Shortcuts

Zoom To Rectangle
Use Zoom To Rectangle  to enlarge the view of an area of the 
embroidery.

Click the Zoom To Rectangle  icon to the right of the status bar, and 
the mouse pointer changes to the zoom in pointer . Then either 
click a point on the embroidery you want to zoom in towards, or click 
and drag a rectangle around the area you want to zoom in to and 
release the mouse button to zoom.

Zoom To Rectangle is automatically deselected after you have used it.

Zoom Out Keys: Ctrl + -

Zoom To Rectangle Keys: Ctrl + 0

Zoom In Keys: Ctrl + =

Zoom To Fit Keys: Ctrl + 9

Click and drag to zoom in on an area

Zoom to Fit
Drag to zoom in and out Click to zoom in instantly

Click to zoom out instantly

Select or input percentage zoom
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Shortcuts
■ Status Bar: 
■ Keys: Ctrl + 0

If you have a wheel mouse, hold the Ctrl key and move the wheel to zoom.

Pan Mode
Use the Pan feature to move around the screen easily. The Pan feature works when you are 
zoomed in on part of the screen, making the scroll bars visible at the right and bottom of 
the work area. 

Hold the Space key down, then start to click and drag. The pan pointer  appears. Click 
and drag until the pointer is in the desired part of the screen.

The pan occurs in real time, that is you see the work area move as you drag across the 
screen.

Alternatively, use the Overview Window to move around the screen when Zoomed In.

Pan Around the Work Area
1 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .
2 Click and drag to draw a box, then release to zoom in. Scroll bars appear to allow you to move around 

the screen at this higher zoom level.
3 Hold the Space key down, then start to click and drag. The pan cursor  appears.
4 Click and drag until the pointer is in the desired part of the screen. (If you have a wheel mouse, you 

can click the wheel to pan around the screen.)
5 Lift the pen or release the mouse button.

Zoom To Fit
Use Zoom To Fit  to view the whole hoop area. Click the Zoom To Fit icon to the right of 
the status bar, and the view will zoom in or out to show the hoop area in the window.

Shortcuts
■ Status Bar: 
■ Keys: Ctrl + 9

Zoom By Percentage
Use the drop-down list in the Status Bar to set percentage levels to zoom in for the active 
embroidery, from 25% up to 800%. Alternatively, enter a number in the percentage text 
box.

Select 100% to display the embroidery at a magnification as close as possible to the Real Size setting you 
chose in mySewnet™ Configure.

Shortcuts
Keys: 100%: Ctrl + 1

200%: Ctrl + 2
400%: Ctrl + 3
800%: Ctrl + 4
75%: Ctrl + 5
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50%: Ctrl + 6
25%: Ctrl + 7

Zoom Bar
Use the Zoom Bar to zoom in or out from the center of the currently selected picture or 
embroidery.

The Zoom Bar is on the right side of the Status Bar.

Use the slider to zoom in or out of the picture or embroidery, or click on the Zoom In  or 
Zoom Out  icons to increase or decrease magnification 10% at a time.

Overview Window
The overview window gives a small overview of the whole work area for the current 
embroidery window. 

When you zoom in a box is shown around the area that is currently visible in the main 
window. Click and drag the box to move to another part of the window.

If there are stitches hidden for the current embroidery, these will also be hidden in the Overview Window.

Show Grid
Use Show Grid  to switch the grid on and off. The grid may be used to help align 
embroideries and stitches.

The cross in the center marks the center of the embroidery. The cross is larger when you zoom in closer.

Size
Set the grid size between 2mm and 50mm, depending on what setting is most suitable for 
your screen resolution and embroideries. Type in a figure or use the up and down arrows 
to change the number. The initial setting is 10mm.

If you position the arrow pointer over the box without clicking, the alternative units and range are shown. 

Grid On Grid Off
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Shortcuts
■ View Tab: 
■ Keys: Alt, V, G

Get Length
Use Get Length  on the View tab (and on the Modify tab) to 
measure the distance between any two points on an embroidery. Click 
the Get Length icon  and the mouse pointer changes to the 
Measure pointer . Then click and drag a line across the embroidery. 
The length of the line is displayed.

For example, use this to obtain the width of a column of stitches or the 
distance between lines of stitching.

The length is shown in millimeters or inches, according to the setting for Show 
Measurements in mySewnet™ Configure. The alternative units are shown in 
parentheses.

Shortcuts
■ View or Modify Tab: 
■ Keys: Alt, V, L; Alt, M, L

Measure Part of an Embroidery
1 Click the Get Length icon. The pointer changes to the measure pointer .
2 Click and drag across the part of an embroidery you want to measure.
3 Read, and if desired, make a note of the number.
4 Repeat the click and drag to measure any other distances, as required.
5 Right-click to deselect the function.

Viewing Backgrounds
Use the Background slider bar to show the garment, quilt or fabric background as On, Off, 
or faded.

Use Move and Rotate Background  to move the garment, quilt or fabric background.

The Background tools are only available after a Background has been selected in the Background Wizard. 
See “Backgrounds” on page 162.

Background On  shows the 
picture in the background.

Click and drag the slider to fade 
the colors in the background 

picture (here by 50%).

Background Off  hides the 
picture. 
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Fade Background
Use the Fade background slider to vary the brightness of the 
background garment, quilt or fabric. Background On  
shows the background at full brightness. Use the slider to 
fade  the background to make it easier to see the embroidery. Use Background Off  
to hide the background and see only the embroidery.

Move and Rotate Background
Use Move and Rotate Background  to move the background that you have placed 
behind your embroideries.

Click the Move and Rotate Background icon  and the mouse pointer changes to a four-
headed arrow . Click and drag to move the garment, quilt block or fabric background 
around the hoop or project area, and move the round handle  to rotate the 
background.

Right-click to set the background in place and deselect the function.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, M

Remove Background
Use Remove Background  to remove the garment, quilt block or fabric background that 
you have placed behind your embroideries.

Click Remove Background  and the background will be removed from the work area.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, E
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FilmStrip
Use the FilmStrip to view and select the designs in the embroidery, and to change the 
stitch order for those designs.

A design selected in the FilmStrip will become selected in the work area.

The FilmStrip is not visible when the Modify tab is selected.
The design types shown in the FilmStrip are: Embroidery in Resize mode ; Embroidery 
in Scale mode , Library designs in Resize  and Scale  mode, SuperDesigns and 
frames , Lettering , Decorations , Monograms , Ribbon designs , Library 
Ribbon designs , digitized designs  and Alignment Stitches . Designs within a 
Group  are indented.

■ Resize or Scale an embroidery: See “Resize and Scale” on page 73.
■ Library designs: See “Working with Protected Designs” on page 33.
■ SuperDesigns: See “Creating SuperDesigns” on page 428.
■ Frames: See “Frames” on page 438.
■ Lettering: See “Creating Lettering” on page 351.
■ Monogram Wizard: See “ExpressMonogram Wizard” on page 326.
■ Decorations and Ribbon designs: See “Embellishments” on page 208.
■ Groups: See “Grouping Selected Embroideries” on page 69.
■ Change the order of the designs: See “Stitch Order” on page 42.

Show and change Group contents with Reveal Groups
Change the stitch order within the design

Decorations

Monogram

Grouped frame and lettering

SuperDesign

Embroidery in Resize mode

Embroidery in Scale mode

Numbered FilmStrip entry

Ribbon Design
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Selecting items within the FilmStrip
Click on items within the FilmStrip to select them, or use the Tab key to select the next 
design, and Shift+Tab to select the previous design.

Moving items within the FilmStrip
Move items within the FilmStrip with the Stitch order buttons, or by dragging.

■ Use Reveal Groups  to view the items within a Group on the FilmStrip, and to move 
items within and outside Groups.

■ Use Ctrl + click to select multiple designs, and Shift + click to select a sequence of designs.
■ Ctrl + click on the top row of a Group will select all items within that Group.

Stitch Order
The Stitch Order commands on FilmStrip: Stitch Later , Stitch Earlier , Stitch Last  
and Stitch First , are used to move embroideries and groups within the design. 
Embroideries at the ’back’ of the design will be stitched out first.

To access the embroideries within a group to change their order, use Reveal Groups  on the FilmStrip or 
context menu.
You can only move items within a Group with the Stitch Order buttons. Drag an item to move it out of a 
Group.

Stitch Later
Stitch Later  brings the selected embroidery or group one step closer to the front.

Shortcut
■ FilmStrip: 

Stitch Earlier
Stitch Earlier  brings the selected embroidery or group one step closer to the back.

Shortcut
■ FilmStrip: 

Stitch Last
Stitch Last  places the selected embroidery or group at the front.

Shortcut
■ FilmStrip: 

Stitch First
Stitch First  places the selected embroidery or group at the back.

Shortcut
■ FilmStrip: 
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Reveal Groups
Use Reveal Groups  on the FilmStrip or context menu to select and edit individual 
designs within a group. The first design in the group is selected initially when Reveal 
Groups is chosen. Click the desired embroidery in the work area or FilmStrip, or use the tab 
key to move between designs.

The designs remain grouped, but they can be moved, rotated, mirrored and resized or scaled individually.

Shortcut
■ FilmStrip: 

Design Panel
Use the Design Panel to change colors, to view and change the Notes and Settings, and to 
view the Clipboard and Overview window. 

Show Design Panel
To open the Design Panel, click Show Design Panel in the View tab.

■ Design Information: See “Design Information” on page 44.
■ Thread Colors: See “Change an Existing Thread Color” on page 53.
■ Edit, move and merge colors: See “Move and Merge Color Blocks” on page 109.
■ Notes and Settings: See “Notes and Settings” on page 44.
■ Overview Window: See “Overview Window” on page 38.
■ Clipboard: See “Clipboard Block” on page 101.

Check the design information

Change a thread color

Edit, move and merge the colors (Modify tab only)

View the contents of the Clipboard

Edit the Notes or Settings information

Select the Notes or Settings information

View the position in the work area when zoomed in

Felting Needle effect

Puffy Foam effect
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Design Information
The dimensions (Height  and Width ), Stitch Count , and number of colors  for 
the active embroidery are shown on the Design Panel. 

The Design Panel also shows the order of the color blocks in the color worksheet and any 
notes and settings that are included in the embroidery. 

Information about lettering, monograms, motifs, SuperDesigns, frames and borders is automatically 
placed in the settings. When embroideries are merged with Combine or Export, all the notes and settings 
are also merged. You may wish to remove duplicate text when you have combined several copies of the 
same embroidery.
Double-click on a color block to change thread colors (or select the block and click 
Change Color ). Also, on the Modify tab use the color worksheet to show or hide 
stitches by color block, and move and merge color blocks.

Notes and Settings
Store up to 2000 characters of notes about an embroidery, such as a description, keywords 
or category of embroidery. This information is shown in the Notes and Settings tabs of the 
Design Panel. Select Notes  or Settings , then click Edit  to open the Notes or 
Settings dialogs.

Information about lettering, monograms, motifs, SuperDesigns, Frames and borders is automatically 
placed in the Settings.
Notes from .vp4, .vp3, .vip, .hus, .pcs and .pes embroideries are automatically placed in the 
Notes box when the embroideries are loaded in mySewnet™ Embroidery. Use the 
mySewnet™ Windows® Explorer plugin to search all your .vp4, .vp3 and .vip format 
embroideries for key words in the Filename or Notes to decide which embroideries to view 
and print.

When embroideries are merged with Combine or Export, all the notes are also merged 
and shown in the Notes box. You may wish to edit the notes and remove duplicate text 
when you have combined several copies of the same embroidery.

To keep the Notes information, save your changed embroideries as file type Husqvarna Viking / Pfaff (.vp4, 
.vp3 or .vip).
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Notes
Click Notes  to display the Notes, then click 
Edit  to change the Notes for the currently 
selected embroidery. The Notes dialog will appear.

The Notes dialog allows free text and keywords to 
be added to the Notes for the selected embroidery. 
Type additional Notes in the Notes box.

Use Ctrl+Enter to start a new line of text.

Up to 2000 characters can be entered in the Notes.

Keywords
Select Keywords for the embroidery from the list, 
then click Add to add them to the Notes for the 
embroidery.

Change the Notes for an Embroidery

1 Select the embroidery for which you want to amend the notes. The embroidery will be highlighted.
2 Click Notes .
3 Click Edit .
4 In the Notes text box make your desired changes to the Notes.

Use Ctrl+Enter to start a new line of text.
5 To add Keywords, select the keyword from the category heading or subcategory in the scrolling list. 

Then click Add.
Double-click to expand the folders until the desired keyword is highlighted. (Alternatively click on the + 
sign.)

6 Click OK to save your amended Notes and added keywords.

Settings
Click Settings  to display the settings, then click 
Edit  to change the Settings for the currently 
selected embroidery. The Settings dialog will appear.

Use Ctrl+Enter to start a new line of text.

You cannot change the Settings for a SuperDesign. Fix it as an 
embroidery first.
Up to 2000 characters can be entered in the Settings.

Change the Settings for an Embroidery

1 Select the embroidery for which you want to amend the settings. The embroidery will be highlighted.
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2 Click Settings 
3 Click Edit .
4 In the Settings text box make your desired changes to the Settings.

Use Ctrl+Enter to start a new line of text.
5 Click OK to save your amended Settings.

Design Player
Use Design Player  to play through the stitches in the embroidery as if they were being 
stitched from an exported embroidery. All parts of the embroidery that are within the 
hoop area are shown, whether or not they are selected.

The current Optimize for Sewing settings from mySewnet™ Configure are used.

■ Any messages, for example instructions for appliqué placement, are displayed following 
their Stop commands.

■ Appliqué fabric is displayed if present, but any background garment, quilt block or fabric 
is not shown.

■ Decorations are shown following their placement stitches.

Embroideries that are outside the hoop are not shown in the Design Player. If an 
embroidery contains a felting needle, the project will be shown "flipped", as it would 
actually be stitched.

Share
Use Share  to save a picture or video of your design. See “Share Picture” on page 50 
and “Share Video” on page 51.

Shortcuts
■ Quick Access Toolbar or Home Tab: 
■ Keys: Ctrl + J; Alt, 0; Alt, H, J

Start or pause play

Control play with
the slider

Design Information

Jump to the first stitch

Jump to the last stitch

Rewind

Play at double the
current speed
Create a picture or video 
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Using the Design Player
1 Press Ctrl + N (New) to clear the work area, then click the SuperDesign tab.
2 Choose "Appliqué" from the SuperDesign Category drop-down menu.
3 Click the arrow to the right of the SuperDesign set drop-down menu and choose Children 1.
4 Click the fifth design in the set, Blocks, and click Apply . The embroidery appears in the work area.
5 Click Design Player .

The Design Player dialog opens.
6 Use the Play button  at the bottom left to start playing through the stitches in the embroidery.
7 Use the controls to play forwards or backwards through the embroidery at different speeds, jump to 

the start or end of the stitches, and stop at any time.
Press Ctrl and use the mouse wheel to zoom in and out.

Life View
Use Life View  to show how an embroidery exported from the project will look in 3D 
with real-world perspective. Zoom in to see detail, and move and rotate the embroidery in 
a three-dimensional view. All parts of the embroidery that are within the hoop area are 
shown, whether or not they are selected. 

Use Life View  at any time when you want to see the design with no grid, stitches 
selected, or markers displayed, and when you want to see the effects of glow in the dark 
and solar reactive threads.

■ Any background garment, quilt block or fabric is shown, together with appliqué fabric, if 
present.

■ Decorations are shown, but not their placement stitches.

Shortcuts
■ Quick Access Toolbar or Home Tab: 
■ Keys: Ctrl + L; Alt, 9; Alt, H, L

Design Information

Move around the window

Change the 3D viewing angle

Zoom in and out

Light and dark effects
Reset
Animate the preview
Share a picture or video online
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Position
Use the position  slider to move to another part of the Life View window. 

Click and drag the cross marker in the center of the box to view the desired part of the 
embroidery, using the zoom slider to control the magnification. 

Rotation
Use the rotation  slider to view the stitching in the embroidery in 3D. 

Click and drag the cross marker in the center of the box to change the angle at which the 
embroidery is viewed, and allow you to visualize the project in varying real-world views. 

Alternatively, click and drag directly in the embroidery preview area to change the angle of view.
Use the zoom and position sliders to select the part of the embroidery to view.

Zoom
Use the zoom slider to change the magnification of the embroidery. 

Drag the slider bar to the right to magnify the view of the embroidery, and to the left to 
shrink the view of the embroidery. The box below the zoom bar displays the current 
magnification. 

Click the marker in the center of the zoom bar (100%) to view the embroidery at a 
magnification as close as possible to the Real Size setting you chose in mySewnet™ 
Configure.

When zoomed in, use the position slider to move around the embroidery.

Design Information
Life View shows the dimensions (Width  and Height ), the number of stitches  and 
the number of colors  in the embroidery.

Glow in the Dark
Use Glow in the Dark  to view the effect of using glow in the 
dark threads. The preview will darken to simulate the lights 
dimming, and the glow in the dark threads will be shown in their 
luminescent colors. 

Glow in the Dark  is only available if glow in the dark thread colors are 
used in the design.
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Solar Reactive
Use Solar Reactive  to view the effect of using photochromic threads. The preview 
simulates the sun shining on the design, and the photochromic threads change shade to 
show the colors they become in sunlight.

Solar Reactive  is only available if photochromic thread colors are used in the design.

Play Demo
Use Play Demo  to animate the preview and show the embroidery at different angles 
automatically. Click to start and stop the animation.

Play My Demo
Use Play My Demo  to animate the preview using your own demo. 
Use the menu options to add the current position as a point in the 
demo, or reset to create a new demo.

Adjust the window to the desired position and rotation, then select Store Demo Point. 
When complete, select Play My Demo to see a preview animation between the stored 
positions. Click to start and stop the animation.

The My Demo animation will be used for Life View in all modules. It is stored in the 
AnimationPath.txt file in the \User\AppData\Local\mySewnet\Embroidery1\LifeView 
folder.

Copy this file to another location as a backup before creating additional My Demo animation paths for 
Life View.

Reset
Use Reset  to set Rotation, Position and Zoom back to the default settings.

Share
Use Share  to save a picture or video of your design. See “Share Picture” on page 50 
and “Share Video” on page 51.

Photochromic threads change color in sunlight.
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Share Picture
Save a picture of your design. Select a size for the picture, 
then save the picture to your computer.

Size
Select a size for your picture. Choose from Standard, 2x, 3x, 
and 4x. Standard size is the size of the picture in Design 
Player or Life View.

Save
Click Save  to save the picture to your computer. The Save As dialog appears for you to 
save the picture, with the default file name being the same as the design. Change the 
name as desired.

The following file formats may be saved: JPEG Low Quality (.jpg), JPEG High Quality (.jpg), 
Tagged Image File Format uncompressed (.tif ) and Portable Network Graphics (.png).
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Share Video
Save a video of your design.

Name the video and select its size, quality and speed. Then save it to your computer. A 
progress bar is displayed while the video is created.

The higher the image quality, the slower the speed of upload and download.

Video Title and Created By
The video title and the name of the creator are used on the opening frames of the video. 
Enter the name of the video, and the name of the creator.

Size
The size of the moving image in pixels. The higher numbers create a higher quality video. 
Choose from 1080p (HD), 720p (HD), 480p and 360p. The initial setting is 480p.

Quality
The bit rate, or speed of data transfer. Choose between Low, Medium and High. The initial 
setting is Medium.

Speed
Set the speed of the Design Player for the video. Choose from Standard, 2x, 4x, 8x, 16x, 
32x, 64x, and 128x. The initial speed is 16x.

This option is only available for videos created from Design Player.

Video Information
The Total Duration of the video in minutes and seconds, and the estimated file size in MB 
are displayed. The duration and size vary according to the Size, Quality and Speed of the 
video.
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File Name
Select a folder and name for the video file. Click Select to browse to a different folder on 
your computer.

Start and Cancel
Click Start to create your video, using the settings that you chose above. A progress bar 
shows during the creation of the video, with an estimate of the creation time. Click Cancel 
to stop the video creation.

All other functions in the dialog box are unavailable (grayed out) during video creation.
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4Changing Colors

Thread Colors
The thread colors are shown in the color worksheet on the Design Panel, in the order in 
which they are used. Any thread effects or special needles used with a color are also 
indicated. A group of stitches using a particular thread color is called a color block. The 
color worksheet can be used to change thread colors and to add thread effects. 

There can be unlimited color changes in an embroidery saved in .vp4.

Colors can be added or changed to any color available in the standard thread ranges and 
an unlimited number of My Threads ranges. My Threads ranges can contain threads 
copied from the standard thread ranges, plus custom threads based on existing threads or 
added as completely new threads.

The Display or Hide, Move color and Merge color functions are available only in the Modify tab.
When the mouse pointer is paused over a thread color in the worksheet, the 
corresponding threads in the embroidery are highlighted. Also, the full name of the thread 
color will pop up.

The first color in the embroidery is at the top of the list, followed by all the thread color 
blocks. The check boxes show which color blocks are hidden. The numbers show the order 
in which the colors are used, and the samples show solid blocks of each thread color in 3D.

Double-click a thread sample to access the Color Selection dialog box for selecting a 
different thread color. Alternatively, select the thread and click the Change Color icon . 
When on the Modify tab, click a check box to show or hide a color block. When a color is 
hidden, its check box in the Color Worksheet is not selected, as shown here:

Change an Existing Thread Color
The Color Selection dialog box will appear when you double-click a thread color in the 
color worksheet, or select a thread and click the Change Color icon . You may choose 
any thread shade from the available thread manufacturers' palettes (for instance, Sulky 

Hidden Visible

Pause over a thread color
to see its name

Merge with color above

Click a color to select it

Move color up the stitch order

Display or hide a color

Change the selected color
Move color down the stitch order

Thread effect symbol



54          mySewnet™ Embroidery   Changing Colors 

Rayon 40 or Robison-Anton Cotton 50) or a thread you have added to My Threads. Select 
colors by visual selection or by typing in a shade number. Alternatively, click one of the 
Quick Colors to select the nearest matching thread color. Once the desired color is 
selected, click OK. Optionally, add a thread or needle effect to the selected color block.

When you select a new thread color, the color worksheet will show the change and the 
work area will show the block of stitches in the new color (assuming the stitches are not 
hidden).

Change a Thread Color
1 Click a color that you want to change in the color worksheet. The color block will be highlighted.
2 Click the Change Color icon  below the color worksheet. The Color Selection dialog box will 

appear.
Alternatively, double-click the color block, or right-click the color block and choose Change Color from the 
context menu.

3 If required, change the thread range. Select the desired thread range from all thread ranges or only 
MyThreadRanges. The available shades for the thread range will be shown in the list.
The Abbreviation shows the reference used for the thread range when threads from that range are added 
to MyThreads.
You can use the Manage button to add new threads and Thread Ranges in mySewnet™ Thread Cache. The 
Color Selection dialog box will close. See the mySewnet™ Thread Cache Reference Guide for more 
information.

4 Click a color in the list to select a thread shade visually. You can use the scroll bar to browse through 
the list of threads.

5 If you know the shade number, click in the Find Thread box then type the required shade number.
6 Alternatively, choose a Quick Color Theme then click the desired Quick Color. The nearest shade that 

is available from the current thread range will be selected. 
This is also a quick way to jump to threads of that color (for example, click light yellow in the Standard 
Theme to jump to light yellow thread shades).

7 If desired, add a thread or needle effect. Then click OK to confirm the color selection. The dialog box 
closes, and your changes are displayed in the work area.

Select a thread range
Show chosen thread ranges

Search for a thread number

Click a thread color
to select a thread

View the thread information

Click a Quick Color to select
a matching thread color

Choose a Quick Color Theme

Puffy Foam depth

Twin needle
stitch size & color

Second thread
color

Wing needle

Felting needle

Cutwork needle
angle

Open Thread Cache
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Effects
Use the effects area of the Color Selection dialog box to show the results of using thread 
effects or special needles.

Only one thread effect can be used on any thread. In the Modify tab, most thread effects are not shown in 

the active subdesign, as it would be difficult to edit the stitches. They are shown in Design Player  and 

Life View , in addition to the other tabs.
Choose an effect. If you choose Puffy Foam, set the foam height. If you choose Twin 
Needle, set the Twin Needle size. Click the color icon for the Second Color if you wish to 
use a different thread color. For Dual Thread, it is recommended to change the Second 
Color. For Twin Needle, this choice depends on the desired result. For Felting Needle select 
a color for the roving fiber for felting. For Cutwork Needle, choose the angle for your 
needles.

Puffy Foam
Use Puffy Foam to show the three-dimensional effect of stitching over embroidery foam.

Click the drop-down arrow and select the height of the puffy foam, between 2.0mm and 
6.0mm. The height is initially set to 3.0mm.

Dual Thread
Use Dual Thread to show the effects of stitching out two threads 
through the same needle. This is particularly suited to blending 
threads for special effects, such as mixing a rayon thread with a 
metallic thread, as in the center of the star.

Twin Needle
Use Twin Needle to show the effect of stitching out the color 
block with a twin needle. This creates a horizontal offset between 
the original thread color in the left-hand needle, and a second 
thread color in the right-hand needle.

There are several ways that the Twin Needle effect can be used, 
including:

• Use with running stitch to create a ribbon effect, typically 
using the same thread color in both needles

Puffy Foam Show the effect of stitching over embroidery foam

Dual Thread Show the effect of using two threads in one needle

Twin Needle Show the effect of using a twin needle

Wing Needle Show the effect of using a wing needle for hemstitch or heirloom designs

Felting Needle Show the effect of using a felting needle with a roving fiber

Cutwork Needle Select a cutwork needle in one of four angles
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• Use with a low density fill area to blend two different thread 
colors and also have a lightly shadowed effect

• Use with a dense fill area to create a shadow effect

It is recommended to use natural hoop orientation for designs with Twin 
Needle colors.

Twin Needle Size
This is only available if the Twin Needle effect is selected for the 
current color block. Click the drop-down arrow and select the 
size of the gap between the twin needles. This is initially set to 3.0mm.

Preview the effect of changing the twin needle size to help decide which needles to buy. 
Ensure that the desired size is recommended for embroidery on your machine.

Second Color
The second color is initially set to the same color as the original color block. Click the color 
change button  to choose a different thread for the second color. The Color Selection 
dialog box appears. Select the desired thread and click OK. The thread sample will change, 
and the thread range and thread number are shown.

Wing Needle
Use Wing Needle  to show the effect of stitching out the 
color block with a wing needle and the chosen thread. 

The wing needle creates holes in the fabric, for hemstitch and 
other heirloom techniques. 

To see the holes more than the stitch, use a fine thread such as Poly 60 
weight. To see the actual stitching, Rayon 40 weight is ideal.

Felting Needle
Use Felting Needle  to show the effect of embellishing 
the selected color block using a felting needle and a 
contrasting roving fiber.

Choose a color for the roving fiber for the felting in the Color 
Selection dialog box. In projects without a roving fiber, 
choose a felting needle color similar to the back of the 
fabric.

If you select Felting Needle in mySewnet™ Digitizing the stitching will 
be adjusted. In other modules the effect is purely visual; for example, to 
see how felting will look in a pre-made design.
When Exporting an embroidery with a Felting Needle effect, the option "Flip design for felting or reverse 
embroidery" is initially selected in the Export dialog box. See “Export” on page 20.

Cutwork Needle
Use Cutwork Needle  to show the line that would be used by cutwork needles to 
automatically cut holes in your fabric areas, or create appliqué areas. Use cutwork needle 
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lines for reverse appliqué embroideries and free-standing lace, or simply to cut out a 
shape or design.

Choose the cutting angle for the cutwork needle.

(When creating cutwork needle lines in mySewnet™ 
Embroidery or mySewnet™ Digitizing, or converting 
running lines to cutwork needle lines in any mySewnet™ 
module, you may use two needles, or for more precise work use four needles.)

ColorSort
Use ColorSort  (Home tab) to reduce the selected embroidery(ies) or group to the 
minimum number of color blocks. The final number of color blocks produced in the 
ColorSort process can vary, depending on any overlap between areas. If possible, it leaves 
only one color block for each thread color used. If necessary, trims are added to connect 
the areas that use the same thread color. Unnecessary Color Change commands are 
removed.

It is usually recommended to use the ColorSort option in Export  when creating an embroidery file 
optimized for stitching.
The ColorSort function in the Home tab is not available for single pieces of lettering, 
monograms, SuperDesigns or Frames.

If desired, click Undo  to return to the original colors.
If you use ColorSort on a multiple selection or group, the number of colors seen in the Color Select area 
may be more than if the same embroideries were combined. This is because ColorSort looks at the 
embroideries within the selection or group separately. To minimize the number of colors for stitching out, 
use Export with ColorSort to create a version for stitching.

Shortcuts
■ Home Tab: 
■ Keys: Alt, H, CS
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Color Tone
Use Color Tone  to change the thread colors in the selected embroidery(ies) or group. 
The Color Tone dialog box includes the Brightness, Contrast and Gamma sliders, and the 
Thread Range box.

Try different settings to enhance different designs. You may also combine more than one Color Tone tool.
Use the Thread Range box to convert all the threads in the selected embroidery(ies) or 
group to a new thread range, with or without adjusting the Color Tone options. Thread 
and needle effects will not be removed.

Shortcuts

■ Home Tab: 
■ Keys: Alt, H, CT

Brightness
The Brightness effect makes the selected part or all of an embroidery lighter or darker 
than the original. Use it to lighten or darken embroideries.

Adjust Brightness from -10 to +10 in steps of 0.1. The default setting is 0.

Contrast
The Contrast effect changes the amount of shading between areas for the embroidery. 
Use it to make specific areas stand out. Adjust Contrast up to +10 or -10 more or less than 
the original. Increasing the setting will increase the darkness of dark areas and the 
lightness of light areas.

Adjust Contrast from -10 to +10 in steps of 0.1. The default setting is 0.

Gamma
Use Gamma to adjust the brightness and contrast together so that dark areas are made 
brighter, but bright areas are not overexposed.

View the original
colors

Preview the changed
colors

Zoom in on the design

Adjust light & dark

Change the color
contrast

Optimize the light/color
balance

Change the thread range
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Adjust Gamma from 2 to 40 in steps of 1. The default setting is 10. Lower values will make 
the embroidery appear lighter.

Thread Range
Use the Thread Range box to select the thread range used for the embroidery from the 
drop-down list. Choose from any of the manufacturer’s thread ranges or one of the 
MyThreads ranges you create using mySewnet™ Thread Cache.

If the embroidery originally used more than one thread range, only one thread range will now be used.
To return to the original thread range(s) used in the design select ’Original Threads’ from 
the top of the list.

Reset
Reset the embroidery back to the original settings.

Zoom
Use the Zoom functions to change the view of the embroidery.

Use Zoom In  to magnify the view. Move the pointer over the embroidery and the 
pointer changes to the zoom in pointer . Then either click a point you want to zoom in 
towards, or click and drag a rectangle around the area you want to zoom in to and release 
the mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the embroidery and the 
pointer changes to the zoom out pointer . Then click a point you want to zoom out 
from.

Click Zoom To Fit  to fit the embroidery to the preview area.

Click Real Size  to view the embroidery at a magnification as close as possible to the 
Real Size setting you chose in mySewnet™ Configure .

Use Color Tone to Change the Colors in a Floral Embroidery
1 Press Ctrl + N (New) to clear the work area, then 

click Insert .
2 In the folder 

\mySewnet\Samples\Embroidery\Stitch load the 
'Floral Motif' embroidery.

3 Move the pointer over the first thread in the color 
worksheet. The thread is highlighted in the work 
area, and its Thread Range and name is displayed.
The Thread Range is Robison-Anton Rayon 40.

4 Click Color Tone  in the Home tab. The Color 
Tone page is displayed.

5 In the Thread Range drop-down list, scroll down 
and select Robison-Anton Poly Neon 40. The 
colors are much brighter. With other thread 
ranges, e.g. Sulky Rayon 40, the change is more 
subtle.
The threads in the design are mapped to the nearest 
color in the range, and the result shown in the 
preview pane.
Use Reset to reverse all changes made to the design.
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6 In the Thread Range drop-down list, scroll up and select ’Original Threads’ to return to the original 
thread range(s) used in the design.

7 Move the slider to the right to change the Brightness to 2. 
Alternatively, click to select the slider and use the right arrow key, or enter a positive number in the 
box.
You can adjust the Brightness between -10 and +10 relative to the starting point by typing in a number, 
using the left and right arrow keys, or by clicking and dragging the slider bar. To darken the embroidery, 
move the slider to the left, use the left arrow key, or enter a negative number in the box.

8 Enter 2.0 in the number box to change the Contrast.
You can adjust the Contrast between -10 and +10 relative to the starting point by typing in a number, 
using the left and right arrow keys, or by clicking and dragging the slider bar.

9 Click the Gamma slider bar to select it, then use the right arrow key to change the Gamma to 20.
You can adjust the Gamma between 2 and 40 by typing in a number, using the left and right arrow keys, or 
by clicking and dragging the slider bar. 

10 Click OK to close the Color Tone dialog box. The threads in the color worksheet change to their new 
color and range.

Quick Colors and Quick Color Themes
Quick Colors
Use the Quick Colors palette to select the nearest matching 
color in the current range to the color that you pick. Use one of 
the theme palettes: Standard, Spring, Summer, Fall, Winter, or 
create your own palette.

Quick Colors are used for thread colors, Felting Needle colors, and appliqué fabric colors.

Quick Color Themes
Use Quick Color Themes for quick selection of thread colors using a related set of colors. 
Create your own Quick Color Themes, which are available for selecting thread colors in the 
Color Selection dialog box in most mySewnet™ Embroidery Software modules. Also use 
Quick Color Themes to set fabric colors in the Appliqué Selection dialog box.

Select a Theme

Delete a custom ThemeCreate a new custom Theme

Give your Theme a name

Choose a color block to edit
Edit the selected color

Apply your changes
Color sample box

Copy a color to the sample box
Paste the sample box color

Replace all colors with the
sample box color
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Select a Quick Color
1 Open a dialog box with the Quick Colors area, such as the Color 

Selection box.
2 Click the arrow to the right of the Quick Colors to choose a Quick Color 

Theme in the menu.
In this menu you can also select Edit Themes to create a new theme, or 
edit a Custom theme.

3 Click the desired Quick Color. The nearest shade that is available from 
the current thread range will be selected. 
This is also a quick way to jump to threads of that color (for example, click light yellow in the Standard 
Theme to jump to light yellow thread shades).

Add a Quick Color Theme
You can add or customize your own Quick Colors themes in the Color Selection or the 
Appliqué Selection dialog box in most mySewnet™ Embroidery Software modules.

1 Open a dialog box with the Quick Colors area, such as the Color Selection box.
2 Click the arrow to the right of the Quick Colors and select Edit Themes in the menu. The Edit Quick 

Color Themes dialog box opens.
Note that if one of the system Themes is selected, the editing options will be unavailable (grayed out).

3 Select a Theme from the drop-down menu at the top.
Your new Theme will be based on the colors in this theme.

4 Click the Add New button. A new theme ’Untitled’ appears.
5 Give your new theme a name, then click Apply. 

You can now select your new theme from the drop-down list at 
the top.

6 Select a color in the palette.
7 Click the Edit Color button. The Colors dialog box appears.
8 Choose a new color from the Standard or Custom tab, then click 

OK. Your chosen color will replace the original color.
9 To copy a color, select a color in the palette, then click Copy 

Color. Your selected color will appear in the Color Box.
10 To paste the color in the Color Box, select a color in the palette, 

then click Paste Color. The color in the palette will be replaced.
11 To replace all colors in the palette, click Paste To All.
12 Click Apply to save the changes to your new Quick Color 

Theme.
13 Click Close to finish editing your new Theme.

To make further edits to your theme, select Edit Themes in the Quick Colors Theme menu.

Edit Quick Color Themes

Theme
Select a Theme from the drop-down list. 

Any new Theme will be based on the colors in this theme.

Add New
Click Add New to create a new theme.

Delete Theme
Click Delete Theme to remove a custom Theme.
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You cannot delete system Themes.

Name
Enter the desired theme name.

Theme Colors
Click a color in the grid and a box will appear around the selected 
color.

Edit Color
Click Edit Color to change the currently selected color in the Colors 
Dialog Box. Alternatively, double-click a color to change it in the Colors Dialog Box.

Apply
Click Apply to save the changes you have made.

Copy Color
Click Copy Color to place the color in the color sample box, to the right of the button.

Use the color sample box to copy a color from one theme to another.

Paste Color
Click Paste Color to replace the color in the currently selected grid position with the color 
in the sample box.

Paste To All
Click Paste To All to place the color in the sample box in all the grid positions. This is useful 
when starting a new Theme if you wish to vary the Theme around a single initial color.

Close
Click Close to finish editing the new theme. The new theme is added to the end of the 
Theme list.

You will be asked if you want to save any changes you have made, if you have not clicked Apply.

Change a Quick Color Theme
Select an existing Quick Color Theme you wish to change from the Theme drop-down list, 
then click Edit Theme.

The predefined Quick Color Themes may not be edited. However, you may use any predefined theme as the 
basis for a new theme.
The options are the same as when you Add a Quick Color Theme. See “Edit Quick Color 
Themes” on page 61.

Delete a Quick Color Theme
1 In the Edit Quick Color Themes dialog box, use the Theme drop-down list to select the Theme you 

wish to remove. 
2 Click Delete Theme. A message will appear to remind you that this action may not be reversed. 
3 Click Yes and the theme will be deleted.

The predefined Quick Color Themes may not be deleted.
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Colors Dialog Box
The Colors dialog box is used to choose or change 
a color for a thread or fabric, or modify any color in 
a Quick Colors Custom theme.

When the Colors dialog box appears, it shows the 
Standard color selection. If desired, click one of 
the Standard colors. A highlight shows the 
selected color. The New/Current box shows the 
difference between the newly chosen color and 
the color currently used.

Click the Custom tab to be able to select any of 
the 16 million RGB colors.

Click in the blended color palette to choose a 
basic color, then use the slider at the side to 
choose the desired brightness level. The HSL and 
RGB values are updated as you change the color 
and the color is previewed in the New/Current 
box.

You can also directly enter Hue, Sat(uration), 
Lum(inance) (HSL) and/or Red, Green, Blue (RGB) 
values. Alternatively, use the up/down buttons on 
each of the HSL and RGB value boxes to make fine 
adjustments to the color.

Color Models

Hue, Saturation, Luminance (HSL) Color Model
Hue is the color (red, yellow, green, or blue) for the selected color, expressed as a value 
between 0 and 239. Saturation (Sat) is the strength or purity of color in a specified hue. 
This is related to the amount of gray in it and is measured from 0 (completely gray) up to a 
maximum of 240 (no gray). The higher the saturation, the purer or more vivid the color. 
Luminosity (Lum) is the intensity of lightness or darkness in a color, specified by a value 
between 0 (black) and 240 (white). If Saturation is 0, the Luminosity setting specifies a 
shade of gray.

Red, Green, Blue (RGB) Color Model
The RGB model, one of the Additive Color models, is used on computer monitors. It has 
three primary colors — red, green, and blue — that it creates by emitting light. These 
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three colors are combined in various proportions to produce all the colors displayed on 
your screen. They are referred to as additive because they combine to produce white. 
Primary colors are measured as a value from 0-255. The colors produced by combining the 
three primaries are a result of the amount of each of those shades present. For example, 
pure red has a red value of 255, a green value of 0, and a blue value of 0. Yellow has a red 
value of 255, a green value of 255, and a blue value of 0. If Red, Green and Blue are set to 
zero, the color is black; if all three are 255, they produce white.
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5Adjusting Embroideries

Selecting Embroideries
Select an Embroidery
On all tabs except the Modify tab, the 
currently selected embroidery is shown 
with a selection box around it. The 
selection box has square resize handles 
on the corners, triangular flip handles on 
the top and left, and a circular rotate 
handle on the right.

If a selection box has round handles on its 
corners, part of it is outside the selected hoop. 
Move it into the hoop, or change the hoop size.
The handles are blue if in resize mode (density retained when resized), white in scale 
mode (stitch count retained when resized). They are green for lettering, SuperDesigns, 
Frames and Flourishes, and light green for Monograms, before they are fixed as 
embroideries. 

If no design is selected there is no selection box visible and the color worksheet appears 
blank.

Select an embroidery with any of the following methods:

■ Click an embroidery in the work area or FilmStrip.
■ Press the Tab key to select each embroidery in turn.

When making a selection, only embroideries that are completely enclosed by the selection line (box, Point, 
Freehand) will be included in the selection.
After embroideries have been combined, there will be only one embroidery, so it will no longer be possible 
to select the individual parts in this way. Use Group  to keep multiple embroideries, lettering and 
SuperDesigns together while retaining the ability to edit them individually. To select items within a group, 
use Restrict Group .
Alternatively, use the Modify tab to select and adjust the desired part of an embroidery. Individual stitches 
and blocks may always be adjusted on the Modify tab (see “Select and Edit Single Stitches” on page 103).

Cut, copy, paste or delete selected designs
Select some or all designs Resize or scale a design

Merge designs & change colors

Arrange & resize designs

View the embroidery as it will be stitched out

Choose a hoop

Group and ungroup designs Multiple hoop designs

Edit a design

Rotate Handle

Center of Rotation

Flip Vertical Handle

Flip

Resize Handle

Horizontal
Handle
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The Context Menu and Individual Designs
Use the Context menu to access editing functions for individual designs, such as size and 
rotation. Right-click on the design, and select the desired function from the context menu. 

From the context menu you can also change the 
properties for stitch types in lettering (in addition to 
font characters, Lettering Shape and so on), frames and 
SuperDesigns, or fix them as stitches. 

Use the context menu to adjust the appliqué fabric and 
margin for lettering, Frames and SuperDesigns, and 
decorations for an embroidery. The Context menu also 
allows you to adjust these properties.

See “Appliqué Selection” on page 192 and “Decoration Selection” 
on page 223.
To adjust the properties for an individual design within a group, click Reveal Groups  in 
the FilmStrip or context menu, then select the desired item.

Multiple Select Features
Use multiple select to select more than one embroidery at a time. 

Hold down the Ctrl key and click the desired embroideries. A selection box will be placed 
around each of the selected embroideries. Alternatively, use one of the multiple select 
tools in the Box Select  drop-down toolbar, or Select All  embroideries.

The selection area must include the complete embroidery, otherwise it will not be selected.

The selected designs are surrounded by a selection box with a dotted outline, and orange 
handles. The faded outlines of the selection boxes for the included embroideries and 
other designs can be seen within the larger selection. Lettering, frames, SuperDesigns and 
Gallery designs retain their green handles, while Monograms retain their light green 
handles.

Selection resize handle 

Selection Rotate handle

Green handles for lettering

White handles for embroidery

Dotted outline for a selection
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The whole selection can be moved, resized or scaled proportionally, or rotated. When a 
selection is enlarged or reduced, each item is resized or scaled according to its individual 
state. Lettering or SuperDesigns with green handles are resized with constant stitch 
density, as are embroideries with blue handles. Embroideries with white handles are 
scaled. There are no flip handles. To mirror the whole selection it must be combined. The 
stitch count and thread colors for the complete selection can be seen in the Design Panel, 
and the width and height of the selection box are displayed.

If you click outside the selection box, the designs will become separate. Use Undo , or select them again 
to recreate the multiple selection. To keep the selected embroideries together after saving, use Group. See 
“Group” on page 69.

Select All
Use Select All  to select all of the embroideries in the work area.

Select All will select embroideries that are outside the chosen hoop.

Shortcuts
■ Home Tab: 
■ Keys: Ctrl + A; Alt, H, SA

Box Select
Use Box Select  to select embroideries in a rectangular area. Click and drag around the 
area you want to select.

Use Add to Selection  with any select function to increase the area of selected embroideries, or use 

Remove From Selection  to make the currently selected area smaller.

Shortcuts
■ Home Tab, Select Drop-Down: 
■ Keys: Alt, H, SS, B

Freehand Select
Use Freehand Select  to select a block of embroideries within an area of any shape. 
Click and drag to draw an irregular outline around the desired designs. When you release 
the mouse the area is closed automatically.

Use Add to Selection  with any select function to increase the area of selected embroideries, or use 

Remove From Selection  to make the currently selected area smaller.

Shortcuts
■ Home Tab, Select Drop-Down: 
■ Keys: Alt, H, SS, F

Point Select
Use Point Select  to select a block of embroideries within an area of any shape, defined 
by a series of points. Click a series of points to create an irregular outline of straight or 
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curved lines around the desired designs. Point Select may be easier to use than Freehand 
Select for precise selections. 

Use Add to Selection  with any select function to increase the area of selected embroideries, or use 

Remove From Selection  to make the currently selected area smaller.

Shortcuts
■ Home Tab, Select Drop-Down: 
■ Keys: Alt, H, SS, P

Select a Leaf with Point Select
1 Press Ctrl + N (New) to clear the work area, then click the SuperDesign tab.
2 In Category, select Wreath, then load several of the leaf designs in this Category.
3 Move the designs so that they are close to each other.
4 Click the Home tab.
5 In the Box Select drop-down menu, choose Point Select . The pointer changes to the Point Select 

pointer .
6 Click to place the first point to select two of the leaves. A yellow round node appears.
7 Click to place a series of points around the leaves.

As you click the third point on the line, the line becomes closed (it becomes a loop). As you place more 
points the line adjusts itself.
The line may ’swing’ while you place points. Just carry on, you can adjust it afterwards.

8 Use Shift+click to place square nodes for straight lines.
9 Move the pointer over one of the nodes on the line. The pointer changes to the Move Node 

pointer . Adjust the node as desired.
When the Move Node pointer is active you can adjust existing nodes.

If you click while the Point Select pointer  is active, another point will be added to the line.
10 When your line is as desired, right-click to surround the leaves with a selection box.

Point Select is useful when selecting a few among several adjacent designs.
11 Right-click to deselect Point Select.

Select None
Use Select None  to deselect all of the embroideries in the work area, including any 
outside the hoop.

Shortcuts
■ Home Tab: 
■ Keys: Ctrl + Shift + A; Alt, H, SN

Replace Selection
Use Replace Selection  to replace the currently selected embroideries with the new 
selection. 

Replace a Selection
1 Place several small embroideries on the work area.
2 Use Box Select  (or another selection tool) to select some of these designs.
3 Ensure that Replace Selection  is selected.

Replace Selection is initially selected.
4 Using Box Select , select some different embroideries.
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The new selection replaces your old selection.

Shortcuts
■ Select, Home Tab: 
■ Keys: Alt, H, RS

Add To Selection
Use Add to Selection  to add the new selection to the currently selected embroideries. 

Add Designs to a Selection
1 Place several small embroideries on the work area.
2 Use Box Select  (or another selection tool) to select some of these designs.
3 Click Add to Selection .
4 Using Box Select , select some different embroideries.

The new selection is added to your old selection.

Shortcuts
■ Select, Home Tab: 
■ Keys: Alt, H, AS

Remove From Selection
Use Remove From Selection  to remove the new selection from the currently selected 
embroideries.

Remove Designs from a Selection
1 Place several small embroideries on the work area.
2 Use Box Select  (or another selection tool) to select some of these designs.
3 Click Remove From Selection .
4 Using Box Select , select some of the embroideries within your selection.

The new selection is removed from your original selection.

Shortcuts
■ Select, Home Tab: 
■ Keys: Alt, H, SD

Grouping Selected Embroideries
In mySewnet™ Embroidery, you can edit embroideries individually, in a 
selection, or in groups which remain together after saving.

When a design including multiple subdesigns is loaded using Insert , all sections will 
be grouped together, ready for moving, resizing and so on. If you use Open, it will match original groups 
exactly.

Group
Use Group  to make a more permanent group of all the currently selected designs. Use 
Group to group the designs permanently, or to make a temporary Group while moving or 
editing them. Each design in the group in turn is placed after the one that is earliest in the 
stitchout order (nearest the back of the project).
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A group can be modified in the same way as a selection. You can move, resize or scale it proportionally, or 
rotate it.

The grouped embroideries are surrounded by a selection box with a solid outline, and 
orange handles. The faded outlines of the selection boxes for the included embroideries 
and other designs can be seen within the larger selection. Text, frames, SuperDesigns and 
Gallery designs retain their green handles, while Monograms retain their light green 
handles.

The group can be moved, resized or scaled proportionally or rotated. When a group is 
enlarged or reduced, each item is resized or scaled according to its individual state. 
Lettering or SuperDesigns with green handles are resized with constant stitch density, as 
are embroideries with blue handles. Embroideries with white handles are scaled. There are 
no flip handles. To mirror the whole group it must be combined. The stitch count and 
thread colors for the complete selection can be seen in the Design Panel, and the width 
and height of the selection box are displayed.

If you click outside the selection box, and then click one of the designs within the group, the designs will still 
be grouped.

Shortcuts
■ Home Tab; Group: 
■ Keys: Alt, H, G

Ungroup
Use Ungroup  to split the currently selected group into the designs which make it up. 
These may be embroideries, or lettering, SuperDesigns, frames, Gallery designs, and 
monograms.

Ungroup can only be used when a group is selected.

Shortcuts
■ Home Tab; Group: 

Group resize handle 

Solid outline for a group

Group Rotate handle

White handles for embroidery

Green handles for lettering
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■ Keys: Alt, H, U

Reveal Groups
Use Reveal Groups  on the FilmStrip or context menu to select and edit individual 
designs within a group. See “Reveal Groups” on page 43.

The designs remain grouped, but they can be moved, rotated, mirrored and resized or scaled individually.

Christmas Greetings: Multiple Select and Group Designs
1 Click File at the top left to open the Welcome screen.
2 In the Welcome screen, click Blank Canvas  to start a new project. The Hoop selection dialog 

opens.
3 From the Universal Hoop Group, set the Hoop Size to 260mm x 200mm - 

Universal Large Hoop 3, Rotated orientation. Click OK.
4 In the Quick Access toolbar, click Insert .
5 In the folder \mySewnet\Samples\Embroidery\Stitch load the embroidery 

'Gifts & Candy Canes'.
This is an embroidery; it has white handles showing that it is initially in Scale 
rather than Resize  mode.

6 Move the embroidery to the right side of the hoop.
7 Click the SuperDesign tab and select the Christmas Tree 1 SuperDesign in the 

Holidays Category.
8 Set the Size of the SuperDesign to 90mm, then click Apply .

The SuperDesign has green handles. For more about SuperDesigns, see “Creating 
SuperDesigns” on page 428.

9 Move the christmas tree SuperDesign to the left of the hoop, a little above the 
gifts embroidery.

10 Click the Letter tab and enter the words "Merry Christmas" in the Letters box.
11 In the Font drop-down list select the font Ivy 2C 15-60mm in the Floral Category. 

Ensure that the Lettering Shape is Horizontal Block, and the Size is 15mm.
12 Click Apply  and move the lettering to the bottom of the screen, in the middle.

The lettering has green handles. For more about lettering see “Creating Lettering” on page 351.
13 Click the Frame tab.
14 In the Frames drop-down menu, select banner 3 in the Banners 2 category.
15 Ensure that Group is selected in Frame Surround.

The banner and lettering will be placed as a Group.
16 Ensure that the Merry Christmas lettering is selected, and click Apply . The banner is placed 

around the lettering.

The selection box around the banner has orange handles and a solid outline, as it is a Group. The lettering 
inside has a faded outline and pale green handles. For more about Frames, see “Frames, Borders and 
Motifs” on page 438.

17 Click the Embellish tab.
If the Embellish tab is not available in your version of mySewnet™ Embroidery, load a star SuperDesign 
from the SuperDesign tab instead, then go to step 23.

18 In the Category section of the Embellish tab, select Decoration .
19 Click Insert from Gallery .
20 Browse to the folder DecorationDesigns\Miscellaneous, select the design Cross 2, and 

click Open to load it into the work area. Close the File Viewer dialog box.
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21 Right-click the decoration design and select Pearl Sequin Cup 4.0 mm in the Context menu.
22 In the Quick Colors, set the sequin color to white, then click OK.
23 Move the Decoration design to the top center, to look like a star. It also has green handles.

For more about Decoration Gallery designs, see “Decoration Gallery Designs” on page 222.
24 Press the Tab key to see each design in turn. Each is in a selection or group with a solid outline and 

orange, green or white handles.
25 Click the Home tab.
26 Use Box Select  or Select All  to select all of the designs. The selection box for the selected 

designs has a dotted outline and orange handles.

Ensure that the selection box has square handles. If not move the designs so that all are within the hoop 
and try again.

27 Click and drag to move the selected designs as a unit, and use the round handle to rotate the 
selection. Use Undo  to reverse your changes.

28 Click outside the hoop. The designs are separate again.
29 In the ribbon bar, note that the Group  and Ungroup  icons are not available (are grayed out).
30 Use Select All  to select the designs again. The Group icon is now available.
31 Click Group . The selection box for the group has a solid outline. 

The faded outlines and handles for the designs within the group can still be seen.
32 Click outside the group. None of the designs are selected.
33 Click the Christmas tree. The whole group is selected again.
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34 Note that the Ungroup  icon is now available.
Groups are permanent until they are broken apart with Ungroup. Note that you cannot Tab between the 
designs within the group.

35 Click Reveal Groups . The Reveal Groups icon is highlighted; and the last placed design, the 
decoration, is selected.
You can now select and edit the designs within the group individually, for example to adjust the position of 
the Merry Christmas lettering within the banner, or to adjust its properties. (The lettering and banner are 
no longer grouped together, because there is only one level of grouping. A group cannot contain 
subgroups.)

36 Click Reveal Groups  again. The group is now a single unit, and the Reveal Groups icon is no longer 
highlighted.

37 Click Ungroup . The designs that were in the group now form a selection.
38 Click and drag to move the selected designs. They move as a unit.

While the block is still selected you can reverse the effects of Ungroup by using either Group or Undo.
39 Click outside the selection box. The designs are now separate.

Use Ungroup to make major changes to a group, or to use the designs within the group separately.

Move
Move the selected embroidery(ies), group or selected block of stitches using 
click and drag. Move the pointer over the selection box and it changes to the 
four-headed arrow pointer . Click inside the selection box and drag it to 
the required position.

When a block is moved on the Modify tab, any stitches which lead to or from 
the block will be stretched to accommodate the new position of the stitches 
moved in the block.

If you accidentally move the center of rotation, simply click and drag inside the selection box again.

Nudge
The selected embroidery(ies), group or block of stitches can be moved in small amounts 
to nudge it accurately into the desired position. Use the arrow keys on the keyboard to 
nudge an embroidery or block.

When more than one embroidery is selected, all of the selected embroideries will be moved. If a group is 
selected, the whole group will be moved unless Restrict Group is enabled.
You can also position embroideries automatically with Move into Hoop, Center in Hoop, 
and the alignment tools. See “Alignment” on page 77.

Resize and Scale
Use Resize  to switch between resize and scale for the selected embroidery(ies) or block 
of stitches. Use resize to change the size of the embroidery and retain constant density. 
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Use scale to change the size of the embroidery and retain constant stitch count. The 
handles on the embroidery selection show when resize or scale is selected.

The handles are blue if in resize mode (density retained when resized), and white in scale 
mode (stitch count retained when resized). On the FilmStrip, different symbols are used for 
resize mode  and scale mode .

Newly created or inserted non-.vp4 designs are initially in scale mode (white handles).
The resize and scale information for each subdesign is remembered separately.

Handles are green for lettering, SuperDesigns and Frames or Flourishes and light green for Monograms 
before they are fixed as embroideries. 
Move the pointer over one of the square corner handles  and it becomes the diagonal 
double-arrow pointer . Click and drag one of the handles to resize or scale. 

Hold down Shift as you click and drag to resize or scale proportionally. Hold down Ctrl to resize or scale 
from the center. Designs within multiple selections or groups (shown with orange handles) are always 
scaled or resized proportionally. If you resize a monogram created with the ExpressMonogram Wizard, it is 
fixed as stitches.
When a Decoration line or shape is enlarged, the number of decorations increases. It decreases as the line 
or shape is made smaller. Decorations placed individually do not change in number.
In the Design Panel, the Height  and Width  boxes will show the new size of the 
embroidery when you release the mouse button. After resizing a group, the percentage 
size change from the original cannot be seen in the Modify Design dialog box.

Use Modify Design  to change the dimensions using numbers.

Shortcuts
■ Home or Modify Tab: 
■ Keys: Alt, H, R or Alt, M, R

Rotation
Rotate the selected embroidery(ies), group or block of stitches to any degree using free 
rotation with the mouse. Alternatively, enter a specific angle using Modify Design , or 
rotate in 45 degree steps .

Free Rotation
Move the pointer over the rotation handle  and it changes to the rotate pointer . 
Click and drag the rotation handle to rotate the embroidery freely to any angle. If desired, 
move the center of rotation  before rotating the embroidery.

Blue handles for resize White handles for scale 
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The selection box around the embroidery and the embroidery outline are rotated around 
the center of rotation.

Move the Center of Rotation
The center of rotation  is initially shown in the middle of the embroidery, selection or 
group. Move the pointer over the center of rotation and it changes to the cross-hair 
pointer . Click on or within the center of rotation, then drag it to any position in the 
work area. This changes the pivot point around which the embroidery(ies) rotate for any of 
the rotation methods.

Click outside the selection box and then select again to return the center of rotation to its initial position.

Rotate 45 Degrees
Use Rotate 45  to rotate the selected embroidery(ies) or group in 45 degree steps. If 
desired, move the center of rotation  before rotating.

Shortcuts
■ Home Tab: 
■ Keys: Alt, H, OT

Modify Design
Use Modify Design  to open the Modify Design dialog, where you can show and change 
the size and rotation of the currently selected embroidery(ies) or group.

To rotate a selected embroidery or block of stitches in the Modify tab, see “Modify Block” on page 107.

Shortcuts
■ Home Tab: 
■ Keys: Alt, H, OD

Rotate Handle

Center of Rotation
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Modify Design
Use the Modify Design dialog box to show and change the 
size and rotation of the currently selected embroidery(ies) or 
group.

Modify the currently selected design as desired, then click 
OK to show your changes in the work area.

Whenever you resize or rotate, it is from the original settings. If a single 
piece of lettering is selected the lettering Properties dialog will appear. If 
a single SuperDesign, Frame or Flourish is selected the Options dialog 
will appear.

Size

Height and Width %
Show and change the height  and width  percentage of the currently selected 
embroidery(ies) or group. The height and width are scaled or resized according to the 
Resize mode.

The size in millimeters to which the design will be changed is shown to the right. After 
resizing a group, the percentage size change from the original cannot be seen in the 
Modify Design dialog box.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Designs within multiple selections or groups (shown with orange handles) are always scaled or resized 
proportionally. If you resize a monogram from the ExpressMonogram Wizard, it is fixed as stitches.
When a Decoration line or shape is enlarged, the number of decorations increases. It decreases as the line 
or shape is made smaller. Decorations placed individually do not change in number.

Rotate

Angle
Use the up and down arrows or enter an angle  from 0 to 359 degrees in the Rotate box. 
The preview shows the selected angle.

If desired, move the center of rotation  before rotating.
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Flip Vertical and Horizontal
Mirror the selected embroidery or block of stitches 
vertically or horizontally using the flip handles on the 
selection box.

There are no flip handles for multiple selections or groups; if 
desired, use Combine in order to mirror. There are no flip 
handles for Monograms; if desired fix as embroidery, then 
mirror.

Horizontally Flip Block
Move the pointer over the Flip Horizontal handle  
and it becomes the horizontal double-arrow pointer . Click the Flip Horizontal handle 
to mirror an embroidery or selected block horizontally. 

Vertically Flip Block
Move the pointer over the Flip Vertical handle  and it becomes the vertical double-
arrow pointer . Click the Flip Vertical handle to mirror an embroidery or selected block 
vertically.

Alignment
The alignment features are found in the Alignment  drop-down list.

Alignment Tools
The Alignment tools allow embroideries and groups to be aligned precisely.

The Alignment tools are only available when more than one embroidery or group is selected. See “Multiple 
Select Features” on page 66.
Select the embroideries and groups that you want to align, then use one of the alignment 
tools. Embroideries can be aligned horizontally or vertically. They can also be centered.

Horizontal Alignment

Align Left
Align Left  aligns all selected embroideries and groups with the left edge of the design 
furthest to the left.

Shortcuts
■ Home Tab, Alignment Drop-Down:
■ Keys: Alt, H, A, H, L

Align Center
Align Center (Center Horizontally)  centers all selected embroideries and groups 
horizontally relative to each other.

Shortcuts
■ Home Tab, Alignment Drop-Down:

Flip Vertical Handle

Flip Horizontal Handle



78          mySewnet™ Embroidery   Adjusting Embroideries 

■ Keys: Alt, H, A, H, C

Align Right
Align Right  aligns all selected embroideries and groups with the right edge of the 
design furthest to the right.

Shortcuts
■ Home Tab, Alignment Drop-Down:
■ Keys: Alt, H, A, H, R

Distribute Horizontally
Distribute Horizontally  aligns all selected embroideries and groups to be equally 
spaced horizontally.

Shortcuts
■ Home Tab, Alignment Drop-Down:
■ Keys: Alt, H, A, H, D

Vertical Alignment

Align Top
Align Top  aligns all selected embroideries and groups with the top edge of the highest 
design.

Shortcuts
■ Home Tab, Alignment Drop-Down:
■ Keys: Alt, H, A, V, T

Align Middle
Align Middle (Center Vertically)  centers all selected embroideries and groups vertically 
relative to each other.

Shortcuts
■ Home Tab, Alignment Drop-Down:
■ Keys: Alt, H, A, V, M

Align Bottom
Align Bottom  aligns all selected embroideries and groups with the bottom edge of the 
lowest design.

Shortcuts
■ Home Tab, Alignment Drop-Down:
■ Keys: Alt, H, A, V, B

Distribute Vertically
Distribute Vertically  aligns all selected embroideries and groups to be equally spaced 
vertically.
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Shortcuts
■ Home Tab, Alignment Drop-Down:
■ Keys: Alt, H, A, V, D

Center In Hoop
Use Center In Hoop  to move the selected embroidery(ies) or group to the center of the 
hoop. 

To move individual embroideries in a group to the center, use Reveal Groups.

Shortcuts
■ Home Tab, Alignment Drop-Down:
■ Keys: Alt, H, A, C

Move Into Hoop
Use Move Into Hoop  to move the selected embroideries and groups into the closest 
area of the hoop.

Only the selected embroideries that are outside the hoop will be moved.

Shortcuts
■ Home Tab:
■ Keys: Alt, H, OV

Edit Design
Edit the selected design using the appropriate editing tool. This may be a tool within 
mySewnet™ Embroidery, or it may be another module such as mySewnet™ Digitizing or 
mySewnet™ Stitch Editor.

For example, for SuperDesigns and Frames the Design Option dialog opens, for embroidery files 
mySewnet™ Stitch Editor opens, and for design outline (.EDO) files mySewnet™ Digitizing opens. See the 
mySewnet™ Stitch Editor or mySewnet™ Digitizing Reference Guide or Help for more information on those 
modules.

Shortcuts

■ Home Tab:
■ Keys: Alt, H, E

Undo and Redo
Undo
Use Undo  to reverse the last action. If you are not satisfied with the result, click Redo.

When you use Undo while on the Modify tab, all stitches in the embroidery being edited are displayed and 
the selected block is deselected.
Each time you use Undo the undone action becomes a Redo.
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For instance, you might move a stitch and then Undo the move. You could now Redo the 
move or do something else. If you delete the stitch instead of using Redo then the Redo is 
lost, along with any other Redos that may have followed.

Undo steps are only lost when you use New.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Z; Alt, 7

Redo
Use Redo  to reverse the last action that was undone by Undo. If you are not satisfied 
with the result, click Undo.

Redo only works if nothing has happened after the last Undo. For instance, if you insert a 
Color Change command, then Undo and move the embroidery then it is not possible to 
Redo the Color Change because something different has happened instead.

When you use Redo while on the Modify tab, all stitches in the embroidery being edited are displayed and 
the selected block is deselected.
Redo steps are only lost when you use New.

Shortcuts
■ Quick Access Toolbar: 
■ Keys: Ctrl + Y; Alt, 8

Combine
The Combine functions are useful if you are sure you will never need to adjust subdesigns 
again, or to enable mirroring of a selection or group of embroideries. Otherwise, it is 
usually recommended to use the Combine Options when you Export  your project to 
an embroidery file for stitching out.

Decorations cannot be combined with other embroideries; instead they are added as a subdesign, last in 
the stitchout order.

Combine All
Use Combine All  to merge all the embroideries on the work area into a single 
embroidery, and fix lettering, SuperDesigns and Frames as stitches. 

It is usually recommended to use the Combine option in Export  when creating an embroidery file for 
stitching out. This method allows you to retain the separate embroideries, lettering, and so on of your 
multipart design as adjustable elements in the .vp4 project file. 
After the embroideries are combined, notes and settings from all the embroideries are 
also combined in the Notes and Settings boxes. Any overlapping stitches are removed if 
the option is selected in Preferences.

If more than one copy of the same embroidery is combined, it is helpful to ColorSort . However, you 

may prefer not to ColorSort  if you plan to use the Split Project Wizard to split the embroidery for 
multiple hoopings.
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Embroideries are combined (and therefore stitched out) in the order that they were 
loaded into mySewnet™ Embroidery. If you copy an embroidery after other files have been 
opened, then paste it back in, the second copy will be stitched after all the other 
embroideries. To change the order use the Stitch Order commands.

Shortcuts
■ Home Tab, Combine Drop-Down: 
■ Keys: Alt, H, M, A

Combine All Embroideries on the Work Area
1 Clear the screen, then load the desired embroideries. The color blocks for each embroidery are shown 

in the color worksheet when it is selected.
2 Create additional lettering, motifs or frames if required, and move, modify and edit each embroidery 

as desired.
3 Click the Home tab.
4 Click Combine , then Combine All. The embroideries are merged, with one outline box 

surrounding all of them. The color worksheet now shows the color blocks for the new combined 
embroidery.

5 The Notes box contains the notes from all the embroideries that have been combined. Click in the 
Notes box and amend as desired.

6 Save the new embroidery.

Combine Selected
Use Combine Selected  to merge the selected embroideries into a single embroidery 
and fix lettering, SuperDesigns and Frames as stitches. 

It is usually recommended to use the Combine option in Export  when creating an embroidery file for 
stitching out. This method allows you to retain the separate embroideries, lettering, and so on of your 
multipart design as adjustable elements in the .vp4 project file. 
After the embroideries are combined, the notes and settings from the embroideries are 
combined in the Notes box. Any overlapping stitches are removed if the option is selected 
in Preferences.

Shortcuts
■ Home Tab, Combine Drop-Down: 
■ Keys: Alt, H, M, S

Combine the Selected Embroideries
1 Click the Home tab.
2 Use Multiple Select to select the desired embroideries.

See “Multiple Select Features” on page 66.
3 From the Combine drop-down, select Combine Selected . The embroideries are merged, with one 

outline box surrounding all of them. The color worksheet now shows the color blocks for the new 
combined embroidery.

4 The Notes box contains the notes from all the embroideries that have been combined. Click in the 
Notes box and amend as desired.

5 Save the new embroidery.

Fix As Stitches
Use Fix as Stitches  to fix the selected subdesign or subdesigns as embroidery. 
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Designs such as lettering, SuperDesigns, frames and Monograms can be resized with constant stitch 
density, and the stitch types adjusted, until they are fixed as embroidery. Other aspects of lettering, such as 
the font or text may also be adjusted until it is fixed.
Lettering, SuperDesigns, frames and Monograms are automatically fixed as embroidery if 
you adjust them in the Modify tab. A warning is given to allow you to avoid fixing the 
design accidentally.

You may occasionally wish to fix designs; for example, to mirror some lettering shapes, a selection or 
group, or resize or scale it without constant properties. It may also be useful if you wish to adjust the 
rotation of the Appliqué Fabric in a SuperDesign.

Shortcuts
■ Home Tab, Combine Drop-Down: 
■ Keys: Alt, H, M, F
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6Encore and Endless

Encore
Use the Encore tab features to place repeated copies of embroideries in a line, a circle or a 
shape, or around the edge of the hoop.

Choose the number of repeats, or the margin and gap, and the number of embroideries 
used. Set the position to standard or mirrored. Click Preview  to see the Encore, and 
Apply  to place the repeated embroidery in the work area according to the chosen 
Finalizing options.

Use any number of embroideries with a line or circle, but only one or two embroideries with a shape or a 

hoop. To use more embroideries, you may Group  them before choosing Encore.
With Line and Circle you can choose the number of Repeats. For Shape and Hoop the number of repeats is 
set by the size of the embroidery, the Gap and the Margin.

Repeat an Embroidery with Encore
1 Place a small embroidery on the work area and select it.
2 Click the Encore tab.
3 Select an Encore type (circle , line , shape  or 

hoop ) and Position (standard  or mirrored ), and 
any other options for that Encore type.
A preview image illustrates the chosen layout.

4 Set the number of Repeats, or the Gap.
5 Click Preview  to view the repeated designs in the work 

area.
While in Preview mode it is not possible to select any other 
function in the Quick Access toolbar. If you click another tab, 
the Encore will be cancelled.

6 Adjust the Encore line or shape on the work area. 
Alternatively, adjust the settings on the Encore tab and 
click Preview  again.
Drag inside the Encore shape to resize, drag the handle to reshape, e.g. to change a circle into an ellipse.

7 If desired, select Group and (if designs overlap) Arrange Similar.
8 Click Apply  to place the repeated designs as an embroidery with the chosen finalizing options.

Shortcuts
■ Encore Tab
■ Keys: Alt, E

Select an Encore type: circle, shape, line or hoop
Select a Position: Standard or Mirrored

Layout indicator

Choose a line type Choose a shape Set the inner hoop margin

Set the gap or number of copies

Optimize the Encore

Preview the Encore
Cancel the Encore

Create the repeated embroidery
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In Encore the designs are repeated in order of their stitching out, from back to front. For Encore Shape or 
Hoop the embroidery that is first in the stitchout order will be placed in the corners. To change the order 
use the Stitch Order commands. 
Encore repeats an embroidery clockwise for Circle, Shape and Hoop, and from left to right for Line. If you 
combine multiple designs before using Encore, try to work from left to right. This will prevent trimmed 
threads from becoming caught under elements in the same color block.

Encore Types
Encore repeats the selected designs in a circle, line, shape or hoop using the chosen 
position and number of repeats.

Encore repeats an embroidery clockwise for Circle, Shape and Hoop, and from left to right for Line. 
Therefore, if you wish to group multiple design elements before using Encore on the grouped result, try to 
work from left to right. This will prevent trimmed threads from becoming caught under elements in the 
same color block.

Type
With Line and Circle you can choose the number of Repeats. For Shape and Hoop the 
number of repeats is set by the size of the embroidery, the Gap and the Margin.

Encore repeats designs in stitchout order, from back to front. In Shape and Hoop the embroidery that is first 
in the stitchout order is placed in the corners. Stitchout order can be changed with the Stitch Order 
commands.
Encore repeats an embroidery clockwise for Circle, Shape and Hoop, and from left to right 
for Line. 

Shortcut
■ Keys: Alt, E, T

Position

You can use any number of embroideries with a line or circle, but only one or two embroideries with a 
shape or a hoop. To use more embroideries, Group them first.

Circle
Use Circle  to place the embroideries in a circle and set the number of repeats. Adjust 
the circle to form an ellipse.

See “Number of Repeats” on page 88.

After clicking Preview , click and drag inside the circle to position the circle as desired. 
Click and drag one of the embroideries to make the circle smaller or larger. 

Circle Place the embroideries in a circle.

Line Place the embroideries in one of 8 line options from left to right.

Shape Place up to two selected embroideries around the edge of a shape.

Hoop Place up to two selected embroideries around the hoop edge.

Standard The copies of the embroidery use the original orientation.

Mirrored Each alternate copy of the embroidery is reflected. 
This works best if the number of Repeats is an even number.
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Click and drag the white handle to reshape the circle to form an ellipse.

When adjusting in an ellipse, you cannot overlap the two sides of the ellipse. When adjusting in a circle, you 
can overlap at the center of the design.

Flowers in an Encore Circle
1 Click the SuperDesign tab.
2 In the category drop-down list, select Flowers.
3 In Flowers 1, click the first flower, then click Apply . The flower is displayed in the work area.
4 Add the second and third flowers to the work area; they will each be added in the center.
5 Click the Home tab, then click Select All  to select the 

three embroideries.
6 Click the Encore tab.
7 In Type, select Circle.
8 In Repeats enter 30.
9 Click Preview . The three SuperDesigns are displayed in 

a repeating sequence around the edge of the circle.
10 Click on the embroidery at the top, and drag it downwards. 

The circle becomes smaller, and the embroideries move 
closer together. 
You can also click and drag the white handle to reshape the 
circle to form an ellipse.

11 Change the number of Repeats and preview again.
If you change to Hoop or Shape and preview, you will notice 
that only the first two flowers that you selected are in the 
Encore.

12 Ensure Group is selected and if the designs are overlapped, select Arrange Similar.
13 Apply  to create the final, repeated embroidery.

Line
Use Line  to place the embroideries in one of eight line types from left to right. Use Line 
Options to select the Line Type.

Line Options
The Line Options are only available when the Type is set to Line.

Line Type
Select a straight line, or one of seven types of curved line from the drop-down menu.

To Adjust an Encore Line
■ Drag the line using the four-headed arrow Move pointer  to position it.
■ Drag the square handle on the top or right side of the line, using the double-headed 

horizontal or vertical pointer, to change the spacing between the designs.

Create a Line of Repeated Embroideries
1 Place some small embroideries on the work area and select them.
2 Click the Encore tab.
3 In Type, select Line .
4 Select the Position (standard  or mirrored ).
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5 Choose a Line Type from the drop-down 
menu.
The first option is a straight line. The other 
seven line types are curved.

6 Set the number of Repeats as desired, from 2 
to 360.

7 Click Preview  to view the repeated 
designs in the work area.

8 Drag the line of embroideries to position it.
9 Drag the square handles on right side and top of the box to stretch or compress the box, and change 

the spacing.
With a straight line, only the handle on the right is available.

10 Ensure Group is selected and if the designs are overlapped, select Arrange Similar.
11 Click Apply  to place the repeated line as an embroidery.

Shape
Use Shape  to place up to two selected embroideries around the edge of a shape. Use 
Shape Options to select from 50 shapes.

Shape Options
The Shape Options are only available when the Type is set to Shape.

Shape
Select your shape from the drop-down list of 50 shapes. 

Remove Corners
The embroidery is repeated along the sides of the hoop, with one embroidery placed at 45 
degrees in each corner of the hoop. Select the Remove Corners option if you do not want 
the 45 degree embroideries in the corners. This option provides flexibility to create 
attractive designs with embroideries of different sizes and shapes.

If two embroideries are selected, the embroidery that is first in the stitch-out order will be placed in the 
corners. Use Stitch Order to change the order. See “Stitch Order” on page 42.

Use Repeated Embroideries in a Shape
1 Place two small embroideries on the work area and select them.
2 Click the Encore tab.
3 In Type, select Shape .
4 Select the Position (standard  or mirrored ).
5 Choose a Shape from the drop-down list. There are 50 

shapes to choose from.
6 Ensure that Remove Corners is not selected.
7 Set the Gap between the embroideries.
8 Click Preview to view the repeated designs in the work 

area.
The embroidery that you loaded or created first is in the 
corners.

9 Drag the shape to position it.
10 Drag the square handles on the top and right sides of the 

box to adjust the shape, and change the number and 
spacing of the embroideries.

11 Ensure Group is selected and if the designs are overlapped, select Arrange Similar.
12 Click Preview  to view the repeated designs in the work area.
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13 Click Apply  to place the shape as an embroidery.

Hoop
Place up to two selected embroideries around the edge of the hoop, to make a border or 
frame.

If two embroideries are selected, the embroidery that is first in the stitchout order is placed in the corners. 
Use Stitch Order to change the order.

Hoop Options
The Hoop Options are only available when the Type is set to Hoop.

Remove Corners
The embroidery is repeated along the sides of the hoop, with one embroidery placed at 45 
degrees in each corner of the hoop. Select the Remove Corners option if you do not want 
the 45 degree embroideries in the corners. This option provides flexibility to create 
attractive hoop borders with embroideries of different sizes and shapes.

If two embroideries are selected, the embroidery that is first in the stitch-out order will be placed in the 
corners. Use Stitch Order to change the order. See “Stitch Order” on page 42.
The maximum size limit for Encore Hoop is 2000mm.

Margin
Use Margin to leave space between the repeated embroideries and the edge of the hoop. 
This is useful if, for example, you wish to make the embroidery Endless, as this will leave a 
margin for adjustment in the hoop when stitching out.

The minimum Margin is zero. The maximum Margin varies, depending on the hoop size.

Use Repeated Embroideries in a Hoop
1 Place two small embroideries on the work 

area and select them.
2 Click the Encore tab.
3 In Type, select Hoop .
4 Select the Position (standard  or 

mirrored ).
5 Ensure that Remove Corners is not selected.
6 Set the Gap between the embroideries.
7 Set the Margin between the line of 

embroideries and the hoop.
8 Click Preview. The Encore forms a frame 

around the inside edge of the hoop. 
The embroidery that you loaded first is in the corners.

9 Adjust the Margin and Gap as desired.
10 Ensure Group is selected and if the designs are overlapped, select Arrange Similar.
11 Click Apply  to place the Encore as an embroidery.

Position

Standard
Use Standard  to place copies of the embroidery in the original orientation one after 
another around the circle, shape or hoop, or along the line.
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Mirror
Use Mirror  to reflect alternate copies of the embroidery. 

This generally looks best if the number of Repeats is an even number.

Number of Repeats
Set the number of repeats in the Encore by changing the gap, or setting the number of 
repeats.

■ For Line and Circle, select the number of Repeats.
■ For Shape and Hoop, set the Gap between the repeated embroideries.

Repeats
This option is only available for Line and Circle.
The total number of copies of the selected embroidery(ies) that will make a circle or line of 
repeated embroideries. Set the number of repeats from 2 to 360. 

Where more than one embroidery is selected, divide the number of repeats by the 
number of selected embroideries to give the number for each. For example, two 
embroideries using 10 repeats will produce five of each embroidery.

Generally, the larger the initial embroidery, the fewer Repeats should be made.

Gap
This option is only available for Shape and Hoop.
Use Gap to set the minimum spacing between repeated embroideries. If necessary, the 
actual spacing is increased where the Gap value would cause incomplete embroideries on 
either side of the hoop. So the spacing between repeated embroideries may differ on the 
long and short sides of the hoop.

Increase the Gap to move the embroideries further apart. Decrease the Gap to move the 
embroideries closer together. Use negative Gap to overlap embroideries by up to 50%.

Set the Gap in steps of 0.1mm. The default Gap is 2.0mm.

Arrangement

Group
Group the embroideries during creation.

Arrange Similar
Place individual designs together when using multiple embroideries that are overlapped, 
to optimize the results from ColorSort. This does not change the display order, only the 
stitchout order.

Preview
Use Preview  to view the repeated designs in the work area, and make any further 
adjustments.
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Cancel
Use Cancel  to cancel the preview without applying the Encore.

Apply
Click Apply  to create the repeated embroidery. If you selected the Group option, the 
embroidery will be grouped before it is shown on the work area. 

If designs overlap it may be helpful to use Arrange Similar to reduce the number of color changes. 
Once the repeated embroidery is created, you can change colors, move, resize or scale, 
rotate and so on. If it is created as a group, use Reveal Groups to adjust elements 
individually.

Endless Embroidery
Use the Endless Embroidery wizard  on the Home tab to add markers (alignment 
stitches) to an embroidery so it can be stitched out in a continuous, regularly spaced, 
sequence as many times as desired. After each stitchout, the fabric is re-hooped and the 
markers are used to align the new stitchout to the previous stitchout. Hence, the 
embroidery can be stitched out as a single, endless embroidery in a band.

If there is more than one embroidery on the screen, the embroideries are grouped 
automatically when the Endless Embroidery wizard is started.

When embroideries inside the hoop are made Endless, any embroideries placed outside the hoop are 
removed.
When the settings are changed, the preview is updated automatically.

The Endless Embroidery settings are reset to their defaults when mySewnet™ Embroidery is closed.

Adjusting an Endless Embroidery
An endless embroidery is a grouped embroidery with start and end markers (alignment 
stitches). After creating an endless embroidery, save it as a .vp4 file to preserve the 
grouping of designs with alignment stitches.

Set the direction of the
fabric movement

Select an end marker to
align the stitchouts

Select the number and
position of markers

Space between designs
Repeat design in hoop

Hoop information

Information & zoom bar
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To reload an Endless embroidery in the Endless Wizard, open it in mySewnet™ Embroidery 
and click the Endless tab. The Endless embroidery will be opened, and the alignment 
stitches will be removed. Adjust it as desired, for example change the End Marker type, 
then close it again and save it.

When you are ready to embroider your project, export it with the desired settings to 
optimize for sewing such as Combine, Remove Overlap and ColorSort.

Shortcuts
■ Home Tab: 
■ Keys: Alt, H, N 

Fabric Direction
This is the direction the fabric will be moved in the hoop for each repeat. This is according 
to the size and orientation of the hoop as it is shown in the Preview area. The Fabric 
Direction affects which sides of the embroidery will be the Start and End, so that the Start 
marker is always on the side of the embroidery that matches the Fabric Direction. Hence, 
the Start Marker 'points' in the direction the fabric will be moved.

The default direction is Up for vertical (Natural) hoops and Left for horizontal (Rotated) 
hoops.

When the Direction is changed, the preview is updated.

End Marker
The end marker alignment stitch is used to line up the next stitchout of the embroidery. 
End marker positions are shown by red dots on the preview. Choose from one of four 
types of end marker:

Corner
A small L-shaped corner of three long loose stitches. The alignment point is the corner of 
the L. This is the default choice for the end marker.

Single Stitch
A long stitch that moves to the corners, placing only one needle point at each corner. This 
is ideal if you are stitching onto a fabric that you are concerned about marking, such as 
leather or a very light weight fabric.

Tie Off
A few stitches in the same place, centered on the alignment point. The Tie Off marker is 
very secure, but may be difficult to remove after stitching.

Line
A line of three long stitches. The alignment point is at the outside end of the line, closest to 
the edge of the hoop.

The Corner and Line markers are particularly helpful for checking that you have re-hooped 
your fabric straight enough for the next embroidery repeat, especially when both marker 
positions are stitched.
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The Preview is not affected by the choice of End Marker.

There is no choice for start markers because they are always movement stitches. The start markers are used 
to move the needle into position so that it can be aligned with the end markers. Hence, only the single 
'jump point' is needed for a start marker. The start marker positions are shown by green dots on the 
preview.

Marker Positions
Select the positions of the markers. Both is recommended for most situations. Some of the 
reasons that you may wish to have markers on only one side are as follows:

■ You have fabric that may be easily marked
■ You have a fabric edge that can be easily followed each time you re-hoop the fabric
■ You have an embroidery with a lot of open space on one side and you do not want to have 

any stitches in the open space, which may also partly conceal the presence of the marker 
stitches

Both
Select Both for movement stitches to both start corners and end markers on both end 
corners. This is the default choice for the marker position.

Left/Bottom
When the Fabric Direction is Up or Down, the markers are placed on the left edge. When 
the Fabric Direction is Left or Right, the markers are placed on the bottom edge.

Right/Top
When the Fabric Direction is Up or Down, the markers are placed on the right edge. When 
the Fabric Direction is Left or Right, the markers are placed on the top edge.

Options

Gap
Use Gap to change the spacing between each stitchout of an embroidery. Gap changes 
the position of the start and end markers, as shown when the preview is refreshed. The 
Gap is split evenly on each side of the stitchout.

Increase the Gap to move the embroideries further apart. Decrease the Gap to move the 
embroideries closer together. The Gap can be increased until the embroidery plus the Gap 
equals the full height or width of the selected hoop. Use negative Gap to overlap 
embroideries by up to 50%.

Set the Gap in steps of 0.1mm. The default Gap is 0mm.

After changing the Gap the preview updates to show the adjustments.

Repeat Embroidery
Repeat the embroidery as many times as possible within the current hoop size. This saves 
having to re-hoop the fabric for each stitchout of a small embroidery.
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After changing the Repeat Embroidery option, note how many times the embroidery can 
be repeated from the preview. The number of repeats is also affected by the Gap and the 
direction the fabric will be moved in the hoop.

Repeat Embroidery is selected by default.

You may wish to save a single version of an endless embroidery as well as a repeated version. This will 
allow you to stitch out as many repeats as necessary. Use the repeated embroidery to stitch out the 
majority of the endless design, then use the single embroidery to stitch the remainder if the repeats do not 
give an exact fit. This works best if you move the single version of the embroidery to the center of the hoop 
before it is saved.

Previewing Changes
When the settings are changed, the preview is updated with any changes to the settings 
that can be shown. The preview shows how the embroidery will be made endless. The 
embroidery is shown in 3D, with the hoop shown as a blue outline. The current hoop size 
is shown in the Information area. The start and end marker positions are indicated by the 
green and red dots, respectively.

To change the 3D background color or texture, use mySewnet™ Configure.
When Repeat Embroidery is selected, the maximum number of repeated copies of the 
embroidery that will fit will be shown in the preview. The number of embroideries will 
change according to the size of the original embroidery, the orientation of the hoop, the 
direction in which the embroidery is made endless and the Gap.

The red dot showing the end marker position is not affected by the choice of end marker type.

Information

Hoop Information
The size of the current hoop is given.

Preview
The Information area shows the current hoop size set for mySewnet™ Embroidery, and the 
stitch count , width , height  and number of color blocks  of the endless, grouped 
embroidery shown in the preview.

Zoom Bar
Use the Zoom Bar at the bottom of the screen to zoom in or out from the center of the 
endless embroidery.

Use the slider to zoom in or out, or click on the Zoom Out  or Zoom In  icons.

OK
Click OK to make the embroidery endless. The preview area is updated automatically.

If Repeat Embroidery was selected and two or more repeated embroideries will fit, the 
repeated embroideries are grouped.
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Start markers are inserted at the beginning of the embroidery as long movement stitches 
to the start marker positions. Movement stitches are added at the end of the embroidery 
to the end marker positions, which are then stitched according to the choice of end 
marker.

The endless embroidery is also centered in the hoop.
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Examples of Endless Embroidery Hoop Orientation and Fabric 
Direction
These pictures show how a heart-shaped embroidery (for example) could be repeated as 
an endless embroidery.

Natural Orientation Hoop with Fabric Moving Up
A hoop with natural orientation is selected, then the Fabric Direction is Up in the Endless 
Embroidery dialog box:

The fabric is hooped and moved in the machine 
like this:

This results in a sequence of hearts, 
stitched in this order:



mySewnet™ Embroidery   Encore and Endless              95

Rotated Orientation Hoop with Fabric Moving Left
A hoop with rotated orientation is selected, then the Fabric Direction is Left in the Endless 
Embroidery dialog box:

The fabric is hooped and moved in the machine 
like this:

This results in a sequence of hearts, 
stitched in this order:
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Stitch Out an Endless Embroidery
1 Load the endless embroidery.
2 Click File, Print.
3 In the print preview, set the Design Scale to 100%.

This is so you can print a worksheet of the endless embroidery at full size to use as a template.
4 Click Print  and print a worksheet of the endless embroidery.
5 If the fabric does not have a straight cut edge you can follow, you may wish to mark a center line on 

the fabric. Make a crease, a chalk line or a line with light-reactive marker down the full length of the 
fabric where the endless embroidery will be stitched.

6 Load the endless embroidery on your embroidery machine and hoop up your fabric. 
If you marked your fabric with a line, align the center marks on the edges of the hoop with the line.
It is recommended to always make a test stitchout of your endless embroidery on a sample of the final 
fabric. Stitch out more than one copy to check that the spacing and marker type give the desired result.

7 Start by stitching out one copy of the embroidery. When the first copy stitches out, ignore the start 
marker movement stitches.

8 At the end of the stitchout, the end marker stitches will be stitched out last. Note where they are.
9 Re-hoop your fabric, moving it in the direction you chose in the Endless Embroidery dialog box. 

For example, if you had a horizontal hoop on screen and chose Left, lay your hoop in front of you 
horizontally as it would appear on screen and move the fabric to the left in the hoop. 
The stitches for the end markers (or single marker if you only used one), must be inside the stitch area 
so that the start marker for the next stitchout can be aligned. 
If you have a hoop template that was supplied with the hoop, use this as a guide to positioning the end 
marker stitches inside the stitch area.

10 Use the printed worksheet to confirm that the next copy of the embroidery will fit in the stitch area 
when the start and end markers are aligned. 
This is particularly important if you are stitching an endless embroidery with a negative Gap, as you may 
need to bring the end marker stitches further into the hoop than seems obvious.

11 Tighten the hoop and ensure the existing embroidery is straight, so that the next copy will stitch in a 
straight line from it. If you marked a center line, this will help to ensure that the fabric is straight.

12 Load the hoop back into the embroidery machine and thread the first color.
13 Instead of starting straight away, use stitch navigation on the embroidery machine to step forward by 

one stitch to the start marker. Then use the needle position controls to align the needle exactly over 
the end marker.
If the needle will not move far enough to align correctly with the end marker, this means the fabric is not 
hooped up with the end marker far enough inside the hoop. You will need to adjust your fabric in the hoop 
and try again.

14 If you chose to use Both markers on the endless embroidery, step forward by one more stitch to the 
second start marker to confirm it is over the second end marker. 
If the second marker is not aligned then the fabric may not be straight in the hoop, in which case you 
should adjust it and try again. Alternatively, there may be pull on the fabric and you may need to choose a 
compromise position that gives the best fit between the two markers.

15 After confirming the alignment is correct, start embroidering. 
16 Repeat from step 8 until you have stitched out the desired number of copies.
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Create an Endless Sewing Tools Border
1 Click Change Hoop . From the Universal Hoop Group, set the 

Hoop Size to 240mm x 150mm - Universal Large Hoop 2, Rotated 
orientation. Click OK.

2 Click the SuperDesign tab in the ribbon bar.
3 Select the Home Category from the drop-down menu.
4 Click to select the needle (2 - Needle), then click Apply to load it in 

the work area.
5 Select the Pin and Tape Measure SuperDesigns (numbers 3 and 6) 

and load them in the work area.
Use the three designs at their default size.

6 Drag the three designs apart, with the Needle at the top, and the 
Pin and the Tape Measure below, as in the picture.

7 Select the Pin design, and click the  flip horizontal handle to 
make it face the other way.

8 Ensure that the Pin is between and to the right of the other designs.
9 Move the designs close together as in the picture. Use Select All  

to check the relative positions of the selection boxes around each 
design.
The designs are positioned so as to show the features of the Endless 
Wizard.
While the relative positions of the designs are important, their position 
within the hoop is not. Designs are positioned in the middle of the hoop 
when they are made Endless.

10 Save the design as Sewing Tools.vp4.
This will make it easier to recreate your Endless Design later.

11 Click the Home tab in the ribbon bar.
12 Click Endless  to use the design in the Endless Wizard.

All designs that are entirely within the hoop are used for the Endless design. Any designs that are partially 
or fully outside the hoop will be removed.

The hoop is in the Rotated position, and the green Start markers can be seen to the left. The design 
will be stitched from left to right. The red End Markers show where the End marker stitches will be 
placed after the rest of the design has been stitched.
For a Natural hoop position, Up would be initially selected in Fabric Direction. This creates a vertical line of 
designs, rather than the horizontal border we are creating here.

13 Deselect (uncheck) Repeat Embroidery. Your three SuperDesigns form an individual Endless Design.
Use single designs of this type to add an extra design at the end of a series of Endless embroidery sections.
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14 For this design we will use multiple design sets. Check Repeat Embroidery to view the three sets of 
designs again.

15 Click OK to view the Endless embroidery section in the work area.
16 Click outside the Grouped Endless design to see the gray stitched Start and End Markers.

The straight line on the left is the Start Marker, and the corners at the right are the End Marker. The markers 
are immediately to the left and right of the Grouped designs.

17 In the Create tab, click Endless  again to reload the design in the Endless Wizard.
18 The original Start and End Markers were removed, and new ones added when you reopened the 

design.
19 Deselect (uncheck) Repeat Embroidery. This time there are three sets of designs.

When you reloaded the design the Start and End Markers were removed, however the design was saved as 
a single Group. To adjust the space between the sets of three SuperDesigns, we need to go back to the 
original set of three.

20 Click Cancel to close the Endless dialog box, then click Undo  in the work area to view your original 
three designs.

21 Click Endless , and in the Endless dialog box click to select (check) Repeat Embroidery to view the 
repeated designs.

22 Set Gap to -10.0 mm. The set of designs move closer together, and to the left and right they overlap 
the Start and End Markers.

Use a negative Gap to overlap the position of designs, or to create a continuous line of adjoining designs.
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23 Click OK to view your Endless design again in the work area.

24 Save your design as Sewing Tools Endless.vp4, and then Export it in a format for your embroidery 
machine.
To view how the Endless design will be used, Copy the design, then use File, New Window and in this 
window set up a very large Custom Hoop (for example, 500 mm x 150 mm). Paste in two copies of your 
endless design. Place the Start Marker (the gray line) of the second design over the End Markers (the gray 
corner stitches) for the first design. This is how you will align your designs on your embroidery machine.

25 Click File, Print and preview the worksheet for the Endless design.
The settings that you used for your Endless design can be seen at the top of the Settings area, below the 
threads. You can use these to recreate the design later. Underneath are the settings for the SuperDesigns 
that you used.

26 In the print preview, set the Design Scale to 100%, then click Print  to print a worksheet for the 
embroidery.
You can use this full size worksheet as a template.

27 Load the endless embroidery on your embroidery machine and hoop up your fabric.
An Endless hoop makes life easier, but you can use any hoop with suitable dimensions. 

28 Check the alignment of your fabric, then stitch out the first section of your endless embroidery.
The end marker stitches are stitched out last. Note their position.

29 Re-hoop your fabric, with the end marker stitches for your first design towards the left of the hoop.
Remember that the first part of the Tape Measure will overlap the Start Marker. Leave room for it when 
hooping up and aligning on your embroidery machine.

30 Use stitch navigation on your embroidery machine to step forward by one stitch to the start marker.
31 Use the needle position controls to align the needle exactly over the end marker.

If the needle will not align correctly, check the position of the fabric in your hoop before trying again.
32 When the alignment is correct, embroider the second section.
33 Repeat for all of the other sections.

For more details on stitching out, see “Stitch Out an Endless Embroidery” on page 96.
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7Modifying Embroideries
Use the Modify tab to edit and insert stitches, or select a block of stitches for editing. Hide 
stitches by color or by using the draw range. Cut and copy blocks of stitches or whole 
embroideries and paste them. Insert new color changes, change the order of colors and 
merge color blocks. Adjust a selected block of stitches precisely, changing its angle and 
size.

All Quick Access toolbar functions except Change Hoop, Undo and Redo are unavailable in the Modify tab.
If more than one design or a group is selected when you click the Modify tab a warning 
message will appear. To edit a single design in a multiple selection, click the work area to 
deselect, then select the desired design. If a group is selected, use Reveal Groups  on 
the FilmStrip or the context menu, then select the desired design. If lettering, a 
SuperDesign or Frame is selected, a warning message will appear that it will be fixed as 
embroidery stitches. Only use the Modify tab in this case if you are prepared to lose the 
ability to adjust the properties such as font and stitch type. Decoration and Ribbon 
designs cannot be altered on the Modify tab.

Viewing Embroideries in the Modify Tab
Embroideries are shown in the Modify tab in 2D View as 
individual stitches with no shading. The selected 
embroidery is shown in color. Any other embroideries use 
pale ghost stitches.

Automatic Ghost Mode
When the Modify tab is selected to edit an embroidery, only 
the embroidery selected for editing is shown in color. All 
other embroideries are automatically shown as pale ghost 
stitches. This allows you to see the positions of other 
embroideries, so that you can observe where they are in 
relation to the embroidery you are editing.

If the background is white or very pale it may be difficult to see the 
’ghost’ stitches.

Select a block of stitches

Switch between resize & rescale

Show the selected stitches

Measure a distance

Insert color changes, Stops & stitchesCut, copy or paste a block

Resize or rotate a block
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Get Length
Use Get Length  on the View tab (and on the Modify tab) to 
measure the distance between any two points on an embroidery. Click 
the Get Length icon  and the mouse pointer changes to the 
Measure pointer . Then click and drag a line across the embroidery. 
The length of the line is displayed.

For example, use this to obtain the width of a column of stitches or the 
distance between lines of stitching.

The length is shown in millimeters or inches, according to the setting for Show 
Measurements in mySewnet™ Configure. The alternative units are shown in 
parentheses.

Shortcuts
■ View or Modify Tab: 
■ Keys: Alt, V, L; Alt, M, L

Measure Part of an Embroidery
1 Click the Get Length  icon. The pointer changes to the measure pointer .
2 Click and drag across the part of an embroidery you want to measure.
3 Read, and if desired, make a note of the number.
4 Repeat the click and drag to measure any other distances, as required.
5 Right-click to deselect the function.

Cut, Copy, Paste and Duplicate
The Cut, Copy, Paste and Duplicate functions are available for whole embroidery(ies) and groups on the 
Home tab of mySewnet™ Embroidery.
Work with blocks of stitches on the Modify tab.

Clipboard Block
The Clipboard Block shows the current block that can be pasted 
into your embroideries. It shows the most recent block of stitches, 
embroidery(ies) or group that has been cut or copied from 
mySewnet™ Embroidery or another mySewnet™ Embroidery 
Software module. It can be used as many times as desired, until a 
new block is cut or copied.

Click in the clipboard to remove the current Clipboard Block.

Cut
Use Cut  to remove a whole embroidery or the currently selected block of stitches from 
the embroidery and make it the Clipboard Block.

On the Modify tab, use one of the block selection methods (Box Select, Freehand Select, 
Point Select or Select All) to select the desired block to be cut. It can then be pasted into 
the same or another embroidery, or pasted into another mySewnet™ Embroidery 
Software module.
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Shortcuts
■ Home or Modify Tab: 
■ Keys: Ctrl + X; Alt, H, X or Alt, M, X

Copy
Use Copy  to make a copy of a whole embroidery or the currently selected block of 
stitches. The copy becomes the Clipboard Block, where it can be pasted as many times as 
required, or pasted into another mySewnet™ Embroidery Software module.

Shortcuts
■ Home or Modify Tab: 
■ Keys: Ctrl + C; Alt, H, CP or Alt, M, CP

Paste
Use Paste  to paste the Clipboard Block as a separate embroidery or, if the Modify tab is 
selected, attach it to the last currently visible stitch of an embroidery. The Clipboard Block 
shows the current stitches that will be pasted. If a group, lettering, a SuperDesign or Frame 
has been copied, a warning message will appear that it will be fixed as stitches if you paste 
into the Modify tab. Only use the Modify tab in this case if you are prepared to lose the 
ability to adjust the properties such as font and stitch type. 

If you paste a design with decorations into the Modify tab, the decorations are not visible. They will 
reappear as separate subdesigns when you move to one of the other tabs.

Paste as an Embroidery
To paste the Clipboard Block as an embroidery, ensure that a tab other than Modify is 
selected, then click Paste. The pasted embroidery is automatically selected, ready to be 
moved and manipulated as required.

Paste as a Stitch Block
To insert a block at any stitch, use any of the controls on the Modify tab that change the 
End stitch in the Draw Range, then click Paste. A pasted block is automatically selected 
with Box Select so that it is ready to be moved and manipulated as required.

Shortcuts
■ Keys: Ctrl + V; Alt, H, V, P or Alt, M, V, P

Paste into Center
Use Paste into Center  to paste the Clipboard Block in the center of the hoop. The 
Clipboard Block shows the current stitches that will be pasted.

Shortcuts
■ Home or Modify Tab: 
■ Keys: Ctrl + Shift + V; Alt, H, V, C or Alt, M, V, C
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Duplicate
Use Duplicate  to make a copy of the selected embroidery or block of stitches, which is 
automatically pasted on the work area below and to the right of the original.

The copied stitches are shown in the Clipboard Block on the control panel.

Shortcuts
■ Home or Modify Tab: 
■ Keys: Ctrl + D; Alt, H, DU or Alt, M, DU

Delete
Use Delete  to delete one or more selected embroideries, groups or blocks of stitches 
after they have been selected using one of the block selection methods (Box Select , 
Freehand Select , Point Select  or Select All ) on the Modify tab.

When all visible stitches are deleted because no block is selected, all remaining stitches 
are shown.

This function differs from Cut because it does not place the stitches on the Clipboard. Therefore stitches 
that have been Deleted cannot be pasted into another embroidery (although Undo can be used if the 
wrong stitches are deleted).

Delete Single Stitches
When you have a single stitch selected, Delete  will remove the stitch.

Shortcuts
■ Home or Modify Tab: 
■ Keys: Del; Alt, H, DE or Alt, M, DE

Select and Edit Single Stitches
Select Stitches
Use Select Stitches  to select and 
edit single stitches. Simply click a 
stitch and a box appears around it to 
show that it is selected.

It may be helpful to zoom in close enough to 
see the separate stitches.
Click and drag the box to move the 
stitch. If desired, use Delete  to 
delete the stitch point.

Shortcuts
■ Modify Tab: 
■ Keys: Alt, M, SS



104          mySewnet™ Embroidery   Modifying Embroideries 

Select a Series of Stitches
Click the first required stitch point, then hold down Shift (on the keyboard) and click the 
last required stitch point. The two stitches you click and all stitches between them will be 
selected. Click outside the block to make a new selection using this method.

To select several individual stitches, hold down Ctrl and click the desired stitches.

Alternatively, hold down Shift and use the left and right arrow keys to select a series of stitches.

Insert Stitches
Use Insert Stitches  to add new stitches to an embroidery. Click Insert Stitches and the 
pointer changes to the insert stitches pointer . Then click where you want to add 
stitches. The stitches will be added using the thread color where you insert the stitches. 
Click Delete to delete the last point placed. Right-click twice to deselect. If you need to use 
a different color for the stitches, insert color changes before and after the new stitches.

Use Insert Stitches for many reasons. For example, you may add more underlay to an 
embroidery or make a new section of an embroidery. You can even change an embroidery 
into an appliqué embroidery by adding placement stitches and Stops to secure the 
appliqué fabric.

Uses include to increase underlay stitching or form a new section of an embroidery.

Shortcuts
■ Modify Tab: 
■ Keys: Alt, M, IS

Select a Block of Stitches
The block Select functions on the Modify tab allow you to select part of an embroidery. A 
selected part of an embroidery is called a block. A block can be resized, rotated, mirrored, 
moved, nudged, duplicated, copied, cut and deleted. You may find it easier to select a 
block when you have selected colors to display and/or changed the ranges of stitches that 
are visible.

When a block has been selected, it has a selection box around it on the work area. The 
selection box has handles which are used to resize, rotate and flip the block. Also, the 
block is outlined within the selection box, to assist with accurate positioning when it is 
moved or rotated.

Blue handles for resize White handles for scale
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Click and drag inside the block to move it. Use the arrow keys on the keyboard to nudge 
the block. Click and drag the square corner handles to scale the block with constant stitch 
count (white handles) or resize with constant density (blue handles), depending on Resize 
mode . Click and drag the round rotate handle to rotate the block freely. Click and drag 
the center of rotation  to rotate around a different point. Click the triangular handles to 
flip the block horizontally or vertically.

A block can also be resized/scaled and rotated precisely using the Modify Block section of the Modify tab.

Pasting a Block
When a block is pasted into an embroidery it is automatically selected as the current block 
and Box Select  is activated. The block is attached to the last visible stitch.

See “Paste” on page 102 and “Paste into Center” on page 102.

Deselecting a Block
Click the work area outside a block to deselect it. The selection box around the block will 
disappear. Right-click to turn off the current select function without deselecting the block.

Selecting an Embroidery to Modify
If there is more than one embroidery selected so that you are unable to enter the Modify 
tab, press the Tab key on the keyboard to select the embroidery you wish to edit.

Box Select
Use Box Select  to select stitches in a 
rectangular area. Click Box Select and the 
pointer changes to the box select pointer . 
Click and drag around the area you want to 
select. When you release the mouse button, the 
block will show you the extent of your selection. 
Click outside the block to make a new selection 
using this method. Right-click to deselect.

Use Box Select to make a quick selection of an area. When 
deleting a selection, if desired, use Freehand Select or 
Point Select to remove any extra stitches.

Use Add to Selection  with any select function to 
increase the area of selected stitches, or use Remove From 

Selection  to make the currently selected area smaller.

Box Select is also activated automatically when a block is pasted into an embroidery.

If the wrong area is selected, click in the work area, but outside the box, to deselect.

Shortcuts
■ Modify Tab: 
■ Keys: Alt, M, SB
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Freehand Select
Use Freehand Select  to select a block of stitches 
within an area of any shape. Click Freehand Select and 
the pointer changes to the freehand select pointer . 
Click and drag to draw an irregular outline around the 
desired area. When you release the mouse the area is 
closed automatically with a straight line between the 
last mouse position and the start position. The block will 
show you the extent of your selection. Click outside the 
block to make a new selection using this method. Right-
click to deselect.

Use Add to Selection  with any select function to increase the 

area of selected stitches, or use Remove From Selection  to 
make the currently selected area smaller.
Freehand Select is useful when an area cannot be easily selected by using the simpler Box 
Select function. It is particularly useful to highlight part of a color area which could not 
otherwise be easily selected.

If the wrong area is selected, click in the work area, but outside the box, to deselect.

Shortcuts
■ Modify Tab: 
■ Keys: Alt, M, SF

Point Select
Use Point Select  to select a block of stitches within an 
area of any shape made of straight and curved lines. Click 
Point Select and the pointer changes to the Point Select 
pointer . Click a series of points to create an irregular 
outline of straight and curved lines around the desired 
area, using Shift+click to place a square (straight line) 
point. Click and drag  to reposition an existing point. 
Click Delete to remove the last–placed point. Right-click 
when the area is complete. The block will show you the 
extent of your selection. Point Select may be easier to use 
than Freehand Select for precise selections. Right-click to 
deselect.

Use Add to Selection  with any select function to increase the area of selected stitches, or use Remove 

From Selection  to make the currently selected area smaller.
If the wrong area is selected, click in the work area, but outside the box, to deselect.

Shortcuts
■ Modify Tab: 
■ Keys: Alt, M, SP
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Select All Visible
Select All Visible  is a one-click function that selects all visible stitches in the current 
embroidery. Click outside the block to deselect.

Use the color worksheet and the Draw Range to select which stitches are visible in the 
current embroidery. This is useful to isolate an area of stitches, especially if it includes 
more than one color, or you only wish to apply a function to part of an area.

Shortcuts
■ Modify Tab: 
■ Keys: Ctrl + A; Alt, M, SA

Select None
Use Select None  to deselect all of the embroideries and blocks in the work area, 
including any outside the hoop.

Shortcuts
■ Modify Tab: 
■ Keys: Ctrl + Shift + A; Alt, M, SN

Replace Selection
Use Replace Selection  to replace the currently selected stitches with the new selection.

Shortcuts
■ Select, Modify Tab: 
■ Keys: Alt, M, SR

Add To Selection
Use Add to Selection  to add the new selection to the currently selected stitches.

Shortcuts
■ Select, Modify Tab: 
■ Keys: Alt, M, SA

Remove From Selection
Use Remove from Selection  to remove the new selection from the currently selected 
stitches.

Shortcuts
■ Select, Modify Tab: 
■ Keys: Alt, M, SD

Modify Block
To rotate or resize the selected embroidery or block of stitches by an exact amount, use 
the Modify Block section of the Modify tab. 
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To rotate the block or embroidery, enter an angle from 0 to 359 
degrees in the Angle  box, then click Apply . If desired, move the 
center of rotation  before rotating.

To resize the block or embroidery, change the height  and width  
percentage of the selected block. The height and width are scaled or resized according to 
the Resize mode.

The size in millimeters to which the design will be changed is shown to the right.

This feature is available on the Modify tab for blocks of stitches, and in the Modify Design  dialog on the 
Home tab for designs.

Shortcuts

View Selected Colors
On the Modify tab you can hide blocks of stitches according to their color. Displaying the 
stitches according to their color is an easy method of showing sections of an embroidery. 
The functions for viewing stitches by color are on the Design Panel when the Modify tab is 
open.

Hide stitches according to color, leaving the visible stitches available for other functions 
without affecting the hidden stitches. Selecting colors for display can be combined with 
the Draw Range to display a particular set of stitches that would be difficult to isolate with 
other functions.

If you have set a Draw Range, then only the stitches in the color blocks that are visible within the range will 
be displayed. Also, hidden colors are not highlighted when the mouse pointer is paused over them in the 
color worksheet.

Color Worksheet
The color worksheet on the Design Panel shows the order in 
which the thread colors are used. The group of stitches using a 
particular thread color is called a color block. The color 
worksheet can be used to change thread colors, and to add 
thread effects. When the Modify tab is open, it may be used to 
hide and show the stitches in any of the color blocks.

When you pause the arrow pointer over a thread color in the worksheet, the 
corresponding threads in the embroidery are highlighted. Also, a popup 
description of the thread color appears.
The color worksheet can also be used to change the order of the 
color blocks, and to merge color blocks.

Percentage Width Keys: Alt, M, MW

Percentage Height Keys: Alt, M, MH

Angle Keys: Alt, M, MR

Apply Keys: Alt, M, MA
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The first color in the embroidery is at the top of the list, followed by all the thread color 
blocks. The check boxes show which color blocks are hidden. The numbers show the order 
in which the colors are used, and the samples show solid blocks of each thread color in 3D.

Double-click a thread sample, or select the thread and click the Change Color  icon to 
access the Color Selection dialog box and select a different thread color, or add thread 
effects. When on the Modify tab, click a check box to show or hide a color block. When a 
color is hidden, its check box in the Color Worksheet is not selected, as shown here:

Move and Merge Color Blocks
Use the arrows below the color worksheet, or the right-click Context menu, to change the 
order of the color blocks, and to choose color blocks to merge together selectively. 

For example, you can keep two adjacent identical color blocks in case you wish to vary them later. If you 
use ColorSort, all identical colors will be merged unless there are overlapping stitches.
The changes you make are applied immediately.

This may be useful if you want to merge two blocks of an identical thread color without affecting the color 
order of the rest of the embroidery. For example, use Move and Merge Color Blocks to assist in creating 
lettering with some characters in varying colors. Alternatively, the Move and Merge Color Blocks functions 
may be useful if ColorSort does not merge colors owing to a few overlapping stitches that do not affect the 
design stitchout.
You can also use Merge when optimizing designs with multiple areas of cutwork and stabilizing lines. 
ColorSort may occasionally merge stabilizing lines in these circumstances.

Move Colors
The Move Up  and Move Down  buttons move the selected color block so that the 
colors are stitched in a different order. Click the required color in the list and it will be 
highlighted, then click the Move Up or Move Down button to move the color to the 
required position.

Alternatively, right-click the block and select Move Up or Move Down from the Context menu.

Merge Colors
The Merge Colors button  will merge the selected color block with the color block 
above it, removing the Color Change command.

Alternatively, right-click the block and select Merge into Previous Color  or Merge into Next Color from 
the Context menu.
Use Merge to delete color changes. Also use it to merge color blocks with the same thread 
color, after first moving one of the color blocks so that they are adjacent.

Insert Color Command
Use Insert Color Command  to add a new color change at the point where you click.

Hidden Visible
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Click the icon and the pointer changes to the insert color pointer . Then click on the 
stitch where you want the color change. The Color Selection dialog box is displayed for 
you to select the thread color for the new color change.

After you have selected a thread color, the stitches on the embroidery are displayed in the 
new color after the new color change and up to the next color change.

When you select the Design tab you will see the new color block in sequence in the color 
worksheet according to where you inserted the Color Change command.

To cancel the function, right-click on the work area or click Cancel in the Color Selection dialog box.

Shortcuts
■ Modify Tab: 
■ Keys: Alt, M, IC

Insert Stop Command
Use Insert Stop Command  to add a command which instructs the embroidery 
machine to stop at the point where you click, displaying a message.

Use stop commands to transform an existing satin stitched 'outline' embroidery into an 
appliqué. Insert the stop commands so the appliqué fabric may be placed on the hoop, 
tacked down and trimmed. Stop commands may also be useful where a movement stitch 
might become trapped under the stitches that follow it.

To view Stop commands with their messages, use the Design Player, or view them in the printed worksheet. 
To remove or edit the text of a Stop Command, use Undo, then Insert a new Stop, or use mySewnet™ Stitch 
Editor.

Insert a Stop Command
1 Open an embroidery, then click the Modify tab.
2 Click Insert Stop Command and the pointer changes to the insert 

stop pointer . 
3 Click on a stitch. The Stop dialog box opens.
4 Use the Quick Text drop-down menu to insert a stitchout hint, or 

enter a message. See “Stop Properties” on page 110.
5 Click OK to place the Stop Command.
6 To cancel the function, right-click on the work area.

Shortcuts
■ Modify Stitch, Modify Tab: 
■ Keys: Alt, M, IP

Stop Properties
Add a stitchout hint to a Stop Command in the Stop properties 
dialog box.

Select a Quick Text comment from the drop-down menu, or 
enter text in the Comment text field. Click OK to save the text. 
Up to 200 characters may be entered.
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Quick Text
Select one of the following texts:

■ Place the appliqué fabric now
■ Cut around the appliqué
■ Place the appliqué shape onto the placement line
■ Cut the hole in your fabric
■ Place the puffy foam on the fabric now
■ Remove any excess puffy foam
■ Check alignment now.

Draw Range
The draw Start and End slider bars on the Modify tab provide a very powerful way of 
viewing an embroidery and understanding exactly how it is formed. They allow you to 
progress forwards and/or backwards through an embroidery stitch by stitch and isolate a 
specific sequence of stitches. If desired, select the visible stitches as a block to work on 
with Select All, without affecting the hidden stitches. Changing the range of stitches can 
be combined with selecting colors to display a particular set of stitches that would be 
difficult to isolate with other functions.

Draw Range (Slider Bars)
The upper slider bar sets the Draw From Start stitch. The lower slider bar sets the Draw To 
End stitch.

Use the Draw Range to set the Start or End stitch in any of the following ways:

• Click and drag the slider box along the slider bar.
• Click the arrows at either end of the slider bar to progress by one stitch at a time. Click 

and hold on an arrow to progress more rapidly.
• Click in the space on the slider bar on either side of the slider box to move in that 

direction and jump through the stitches rapidly. You can also click and hold, but the 
slider box will stop when it reaches the arrow pointer.

In all cases, the work area will show the range of stitches as the Start or End stitch changes.

When you set a Draw Range, only the stitches in the color blocks that are visible within the range will be 
displayed.

Draw All Stitches
Use Draw All Stitches , on the Modify tab, to display all stitches in the embroidery 
selected for editing. When you have hidden stitches by changing the color selection or the 
Draw Range, click the icon to view all stitches again. All the color blocks will become 
visible and the Draw Range will be reset to all stitches.

Drag the slider Click the + or - button Click the space by the slider
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Shortcuts
■ Display, Modify Tab: 
■ Keys: Alt, M, DA
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8ExpressDesign Wizard
Use the ExpressDesign Wizard to create new embroideries automatically from pictures. 
There are three embroidery types that can be created in the ExpressDesign Wizard: 
Express Embroidery, Express Trace and Express Border.

Express Embroidery
Create a new embroidery by converting color areas in a picture to fill and satin areas, using 
running stitch or satin border outlines where necessary.

Express Embroidery works best when using pictures that have well defined, flat color areas 
and outlines.

Express Trace
Create a new embroidery by tracing outlines in the picture. Use light or heavy running 
stitch to create redwork or blackwork style embroidery, create quilt stencils and so on. Use 
satin border of constant width for designs that demand broader outlines.

Express Border
Create a new embroidery by creating borders around shapes in a picture. The border can 
be created as a satin border, appliqué, an outline of running, double or triple stitch, or a 
border of motifs.

Create an ExpressDesign Embroidery
1 Click the Create tab.
2 In the ExpressDesign drop-down list choose ExpressDesign into Hoop  or ExpressDesign into 

Rectangle .

ExpressDesign into Hoop  creates an embroidery that is a best-fit to the currently selected hoop and 
orientation. 

Express Embroidery Express Trace Express Border

Create a new embroidery by 
converting color areas in a picture 
to fill and satin areas, outlining it 
with running stitch or satin line.

Create a new embroidery by 
tracing outlines in a picture.

Create a new embroidery or 
appliqué design by creating 
borders around shapes in a 
picture.
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ExpressDesign into Rectangle  creates an embroidery that is a best-fit to a rectangular area you draw 
on the mySewnet™ Embroidery screen with click and drag.

3 In the Choose Design Type wizard page, select the desired design type from: Express Embroidery, 
Express Trace, or Express Border, then click Next.

4 Select a picture in the Choose Picture page.
5 Step through the rest of the ExpressDesign Wizard. 
6 When you Finish, the new embroidery will be placed in the center of the hoop, or where you drew the 

rectangle, fitting proportionally, depending on the picture shape. 
7 Use Save  to keep the new embroidery in multipart .vp4 format.
8 Use Export  to save in other formats, and optimize for stitching.

ExpressDesign into Hoop
Use the ExpressDesign into Hoop  option to create a new embroidery in the 
ExpressDesign Wizard that is a best-fit to the currently selected hoop and orientation. 

If desired, click Change Hoop  and choose a different hoop size before using ExpressDesign into Hoop.

Click ExpressDesign into Hoop  and the Choose Design Type page of the 
ExpressDesign Wizard will appear. Choose the desired design type, then choose a picture 
and step through the rest of the ExpressDesign Wizard. When you Finish, the new 
embroidery will be placed in the center of the hoop. Use Save  to keep the new 
embroidery, together with any other embroideries in the work area. Use Export  to save 
in other formats, and optimize for stitching.

Shortcuts

■ Create Tab: 
■ Keys: Alt, C, E, H

ExpressDesign into Rectangle
Use the ExpressDesign into Rectangle  option to create a new embroidery in the 
ExpressDesign Wizard that is a best-fit to a rectangular area you draw.

Click ExpressDesign into Rectangle  and the mouse pointer will change to the draw 
rectangle pointer . Click and drag on the work area to draw a rectangle of the desired 
size. When you release the mouse button, the Choose Design Type page of the 
ExpressDesign Wizard will appear.

If the rectangle is wrong and you wish to try again, click Cancel when the ExpressDesign Wizard appears. 
Then click ExpressDesign into Rectangle again.
Choose the desired design type, then choose a picture and step through the rest of the 
ExpressDesign Wizard. When you Finish, the new embroidery will be placed where you 
drew the rectangle, and will fit the rectangle proportionally, depending on the picture 
shape. Use Save  to keep the new embroidery. Use Export  to save in other formats, 
and optimize for stitching.

Shortcuts

■ Create tab, ExpressDesign Wizard Drop-Down: 
■ Keys: Alt, C, E, R
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Choosing and Optimizing Pictures for the 
ExpressDesign Wizard
If you wish to modify a picture before using it in the ExpressDesign Wizard, you will need 
to use a picture editor. If you have it available, use mySewnet™ PhotoStitch to adjust your 
picture, save it with a new name, then use the new picture in the ExpressDesign Wizard.

It is recommended to keep your original picture in case you wish to adjust it again with different options.

General Considerations
The ExpressDesign Wizard works best with pictures that have well defined color areas and 
outlines.

You may also wish to tidy up a picture before using it in the ExpressDesign Wizard, by 
deleting elements that are not required. Some pictures have stray or irregular lines and 
shapes that are not part of the main picture. For example, lines that add emphasis or 
suggest movement, speech or thought bubbles, decorative symbols, undesirable text, 
date marks, and so on.

In the example, the border has also been removed. Alternatively, this could be done in the Crop page of the 
ExpressDesign Wizard. However, this rough crop has left white space around the edges of this picture. The 
Crop page of the ExpressDesign Wizard will now automatically remove the extra white around the edges, 
without requiring further adjustment.

Picture Proportions
To fill the hoop or rectangle, the picture proportions should be similar to the proportions 
of the hoop or rectangle you draw. The Rotate and Crop Picture page of the ExpressDesign 
Wizard can be used to crop the picture to the desired proportions.

Cleaning a Picture
Some pictures may have random marks, speckles or excess details. If desired, use an image 
editor to clean up your picture before importing it. For example, you may have an outline 

Before tidying: there are sections of text and 
emphasis lines in the picture

After tidying: the essential part of the 
picture is retained
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in a picture that is serrated on one side. Smoothing such an outline will usually give better 
results, particularly from Express Trace and Express Border.

Enhancing Details
The significance of details in a picture is dependant on the overall size of the picture after 
it is cropped, so small details are more significant in a small picture. Also, small details are 
enlarged as the size of the created embroidery increases, so extra detail may appear if you 
simply make a larger embroidery with the same picture.

However, very small details in a picture may sometimes be ignored, as they may not have 
enough significance to be created as an area or outline in the embroidery. To enhance 
details, select Picture Options in the ExpressDesign Wizard, ensure Expand Pixel-Thin Lines 
is selected and set the Area Sensitivity to High. If this does not work, either enlarge the 
details in your picture editor, or, for outline details, connect small details together so they 
are created as a single outline.

Thick lines in a picture may be created as satin border when you would prefer regular 
outlining for a more detailed effect. To automatically reduce thick outlines, select Reduce 
Thick Lines in the Picture Options.

Patching Gaps in Pictures
Some pictures may have unwanted gaps in outlines that are too small to pick out easily. 
This can affect all the ExpressDesign Wizard design types. Outlining for an Express 
Embroidery and tracing for an Express Trace may not work as desired. Also, it may not be 
possible to make properly enclosed areas for Express Border. If you suspect your picture 
may have gaps, you can test your picture with flood fill in your picture editor, then patch 
up any gaps that are found.

Before cleaning: the line has shading serrations and 
there are dust marks from the scan

After cleaning: the line is smooth and the dust marks 
have been removed
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Patch the Gaps in a Picture of a Lion
1 Open the picture in your chosen picture editor.

The icons in this example are for the Paint tab of mySewnet™ Draw & 
Paint.

2 Choose contrasting foreground and background colors, so that it 
will be easy to see which color is being used. Try to choose bright 
colors that are not already used in the picture. If the picture is a 
black and white line drawing you wish to colorize, simply choose 
the color you desire for the area.

3 Select Flood Fill .
4 If adjacent areas are different colors, then right-click in the adjacent 

areas to fill them with the background color.
5 Click in one of the areas to fill with the foreground color. If there are 

gaps in the outline around the area, more than one area of the 
picture will be flood filled.

6 Click Undo  until the flood fills have been undone and the picture is in its original state.
7 Use Pick Color  to select the color used for the outline around the area.
8 Click Paintbrush  and select the second line thickness.
9 Zoom To rectangle  to the outline to find the gaps, then draw lines to fill any gaps in the outline.

In the example, only gaps in the outline around the body have been patched. There are other outlines that 
need patching.

10 Select the foreground color again, test with Flood Fill  and Undo . When only the expected area 
is flood filled, that part of the picture is ready for the ExpressDesign Wizard.

11 Repeat for other areas of the picture where you suspect there may be gaps.

Pictures for Express Embroidery
Many types of picture are suitable for creating an Express Embroidery. The primary factor, 
however, is to use pictures with well defined color areas and/or well defined outlines. 
Pictures that have complex color areas, such as photographs or scanned pictures that 
have not been cleaned up, can be used to create an Express Embroidery, but you may not 
get the best result unless some time is spent modifying the original picture.

Keeping and Removing Parts of the Background
In some pictures, you will want to use the option to remove all of the background color. 
However, this may also mean that some parts of the picture you wish to keep will not be 
included in the design. For example, if you have a cartoon character, the whites of the eyes 

Click in an area to fill it Draw lines to patch the gaps The outline is now complete
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or teeth might be removed if you remove all of the background color. To prevent this, use 
a false color, such as gray, to flood fill the white parts you want to keep, then change the 
gray thread color to white after finishing the ExpressDesign Wizard.

Some pictures may have graduated backgrounds, but you need to remove all of the 
background. In this case, use Pick Color to select the main background shade, then flood 
fill all the other shades in the graduated background so that the background is a single 
color. This will also prevent the multiple colors in the graduated background from 
interfering with color optimization on the Choose Thread Colors page of the 
ExpressDesign Wizard.

Pictures for Express Trace
Pictures are converted to black and white using the Monochrome Threshold in the 
ExpressDesign Wizard. The objective is to end up with a black and white line drawing, that 
can be traced using only one color. If there are large solid areas that cannot be removed 
with the Monochrome Threshold, it may be best to edit the picture before loading it so 
that the solid areas are removed.

If a picture does not have its own outlines, use Find Outlines on the Outline Finder and 
Expander page. This works best with clearly defined color areas with sharp edges.

Pictures that have gradual color changes, such as photographs or previously scanned pictures saved in 
JPEG format, may not have strong color boundaries that can be detected by Find Outlines.

Connected Outlines
When editing or creating a picture for Express Trace, check how the outlines are 
connected to each other and, where possible, look for unobtrusive places to connect 
outlines. When the outlines are more connected, there will be fewer movement stitches in 
the final embroidery and the embroidery will also stitch out more efficiently. Also, for 
smaller embroideries, adding connections between outlines will be less noticeable and 
will also prevent small sections of stitches that might be less secure.

The eyes are white, and so are the gaps 
between body and legs

The eyes are gray and will no longer be 
removed with all background areas
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Pictures for Express Border
Express Border uses Monochrome Threshold to separate shapes from the background. 
This leaves black shapes on a white background. Any solid or fully enclosed shapes in the 
picture will then have a border added around them. If there are shapes within shapes, the 
inner shapes will be ignored.

Pictures with Dark Borders and Backgrounds
A picture that has a black or very dark border or background may simply create a 
rectangular border. This is especially the case if the background or border cannot be 
removed with Monochrome Threshold.

For pictures with a dark border, it may be possible to remove the border on the Rotate and 
Crop Picture page of the ExpressDesign Wizard. If this is not possible, edit the picture to 
remove the border or change the border color.

For pictures on a dark background, use a picture editor to invert the colors in the picture 
or change the background color to a light color.

After editing the picture, load it again in the ExpressDesign Wizard.

Stippled Pictures
Stippled pictures are not suitable for creating an Express Embroidery. This is because the 
color areas approximate solid colors with dots of two or more colors in a stipple pattern.

Stippled pictures may be used for Express Trace or Express Border, if they have solid 
outlines or areas that can be extracted using Monochrome Threshold.

Choose Design Type

Use the Choose Design Type page to create a colored embroidery, trace an outline, or 
create a border or appliqué design from a picture. 

Convert color areas

Trace picture outlines

Create borders or appliqués

to satin and fill

around shapes in a picture
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Express Embroidery
Create a new design by converting color areas in a picture to fill and 
satin areas, using running stitch or satin border outlines where 
necessary.

Express Trace
Create a new design by tracing outlines in the picture. Use double 
trace or quadruple trace to create redwork or blackwork style 
embroidery, create quilt stencils and so on. Use satin line trace for 
larger designs or when a bolder outline is more pleasing.

Express Border

Create a new design by simplifying a picture into solid color areas. 
Borders are created around these shapes as satin, appliqué, running 
stitch, double stitch, triple stitch or motifs.

Next
Click Next to go to the Choose Picture page.

Choose Picture

Use the Choose Picture page to select the picture you wish to convert to a design. Select a 
picture from clipart, or one you have previously scanned or created in an image editor. 
Alternatively, paste a captured picture.

Load a Picture
Click Load a Picture  to open a picture from clipart, or one you have previously scanned 
or created in an image editor. After selecting a picture, the preview box will show the 
selected picture with its name underneath. Click Next to continue.

Select a picture file on
your computer

Paste a copied picture

Import a file from a
scanner or camera

The picture is previewed

Create or Edit in Draw & Paint
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The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), PatternCAD (.4dq), Portable Network Graphics (.png), Tagged 
Image File Format uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows Enhanced 
Meta File (.emf ) and Windows Icon (.ico).

Select a Picture File
1 Click Load a Picture  and the Picture Viewer dialog box appears.
2 Double-click to expand the folders until the desired folder is highlighted.
3 Click on a picture to select it.
4 Click OK to open the picture in the Choose Picture page.
5 Click Cancel to exit without selecting a picture.

Paste Picture
Use Paste Picture  to load the picture in the Clipboard Block. The picture is shown in the 
preview area.

Paste Picture is not available if the Clipboard Block is empty.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from a scanner, a digital camera or another suitable device. Only devices that use Windows 
Image Acquisition (WIA) can be used to obtain pictures.

WIA (Windows Image Acquisition) is a standard method for transferring pictures from the device’s 
scanning or downloading program to another program, in this case the mySewnet™ Embroidery module 
of the mySewnet™ Embroidery Software. If the manufacturer provides the appropriate software 
components needed for WIA compliance, these should have been installed when the device was installed.
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 
required. When the device and its software finish processing the picture, it will be shown 
in the Choose Picture page.

Create New Picture and Edit Picture
Create a new picture  or edit an existing picture  in mySewnet™ Draw & Paint.

Choose a picture folder

Scroll to view more pictures

Click to select a picture
Scroll to view more folders

Change the icon size

Load the selected picture
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Preview and Name
Under the preview pane is a box for the name of the chosen file. If the picture is a scanned 
image then the box will contain the words Scanned Picture.

Back
Return to the Choose Design Type page.

Next
Go to the Rotate and Crop Picture page.

Rotate and Crop Picture

If required, rotate the picture to any angle from 0 to 359 degrees. For example, this is 
useful for straightening scanned pictures.

When the picture is rotated between the 90 degree steps, the picture is made larger and 
the detected background color is added. If there is no distinctive background color, white 
is used.

Use the Crop function to select the section of the picture that is to be used to create the 
design. The picture is automatically cropped to remove excess background color. If 
required, adjust the crop lines to select the desired part of the picture. Use Perspective 
Correction to adjust for perspective or skew.

Sometimes, the automatic crop area may not appear to remove as much background color as possible. 
This can happen when the background color appears to be a plain color, such as white, but actually has 
minor variations that are not immediately visible. For example, this often happens with the JPEG-JFIF 
Compliant (*.jpg, .jif, .jpeg) picture format.
Click and drag anywhere inside the crop box to move the crop box. Click and drag outside 
the crop box to draw a new crop box.

Select All
Click the Select All button to select the whole picture. Alternatively, double-click the 
picture to select the whole picture.

Change the angle of the picture

Zoom in and out

Select the whole picture or 

Adjust the crop lines as desired

use the default crop settings

Correct the perspective in the picture Save the edited picture
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Automatic
Click Automatic to set the crop lines back to the default position for the current picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly. Drag the Stretch Picture  slider to make the 
picture in the Preview wider or narrower. Use Save Picture  to save your edited picture.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point on the picture you want to zoom 
out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at a magnification as close as possible to the Real 
Size setting you chose in mySewnet™ Configure.

Back
Return to the Choose Picture page.

Next
Go to the Choose Thread Colors, Outline Finder and Expander or Monochrome Threshold 
page, according to the chosen design type.
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Outline Finder and Expander

The Outline Finder and Expander page of the ExpressDesign Wizard only appears if you 
are creating an Express Trace design. If the picture consists of mainly solid color areas, use 
this page to create outlines appropriate for tracing.

Find Outlines
Select this option to find the outlines in your picture and show them in the preview area.

Find Outlines looks for distinctive boundaries between color areas in the picture. Pictures that have 
gradual color changes, such as photographs or previously scanned pictures saved in JPEG format, may not 
have strong color boundaries that can be detected by Find Outlines.
It is usually not necessary to Find Outlines in a picture that already has black outlining. 
However, if there are additional color boundaries that do not have outlining in the picture, 
you may still wish to use Find Outlines.

Expand
This is only available when Find Outlines is selected. Use this option to increase the 
thickness of outlines that have been found, by adding up to 5 pixels on each side of the 
lines. It is initially set to 1. Lines are traced down the center by Express Trace, so setting 
Expand to at least 1 will allow curves to be traced more smoothly and continuously.

If Expand is set to 0 (zero), the outlines found in the picture will be only one pixel wide. When a line changes 
direction, this may cause a break in the line where pixels only meet at the corner. This may cause a line to 
be traced in multiple sections, or not at all. Therefore, it is recommended to set Expand to at least 1.
If desired, use higher Expand values to merge outlines when parallel outlines are close 
together. Alternatively, you may be able to exclude unwanted lines by using Monochrome 
Threshold on the next page.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 

Find the outline in the picture

Increase the thickness of the line

Preview your changes
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or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point on the picture you want to zoom 
out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at a magnification as close as possible to the Real 
Size setting you chose in mySewnet™ Configure.

Preview
The preview shows the picture. If Find Outlines is selected, the preview shows the outlines 
that have been found, and the effect of using Expand.

Back
Return to the Rotate and Crop Picture page.

Next
Go to the Monochrome Threshold page.

Monochrome Threshold

The Monochrome Threshold page of the ExpressDesign Wizard appears if you are creating 
an Express Trace or Express Border design.

The Monochrome Threshold turns all shades or colors in the picture into either black or 
white. It acts on the whole picture. The Monochrome Threshold creates defined areas that 
are suitable for creating the final designs.

Interior details, within enclosed shapes in the picture, will not be preserved when creating Express Border.
Move the Monochrome Threshold slider bar to the desired setting, or enter a value directly 
in the box, then click Next.

Adjust the color sensitivity

Original picture

Preview monochrome version
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Adjust the Monochrome Threshold between 0 and 255 by typing in a number, clicking on 
the left or right of the slider bar or by clicking and dragging the slider bar. To make more of 
the image black, move the slider to the right or type a higher number in the box. To make 
more of the image white, move the slider to the left or type a lower number in the box.

Original Picture
The thumbnail on the left shows the original picture. This allows you to see which colors in 
the picture have been turned black or white.

Preview
The preview picture shows the result of applying the Monochrome Threshold.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point on the picture you want to zoom 
out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at a magnification as close as possible to the Real 
Size setting you chose in mySewnet™ Configure.

Back
Return to the Rotate and Crop Picture page or Outline Finder and Expander page, 
according to the chosen design type.

Next
Go to the Express Trace Options or Express Border Options page, according to the chosen 
design type.
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Express Embroidery Options
Choose Thread Colors

The Choose Thread Colors page of the ExpressDesign Wizard only appears when you are 
creating an Express Embroidery. Use the Choose Thread Colors page to match thread 
colors to colors in the picture, to set the number of colors, and to choose the color order. 
Select whether or not to keep the background and, if desired, pick a different background 
color. Optionally, choose whether or not to expand thin lines and set the sensitivity to 
small areas in the picture.

Color Selection

Number of Colors
The Number of Colors  is initially set to the recommended number of colors. The 
ExpressDesign Wizard determines the optimal number of colors for converting the picture 
into thread colors. When this number is changed, the list of colors and the preview are 
updated.

The maximum Number of Colors is 256. For pictures with less than 256 colors, the 
maximum is the total number of colors in the picture.

The total number of colors in photographs and other complex color pictures may be shown as 256+. This 
may mean that there are a lot of small color areas in the picture. This can also happen with clipart in JPEG-
JFIF Compliant (.jpg, .jif, .jpeg) format, as this format introduces minor color variations that may not be 
visible.

Apply
Click Apply to recalculate the threads with the new number of colors.

Reset
Use Reset to return the color list to the initial set of picture colors chosen on the Choose 
Thread Colors page. The colors are also re-ordered from light to dark. The picture colors 

Select a Thread Range

Delete all colors

Move colors up & down the list
Change a thread color

Remove the background color

Choose a color from the picture

Zoom in and out

Choose a thread

Delete a color

Return to the original color list

Pick a background color from the picture
Enhance detail in the picture

Set the number of colors
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will be matched to thread colors from the thread range shown in the Change All To box. 
Any custom thread matches that are required must be re-selected with Change Thread.

Change All To
Click the drop-down arrow to choose a different thread range. When a thread range is 
chosen, each picture color in the list will be assigned the nearest matching thread color 
from the chosen thread range.

When a new thread range is chosen, all custom thread matches set by Change Thread will be lost.

Picture and Thread Color List
The color list shows the colors that have been automatically selected. The colors are 
picked to give the closest representation of the original picture with the current Number 
of Colors. Each time the number of colors is changed, this list is updated. 

Sometimes, when the Number of Colors is reduced to a low number, colors will be chosen 
that are averages of two or more prominent colors in the picture. This can give a 
posterized appearance to the Reduced Colors Preview. If this effect is not desired, increase 
the Number of Colors.

The list shows a sample of each color currently selected from the picture. Initially, the 
colors are shown from light to dark, with each picture color automatically matched to a 
thread color from the thread range shown in Change All To. The color order can be 
changed. This affects the order that colors are used in the final design.

The basic color order is set by this list. However, the order for stitch types is satin, then fill, then outlines 
(running stitch or satin border). Hence, if black is moved so that it is first in this list, it will still be last in the 
final design if it is only used for outlining.
The same thread color may be matched to two or more colors in the picture. Each thread 
color can be individually changed with Change Thread. When thread colors are changed 
in the list, the Thread Color Preview is updated.

When more than one color in the picture is matched to the same thread color, the number of color changes 
in the final embroidery is reduced.

Move Up and Move Down
Use Move Up and Move Down to change the order of colors in the list.

Change Thread
Click a color in the list, then click the Change Thread button. The Color Selection dialog 
box will appear so that a different thread color can be chosen. Alternatively, double-click a 
color in the list and the Color Selection dialog box will appear.

It is recommended only to use Change Thread after the main thread range has been selected.

Pick
Click Pick to add thread colors to the list by clicking the desired colors in the Source 
Picture.

When Pick is selected, the pointer changes to an eyedropper  over the source picture. 
Click the picture to pick up the color under the tip of the eyedropper, and the nearest 
matching thread color from the selected Thread Range will be automatically selected and 
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added to the thread color list. The Thread Color Preview will be updated to show any other 
areas that can use the selected thread color.

The thread color is picked for the clicked color according to the RGB (red, green, blue) value at the point 
clicked. If there is already a thread color assigned to that exact RGB value, it will be highlighted in the list 
instead of adding a thread color to the list.

Delete
Delete the picture color currently highlighted in the list. The deleted color is replaced with 
the nearest remaining picture color in the list. The Thread Color Preview is re-displayed, 
with the reduced set of thread colors.

Delete All
Click Delete All to remove all the thread colors from the list if you wish to use Pick to 
choose colors from the Source Picture.

Background Color
The background color is automatically determined. It is the color which is used the most 
along the edges of the picture. If desired, select a different background color.

Current Background Color
The large color square shows the current background color.

Pick Background Color
Click Pick Background Color  to choose a different color from the Source Picture as the 
background color. When Pick Background Color is selected, the pointer changes to an 
eyedropper  over the source picture. Click the picture to pick up the color under the tip 
of the eyedropper. The sample of the current background will change. Depending on the 
choice for Automatically Remove Background Color, the Thread Color Preview may show 
the effect of removing the selected color.

Automatically Remove Background Color
When this is selected, the Thread Color Preview will show any areas that will be removed 
as a checkerboard pattern.

When removing the background color, choose between:

■ Remove main background only
Any areas of the background color that are connected to the edges of the picture will not 
be used in the final design. Use this option when there are significant design elements in 
the background color within the design.

■ Remove all background color areas
Any areas of the background color will not be used in the final design. Use this option 
when the background shows through gaps in the composition. Also choose this if you 
wish to remove a background color that is not connected to the edges of the picture.

Removing Multiple Background Colors
Some pictures may have more than one background color, even after color reduction. To 
remove additional unwanted background colors, change the thread color so that all the 
background colors use the same thread color.
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If the thread color used for the background color is the same as for a color area that you wish to keep, 
change the background thread color to a 'false color' that is not needed for this design.

Picture Options

Click the Picture Options button to see the Picture Options dialog box, which is used to set 
the Black Lines option and set the Area Sensitivity.

Black Lines
There are three options for handling black lines in your picture. Expand Pixel-Thin Lines is 
chosen by default.

Select No Change if you feel that outlines in the picture do not need to be expanded or reduced.
Select Expand Pixel-Thin Lines to make black lines thicker, to prevent broken lines where 
pixels join at corners. This option is on by default, to ensure that outlines in the picture are 
continuous.

Select Reduce Thick Lines if your picture has very heavy outlines, and you prefer to have markout stitching 
in your picture rather than satin outlines.

Area Sensitivity
Area Sensitivity is used to determine how significant small areas of color in the picture 
may be. Choose High, Medium or Low. Area Sensitivity is set to Medium each time the 
ExpressDesign Wizard is used.

Use High sensitivity to increase the detail extracted from the picture. This is useful, for 
example, when facial details are ignored at Medium sensitivity. Use Low sensitivity to 
decrease the detail extracted from the picture. This is useful, for example, when unwanted 
details are retained in the design at Medium sensitivity.

Previews

Source Picture
This shows the original picture, after being rotated and cropped, in full color.

Thread Color Preview
This shows how the thread colors have been chosen to replace colors in the picture. This 
gives an approximate indication of where thread blocks will be in the final design.

If variegated threads have been selected, only the first color is shown in the preview.
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Zoom
Use the Zoom functions to change the view of the picture. The same area of the picture is 
shown in both previews when the zoom level is changed.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point on the picture you want to zoom 
out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at a magnification as close as possible to the Real 
Size setting you chose in mySewnet™ Configure.

Back
Return to the Rotate and Crop Picture page.

Next
Go to the Fabric and Stitch Type Options page.

Fabric and Stitch Type Options

The Fabric and Stitch Type Options page of the ExpressDesign Wizard only appears when 
you are creating an Express Embroidery. Use the Fabric and Stitch Type page to choose the 
typical fabric that the design will be stitched onto, and the preference for fill areas or satin 
areas.

Choose a fabric type

Add underlay to the design

Create more satin or
more fill areas

View the design information

Preview the embroidery

Place on the work area
Make further edits
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Fabric Advisor

Fabric
Choose the fabric on which the design will be stitched. Adjustments are made in the 
embroidery creation process to suit the chosen fabric, such as the type of underlay chosen 
for individual areas of satin or fill.

Design Underlay
Choose Design Underlay to provide stitching below the whole embroidery, in addition to 
automatic underlay in different areas.

When Design Underlay is turned off it is easier to convert areas to lightly stitched specialty fills in 
mySewnet™ Stitch Editor or mySewnet™ Digitizing .

Preferred Stitch Type
This affects whether areas are likely to be created as satin or fill. If you prefer satin, move 
the slider to the right. If you prefer fill, move the slider to the left. The design size also 
influences whether areas are created as satin or fill, as this affects the size of individual 
areas.

To see the effect of different options, click Refresh Preview to regenerate the design.

Refresh Preview
Refresh the preview with your new settings. If a change is made to the options, you must 
click Refresh Preview before you can click Finish.

Design Information
The design information boxes show the dimensions (Width  and Height ), Stitch 
Count , and number of colors  for the embroidery. The design information may 
change when the embroidery is exported, depending on the Optimize for Sewing Options 
in the Export dialog.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point on the picture you want to zoom 
out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at a magnification as close as possible to the Real 
Size setting you chose in mySewnet™ Configure.
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Thread Color Preview
This shows how the thread colors have been chosen to replace colors in the picture. This 
allows you to view and check the final design before closing the ExpressDesign Wizard.

Back
If desired, use the Back button to go back through the ExpressDesign Wizard and modify 
settings before previewing the design again.

Finish
Accept the final design and close the ExpressDesign Wizard.

If you have changed any of the options, you must click Refresh Preview before you can click Finish.

Express Trace Options

The Express Trace Options page of the ExpressDesign Wizard only appears if you are 
creating an Express Trace design. Select whether lines in the picture will be traced with a 
combination of double and running stitch, a combination of triple and running stitch, or 
satin line. Also select the thread color.

Trace Method

Double Trace 
Trace the picture with Double Stitch where possible, with a layer of Running Stitch where 
necessary.

Quadruple Trace 
Trace the picture with Triple Stitch where possible, with an additional layer of Running 
Stitch where necessary.

Satin Line Trace 
Trace the picture with satin line, using the same width and density for the satin line 
throughout.

Choose a stitch line type

Set the properties for the line

Select the thread color

Enhance detail in the picture

View the design information
Place on the work area
Make further edits

Preview the embroidery



134          mySewnet™ Embroidery   ExpressDesign Wizard 

Stitch Options
Click the Stitch Options button to see the options for the selected Trace Method.

• If Double Trace or Quadruple Trace are selected the Trace Options dialog box is 
displayed. See Trace Options below.

• If Satin Line Trace is selected the Satin Line dialog box is displayed. See “Satin Line” on 
page 497.

Trace Options
Use the Trace Options dialog box to set the Stitch Length of the running stitch to use for 
Double Trace and Quadruple Trace, from 1 to 12mm in steps of 0.1mm. The initial setting is 
2mm.

Thread Color
Set the Thread Color for the stitches. Click the Color Change button  to choose a 
different color in the Color Selection dialog box. The thread sample is updated with the 
selected color. See “Change an Existing Thread Color” on page 53.

Picture Options
Click the Picture Options button to see the Picture Options dialog box, which is used to set 
the Area Sensitivity.

Area Sensitivity
Area Sensitivity is used to determine how significant small areas of color in the picture 
may be. Choose High, Medium or Low. Area Sensitivity is set to Medium each time the 
ExpressDesign Wizard is used.

Use High sensitivity to increase the detail extracted from the picture. This is useful, for 
example, when facial details are ignored at Medium sensitivity. Use Low sensitivity to 
decrease the detail extracted from the picture. This is useful, for example, when unwanted 
details are retained in the design at Medium sensitivity.

Design Information
The design information boxes show the dimensions (Width  and Height ), and Stitch 
Count  for the embroidery. The design information may change when the embroidery is 
exported, depending on the Optimize for Sewing Options.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point on the picture you want to zoom 
out from.
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Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at a magnification as close as possible to the Real 
Size setting you chose in mySewnet™ Configure.

Preview
The preview allows you to view and check the final design before closing the 
ExpressDesign Wizard.

Back
If desired, use the Back button to go back through the ExpressDesign Wizard and modify 
settings before previewing the design again.

Finish
Accept the final design and close the ExpressDesign Wizard.

Express Border Options

The Express Border Options page of the ExpressDesign Wizard only appears if you are 
creating an Express Border design. Use the Border Options to select the type of stitching 
used for the borders, and to choose the thread color.

Border Type
Select the type of border to create around areas of the picture from one of the following: 

■ Satin Line : see “Satin Line” on page 497.

■ Running Stitch : see “Running Stitch” on page 493.

■ Double Stitch : see “Double Stitch” on page 494.

■ Triple Stitch : see “Triple Stitch” on page 496.

■ Motif Line : see “Motif Line” on page 498.

Stitch Options
After selecting the type of border, click the Stitch Options button to show the properties 
for that border type. If desired, adjust the properties and click OK.

Choose a stitch type 
for the border
Set the properties for the border

Select the thread color

Enhance detail in the picture

View the design information
Place on the work area
Make further edits

Add appliqué to the design



136          mySewnet™ Embroidery   ExpressDesign Wizard 

Appliqué
Select Appliqué  to use appliqué within the borders of the design.

■ Click Select Fabric to change the appliqué fabric. See “Appliqué Selection” on page 192.
■ Click Appliqué Options to select the appliqué type. See “Appliqué Options” on page 137.

When Appliqué is selected, the preview shows where the appliqué fabric should be placed.

Thread Color
Set the Thread Color for the stitches. Click the Color Change button  to choose a 
different color in the Color Selection dialog box. The thread sample is updated with the 
selected color. See “Change an Existing Thread Color” on page 53.

Picture Options
Click the Picture Options button to see the Picture Options dialog box, which is used to set 
the Area Sensitivity.

Area Sensitivity
Area Sensitivity is used to determine how significant small areas of color in the picture 
may be. Choose High, Medium or Low. Area Sensitivity is set to Medium each time the 
ExpressDesign Wizard is used.

Use High sensitivity to increase the detail extracted from the picture. This is useful, for 
example, when facial details are ignored at Medium sensitivity. Use Low sensitivity to 
decrease the detail extracted from the picture. This is useful, for example, when unwanted 
details are retained in the design at Medium sensitivity.

Design Information
The design information boxes show the dimensions (Width  and Height ), and Stitch 
Count  for the embroidery. The design information may change when the embroidery is 
exported, depending on the Optimize for Sewing Options.

Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point on the picture you want to zoom 
out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at a magnification as close as possible to the Real 
Size setting you chose in mySewnet™ Configure.
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Preview
The preview shows where the borders will be created. It allows you to view and check the 
final design before closing the ExpressDesign Wizard.

Back
If desired, use the Back button to go back through the ExpressDesign Wizard and modify 
settings before previewing the design again.

Finish
Accept the final design and close the ExpressDesign Wizard.

Appliqué Options
Use the Appliqué Options dialog box to select an 
Appliqué Method for appliqué placement, and set 
the Appliqué Piece Margin. 

Appliqué Placement
When appliqué is created from a border shape, 
additional stitches are added at the beginning of 
the embroidery for placing appliqué fabric. Use 
these options to determine how these stitches are 
added. The border used to finish the appliqué uses 
line options for the selected border stitch type.

Appliqué Method
Choose the method for placing and securing the appliqué fabric.

■ Standard Appliqué
Stitch a running line to show where appliqué fabric should be placed, then stop to 
position the fabric. Stitch down the appliqué fabric with double stitch, then stop so the 
fabric may be trimmed. Finish the edges with the selected border stitching.

■ Pre-cut Piece
Use a pre-cut appliqué piece; created, for example, using an automatic cutter or cutwork 
needles.

Stitch a running line to show where the pre-cut appliqué piece should be placed, then 
stop to position the appliqué piece. Stitch down the appliqué piece with double stitch, 
then finish the edges with the selected border stitching.

■ Pre-placed Piece
Place the appliqué fabric before stitching.

Place the appliqué layer in position, then stitch down the appliqué fabric with double 
stitch. Stop so the fabric may be trimmed. Finish the edges with the selected border 
stitching.

■ Cut-out
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Use the appliqué placement line as a guide to where the fabric should be cut; for example 
for reverse appliqué.

Stitch a double stitch line. Stop so the fabric may be cut to form a hole defined by the 
stitched outline. Finish the edges with the selected border stitching.

Appliqué Piece Margin
Set the margin for appliqué placement relative to the drawn border shape from -10mm to 
10mm. The initial value is 1.0mm.

Use a positive value when trimming the appliqué fabric before the border is stitched, for example with 
Standard Appliqué and Pre-placed Appliqué. A negative value is recommended for cut-out and reverse 
appliqué.

Match Placement Line
Adjust the position of the first running stitch line for either Standard Appliqué or Pre-cut 
Piece so that it matches the outline of the appliqué piece after the Appliqué Piece Margin 
has been applied.

This may be useful for precise positioning of appliqué pieces that have been pre-cut with an automated 
cutter, to ensure the placement line is visible.

Using Express Embroidery, Trace and Border
Create a Happy Sun Embroidery

1 If required, click File, New Window.
2 In the Quick Access toolbar click Change Hoop  and set the hoop size to 100mm x 100mm - 

Universal Square Hoop 1. Click OK.
3 Click the Create tab.
4 Click the drop-down arrow 

beneath the ExpressDesign 
Wizard icon , then click 
ExpressDesign into Hoop . 
The Choose Design Type page of 
the ExpressDesign Wizard 
appears.

5 Leave Create Express Embroidery 
selected and click Next. The 
Choose Picture page of the 
ExpressDesign Wizard appears.

6 Click Load a Picture  and the 
picture viewer will appear.

7 Browse to the folder 
\mySewnet\Samples\Embroidery
\Pics.

8 Click 'Happy Sun.png' and click 
OK.
The picture is loaded onto the Choose Picture page, with its name shown below the preview area.

9 Click Next and the Rotate and Crop Picture page will appear. No rotation or adjustment of the crop 
lines is needed, so click Next and the Choose Thread Colors page will appear.

10 There are 7 colors automatically picked for this picture. For this picture, it is recommended to use all 7 
of the detected 7 colors, so no adjustment is needed.
For other pictures, you may wish to increase or decrease the number of colors picked. Click the up and 
down arrows next to the number, or click in the box and enter the desired number.
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11 If the colors in the color list are not set to Robison-Anton Rayon 40, click the drop-down arrow at the 
end of the Change All To box and select Robison-Anton Rayon 40.

12 Ensure the Automatically 
Remove Background Color 
checkbox is selected to remove 
the white background.
In Background Color, the large 
white square shows that white is 
the detected background color. 
When Automatically Remove 
Background Color is selected, the 
background color is replaced by a 
check pattern in the Thread Color 
Preview. This shows where there 
will be no stitches.

13 Click the Picture Options button.
14 In the Picture Options dialog, 

ensure that Expand Pixel-Thin 
Lines is selected in Black Lines.

15 In Area Sensitivity, ensure that 
the setting is Medium.

16 Click OK.
17 Click Next. The Fabric and Stitch 

Options page appears.
18 Leave fabric as Woven.
19 Ensure that Design Underlay is 

selected.
20 Move the Preferred Stitch Type 

slider to 4. This will use fill for the 
sun’s face, and satin for the sun’s 
rays.

21 Click Refresh Preview. The 
embroidery shown in the 
preview area is updated.

22 Click Finish. The Happy Sun 
embroidery appears on the work area.
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Create a Happy Sun Express Trace
1 If required, click File, New Window, then click the Create tab.
2 Click the drop-down arrow beneath the ExpressDesign Wizard icon , and then click ExpressDesign 

into Rectangle . The pointer changes to the draw rectangle pointer .
3 Starting at the corner of a grid 

square, click and drag to draw a 
square that is seven by seven 
grid squares.
If the rectangle is wrong and you 
wish to try again, click Cancel 
when the Choose Design Type 
page of the ExpressDesign Wizard 
appears and return to step 2.

4 Release the mouse button and 
the Choose Design Type page of 
the ExpressDesign Wizard will 
appear.

5 Select the Create Express Trace 
option.

6 Click Next and the Choose 
Picture page will appear.

7 Click Load a Picture  and the picture viewer will appear.
8 Browse to the folder \mySewnet\Samples\Embroidery\Pics.
9 Select 'Happy Sun.png', then click OK. The picture will be loaded onto the Choose Picture page, with 

its name shown below the preview area.
10 Click Next and the Rotate and 

Crop Picture page will appear. No 
rotation or cropping is required, 
so click Next and the Outline 
Finder and Expander page will 
appear.

11 The picture already has outlines 
that can be used, so ensure the 
Find Outline option is not 
selected (unchecked). Click Next 
and the Monochrome Threshold 
page will appear.

12 Set the Monochrome Threshold 
to less than 75, so that only the 
outlines show in the preview.

13 Click Next and the Express Trace 
Options page will appear.
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14 Ensure Double Trace is selected.
Double Trace traces lines in the 
picture with a combination of 
double stitch and running stitch. 
Quadruple Trace creates a bolder 
effect by using a combination of 
triple stitch and running stitch. If 
you prefer a bolder effect, choose 
Quadruple Trace instead.

15 Click the Thread Color icon  
and set the thread color to Sulky Rayon 40 1124 (Sun 
Yellow). The preview will show the embroidery in the 
chosen thread color.

16 Click Finish and the Happy Sun embroidery will appear 
on the work area, where the rectangle was drawn.

Create an Umbrella Border
1 If required, click File, New Window, then click Change Hoop  in the Quick Access toolbar.
2 Set the hoop size to 100mm x 100mm - Universal Square Hoop 1. Click OK.
3 Click the Create tab.
4 Click the drop-down arrow beneath the 

ExpressDesign Wizard icon , then click 
ExpressDesign into Hoop . The Choose 
Design Type page of the ExpressDesign 
Wizard appears.

5 Select the Create Express Border option and 
click Next. The Choose Picture page of the 
ExpressDesign Wizard appears.

6 Click Load a Picture  and the picture 
viewer will appear.

7 Browse to the folder \mySewnet\Samples 
\Embroidery\Pics.

8 Click 'Umbrella.png', then click OK. The 
picture will be loaded onto the Choose 
Picture page, with its name shown below the preview area.
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9 Click Next and the Rotate and 
Crop Picture page will appear. 

10 Click Select All.
This will create a small margin 
around the embroidery, so that it 
does not touch the edge of the 
hoop area.

11 Click Next and the Monochrome 
Threshold page will appear.

12 Set the Monochrome Threshold 
to 244 or more, so that all of the 
colored areas in the umbrella are 
black.
This creates a clearly defined 
shape to use for the border. If a 
lower number is used, extra lines 
may appear in the umbrella 
handle, or there may be gaps.

13 Click Next and the Express Border Options page will appear.
14 Ensure that Satin Line is selected as the Border Type.
15 Click Stitch Options. The Satin Line dialog box will 

appear.
16 Ensure that Width is set to 2.0mm, that Density is set to 

4, and that Underlay is selected, then click OK.
17 Click the Thread Color icon  and set the thread color 

to Robison-Anton Rayon 40 2259 (Wild Pink). The 
preview will show the embroidery in the chosen thread 
color. Click OK. The umbrella border is now pink.

18 Ensure that Appliqué  is selected.
19 Click Select Fabric.
20 In the Quick Colors section of the Appliqué Selection 

dialog box, choose a fabric and color that will match the 
satin line for the border.
Click the arrow to the right of the Quick Colors to view 
more color palettes.

21 Click Finish to place the embroidery on the work area.
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9Quilt Block Wizard

Overview
Use the Quilt Block Wizard  to create a filled or outline quilt block automatically – you 
can even create a quilting fill around an embroidery!

The most recently used quilt block dimensions are remembered, even if the program has been restarted. 
Information about the Fill Pattern used is stored in the settings of the embroidery that is created.

Quilt Block Wizard
Use the Quilt Block Wizard to create a quilt block automatically. The Quilt Block Wizard 
opens at the Select Quilt Block Style page.

Shortcuts

■ Create Tab: 
■ Keys: Alt, C, Q
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Select Quilt Block Style
The Quilt Block Wizard starts at the Select Quilt Block Style page. This enables you to select 
one of five quilt block styles.

Select a style for the quilt block. Choose the desired option, and then click Next to go to 
the Select Size page.

Filled Quilt Block; Inner Embroidery
Use Filled Quilt Block; Inner Embroidery to make a filled quilt block 
surrounding an embroidery.

Outline Quilt Block; Filled Inner Shape
Use Outline Quilt Block; Filled Inner Shape to make an unfilled quilt block 
containing a filled shape.

Filled Quilt Block; Outline Inner Shape
Use Filled Quilt Block; Outline Inner Shape to make a quilt block with an 
unfilled shape, surrounded by a fill.

Filled Quilt Block; No Inner Shape
Use Filled Quilt Block; No Inner Shape to fill the quilt block with a motif or 
pattern.

Outline Quilt Block; No Inner Shape
Use Outline Quilt Block; No Inner Shape to create a quilt block without any 
internal shape or fill. This option is useful when creating blocks to piece.

Next
Go to the Select Size page.

Fill surrounding an embroidery
Filled internal shape
Shape surrounded by fill
Filled quilt block
Quilt block; no shape or fill
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Select Size
Use the Select Size page to select a shape for your quilt block, set its size and angle, and 
add a cut line around the block.

Shape
Select one of nine shapes from the drop-down list.

All of these quilt block shapes can be tessellated — they will fill an area if tiled individually or combined 
with another shape, with no overlaps or gaps.

Angle
Use Angle to change the angle at which the quilt block is created and displayed. This is an 
easy way to place a block "on point".

Click the Rotate 45 icon  to rotate the shape by 45 degrees in a clockwise direction.

Alternatively, enter an Angle from 0 to 359 degrees. The initial setting is 0.

Alter the Angle by typing a number in the box, or use the up and down arrows to change the number.
Changes in Angle are visible in the preview pane.

Enter Size
Select which dimensions to measure for your quilt block, and enter the desired size(s). The 
selected dimension is indicated by the dotted line and letter A or B.

The default dimensions will depend upon the shape selected. The minimum size for the sides of a square 
block is 10mm and the maximum size is 1m.

Cut Line
Use the Cut Line options to set the seam allowance for your quilt block.

Include a cut line around my Quilt Block
Select this checkbox to add a line outside the edge of the quilt block to indicate where the 
fabric is to be cut and folded as a quilt block.

Select one of nine shapes

Set the quilt block angle

Set the quilt block size

Create a seam allowance
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Click Options to set the Margin and Stitch Length for your quilt block in the Cut Line 
Options dialog.

Margin
Set the Margin between the quilt block and the Cut Line. 
The minimum margin is 1mm, and the maximum margin 
is 100mm. The initial setting is 12mm.

Stitch Length
Set the stitch length for the cut line. The stitch length 
can be changed from 0.3mm to 12mm in steps of 
0.1mm. The initial setting is 3mm.

Back
Return to the Select Quilt Block Style page.

Next
If you selected ’Filled Quilt Block; Inner Embroidery’ on the Select Quilt Block Style page, 
go to the Load Embroidery page.

If you selected ’Filled Quilt Block; No Inner Shape’ on the Select Quilt Block Style page, go 
to the Select Fill pattern page. 

If you selected a quilt block with an Inner Shape on the Select Quilt Block Style page, go to 
the Select Shape page.

Finish
If you selected ’Outline Quilt Block; No Inner Shape’ on the Select Quilt Block Style page, 
click Finish to close the Wizard.
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Load Embroidery
This page appears if you chose Filled Quilt Block; Inner Embroidery in the Select Quilt 
Block Style page. 

The Load Embroidery page enables you to load an embroidery to use in the center of your 
quilt block. Use the Load Embroidery page to load one embroidery. After choosing an 
embroidery, you can select a different embroidery but only the most recently chosen 
embroidery will be shown on the preview area.

It is not possible to drag and drop an embroidery onto the Quilt Block Wizard from Windows® Explorer.

Open Embroidery
Click Open Embroidery  to load an embroidery with the Open dialog box. Select the 
desired embroidery and click Open. The Open dialog box will close and the embroidery is 
shown in the preview area.

Paste
Click Paste  to load the embroidery shown in the Clipboard Block. The embroidery is 
shown in the preview area.

Paste is not available if the Clipboard Block is empty.

Clipboard Block
This shows the embroidery, if any, that has been copied or cut to the clipboard, either from 
another mySewnet™ Embroidery Software module or from within mySewnet™ 
Embroidery before the Quilt Block Wizard was started.

Preview
A preview of the embroidery, and its stitch count , width , height  and number of 
color blocks  is displayed.

Back
Return to the Select Size page.

Browse for an embroidery

Paste a copied embroidery

View the clipboard contents

Preview the opened embroidery
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Next
Go to the Adjust Embroidery page.

Adjust Embroidery
This page appears after the Load Embroidery page if you chose Filled Quilt Block; Inner 
Embroidery in the Select Quilt Block Style page. 

If you loaded an embroidery that was too large for the specified quilt block, it will be outlined in red. Return 
to the Select Quilt Block Style page and choose a different size for the quilt block, or select another 
embroidery.

Use the Adjust Embroidery page to set the angle and position of the embroidery within 
the quilt block, and the margin around it.

To reset all the settings quickly, go back to the Load Embroidery page and load the design again.

Position
Click and drag anywhere inside the solid blue line around the embroidery (the margin) to 
move the embroidery with the move pointer .

If you drag the embroidery so that the margin is outside the edge of the quilt block, the outline will become 
red, and the Next button will be grayed out (unavailable).

Angle
Use Angle to change the angle at which the embroidery is displayed, as shown by the 
arrow.

Click the Rotate 45 icon  to rotate the embroidery by 45 degrees in a clockwise 
direction.

Alternatively, enter an Angle from 0 to 359 degrees. The initial setting is 0.

Alter the Angle by typing a number in the box, or use the up and down arrows to change the number.
Changes in Angle are visible in the preview pane.

Mirror Horizontally 
Use Mirror Horizontally  to mirror the embroidery from left to right.

Drag the embroidery into place

Set the embroidery angle

Flip the embroidery horizontally
Flip the embroidery vertically

Set the space around the
embroidery
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Mirror Vertically
Use Mirror Vertically  to mirror the embroidery from top to bottom.

Margin
Use Margin to leave space between the embroidery and the fill around it. 

The minimum Margin is zero. The maximum Margin is 50mm. The initial setting is 5mm.

A blue line around the embroidery indicates the position of the margin. If the margin is outside the edge of 
the quilt block, the outline becomes red, and the Next button is grayed out (unavailable).

Back
Return to the Load Embroidery page.

Next
Go to the Select Fill Pattern page.
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Select Shape
This page appears if you chose to use an Inner Shape for your quilt block in the Select Quilt 
Block Style page.

Select an internal shape for your quilt block, and set its size and angle.

Shape
Select one of 120 shapes from the drop-down list.

Size and Position
Click and drag one of the corner resize handles, or anywhere on the dotted line box 
surrounding the internal Shape, to resize it. The Width and Height boxes will show the 
new dimensions.

Alternatively, enter the desired dimensions in the Width and Height boxes.

Alter the shape by entering a number in the box, or use the up and down arrows to change the number.
Click and drag anywhere inside the dotted line box to move the internal Shape.

To change the shape, deselect the Proportional checkbox and then adjust the size.

Angle
Use Angle to change the angle at which the internal shape is displayed.

Click the Rotate 45 icon  to rotate the shape by 45 degrees in a clockwise direction.

Alternatively, enter an Angle from 0 to 359 degrees. The initial setting is 0.

Alter the Angle by typing a number in the box, or use the up and down arrows to change the number.
Changes in Angle are visible in the preview pane.

Back
Return to the Select Size page.

Next
Go to the Select Fill Pattern page.

Select an internal shape

Set the angle of the shape

Enter dimensions for the shape

Click & drag to resize the shape
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Select Fill Pattern
This page appears if you chose to use a fill for your quilt block in the Select Quilt Block 
Style page.

Choose a fill type for your quilt block, and set the options for it.

Stipple Fill
Use Stipple Fill  to create a stippled fill for an area.

When created, Stipple Fill areas do not have an outline.
Click the Options button to set the properties for the stipple fill. The QuiltStipple Fill 
Properties dialog box appears.

See “QuiltStipple Fill” on page 482.

Channel/Parallel Fill
Use Channel/Parallel Fill to create a fill of parallel lines for an area. Four types are available:

 Channel Fill Vertical

 Channel Fill Horizontal

 Channel Fill Diagonal Right

 Channel Fill Diagonal Left

Click the Options button to set the properties for the fill. The Crosshatch Fill properties 
dialog box appears.

See “Crosshatch Fill” on page 465.

Diamond/Square/Crosshatch Fill
Use Diamond/Square/Crosshatch Fill to create a crosshatched fill for an area. Four types 
are available:

 Diamond Fill

 Square Fill

 Crosshatch Fill

Create a stippled fill

Create a fill of parallel lines

Create a crosshatched fill area
Select decorative stitches 

Use echo lines around the 

Create a fill of contour lines

Select a shape and motif lines

for a motif fill

shape or embroidery
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 Curved Crosshatch Fill

Click the Options button to set the properties for the fill. The Crosshatch Fill or Curved 
Crosshatch Fill Properties dialog box appears.

See “Crosshatch Fill” on page 465 or “Curved Crosshatch Fill” on page 467.

Motif Fill
Use Motif Fill  to create a motif fill for an area.

Click the Options button to set the properties for the motif fill. The Motif Fill properties 
dialog box appears.

See “Motif Fill” on page 461.

Echo Fill
Use Echo Fill  to place echo lines within an area.

Click the Options button to set the properties for the echo fill. The Echo Fill properties 
dialog box appears.

See “Echo Fill” on page 474.

Contour Fill
Use Contour Fill  to create a contour fill for an area.

Click the Options button to set the properties for the contour fill. The Contour Fill 
properties dialog box appears.

See “Contour Fill” on page 483.

Shape Fill
Use Shape Fill to create a shape fill for an area. Two types are available:

 Shape Fill

 Shape Fill with Motifs

Click the Options button to set the properties for the shape fill. The Shape Fill properties 
dialog box appears.

See “Shape Fill” on page 476.

Design Information
The design information boxes show the dimensions (Width  and Height ), Stitch 
Count , and number of colors  for the embroidery. The design information may 
change when the embroidery is exported, depending on the Optimize for Sewing 
Options.

Back
Return to the Adjust Embroidery, Select Shape, or Select Size page.

Finish
Click Finish to close the Wizard.
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Quilt Block Wizard Examples
Surround an Embroidery in a Quilt Block with an Echo Fill

1 In the Create tab, click Quilt Block . 
The Select Quilt Block Style page appears.

2 Select Filled Quilt Block; Inner Embroidery .
This will create a filled quilt block with an embroidery in the center.

3 Click Next. The Select Size page appears.
4 Click the drop-down arrow to the right of the Shape list. There are nine shapes to select 

from.
All of these quilt block shapes can be tessellated — they will fill an area if tiled individually 
or combined with another shape, with no overlaps or gaps.

5 In the Shape drop-down list select Shape 6, a hexagon.
6 In Enter Size, click the arrow on the drop-down menu. For a hexagon you can select 

from Point to Point, Side, or Side to Side.
7 Ensure that Point to Point is selected in Enter Size.
8 Set measurement A to 150mm.
9 Ensure that "Include a cut line around my Quilt Block" is selected.

10 Click Next and the Load Embroidery page of the wizard will appear. 
11 Click the Open Embroidery icon  and the Open dialog box appears.
12 In the Open dialog box, browse to the folder \mySewnet\Samples\Embroidery\Stitch.
13 If required, scroll down to see more embroideries until you see the embroidery 'Iris Single'.
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14 Click the 'Iris Single’ embroidery to select it, then click Open and the embroidery will be loaded onto 
the preview area.

After choosing an embroidery you can select a different embroidery, but only the most recently chosen 
embroidery will be shown on the preview area. The dimensions, number of stitches, and thread colors used 
in the embroidery are shown below the preview pane.

15 Click Next. The Adjust Embroidery page will appear. The embroidery is placed in the center of the 
quilt block shape, with a clear margin and blue fill area surrounding it.

16 Click Rotate 45  twice. The embroidery rotates clockwise by 90 degrees in the preview pane.
You can use Angle and Rotate 45  to rotate the shape by 45 degrees, or an angle that you choose, in a 
clockwise direction.

17 Set the Angle numbers box to zero to return the embroidery to its original position.
18 Click Mirror Vertically  to reverse the embroidery.

Use Mirror Horizontally  to mirror the embroidery from top to bottom, or Mirror Vertically  to mirror 
the embroidery from left to right.

19 Click Mirror Vertically  again to set the embroidery back to the previous position.
20 Click the up arrow next to Margin to increase the margin by 2mm. The margin around the flower 

embroidery grows larger.
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21 Click and drag the embroidery so that the margin lies 
outside the edge of the quilt block. The blue fill 
disappears, and the line showing the edge of the 
margin becomes red.
You could drag it back to its original position, but it is just 
as easy to reload the embroidery.

22 Click Back. In the Load Embroidery page, click Open 
Embroidery to open the Open dialog box and load Iris 
Single again.

23 Click Next. In the Adjust Embroidery page the 
embroidery has returned to its original position and 
settings.
If you had clicked Next without loading the embroidery 
again, your changes would have been retained.
Click Next. The Select Fill Pattern page will appear.

24 The embroidery is surrounded by an unstitched margin, and the default fill, a Stipple Fill. The Options 
button is available to change the Stipple Fill settings.

25 Click Echo . The fill around the embroidery changes to an Echo Fill.
The outer lines in the echo fill follow the outline of the quilt block, while the inner lines follow the outline of 
the embroidery.

26 Click the Options button for Echo Fill. The Echo Fill properties dialog box opens.
27 Set the Gap to 4.0mm, and ensure the Stitch length is 2mm.

The Style is set to style 1, rounded corners. You can also use square (Style 2) or diagonal (Style 3) corners.
These styles have more significant effects when using the Inner Shape quilt block options.

28 Click OK to view the effect of the changes. 
29 The gap between the embroidery and the echo lines is greater than 

the gap between the lines themselves. Click Back to return to the 
Adjust Embroidery page.

30 Set the Margin to 4mm, then click Next to return to the Select Fill 
Pattern page. 
The first line in the echo fill now starts at the same distance from the 
embroidery as the other lines are from each other.
There are several small ’islands’ around the flower.

31 Under Echo, click Options and in the Echo Fill dialog box set the Gap 
to 4.2mm. Click OK.
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This increases the distance slightly between the lines of stitching, and removes the small islands, but is still 
similar to the margin.

Adjust the Gap and Style, and the position of the embroidery to achieve your preferred results.
32 Click Finish to place the finished quilt block in 

the work area, as shown.
Two rows of stitching around the quilt block 
show the lines at the edge of the block where the 
fabric should be cut and folded.
Note the orange handles for the group created 
from the embroidery, the echo lines and the cut 
line.

33 In the Color Worksheet, select the colors for 
the echo lines and the cut line and change 
them to the dark purple used in the Iris petals 
in the embroidery. 
The color of the stitching in the fill now matches 
the main color in the embroidery.

Show an Echo Around an Embroidery
1 Clear the screen, then in the Quick Access toolbar, click Insert Embroidery . The Open dialog box 

appears.
2 In the Open dialog box, browse to the folder 

\mySewnet\Samples\Embroidery\Stitch.
3 Click the Blanket Stitch Flower embroidery to 

select it, then click Open. The flower design 
appears in the work area.

4 With the flower embroidery still selected, in the 
Home tab click Copy . The flower appears in 
the Clipboard.

5 In the Create tab, click Quilt Block . 
The Select Quilt Block Style page appears.

6 Select Filled Quilt Block; Inner Embroidery .
This will create a filled quilt block with an 
embroidery in the center.

7 Click Next. The Select Size page appears.
8 Click the drop-down arrow to the right of the Shape list. There are nine shapes to select from.
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All of these quilt block shapes can be tessellated — they will fill an area if tiled individually or combined 
with another shape, with no overlaps or gaps.

9 In the Shape drop-down list select Shape 6, a hexagon.
10 Ensure that Point to Point is selected in Enter Size, and that "Include a cut line around my Quilt Block" 

is selected.
11 Set measurement A to 200mm.
12 Click Next and the Load Embroidery page of the wizard will appear. The Blanket Stitch Flower can be 

seen in the Clipboard Block in the dialog.
13 Click Paste . The blanket stitch flower is placed in the preview pane.

Use Copy and Paste to use embroideries that you have created or loaded in mySewnet™ Embroidery in the 
Quilt Block Wizard.

The dimensions, number of stitches, and thread colors used in the embroidery are shown below the 
preview pane.

14 Click Next. The Adjust Embroidery page will appear. The embroidery is placed in the center of the 
quilt block shape, with a clear margin and blue fill area surrounding it.

15 Click Next. The Select Fill Pattern page will appear.
The embroidery is surrounded by an unstitched margin, and the default fill, a Stipple Fill. The Options 
button is available to change the Stipple Fill settings.

16 Click Echo . The fill around the embroidery changes to an Echo Fill, emphasizing the blanket 
flower.
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The outer lines in the echo fill follow the outline of the quilt block, while the inner lines follow the outline of 
the embroidery.

17 Click Finish to place the finished quilt block in the work area.

Create a Quilt Block with a Central Filled Shape
1 In the Create tab, click Quilt Block . 

The Select Quilt Block Style page appears.
2 Select Outline Quilt Block; Filled Inner Shape .

This will create a block with a filled shape in the center.
3 Click Next. The Select Size page appears.
4 Click the drop-down arrow to the right of the Shape list. There are nine shapes to 

select from.
All of these quilt block shapes can be tessellated — they will fill an area if tiled 
individually or combined with another shape, with no overlaps or gaps.

5 In the Shape drop-down list select Shape 2, a rectangle.
In the preview area two sides of the rectangle are shown with a dotted line, sides A (the 
top) and B (the side).

6 In Enter Size, click the up and down arrows in boxes A and B. The rectangle changes 
shape.
This enables you to set the rectangle shape and size.

7 In the Shape drop-down list select Shape 1, a square.
Only one side, A, now has a dotted line as all sides are the same size. The box B is now 
unavailable (grayed out).

8 In Enter Size, click the drop-down arrow to the right of the box. You can select from 
Side and Diagonal, so you can enter the measurements according to the quilt 
pattern you are piecing.
If you select Diagonal the dotted line 'A' will run diagonally across the center of the square.

9 Ensure that Side is selected in Enter Size.
10 Set side A to 150mm.
11 Position the arrow pointer over box A in Enter Size without clicking. A tooltip will show the 

measurement in inches, and the minimum and maximum size.
Positioning the arrow pointer over a measurement box will show the alternative measurement. You may 
also enter the alternative measurement with units of mm or " and it will be automatically converted.

12 Set A to 200mm. The square is now 200mm wide and high.
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13 Ensure that "Include a cut line around my Quilt Block" is selected.

14 Click Next. The Select Shape page will appear.
Use this page to select the internal shape for the quilt block.

15 Click the drop-down arrow to the right of the Shape list. There are 120 shapes to 
select from.

16 Scroll down the list and select Shape 71, a heart. In the preview pane the internal 
shape becomes a heart.
To resize the shape, use the handles on the corners of the box. The Width and Height boxes 
will show the new dimensions.
To change the shape, deselect the Proportional checkbox, then move a corner handle or 
one of the dotted lines.
To move the shape, click and drag within the box, and position the shape as desired.

17 No adjustment of the shape is required, so click Next. The Select Fill Pattern page will appear. The 
heart shape is filled with the default stipple stitch.

18 Click Motif . The fill pattern changes to stars, and the Options button in the motif area becomes 
available.

19 Click the Options button for motifs. The Motif Fill Properties dialog box opens at the Motif 1 tab.
20 In Motif 1, set the Group to Universal and the Category to General Motifs 1.
21 Click the drop-down arrow for Pattern, scroll down the list and select Pattern 6, a heart.
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22 Ensure that the motif Height is set to the default value of 8mm.

23 Click the Spacing tab.
24 In Gap, set Horizontal to 10% and set Vertical to 25%. 

This will create more space between the hearts in the fill.
25 In Offset, set Horizontal to 50%.

This will alternate the positioning of the hearts.

26 Click OK to return to the Select Fill Pattern page.
Use the preview on the Select Fill Pattern page to check your adjustments.

27 Click the Options button for motifs again.
28 Click the Options tab.
29 Change the Stitch type to Triple.

30 In the Spacing tab, set the Horizontal Gap to 10% and the Vertical Gap to 20%.
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31 Click OK to return to the Select Fill Pattern page.

32 Click Finish. The quilt block is displayed in the design area.

Two rows of stitching around the quilt block show the lines at the edge of the block where the fabric should 
be cut and folded.
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10Backgrounds
Load project backgrounds for use with mySewnet™ Embroidery in the Background 
Wizard. Use the Background Wizard  to preview the embroideries you have designed 
on a garment, home decor item, fabric or quilt block, or other background.

In addition to the basic Backgrounds installed with the software, further Backgrounds can be downloaded 
and installed from the Downloads page: download.mysewnet.com.
You can also use the Background Wizard to create new backgrounds for your 
embroideries.

Use Realistic 3D  or Life View  to view embroideries and backgrounds in 3D without a grid, hoop or 
selection box. 

Viewing Backgrounds
Use the Background slider bar to show the garment, quilt or fabric background as On, Off, 
or faded.

Use Move and Rotate Background  to move the garment, quilt or fabric background. 
Click and drag to move the background. Use the background or fabric handle  to 
rotate the background. Right-click to set the background in place and deselect the 
function.

The Background tools are only available after a Background has been selected or created in the 
Background Wizard. 

Fade Background
Use the Fade background slider to vary the brightness of the 
background garment, quilt or fabric. Background On  
shows the background at full brightness, fade  the 
background to make it easier to see the embroidery, and use Background Off  to hide 
the background and see only the embroidery.

Background On  shows the 
picture in the background.

Click and drag the slider to fade the 
colors in the background picture 

(here by 50%).

Background Off  hides the 
picture. 
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Move and Rotate Background
Use Move and Rotate Background  to move the background that you have placed 
behind your embroideries.

Click the Move and Rotate Background icon  and the mouse pointer changes to a four-
headed arrow . Click and drag to move the garment, quilt block or fabric background 
around the hoop or project area, and move the round handle  to rotate the 
background.

Right-click to set the background in place and deselect the function.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, M

Remove Background
Use Remove Background  to remove the garment, quilt block or fabric background that 
you have placed behind your embroideries.

Click Remove Background  and the background will be removed from the work area.

Shortcuts
■ View Tab: 
■ Keys: Alt, V, E

Background Wizard
The Background Wizard  is started when you click Background Wizard. Use the 
Background Wizard to load an existing background or create a new background.

Shortcuts
■ View Tab:  
■ Keys: Alt, V, W 
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Load and Create Backgrounds
There are three types of backgrounds used in the Background Wizard: Garment, Quilt 
Block and Fabric. There is a folder for each background type within the special 
Backgrounds folder.

Garment
A garment is treated as a single item, so the garment is shown 
once on the mySewnet™ Embroidery screen. Use the garment 
setting for a background you want to show once, such as a 
blouse, a sweater, a tote bag or a pillowcase.

General garment categories are provided.

Quilt Block
A quilt block is treated as a single item, so the quilt block is shown 
once on the mySewnet™ Embroidery screen. Use the quilt block 
setting to preview your embellishments to quilt blocks.

Fabric
Fabric is treated as a swatch from a large area of fabric, so it is 
repeated to fill the work area. Use the fabric setting for a 
background that you want to have repeated, such as large home 
decorating projects (curtains, tablecloths or bed covers).

General fabric categories are provided.

Examples of the garment, quilt block and fabric backgrounds are shown in 
the Backgrounds subfolder of the Sample Guides.
Examples of backgrounds with placement guidelines for monograms are shown in the mySewnet™ 
Monogram Template Guide.pdf in the same subfolder.

Real Size Backgrounds
When you add a new background to your collection, you will need to provide a 
measurement so that it can be matched to the real size of embroideries. The garment, 
quilt block and fabric backgrounds supplied with mySewnet™ Embroidery have already 
been set to real size.
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Choose Background
Use the Choose Background page of the Background Wizard to load an existing 
background or create a new background.

Load Previously Saved
When you click Next, you may browse and select an existing background.

See “Load an Existing Background with the Background Wizard” on page 166.

Add New Background
When you click Next, you can make a new background from a picture or a digital source 
such as a scanner or digital camera.

See “Make a New Background with the Background Wizard” on page 167.

Type
The Type will affect the choices that are available in some pages of the Background 
Wizard.

Garment
Load or create a garment. A garment is shown as a single item as a background for 
embroideries and decorations.

Quilt Block
Load or create a quilt block. A quilt block is shown as a single item as a background for 
embroideries and decorations.

Fabric
Load or create a fabric background. A fabric is repeated to fill the work area.

Load an existing background
Create a new background

Use a single garment

Use a single quilt block

Use a fabric background
repeated to fill the work area
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Load an Existing Background with the Background 
Wizard

Use the Load Background page of the Background Wizard to select a previously saved 
garment, quilt block or fabric background. Click the Load Background icon  to select a 
garment, quilt block or fabric, as chosen under Type in the start page. Only backgrounds 
of the correct Type will be shown in the browser.

Open a folder, and scroll down and click a background to select it.

Click the thumbnail of the desired background and it will be shown on the Load 
Background page. The file name is shown in the box under the preview.

When the desired background is shown, click Finish to close the wizard and display the 
selected background in the work area.

Select a background file from
the special Backgrounds folder

The background is previewed

Click Finish to load the 
background

Choose a background folder

Scroll to view more backgrounds

Click to select a background

Scroll to view more folders

Change the icon size

Load the selected background
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Make a New Background with the Background 
Wizard
Use the Background Wizard to create a new background from a picture of your garment, 
quilt block or fabric.

To make a new background, follow these steps:

• Choose Picture
Select an existing picture or scan a new picture.

• Rotate and Crop Picture
Adjust the picture angle if desired, and select the part of the picture you wish to use for 
the background.

• Set Size
Enter a measurement so the background will be shown at its Real Size behind the 
embroidery.

• Set Background Name
Specify a name and category for the background and save it.

Once these steps are complete, the Background Wizard is closed, and the background 
displayed in the work area.

Choose Picture
Use the Choose Picture page of the Background Wizard to select a picture for the new 
background.

From Scanner or Camera will not be available if you do not have a Windows Image Acquisition (WIA) 
compliant scanner or digital camera attached to your computer.

Load a Picture
Click Load a Picture  to open a picture from clipart, or one you have previously saved, 
scanned or created in an image editor. After selecting a picture, the preview box will show 
the selected picture with its name underneath. Click OK to continue.

Select a picture file on
your computer

Paste a copied picture

Import a file from a scanner
or camera

The picture is previewed

  
Edit a picture in Draw & Paint
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The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), Tagged Image File Format 
uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows Enhanced Meta File (.emf ) 
and Windows Icon (.ico).

Load a Picture for a Background
1 Click Load a Picture  and the Picture Viewer dialog box appears.
2 Double-click to expand the folders until the desired folder is highlighted, for example: 

\mySewnet\Samples\Embroidery\Pics
3 Click on a picture to select it.
4 Click OK to open the picture in the Choose Picture page.
5 Click Cancel to exit without selecting a picture.

Paste Picture
Use Paste Picture  to load the picture in the Clipboard Block.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from a scanner, a digital camera or another suitable device. Only devices that use WIA can 
be used to obtain pictures.

WIA is a standard method for transferring pictures from the device’s scanning or downloading program to 
another program. If the manufacturer provides the appropriate software components needed for WIA 
compliance, these should have been installed when the device was installed. Each scanner or digital 
camera has its own program that is used to scan or download pictures. Refer to the manual or online help 
provided with the program for instructions, if required. When the device and its software finish processing 
the picture, it will be shown in the Choose Picture page.
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 
required. When the device and its software finish processing the Picture, it will be shown 
in the Choose Picture page.

Create New Picture and Edit Picture
Create a new picture or edit an existing picture in mySewnet™ Draw & Paint.

Preview and Name

Choose a picture folder

Click to select a picture

Scroll to view more folders

Change the icon size

Load the selected picture
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Under the preview pane is a box for the name of the chosen file. If the picture is a scanned 
image then the box will contain the words Scanned Picture.

Rotate and Crop Picture
Use the Rotate and Crop Picture page to adjust the picture angle as desired by rotating the 
picture from 0 to 359 degrees, and to select the section of the picture that is to be used to 
create the background. The Rotate and Crop Picture page is the same for garments and 
quilt blocks, and different for fabrics. If required, adjust the crop lines to select the desired 
part of the picture.
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Rotate and Crop Picture for Garment or Quilt Block
Use the Rotate and Crop Picture page to select the section of the picture that is to be used 
to create the background. If required, adjust the crop lines to select the desired part of the 
picture.

Rotate
Rotate  the picture from 0 to 359 degrees. Adjust the picture angle as desired. This is 
often necessary with scanned pictures.

Enter the desired Rotation angle  or use the up/down arrows to change the angle. The 
preview will show the effect.

When the picture is rotated between the 90 degree steps, the picture is made larger and 
white background is added.

Crop
■ To adjust the crop area, position the mouse over the crop boundary until a double-headed 

arrow  appears, then click and drag to move the boundary line.
■ To move the crop area, position the mouse inside the crop boundary until a four-headed 

arrow  appears, then click and drag to move the whole rectangle.
■ To redraw the crop area, click and drag outside the crop boundary to draw a new 

rectangle, which can then be adjusted as required.

Initially, the picture is automatically cropped to remove excess background color.

Sometimes, the automatic crop area may not appear to remove as much background color as possible. 
This can happen when the background color appears to be a plain color, such as white, but actually has 
minor variations that are not immediately visible. For example, this often happens with the JPEG-JFIF 
Compliant (*.jpg, .jif, .jpeg) picture format.

Select All and Automatic
Use Select All to select the whole of the picture. Use Automatic to set the crop lines back 
to the default position for the current picture.

Change the angle of the picture

Zoom in and out

Select the whole picture or 

Adjust the crop lines as desired

use the default crop settings

Correct the perspective in the picture Save the edited picture
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Rotate and Crop a Picture
1 Drag the rotational slider to rotate the picture to the desired angle.

Alternatively, enter a number in the rotation angle number box, or use the arrows to increase or 
decrease the angle of rotation.

2 Drag the blue handles on the crop area boundary line to select the desired part of the picture.
Hold the Shift key while dragging to resize the rectangle proportionally. Hold the Ctrl key while dragging to 
resize the rectangle without moving its center.

3 Drag anywhere inside the crop box to move the crop box.
If you need to expand a crop box again, make sure it is not touching the edge of the frame, as this will stop 
it expanding.

4 If desired, click Automatic to select the crop lines automatically, or click Select All to use the whole of 
the picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly.

When taking a picture, hold the phone or camera so as to avoid reflected light and shadow on your 
subject.

Stretch Picture
Drag the Stretch Picture  slider to make the picture in the Preview wider or narrower.

Save Picture
Use Save Picture  to save your edited picture.

Change the Perspective in a Picture
1 In the Rotate and Crop Picture page, ensure that Perspective Correction  is selected.
2 Move the pointer over one of the red crop handles in the corner.

The pointer changes to a diagonal double-headed arrow .

Enable perspective correction

Drag the red handles 
to select an area

Adjust the proportions of the picture Save the edited picture
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3 Move the red corner handles so that the crop lines frame the picture. The angle of the adjoining crop 
lines changes.
A version of the picture with the perspective corrected appears in the Preview area.
When taking a photo for a background, hold the phone or camera so as to avoid reflected light and 
shadow on your subject.

4 Drag theStretch Picture  slider to correct the proportions of the picture.
5 If desired, Save  the edited picture.

Zoom
Use the Zoom functions to change the view of the picture.

The fabric preview on the right is not affected by zoom.
Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.
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Rotate and Crop Picture for Fabric
Use the Rotate and Crop Picture page to select the section of the picture that is to be used 
to create the background, and rotate the picture. If required, adjust the crop lines to select 
the desired part of the picture.

■ To adjust the crop area, position the mouse over the crop boundary until a double-headed 
arrow  appears, then click and drag to move the boundary line.

■ To move the crop area, position the mouse inside the crop boundary until a four-headed 
arrow  appears, then click and drag to move the whole rectangle.

■ To redraw the crop area, click and drag outside the crop boundary to draw a new 
rectangle, which can then be adjusted as required.

Initially, about half the area of the picture is selected from the middle of the picture, as 
shown by the dashed box in the picture on the left. The preview on the right shows four 
copies of the selected fabric area tiled together.

The tiled preview will change dynamically as you change the crop area.

To see where the four sections of the background are joined, 
select the Show Divider option. Dashed lines show where 
the tiled sections will be joined. This is useful for patterned 
fabric, to ensure the pattern repeats as desired.

When the desired area is selected, click Next.

Rotate
Rotate  the picture from 0 to 359 degrees. Adjust the 
picture angle as desired. This is often necessary with 
scanned pictures.

Enter the desired Rotation angle  or use the up/down arrows to change the angle. The 
preview will show the effect.

Drag crop lines to select area

Drag inside area to move it

Click outside area to redraw it

Show divider lines for tiled area
Zoom in and out

Change the angle of the picture
Use the default crop settings

Select the whole picture

Correct the perspective in the picture Save the picture
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When the picture is rotated between the 90 degree steps, the picture is made larger and 
white background is added.

Select All and Automatic
Use Select All to select the whole of the picture. Use Automatic to set the crop lines back 
to the default position for the current picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly. Drag the Stretch Picture  slider to make the 
picture in the Preview wider or narrower. Use Save Picture  to save your edited picture.

Zoom
Use the Zoom functions to change the view of the picture.

The fabric preview on the right is not affected by zoom.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Enable perspective correction

Drag the red handles 
to select an area

Adjust the proportions of the picture Save the edited picture
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Set Size
Use Set Size to enter a real measurement of the garment, quilt block or fabric so that it will 
be displayed at real size when it is used as the background or appliqué fabric. Fabric is 
measured differently than garments and quilt blocks.

The cropped section of fabric is shown in the preview. Click and drag the arrows at either 
end of the yellow line to place a line across the picture. This should match a measurement 
you have made across the same area of the real fabric.

Then enter the length of the line in the ’Length of displayed line’ text box, or use the up/
down arrows.

Garments and Quilt Blocks
For garments and quilt blocks, the length can be from 1mm to 2000mm. 

Fabric
For fabric, the length can be from 1mm to 300mm. However, the fabric tile must not be 
larger than 300mm x 300mm, so if the line does not span the whole picture it must be 
shorter than 300mm.

If the length would make the fabric tile larger than 300mm in either dimension, a message will appear. 
Repeat the process so that the tile is smaller.
Click OK and the measurement you entered will be shown next to the picture. Check that 
the line and the length matches the measurement you made of the real fabric. If desired, 
click and drag the arrows to place a new line and re-enter the line length.

When the line is measured correctly, click Next.

Drag the arrows to place the line

Input the length of the line
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Set Background Name
Use Set Background Name to save the finished background in a category and give it a 
name. The categories are the folder names you will see when browsing for existing 
backgrounds. Garment, quilt block or fabric categories are set separately.

Background Name
If you started with an existing picture, the picture name will be shown by default as the 
name for the new background. If you scanned a new picture, it will not have a name so 
you will need to enter a name.

Garment, Quilt Block or Fabric Category
There are three different groups of folders, one each for Garments, Quilt Blocks and 
Fabrics. 

Garments
■ The default category is My Garments. To choose a different category, browse among the 

folders in Garments.

Quilt Blocks
■ The default category is My Quilt Blocks. To choose a different category, browse among the 

folders in Quilt Blocks.

Fabrics
■ The default category is My Fabrics. To choose a different category, browse among the 

folders in Fabrics.

Select from existing categories, or click Make New Category to provide the name of a new 
category.

Make New Category
To make a new category, click Make New Category, and enter a new folder name. Click OK 
to create the category.

The new category will be created as a subfolder for the currently selected type.

Select an existing category

Create a new category

Enter a background name



mySewnet™ Embroidery   Backgrounds              177

When make a new category, it will be available as a Fabric Category next time you use the 
Background Wizard.

Finish
Click Finish to save the new background with the specified name in the specified Category 
and close the Background Wizard. The selected or new background will be displayed in 
the work area.

Load a Garment in the Background Wizard
This exercise uses items from the full set of Backgrounds. See “Backgrounds” on page 11.

1 If required, click File, New Window, 
then click the View tab.

2 Click Change Hoop  and in the 
Hoop Selection dialog box select 
260mm x 200mm - Universal Large 
Hoop 3.

3 Set Orientation to Natural and click 
OK.

4 Click Background Wizard . The 
Choose Background page of the 
Background Wizard appears.

5 Ensure the setting for Background is 
Load Previously Saved and for Type is 
Garment.

6 Click Next. The Load Background 
page of the Background Wizard 
will appear.

7 Click Load Background .
8 In the Picture Viewer dialog box, 

browse to the folder 
Garments\Ladies\T-Shirts Round 
Neck\Medium, and all the 
garments in the folder will be 
shown.
In some views, if you position the 
arrow pointer over a thumbnail 
without clicking, the name of the 
garment will be shown. The 
garment is called 'T-Shirt 1 Med 
Green_Lt'.

9 Click the light green t-shirt to 
highlight it.
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10 Click OK to load the t-shirt in the Load 
Background page of the wizard.

11 Click Finish and the t-shirt will be shown 
in the work area.

12 In the Quick Access toolbar, click 
Insert .

13 Browse to the folder \mySewnet 
\Samples\Embroidery\Stitch.

14 Scroll down to the embroidery ’Sunshine 
Applique Large with Lettering’.

15 Click to highlight the embroidery, then 
click Open to load it into the work area on 
the t-shirt.

16 Click Move and Rotate 
Background .

17 Click and drag the 
background so that the 
embroidery is at the top of 
the t-shirt.

18 Click Realistic 3D  to 
view the embroidery on the 
t-shirt.

Make a New Fabric with the Background Wizard
1 Click the View tab.
2 Click Background Wizard . The Choose 

Background page of the Background Wizard 
appears.

3 Select Add New Background under 
Background, and Fabric under Type.

4 Click Next and the Choose Picture page will 
appear.

5 Click Load a Picture  and the Picture 
Viewer will appear.

6 In the Picture Viewer browse to the folder 
\mySewnet\Samples\Embroidery\Pics.
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7 Click the picture of the sky with 
clouds to highlight it.

8 Click OK to load the picture into 
the Choose Picture page. The 
picture 'Evening Sky.jpg' is 
loaded onto the Choose Picture 
page, with its name shown 
below the preview area.

9 Click Next and the Rotate and 
Crop Picture page will appear.

10 The angle does not need to be 
changed, so do not rotate the 
picture.

11 The picture on the left has a 
dashed outline around the area of the picture that will be 
cropped. Move the mouse over the handle at the bottom left 
of the dashed crop box so that the pointer becomes a 
double-headed arrow.

12 Click and drag the handle a little to the right and notice that 
the preview to the right changes as you move the crop line. 
Move the handle until the blue squares on the left of the 
crop box are each in the center of a cloud.

13 Also click and drag the top 
handles of the crop box down a 
little. The large clouds in the 
right-hand preview should be 
joined together as shown.

14 When you are happy that the 
clouds in the right-hand 
preview look correct, click Next. 
The Set Size page will appear, 
which is used to set a real-
world size for the background.
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15 Click and drag to adjust the 
arrows on the yellow 
measuring bar, so the line goes 
from the left edge of the 
background picture across to 
the right edge. In the ’Length of 
displayed line’ text box enter 
240. The measurement and the 
measurement line are both 
shown.
Notice that if you position the 
arrow pointer over the box the 
length is shown in inches.

16 Click Next and the Set 
Background Name page will 
appear.

17 In the Fabric Category box, 
ensure My Fabrics is the 
selected category.

18 Leave the Background Name as 
'Evening Sky', which is the same 
as the picture you loaded.

19 Click Finish. Your new 
background is loaded into the 
work area.
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Create a new Garment in the Background Wizard
1 Click the View tab.
2 Click Background Wizard . The 

Choose Background page of the 
Background Wizard appears.

3 Select Add New Background under 
Background, and Garment under Type.

4 Click Next and the Choose Picture page 
will appear.

5 Click Load a Picture  and the Picture 
Viewer will appear.

6 In the Picture Viewer browse to the 
folder \mySewnet\Samples 
\Embroidery\Pics.

7 Click the picture of the red long 
sleeve shirt to highlight it.

8 Click OK to load the picture into the 
Choose Picture page. The picture 
'Long sleeve shirt.png' is loaded 
onto the Choose Picture page, with 
its name shown below the preview 
area.

9 Click Next and the Rotate and Crop 
Picture page will appear.

10 The angle does not need to be 
changed, so do not rotate the 
picture.

11 Click Perspective Correction  to 
remove the effects of perspective in 
this picture. The crop handles 
become red.

12 The picture on the left has a dashed outline around the area of the picture that will be cropped. Move 
the mouse over the handle at the bottom right of the dashed crop box so that the pointer becomes a 
double-headed arrow.

13 Drag both of the two bottom red 
handles so that the bottom crop 
line runs parallel to the bottom of 
the shirt. .
When you take a picture for a 
garment, hold the phone or camera 
so as to avoid reflected light and 
shadow on your subject.

14 Drag the red handles at the top to 
remove the effects of perspective 
in the picture of the shirt in the 
Preview.

15 Use the Stretch Picture  slider 
to adjust the width of the picture 
in the Preview.

16 When you are happy with the 
appearance of the shirt in the 
Preview, click Next. The Set Size 
page appears, to set a size for the garment.
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17 Click and drag to adjust the arrows 
on the yellow measuring bar, so 
the line goes from the left edge of 
the body of the shirt to the right 
edge. 

18 In the ’Length of displayed line’ 
text box enter 550mm. The 
measurement and the 
measurement line are both shown.
Notice that if you position the arrow 
pointer over the box the length is 
shown in inches.

19 Click Next and the Set Background 
Name page will appear.

20 If needed, click Make New 
Category, then enter the name "My 
Garments" for your new garment 
category.

21 Click OK.
22 In the Garment Category box, ensure that My Garments is the selected category.
23 Leave the Background Name as 

'Long sleeve shirt', which is the 
same as the picture you loaded.

24 Click Finish. Your new background 
is loaded into the work area.

25 Drag the slider on the Zoom Bar at 
the bottom of the screen to the left 
so that you can see the whole shirt.

26 Click Move and Rotate 
Background .

27 Click and drag the background so 
that the hoop is at the top right of 
the shirt.

28 In the Quick Access toolbar, click 
Insert .

29 Browse to the folder \mySewnet 
\Samples\Embroidery\Stitch.

30 Scroll down to the embroidery 
’Champion Dad’.
Alternatively, use the embroidery that 
you created in “Create a Framed 
Badge: Champion Dad” on page 446.

31 Click to highlight the embroidery, 
then click Open to load it into the 
work area on the shirt.

32 Drag the slider on the Zoom Bar at 
the bottom of the screen to the left 
again so that you can see most of the 
shirt.

33 Click Realistic 3D  to view the 
embroidery on the shirt.
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11Appliqué

View and Adjust Appliqué Pieces

Use the appliqué features to view and adjust appliqué pieces. The appliqué fabric is 
shown under the embroidery, as it would appear when stitched out. An unlimited number 
of appliqué areas may be added to the work area.

The appliqué features show how a fabric would be placed. They do not alter the stitches. To create new 
appliqué designs, or add a border, use the ExpressDesign Wizard or mySewnet™ Digitizing. To add extra 
stitches and stop commands to an existing embroidery, use the Modify tab or mySewnet™ Stitch Editor. To 
place appliqué fabrics at a precise command it may be easier to navigate through the design in 
mySewnet™ Stitch Editor.
mySewnet™ Embroidery includes many Fonts, SuperDesigns and Frames with appliqué 
fabric, stitches and Stop Commands. The fabric and some stitch types may be adjusted 
using the Context menu. To change the fabric pattern position, create holes or alter the 
outline, you must Fix as Stitches before using the features on the Appliqué tab.

Any fabric background may be used as appliqué, and any number of different appliqué fabrics may be 
used, as desired. 
Ensure that the correct design is selected before adding appliqué. Use the Tab key to step through the 
embroideries.

Appliqué Piece
Use the Appliqué Piece functions to add appliqué fabric to an existing design with 
appliqué areas, and to adjust appliqué areas within a design.

Change the Fabric in an Appliqué Embroidery
1 Click File at the top left to open the Welcome screen.
2 In the Welcome screen, click Blank Canvas  to start a new project. 

The Hoop selection dialog opens.
3 From the Universal Hoop Group, set the Hoop Size to 100mm x 

100mm - Universal Square Hoop 1. Click OK.
4 In the Quick Access toolbar, click Insert .
5 In the folder \mySewnet\Samples\Embroidery\Stitch load the 

embroidery 'Night Time_applique'.
6 Click the Appliqué tab.
7 Click Next Piece . The points for the appliqué area for the moon are 

highlighted.
All of the appliqué functions are now available.

Audition a fabric for 

Delete an appliqué piece
Insert and Delete points in the outline of an appliqué area
Select an appliqué area, or move to another areaDefine the outline of an appliqué area

Cut a hole in an appliqué area

the appliqué

Find appliqué areas in an embroidery
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8 Click and drag the square zigzag fabric handle . The fabric for the moon moves.
Use the fabric handle to move the origin point (center of design) of a tiled fabric.
This handle  is only available for fabric tiles; you cannot rotate quick Appliqué or Pictures.

9 Click and drag the round handle. The fabric for the moon rotates.
The fabric rotates around the fabric handle (the origin point of the fabric tile).

10 Click Select Fabric  or choose that option in the Context menu. The Appliqué Selection dialog box 
opens.

11 To change the fabric, click Fabric in Appliqué Type, then click Load Previously Saved Fabric  and 
choose another fabric.

12 Click OK to close the Appliqué Selection dialog box.

If there is more than one appliqué fabric in the design, click Next Piece  to view the second fabric.

Appliqué Outline
Use the Appliqué Outline  functions to draw or place points to define a line of any 
shape to create an appliqué outline.

Freehand Appliqué Outline
Use the Appliqué Outline  function Freehand Appliqué Outline  to draw a line of any 
shape to create an appliqué outline. 

Select a Color Command  or Stop Command  to start the appliqué piece from, then 
draw the outline. (When hovering over a Color Command you will see the stitching that 
follows it.) Release the mouse button to complete the line. Right-click, and the Appliqué 
Selection dialog box opens. Select a fabric, then click OK to place the Appliqué Piece.

Hold down Shift to place a corner point when creating or editing a line.

Shortcuts
■ Create, Appliqué Tab: 
■ Keys: Alt, A, A, T

Point Appliqué Outline
Use the Appliqué Outline  function Point Appliqué Outline  to place points to define 
a line of any shape to create an appliqué outline. 

Select a Color Command  or Stop Command  to start the appliqué piece from, then 
place points to draw the outline. (When hovering over a Color Command you will see the 
stitching that follows it.) Right-click to finish, and the Appliqué Selection dialog box opens. 
Select a fabric, then click OK to place the Appliqué Piece.

Hold down Shift to place a corner point when creating or editing a line.

Shortcuts
■ Create, Appliqué Tab: 
■ Keys: Alt, A, A, P
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Appliqué Hole
Use the Appliqué Hole  functions to draw or place points to define a line of any shape 
to create a hole within the selected appliqué area. Select the desired Appliqué Piece so its 
points are displayed, then draw the hole. 

Freehand Appliqué Hole
Use Freehand Appliqué Hole  to draw a line of any shape to create a hole within the 
selected appliqué area. 

Select the desired Appliqué Piece so its points are displayed, then draw a line to form the 
hole. Release the mouse button to complete the line. Right-click, and any appliqué fabric 
is removed from the hole.

Hold down Shift to place a corner point when creating or editing a line. Click Delete to remove the last-
placed point.

Shortcuts
■ Create, Appliqué Tab: 
■ Keys: Alt, A, H, T

Point Appliqué Hole
Use Point Appliqué Hole  to place points to define a line of any shape to create a hole 
within the selected appliqué area. 

Select the desired Appliqué Piece so its points are displayed, then place points to draw a 
hole. Right-click, and any appliqué fabric is removed from the hole.

Hold down Shift to place a corner point when creating or editing a line. Click Delete to remove the last-
placed point.

Shortcuts
■ Create, Appliqué Tab: 
■ Keys: Alt, A, H, P

Express Appliqué
Use Express Appliqué  to automatically find appliqué stitches within an existing 
embroidery, and apply an appliqué fabric to them.

Multiple appliqué areas can be detected in the same design. To add appliqué to part of a project, select the 
desired embroidery before using Express Appliqué.
In the Appliqué window, select an appliqué embroidery with no fabric, click Express 
Appliqué , then add a fabric in the Appliqué Selection dialog box. Optionally, adjust the 
overlap margin with Appliqué Piece Margin.

Express Appliqué detects the pattern of Stop and Color Change Commands used with appliqué placement 
stitches, and inserts appliqué fabric in that area. If an appliqué area is not detected automatically, use 
Freehand Appliqué Outline or Point Appliqué Outline to define it.

Shortcuts
■ Create, Appliqué Tab: 
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■ Keys: Alt, A, Q

Add Appliqué to a Sun Embroidery
This exercise uses items from the full set of Backgrounds. See “Backgrounds” on page 11.

1 Click File, Open  to open an embroidery in a new window.
2 Browse to the folder \mySewnet\Samples\Embroidery\Stitch and load the embroidery 'Sunshine 

Applique Large with Lettering'.

The embroidery is loaded as a multiple selection with the hoop included. If you use Insert , the initial 
hoop is retained, and the embroideries are inserted as a group.

3 Click the View tab, and use the Background Wizard  to load Garments\Ladies\T-Shirts Round 
Neck\Medium\T-shirt 1 Med Green_Lt. Then use Move and Rotate Background  to move the T-
shirt downwards.

4 Click the Appliqué tab.
5 Click Express Appliqué . The Appliqué Selection dialog box opens so you can choose a fabric for 

your appliqué.
Express Appliqué detects the pattern of Stop and Color Change Commands used by appliqué placement 
stitches and inserts appliqué fabric in that area.

6 In Appliqué Type, click Fabric.
7 Click Load Previously Saved Fabric  to load a fabric in the Picture Viewer.

8 Browse to the folder General\Lattice.
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9 Click the fabric Lattice 1 - 18, then click OK. The Picture Viewer will close and the fabric will be shown 
in the Appliqué Selection dialog box.
If desired, adjust the Appliqué Piece Margin.

10 Click OK to close the Appliqué Selection dialog box. 
The fabric is shown under the sun’s face, as if you had 
stitched it down as an appliqué.

11 In the Quick Access toolbar, click Life View .
12 Move the Zoom Bar slider to the left so that you can see 

the t-shirt as well as the embroidery.
Note that the threads for the sun’s face and lettering are 
white.

13 Click Solar Reactive . The white threads turn yellow 
and orange.

14 In the Quick Access toolbar, click Save As  and save 
the embroidery with the appliqué and background as 
’Sunshine Applique Large with Lettering and 
Background’.
The sun and lettering will be stored separately within this 
multipart embroidery, making further adjustment easier.

Select Piece
Use Select Piece  to select an Appliqué Piece to alter its shape and preview or adjust its 
fabric. 

Click Select Piece , and then click the desired Appliqué Piece.

Shortcuts
■ Select, Appliqué Tab: 
■ Keys: Alt, A, T

Next Piece
Use Next Piece  to select the next Appliqué Piece in the stitchout order.

Next Piece will select an appliqué piece even if no appliqué piece is currently selected.

Shortcuts
■ Select, Appliqué Tab: 
■ Keys: Alt, A, N

Previous Piece
Use Previous Piece  to select the previous Appliqué Piece in the stitchout order.

Previous Piece will select an appliqué piece even if no appliqué piece is currently selected.

Shortcuts
■ Select, Appliqué Tab: 
■ Keys: Alt, A, P

Select Appliqué Pieces
1 Click File at the top left to open the Welcome screen.
2 In the Welcome screen, click Blank Canvas  to start a new project. The Hoop selection dialog 

opens.
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3 From the Universal Hoop Group, set the Hoop Size to 100mm x 100mm - Universal Square Hoop 1. 
Click OK.

4 In the Quick Access toolbar, click Insert .
5 In the folder \mySewnet\Samples\Embroidery\Stitch load the embroidery 'Blocks_fixed'.
6 Click the Appliqué tab.

Note that the Select Piece icon  is available. This indicates that there is 
at least one appliqué piece in the embroidery.

7 Click Select Piece , then click the A block. The points outlining the 
appliqué appear.

8 Click and drag one of the points to change the shape of the appliqué.
Note that you can change the shape of the appliqué area, but this does 
not affect the satin border.

9 Click Undo  to return to the original shape.
You can also use the Fabric Handle  to change the position and 
rotation of the fabric.

10 Click Next Piece . The letter C block is now selected.
11 Click Previous Piece  twice. First the A and then the B are selected.
12 Click Delete Piece . The appliqué fabric for the B block is removed, leaving the border lines for the 

brick.

Insert Points
Use Insert Points  to add new points into the currently selected Appliqué Piece.

Select the desired appliqué piece, then click Insert Points . The pointer changes to the 
plus pointer . Click to add a point to the outline of the selected area. Right-click to finish 
adding points.

Hold down Shift to place a straight line or corner point. Click Undo  to remove the new point.

Shortcuts
■ Edit, Appliqué Tab: 
■ Keys: Alt, A, I

Delete Points
Use Delete Points  to delete points from the currently selected Appliqué Piece.

Select the desired appliqué piece, then click Delete Points . The pointer changes to the 
minus pointer . Click to remove a point from the outline of the selected area. Right-click 
to finish deleting points.

Click Undo  to replace a deleted point.

Shortcuts
■ Edit, Appliqué Tab: 
■ Keys: Alt, A, D

Delete Piece
Use Delete Piece  to delete the currently selected Appliqué Piece with its outline.

Select the desired appliqué piece, then click Delete Piece . The appliqué piece is 
removed from the design.
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Shortcuts
■ Edit, Appliqué Tab: 
■ Keys: Alt, A, X

Select Fabric
Use Select Fabric  to audition a fabric for the selected appliqué piece in the Appliqué 
Selection dialog box. 

Select the desired appliqué piece, then click Select Fabric  and the Appliqué Selection 
dialog box appears. See “Appliqué Selection” on page 192.

Shortcuts
■ Edit, Appliqué Tab: 
■ Keys: Alt, A, F

Add Appliqué to a Sun Embroidery
This exercise uses items from the full set of Backgrounds. See “Backgrounds” on page 11.

1 Click File, Open  to open an embroidery in a new window.
2 Browse to the folder \mySewnet\Samples\Embroidery\Stitch and load the embroidery 'Sunshine 

Applique Large with Lettering'.

The embroidery is loaded as a multiple selection with the hoop included. If you use Insert , the initial 
hoop is retained, and the embroideries are inserted as a group.

3 Click the View tab, and use the Background Wizard  to load Garments\Ladies\T-Shirts Round 
Neck\Medium\T-shirt 1 Med Green_Lt. Then use Move and Rotate Background  to move the T-
shirt downwards.

4 Click the Appliqué tab.
5 Click Zoom To Rectangle , then click and drag to zoom in on the sun’s face.
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6 Click Appliqué Outline  and in the drop-down menu 
select Point Appliqué Outline.
Appliqué is added by placing a series of points to mark the 
edge of the area where you want to show the appliqué fabric. 

7 Select the color command  to the left of the grid line. As 
you hover over it, the stitches of the satin ring are 
highlighted. This will be a good location for the fabric.
The red markers are Stop Command markers , and the blue 
markers are Color Change  markers.

8 Click to place the first point of the area at the top point of 
the sun’s face. A yellow round node appears, and the 
pointer changes to the Point pointer .

9 Click to place a second point, down and to the right of the 
first point, following the satin line around the sun’s face.
As you place points a line is drawn. Make sure that this line is 
on the satin line, as this marks where the edge of your appliqué will be.

10 Click to place a third point further around the circle.
As you click the third point on the line, the line becomes closed (it becomes a loop). As you place more 
points the line adjusts itself.
The line may ’swing’ while you place points. Just carry on, you can adjust it afterwards.
You can use Shift+click to place square nodes for straight lines.

11 Move the pointer over one of the nodes on the line. The pointer changes to the Move Node 
pointer . Adjust the node as desired.
When the Move Node pointer is active you can adjust existing nodes.
If you click while the Point pointer  is active, another point will be added to the line.

12 Place points to complete the circle.
13 Right-click to finish marking out your 

appliqué area. The Appliqué Selection 
dialog box will appear, so you can choose a 
fabric for your appliqué.
If you made a mistake while placing the 
appliqué line, click Cancel in the Appliqué 
Selection dialog box without choosing a fabric 
and start again.

14 In Appliqué Type, click Fabric.
15 Click Load Previously Saved Fabric  to 

load a fabric in the Picture Viewer.

16 Browse to the folder General\Lattice.
17 Click the fabric Lattice 1 - 18, then click OK. The 

Picture Viewer will close and the fabric will be 
shown in the Appliqué Selection dialog box.

18 Click OK to close the Appliqué Selection dialog 
box. The fabric is shown under the sun’s face, 
as if you had stitched it down as an appliqué.
If the fabric is on top of the embroidery, the 
wrong command marker, or the wrong 
embroidery was selected. Undo the appliqué and 
try again.
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19 Click Zoom To Fit .

20 In the Quick Access toolbar, click Life View .
21 Move the Zoom Bar slider to the left so that you can see 

the t-shirt as well as the embroidery.
Note that the threads for the sun’s face and lettering are 
white.

22 Click Solar Reactive . The white threads turn yellow 
and orange.

23 In the Quick Access toolbar, click Save As  and save 
the embroidery with the appliqué and background as 
’Sunshine Applique Large with Lettering and 
Background’.
The sun and lettering will be stored separately within this 
multipart embroidery, making further adjustment easier.
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Appliqué Selection
Use the Appliqué Selection dialog box to change and add appliqué fabrics.

You can only change the pattern position of the appliqué pieces for fixed embroideries. To change the 
appliqué fabric pattern position for lettering, SuperDesigns and Frames, fix as an embroidery. To change 
the fabric or angle only, or the appliqué piece margin, use the context menu.
Use the Appliqué Selection dialog box to select a fabric or picture to use for appliqué. Click 
OK to use the selected appliqué fabric.

Appliqué Type
Choose an appliqué type (or simply select one of the recently used swatches). Select from:

■ Quick
Select a color and texture for your fabric. See “Quick Appliqué Options” on page 192. 

■ Fabric
Select a background fabric, or add a new background fabric from a picture. Set the angle 
for the fabric. See “Fabric Options” on page 193.

■ Picture
Create an individual non-tiling appliqué from a picture. For instance, use a photo for a 
printed appliqué memory piece. See “Picture Options” on page 193.

■ Cut-out
Create an appliqué placement line as a guide to where the fabric should be cut to form a 
hole; for example, for reverse appliqué.

Quick Appliqué Options
The Quick Appliqué Options are available when Quick is selected in 
Appliqué Type. In the mySewnet™ QuickFont Wizard only the Quick 
Appliqué options are available.
Select a color and texture for your fabric.

Select a Quick Color & texture

Choose an appliqué type

Choose a system fabric

Load an individual picture 

Preview the appliqué fabric

Reuse a recent fabric

or add a new one

for printed appliqué
Set the appliqué border margin 
Match pre-cut piece and outline

Print a sheet of appliqué fabric
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Color
Click the color sample to change the color in the Colors dialog box. See “Colors Dialog 
Box” on page 63. 

Quick Colors
Click one of the Quick Colors to select a color for the fabric. Use the drop-down menu to 
choose a different Quick Colors theme, or to create your own theme. See “Quick Color 
Themes” on page 60. 

Texture
Select the texture to use for the fabric. Click on the down arrow and choose the desired 
fabric type.

Fabric Options
The Fabric Options are available when Fabric is selected in 
Appliqué Type. 

Load Previously Saved Fabric
Use Load Previously Saved Fabric  to load a sample fabric, or a fabric from My Fabrics, 
in the Background Picture Viewer. See “Background Picture Viewer” on page 195. 

Add New Background Fabric
Use Add New Background Fabric  to create a new fabric background in the 
Background Wizard. See “Background Wizard” on page 196. 

Angle
Use Angle to change the angle at which the pattern will be displayed.

You may also change the angle and position of the fabric pattern directly by selecting the appliqué piece in 
the work area.
Enter an Angle from 0 to 359 degrees. The initial setting is 0. Alter the Angle by entering a 
number in the box, or use the up and down arrows to change the number. Changes in 
Angle are visible in the preview pane.

Print Sheet
Print a sheet of appliqué fabric from the selected Quick Appliqué or Fabric pattern. Flip the 
picture for an iron-on transfer, and select a printer and paper size in the Print Setup dialog 
box. See “Print Setup” on page 508.

Picture Options
The Picture Options are available when Picture is selected in Appliqué Type. 
Click Select Picture to create a picture background in the Load Picture Wizard. See “Load 
Picture Wizard” on page 202.

Fabric Preview
The chosen fabric is previewed on the right.
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Recent Swatches
Select a recently used fabric to use again.

Appliqué Piece Margin
Set the margin for appliqué placement relative to the drawn border shape from -10mm to 
10mm. The initial value is 1.0mm.

Use a positive value when trimming the appliqué fabric before the border is stitched, for example with 
Standard Appliqué and Pre-placed Appliqué. A negative value is recommended for cut-out and reverse 
appliqué.
Appliqué Piece Margin is only available when adjusting appliqué lettering, SuperDesigns and Frames 
using the Stitch Types options or context menu.
Use the Appliqué Piece Margin and Match Placement Line settings in Preferences to override the initial 
appliqué placement settings for lettering, SuperDesigns, Frames and Flourishes. See “Appliqué Piece 
Margin” on page 510.

Match Placement Line
Adjust the position of the first running stitch line for either Standard Appliqué or Pre-cut 
Piece so that it matches the outline of the appliqué piece after the Appliqué Piece Margin 
has been applied.

This may be useful for precise positioning of appliqué pieces that have been pre-cut with an automated 
cutter, to ensure the placement line is visible.
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Background Picture Viewer
Use the Picture Viewer to select a fabric from the system fabrics, or from the My Fabrics 
folder with fabric backgrounds you have added.

To open the Picture Viewer, in the Appliqué Selection dialog box select Fabric, then click Load Previously 

Saved Fabric .
Open a folder, and scroll down and click a fabric to select it. Click OK to load the fabric in 
the Appliqué Selection dialog box.

To create a new fabric in the Background Wizard, in the Appliqué Selection dialog box select Fabric, then 

click Add New Background Fabric . See “Background Wizard” on page 196.

Choose a fabric folder

Scroll to view more fabrics

Click to select a fabric

Scroll to view more folders

Change the icon size

Load the selected fabric
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Background Wizard
Use the Background Wizard to create a new background or appliqué fabric from a picture.

Choose Picture
Use the Choose Picture page of the Background Wizard to select a picture for the new 
appliqué fabric.

From Scanner or Camera will not be available if you do not have a Windows Image Acquisition (WIA) 
compliant scanner or digital camera attached to your computer.

Load a Picture
Click Load a Picture  to open a picture from clipart, or one you have previously saved, 
scanned or created in an image editor. After selecting a picture, the preview box will show 
the selected picture with its name underneath. Click OK to continue.

The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), Tagged Image File Format 
uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows Enhanced Meta File (.emf ) 
and Windows Icon (.ico).

Select a picture file on
your computer

Paste a copied picture

Import a file from a scanner
or camera

The picture is previewed

  
Edit a picture in Draw & Paint

Choose a picture folder

Click to select a picture

Scroll to view more folders

Change the icon size

Load the selected picture
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Load a Picture for a Background
1 Click Load a Picture  and the Picture Viewer dialog box appears.
2 Double-click to expand the folders until the desired folder is highlighted, for example: 

\mySewnet\Samples\Embroidery\Pics
3 Click on a picture to select it.
4 Click OK to open the picture in the Choose Picture page.
5 Click Cancel to exit without selecting a picture.

Paste Picture
Use Paste Picture  to load the picture in the Clipboard Block.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from a scanner, a digital camera or another suitable device. Only devices that use WIA can 
be used to obtain pictures.

WIA is a standard method for transferring pictures from the device’s scanning or downloading program to 
another program. If the manufacturer provides the appropriate software components needed for WIA 
compliance, these should have been installed when the device was installed. Each scanner or digital 
camera has its own program that is used to scan or download pictures. Refer to the manual or online help 
provided with the program for instructions, if required. When the device and its software finish processing 
the picture, it will be shown in the Choose Picture page.
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 
required. When the device and its software finish processing the Picture, it will be shown 
in the Choose Picture page.

Create New Picture and Edit Picture
Create a new picture or edit an existing picture in mySewnet™ Draw & Paint.

Preview and Name

Under the preview pane is a box for the name of the chosen file. If the picture is a scanned 
image then the box will contain the words Scanned Picture.
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Rotate and Crop Picture
■ To adjust the crop area, position the mouse over the crop boundary until a double-headed 

arrow  appears, then click and drag to move the boundary line.
■ To move the crop area, position the mouse inside the crop boundary until a four-headed 

arrow  appears, then click and drag to move the whole rectangle.
■ To redraw the crop area, click and drag outside the crop boundary to draw a new 

rectangle, which can then be adjusted as required.

Initially, about half the area of the picture is selected from the middle of the picture, as 
shown by the dashed box in the picture on the left. The preview on the right shows four 
copies of the selected fabric area tiled together.

The tiled preview will change dynamically as you change the crop area.

To see where the four sections of the background are joined, 
select the Show Divider option. Dashed lines show where 
the tiled sections will be joined. This is useful for patterned 
fabric, to ensure the pattern repeats as desired.

When the desired area is selected, click Next.

Rotate
Rotate  the picture from 0 to 359 degrees. Adjust the 
picture angle as desired. This is often necessary with 
scanned pictures.

Enter the desired Rotation angle  or use the up/down arrows to change the angle. The 
preview will show the effect.

When the picture is rotated between the 90 degree steps, the picture is made larger and 
white background is added.

Drag crop lines to select area

Drag inside area to move it

Click outside area to redraw it

Show divider lines for tiled area
Zoom in and out

Change the angle of the picture
Use the default crop settings

Select the whole picture

Correct the perspective in the picture Save the picture
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Select All and Automatic
Use Select All to select the whole of the picture. Use Automatic to set the crop lines back 
to the default position for the current picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly. Drag the Stretch Picture  slider to make the 
picture in the Preview wider or narrower. Use Save Picture  to save your edited picture.

Zoom
Use the Zoom functions to change the view of the picture.

The fabric preview on the right is not affected by zoom.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Set Size
Use Set Size to enter a real measurement of the fabric so that it will be displayed at real 
size when it is used as the appliqué fabric.

Enable perspective correction

Drag the red handles 
to select an area

Adjust the proportions of the picture Save the edited picture
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The cropped section of fabric is shown in the preview. Click and drag the arrows at either 
end of the yellow line to place a line across the picture. This should match a measurement 
you have made across the same area of the real fabric.

Then enter the length of the line in the ’Length of displayed line’ text box, or use the up/
down arrows.

The length can be from 1mm to 300mm. However, the fabric tile must not be larger than 
300mm x 300mm, so if the line does not span the whole picture it must be shorter than 
300mm.

If the length would make the fabric tile larger than 300mm in either dimension, a message will appear. 
Repeat the process so that the tile is smaller.
Click OK and the measurement you entered will be shown next to the picture. Check that 
the line and the length matches the measurement you made of the real fabric. If desired, 
click and drag the arrows to place a new line and re-enter the line length.

When the line is measured correctly, click Next.

Drag the arrows to place the line

Input the length of the line
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Set Background Name
Use Set Background Name to save the finished appliqué fabric in a category and give it a 
name. The categories are the folder names you will see when browsing for existing 
backgrounds.

Background Name
If you started with an existing picture, the picture name will be shown by default as the 
name for the new background. If you scanned a new picture, it will not have a name so 
you will need to enter a name.

Fabric Category
The default category is My Fabrics. To choose a different category, browse among the 
folders in Fabrics.

Select from existing categories, or click Make New Category to provide the name of a new 
category.

Make New Category
To make a new category, click Make New Category, and enter a new folder name. Click OK 
to create the category.

The new category will be created as a subfolder for the currently selected type.
When make a new category, it will be available as a Fabric Category next time you use the 
Background Wizard.

Finish
Click Finish to save the new background with the specified name in the specified Fabric 
Category and close the Background Wizard. The selected or new background will be 
displayed in the work area.

Select an existing category

Create a new category

Enter a background name
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Load Picture Wizard
Use the Load Picture Wizard to use a picture as an individual non-tiled appliqué 
background, for example for a printed appliqué memory piece.

Choose Picture

Use the Choose Picture page to select the picture you wish to use as a background.

Load a Picture
Click Load a Picture  to open a picture from your My Pictures folder. Alternatively, 
browse to a folder elsewhere on your computer. After selecting a picture, the preview box 
will show the selected picture with its name underneath.

The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), PatternCAD (.4dq), Portable Network Graphics (.png), Tagged 
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Image File Format uncompressed (.tiff., tif ), Windows Meta File (.wmf), Windows Enhanced 
Meta File (.emf ) and Windows Icon (.ico).

Load a Picture with the Viewer
1 Click Load a Picture  and the Picture Viewer dialog box appears.
2 Double-click to expand the folders until the desired folder is highlighted.
3 If desired, change the icon size to see more or fewer pictures.
4 Click on a picture to select it.
5 Click OK to open the picture with its name underneath.
6 Click Cancel to exit without selecting a picture.

Paste Picture
Click Paste Picture  to load the picture in the Clipboard Block. The picture is shown in 
the preview area.

Paste Picture is not available if the Clipboard Block is empty.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from a scanner, a digital camera or another suitable device. Only devices that use Windows 
Image Acquisition (WIA) can be used to obtain pictures.

WIA is a standard method for transferring pictures from the device’s scanning or downloading program to 
another program. If the manufacturer provides the appropriate software components needed for WIA 
compliance, these should have been installed when the device was installed. 
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 
required. When the device and its software finish processing the picture, it will be shown 
in the Choose Picture page.

Create New Picture and Edit Picture
Create a new picture  or edit an existing picture  in mySewnet™ Draw & Paint.

Preview and Name
Under the preview pane is a box for the name of the chosen file. If the picture is a scanned 
image then the box will contain the words Scanned Picture.

Next
Go to the Crop and Rotate Picture page.
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Rotate and Crop Picture

Use the Rotate and Crop Picture page to select the section of the picture that is to be used 
to create the appliqué background. If required, rotate the picture, and click and drag the 
boundary line of the crop area to select the desired part of the picture.

Click and drag anywhere inside the crop box to move the crop box.

If you need to expand a crop box again, make sure it is not touching the edge of the frame, as this will stop 
it expanding.
When the desired area is selected, click Finish.

Rotate
Rotate  the picture from 0 to 359 degrees. Adjust the picture angle as desired. This is 
often necessary with scanned pictures.

Enter the desired Rotation angle  or use the up/down arrows to change the angle. The 
preview will show the effect.

When the picture is rotated between the 90 degree steps, the picture is made larger and 
white background is added.

Select All and Automatic
Use Select All to select the whole of the picture. Use Automatic to set the crop lines back 
to the default position for the current picture.

Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly. Drag the Stretch Picture  slider to make the 
picture in the Preview wider or narrower. Use Save Picture  to save your edited picture.
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Zoom
Use the Zoom functions to change the view of the picture.

Use Zoom In  to magnify the view. Move the pointer over the picture and the pointer 
changes to the zoom in pointer . Then either click a point you want to zoom in towards, 
or click and drag a rectangle around the area you want to zoom in to and release the 
mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture and the pointer 
changes to the zoom out pointer . Then click a point you want to zoom out from.

Click Zoom To Fit  to fit the picture to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen.

Back
Return to the Choose Picture page.

Finish
Use the selected image for the appliqué

Export Appliqué
Use Export Appliqué Pieces  in the File menu to save or print appliqué outlines ready 
for cutting.

There are five export methods: save as SVG, DXF or FCM files for use in fabric cutters, save 
as VP4 or VP3 stitch files for use with INSPIRA™ Cutwork Needles, print as an outline 
template to cut around, print directly onto printable fabric or an iron-on transfer (this 
prints the image of the appliqué piece), or save as PNG files with the fabric image placed 
as the fill for each shape (for use with fully customized layouts).

See “Export Appliqué Pieces” on page 25 for more information.

Appliqué Options
Use the Appliqué Options dialog box to select an 
Appliqué Method for appliqué placement, and set 
the Appliqué Piece Margin, the Running Stitch 
Length, and the Double Stitch Length.

Appliqué Placement
When appliqué is created from a border shape, 
additional stitches are added at the beginning of 
the embroidery for placing appliqué fabric. Use 
these options to determine how these stitches are 
added. The border used to finish the appliqué 
uses line options for the selected border stitch type.
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Appliqué Method
Choose the method for placing and securing the appliqué fabric.

■ Standard Appliqué
Stitch a running line to show where appliqué fabric should be placed, then stop to 
position the fabric. Stitch down the appliqué fabric with double stitch, then stop so the 
fabric may be trimmed. Finish the edges with the selected border stitching.

■ Pre-cut Piece
Use a pre-cut appliqué piece; created, for example, using an automatic cutter or cutwork 
needles.

Stitch a running line to show where the pre-cut appliqué piece should be placed, then 
stop to position the appliqué piece. Stitch down the appliqué piece with double stitch, 
then finish the edges with the selected border stitching.

■ Pre-placed Piece
Place the appliqué fabric before stitching.

Place the appliqué layer in position, then stitch down the appliqué fabric with double 
stitch. Stop so the fabric may be trimmed. Finish the edges with the selected border 
stitching.

■ Cut-out
Use the appliqué placement line as a guide to where the fabric should be cut; for example 
for reverse appliqué.

Stitch a double stitch line. Stop so the fabric may be cut to form a hole defined by the 
stitched outline. Finish the edges with the selected border stitching.

Appliqué Piece Margin
Set the margin for appliqué placement relative to the drawn border shape from -10mm to 
10mm. The initial value is 1.0mm.

Use a positive value when trimming the appliqué fabric before the border is stitched, for example with 
Standard Appliqué and Pre-placed Appliqué. A negative value is recommended for cut-out and reverse 
appliqué.

Match Placement Line
Adjust the position of the first running stitch line for either Standard Appliqué or Pre-cut 
Piece so that it matches the outline of the appliqué piece after the Appliqué Piece Margin 
has been applied.

This may be useful for precise positioning of appliqué pieces that have been pre-cut with an automated 
cutter, to ensure the placement line is visible.

Running Stitch Length
Set the length of running stitch used for the placement outline in the first and second 
appliqué methods, from 1 to 12mm in 0.1mm steps. The initial setting is 2.0mm.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.
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Double Stitch Length
Set the length of double stitch used to stitch down the appliqué fabric, from 1 to 12mm in 
0.1mm steps. The initial setting is 2.0mm.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.
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12Embellishments
Decorate your chosen background and embroidery with ribbon, yarn, strings of beads, 
and decorations such as beads, sequins, hotfix crystals or nailheads. 

Add ribbon, yarn or strings of beads to your design for the Embellishment or Ribbon 
Attachment, or place an indicator line for sewing with a specialist foot. Choose a color and 
width in the Selection dialog, then draw lines and shapes, or add a Gallery design.

For Decorations, choose the desired embellishment in the Decoration Selection dialog, 
then click to place decorations one at a time, or in lines or shapes. 

Adjust the placing and type of embellishments in your project using Edit Points  or the 
Context menu. 

Embellish

Use the Embellish tab to add ribbon and decorations to your design.

Select an Embellishment Type
Choose a type of embellishment for your design. In Category, select Ribbon , Yarn , 
String of Beads , or Decorations  for beads, sequins, hotfix crystals or nailheads.

• See “Ribbon” on page 211.
• See “Yarn” on page 214.
• See “String of Beads” on page 216.
• See “Decoration” on page 219.

When a design is exported for stitching out, Embellishments are placed last in the 
stitchout order. You can view this order in the Design Player .

First, all of the embroidery apart from Embellishments is stitched. After this the indicator 
stitches for Decorations, followed by Yarn, Ribbon and Strings of Beads are stitched. In the 
Design Player , the Decorations that you would stitch or glue by hand are shown last.

The settings in the Export  dialog, and in the Export tab in mySewnet™ Configure do not affect this 
stitch order.

Place a single decoration

Delete selected embellishment

View selection properties

Break up a line of decorations

Select and draw a shape

Place a design from the Gallery

Adjust points in a line
Inset or delete points in a line

Choose Ribbon, Yarn, Strings of Beads or Decorations
Draw a Freehand or Point Line
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Drawing and Placing Embellishments
Draw Lines  of Embellishments, Place Shapes , or use a ready made design with 
Insert from Gallery .

You can also place individual Decorations with Place Individual . See “Place Individual” on page 220.

Draw Line
Use Draw Line  to place lines of the chosen embellishment on your project. Choose 
Freehand Line  or Point Line  from the drop-down menu.

Freehand Line
Use Freehand Line  to click and drag to draw a line of embellishments. 

In the Draw Line  drop-down menu, click Freehand Line  and choose the settings 
for your selected Embellishment type in the selection dialog. Then click and drag to draw a 
line. When you release the mouse the line is drawn automatically. Right-click and select 
"Finish placing line" in the Context menu to end.

• For ribbon, select color and width in the Ribbon Selection dialog (see “Ribbon 
Selection” on page 213). 

• For yarn, select color and width in the Yarn Selection dialog (see “Yarn Selection” on 
page 216). 

• For String of Beads, select color and size in the String of Beads Selection dialog (see 
“String of Beads Selection” on page 219). 

• For Decorations, select a decoration type, material, color, size and angle in the 
Decoration Selection dialog (see “Decoration Selection” on page 223).

Use Edit Points  and Properties  or the Context menu to make changes to your line. See “Edit Points” 
on page 225.

Shortcuts

■ Draw Line Drop-Down, Add Embellishment, Embellish Tab: 
■ Keys: Alt, D, L, F

Point Line
Use Point Line  to place points to draw a line of embellishments.

Point Line may be easier to use than Freehand Line for precise drawing. 
In the Draw Line  drop-down menu, click Point Line  and choose the settings for 
your selected Embellishment type in the selection dialog. Then click a series of points to 
create a line. Right-click to finish the line. Right-click and select "Finish placing line" in the 
Context menu to deselect.

• For ribbon, select color and width in the Ribbon Selection dialog (see “Ribbon 
Selection” on page 213). 

• For yarn, select color and width in the Yarn Selection dialog (see “Yarn Selection” on 
page 216). 

• For String of Beads, select color and size in the String of Beads Selection dialog (see 
“String of Beads Selection” on page 219). 
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• For Decorations, select a decoration type, material, color, size and angle in the 
Decoration Selection dialog (see “Decoration Selection” on page 223).

Use Edit Points  and Properties  or the Context menu to make changes to your line. See “Edit Points” 
on page 225.

Shortcuts
■ Draw Line Drop-Down, Add Embellishment, Embellish Tab: 
■ Keys: Alt, D, L, P

Place Shape
Use Place Shape  to draw a shaped line of 
embellishments on your project, using the shape currently 
selected in the gallery of preset shapes. 

Once placed, a Decoration shape is treated as a line of decorations.
Click the drop-down arrow to the right of the shapes gallery, 
and scroll to select the desired shape in the list. Click Place 
Shape  and choose the settings for your selected 
Embellishment type in the selection dialog, then click OK. 

• For ribbon, select color and width in the Ribbon Selection dialog (see “Ribbon 
Selection” on page 213). 

• For yarn, select color and width in the Yarn Selection dialog (see “Yarn Selection” on 
page 216). 

• For String of Beads, select color and size in the String of Beads Selection dialog (see 
“String of Beads Selection” on page 219). 

• For Decorations, select a decoration type, material, color, size and angle in the 
Decoration Selection dialog (see “Decoration Selection” on page 223).

The shape is shown as an embellishment line, with handles to resize, flip and rotate the 
shape. To move the shape, click and drag inside the shape.

Resize the shape with the resize handles on the corners. Hold down Shift as you click and 
drag to retain the current proportions of the shape. Hold down Ctrl to resize from the 
center. Rotate the shape with the circular rotate handle on the right. Mirror the shape 
horizontally or vertically with the triangular flip handles on the left and top. 

For best results when resizing shapes with sharp points, it is recommended to hold down Shift so that the 
shape is perfectly in proportion.

Use Edit Points  and Properties  or the Context menu to make changes to your shape. See “Edit 
Points” on page 225.

Shortcuts
■ Add Embellishment, Embellish Tab: 
■ Keys: Alt, D, S
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Insert from Gallery
Use Insert from Gallery  to select a design from one of the Design Galleries.

See: 

• “Ribbon Gallery Designs” on page 213, 
• “Yarn Gallery Designs” on page 215, 
• “String of Beads Gallery Designs” on page 218 and 
• “Decoration Gallery Designs” on page 222.

Shortcuts
■ Add Embellishment, Embellish Tab: 
■ Keys: Alt, D, I

Ribbon
Adding Ribbon
Add Ribbon  to your design for the Embellishment Attachment (or the Ribbon 
Attachment), or place an indicator line for sewing with a standard ribbon foot. Choose a 
color and width in the Ribbon Selection dialog, then draw ribbon lines and shapes, or add 
a Ribbon Gallery design.

Draw or place your line of ribbon within the green rectangle on the work area. The green rectangle 
indicates the area accessible to the Embellishment Attachment within the selected hoop. Hoops used with 
the Embellishment Attachment must be at least 200mm wide or high.
Draw a line of ribbon with Draw Line , use Place Shape , or add a design with Insert 
from Gallery .

Use Edit Points  and Properties  or the Context menu to make changes to the ribbon. See “Edit 
Points” on page 225.

Designing with Ribbon
Place your ribbon lines and designs to work with your Embellishment Attachment. Any 
ribbon should be placed within the green rectangle.

The green rectangle indicates the area accessible to the Embellishment Attachment within the selected 
hoop. To stitch ribbon in a wider area, select a larger hoop.
When designing with ribbon, use a continuous line where possible, and plan your start 
and end before placing your design. Ribbon lines cannot be split.

Avoid very sharp corners, and do not use loops smaller than 5mm in diameter.

You can stitch over another ribbon line, but not more than twice.

Turnable hoops cannot be used with the Embellishment or Ribbon Attachments.
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Draw a Line of Ribbon
1 In the Category section of the Embellish tab, select Ribbon .
2 In the Draw Line  drop-down menu, choose Freehand Line . The 

Ribbon Selection dialog box appears.
3 Select a ribbon color and size, then click OK to close the Ribbon Selection 

dialog box.
The pointer changes to the pen pointer .

4 Draw a line for the ribbon.
5 Right-click when you have placed the ribbon and select "Finish placing line" 

from the Context menu.

To change the ribbon later, use Edit Points  and Properties . See “Edit Points” on page 225.

Place Points for a Line of Ribbon
1 In the Category section of the Embellish tab, select Ribbon .
2 In the Draw Line  drop-down menu, choose Point Line . The Ribbon Selection dialog box will 

appear.
3 Scroll down and select a ribbon color and size, then click OK to close the Ribbon Selection dialog box.

The pointer changes to the Point pointer .
4 Click to place points for a line for the ribbon.
5 Right-click when you have placed the ribbon and select "Finish placing line" from the Context menu.

To change the ribbon later, use Edit Points  and Properties . See “Edit Points” on page 225.

Draw a Ribbon Shape
1 In the Category section of the Embellish tab, select Ribbon .
2 Click the drop-down arrow to the right of the shapes gallery and select 

a shape from the list. 
3 Click Place Shape . The Ribbon Selection dialog box will appear.
4 Select a ribbon color and size, then click OK to close the dialog box. The 

ribbon shape is shown.
5 Click and drag on one of the corner handles to enlarge or shrink the 

shape.
Hold down Shift to retain the original proportions. Hold down Ctrl to resize 
from the center. 

6 Move the pointer over the shape. The pointer changes to the move 
pointer . 

7 Click and drag the shape to the desired position.

To change the ribbon later, use Edit Points  and Properties . See “Edit Points” on page 225.
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Ribbon Gallery Designs
With Ribbon  selected, use Insert from Gallery  to insert a Ribbon design into your 
current project. Change the size and color to complement your project.

Click Insert from Gallery  and in the File Viewer dialog box, scroll down and click to 
highlight the desired design. Click Open to load the design.

Use Edit Points  and Properties  or the Context menu to change the size and color of the ribbon in 
the design.

Ribbon Selection
Use the Ribbon Selection dialog box to choose a color and width for your ribbon. The 
length of ribbon needed for the line or shape is displayed.

Use Edit Points  to select a piece of ribbon on the work area for editing. See “Edit Points” on page 225.

Color
Choose a color in the Colors dialog, or select a color and theme from the Quick Colors. 
Click the drop-down color menu to choose a color in the Colors dialog, or pick a Quick 
Color. 

View the amount of ribbon needed

Choose a color for your ribbon

Select the width of your ribbon
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Click the drop-down menu to the right of the Quick Colors to see other Quick Color 
themes, or to create a new theme.

See “Colors Dialog Box” on page 63 and “Quick Color Themes” on page 60.

Size
Select the ribbon width from the drop-down menu.

The available sizes are 5mm, 6mm, 7mm, 8mm, 9mm, 10mm, 11mm and 12mm.

Yarn
Adding Yarn
Add Yarn  to your design for the Embellishment Attachment, or place an indicator line 
for sewing with a standard yarn foot. Choose a color and width in the Yarn Selection 
dialog, then draw yarn lines and shapes, or add a Yarn Gallery design.

Draw or place your line of yarn within the green rectangle on the work area which indicates the area 
accessible to the Embellishment Attachment within the selected hoop.
Draw a line of yarn with Draw Line , use Place Shape , or add a design with Insert 
from Gallery .

Use Edit Points  and Properties  or the Context menu to make changes to the yarn. See “Edit Points” 
on page 225.

Designing with Yarn
Place your yarn lines and designs to work with your Embellishment Attachment. Any yarn 
should be placed within the green rectangle.

The green rectangle indicates the area accessible to the Embellishment Attachment within the selected 
hoop. To stitch yarn in a wider area, select a larger hoop.
When designing with yarn, use a continuous line where possible, and plan your start and 
end before placing your design. Yarn lines cannot be split.

Avoid very sharp corners, and do not use loops smaller than 5mm in diameter.

Take care when stitching over another yarn line, depending on the yarn type.

Turnable hoops cannot be used with the Embellishment Attachment.

Draw a Line of Yarn
1 In the Category section of the Embellish tab, select Yarn .
2 In the Draw Line  drop-down menu, choose Freehand Line . The 

Yarn Selection dialog box appears.
3 Select a yarn color and size, then click OK to close the Yarn Selection dialog 

box.
The pointer changes to the pen pointer .

4 Draw a line for the yarn.
5 Right-click when you have placed the yarn and select "Finish placing line" 

from the Context menu.

To change the yarn later, use Edit Points  and Properties . See “Edit Points” on page 225.
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Place Points for a Line of Yarn
1 In the Category section of the Embellish tab, select Yarn .
2 In the Draw Line  drop-down menu, choose Point Line . The Yarn Selection dialog box will 

appear.
3 Scroll down and select a yarn color and size, then click OK to close the Yarn Selection dialog box.

The pointer changes to the Point pointer .
4 Click to place points for a line for the yarn.
5 Right-click when you have placed the yarn and select "Finish placing line" from the Context menu.

To change the yarn later, use Edit Points  and Properties . See “Edit Points” on page 225.

Draw a Yarn Shape
1 In the Category section of the Embellish tab, select Yarn .
2 Click the drop-down arrow to the right of the shapes gallery and select a shape 

from the list. 
3 Click Place Shape . The Yarn Selection dialog box will appear.
4 Select a yarn color and size, then click OK to close the dialog box. The yarn 

shape is shown.
5 Click and drag on one of the corner handles to enlarge or shrink the shape.

Hold down Shift to retain the original proportions. Hold down Ctrl to resize from the 
center. 

6 Move the pointer over the shape. The pointer changes to the move pointer . 
7 Click and drag the shape to the desired position.

To change the yarn later, use Edit Points  and Properties . See “Edit Points” on page 225.

Yarn Gallery Designs
With Yarn  selected, use Insert from Gallery  to insert a Yarn design into your current 
project. Change the size and color to complement your project.

Click Insert from Gallery  and in the File Viewer dialog box, click to highlight the desired 
design. Click Open to load the design.

Use Edit Points  and Properties  or the Context menu to change the size and color of the yarn in the 
design.
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Yarn Selection
Use the Yarn Selection dialog box to choose a color and width for your yarn. The length of 
yarn needed for the line or shape is displayed.

Use Edit Points  to select a piece of yarn on the work area for editing. See “Edit Points” on page 225.

Color
Choose a color in the Colors dialog, or select a color and theme from the Quick Colors. 
Click the drop-down color menu to choose a color in the Colors dialog, or pick a Quick 
Color. 

Click the drop-down menu to the right of the Quick Colors to see other Quick Color 
themes, or to create a new theme.

See “Colors Dialog Box” on page 63 and “Quick Color Themes” on page 60.

Size
Select the yarn width from the drop-down menu.

The available sizes are 1mm, 2mm, 3mm, 4mm and 5mm.

String of Beads
Adding Strings of Beads
Add Strings of Beads  to your design for the Embellishment Attachment, or place an 
indicator line for sewing with a bead foot. Choose a color and width in the String of Beads 
Selection dialog, then draw lines and shapes, or add a String of Beads Gallery design.

Draw or place your Strings of Beads within the green rectangle on the work area. The green rectangle 
indicates the area accessible to the Embellishment Attachment within the selected hoop. Hoops used with 
the Embellishment Attachment must be at least 200mm wide or high.
Draw a string of beads with Draw Line , use Place Shape , or add a design with 
Insert from Gallery .

Use Edit Points  and Properties  or the Context menu to make changes to the String of Beads. See 
“Edit Points” on page 225.

View the amount of yarn needed

Choose a color for your yarn

Select the width of your yarn



mySewnet™ Embroidery   Embellishments              217

Designing with Strings of Beads
Place your bead lines and designs to work with your Embellishment Attachment. Any 
Strings of Beads should be placed within the green rectangle.

The green rectangle indicates the area accessible to the Embellishment Attachment within the selected 
hoop. To stitch bead strings in a wider area, select a larger hoop.
When designing with Strings of Beads, use a continuous line where possible, and plan 
your start and end before placing your design. String of Beads lines cannot be split.

Warning colors indicate problems with the design:

• Red indicates that the angle of a corner is too sharp (over 60 degrees). Adjust the points 
in the line to smooth the curve.

• Purple indicates that the line is too close to itself, or crosses itself. Change the line so 
that no parts are too close.

• Orange indicates that two lines are too close to each other. Move them apart.

Turnable hoops cannot be used with the Embellishment Attachment.

Draw a String of Beads
1 In the Category section of the Embellish tab, select String of Beads .
2 In the Draw Line  drop-down menu, choose Freehand Line . The 

String of Beads Selection dialog box appears.
3 Select a bead color and size, then click OK to close the String of Beads 

Selection dialog box.
The pointer changes to the pen pointer .

4 Draw a line for the String of Beads.
5 Right-click when you have placed the bead line and select "Finish placing 

line" from the Context menu.

To change the String of Beads later, use Edit Points  and Properties . See “Edit Points” on page 225.

Place Points for a String of Beads
1 In the Category section of the Embellish tab, select String of Beads .
2 In the Draw Line  drop-down menu, choose Point Line . The String of Beads Selection dialog 

box will appear.

Orange shows two different
lines are too close

Red indicates a sharp corner

Purple shows a line crosses
or is too close to itself
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3 Scroll down and select a bead color and size, then click OK to close the String of Beads Selection 
dialog box.
The pointer changes to the Point pointer .

4 Click to place points for a line for the beads.
5 Right-click when you have placed the String of Beads and select "Finish placing line" from the Context 

menu.

To change the String of Beads later, use Edit Points  and Properties . See “Edit Points” on page 225.

Draw a String of Beads Shape
1 In the Category section of the Embellish tab, select String of Beads .
2 Click the drop-down arrow to the right of the shapes gallery and select a shape 

from the list. 
In general, lines work better for bead strings than closed shapes, but for instance, an 
opened shape may make a good highlight for a frame.

3 Click Place Shape . The String of Beads Selection dialog box will appear.
4 Select a bead color and size, then click OK to close the dialog box. The String of 

Beads shape is shown.
5 Click and drag on one of the corner handles to enlarge or shrink the shape.

Hold down Shift to retain the original proportions. Hold down Ctrl to resize from the 
center. 

6 Move the pointer over the shape. The pointer changes to the move pointer . 
7 Click and drag the shape to the desired position.

To change the String of Beads later, use Edit Points  and Properties . See “Edit 
Points” on page 225.

String of Beads Gallery Designs
With Strings of Beads  selected, use Insert from Gallery  to insert a String of Beads 
design into your current project. Change the size and color to complement your project.

Click Insert from Gallery  and in the File Viewer dialog box, scroll down and click to 
highlight the desired design. Click Open to load the design.

Use Edit Points  and Properties  or the Context menu to change the size and color of the beads in the 
design.
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String of Beads Selection
Use the String of Beads Selection dialog box to choose a color and size for your beads. The 
length of bead string needed for the line or shape is displayed.

Use Edit Points  to select a string of beads on the work area for editing. See “Edit Points” on page 225.

Color
Choose a color in the Colors dialog, or select a color and theme from the Quick Colors. 
Click the drop-down color menu to choose a color in the Colors dialog, or pick a Quick 
Color. 

Click the drop-down menu to the right of the Quick Colors to see other Quick Color 
themes, or to create a new theme.

See “Colors Dialog Box” on page 63 and “Quick Color Themes” on page 60.

Size
Select the bead size from the drop-down menu. The available sizes are 2mm and 4mm.

When a string of beads is selected, a message shows how much will be needed.

Decoration
Adding Decorations
Add Decorations  such as beads, sequins, crystals or nailheads to your project as 
individual decorations with Place Individual , or as lines of decorations with Draw 
Line  or Place Shape . Insert a special design with decorations using Insert from 
Gallery .

The Decorations added with Place Individual  form a decoration subdesign, or are added to an existing 
decoration subdesign if one is selected.

Use Edit Points  and Properties  or the Context menu to make changes to the line of decorations. See 
“Edit Points” on page 225.

View the length of the string of beads needed

Choose a color for your string of beads

Select the size of your beads
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Place Individual
Use Place Individual  to place decorations individually on your project. 

Click Place Individual  and select a decoration type, material, color, size and angle in the 
Decoration Selection dialog. Then click to place decorations. See “Decoration Selection” 
on page 223.

Shortcuts
■ Add Decoration, Embellish Tab: 
■ Keys: Alt, D, P

Place Individual Beads on an Embroidery
1 Load the desired background and embroideries.
2 Position the embroideries as desired.
3 In the Category section of the 

Embellish tab, select Decoration .
4 Click the Place Individual icon . The 

Decoration Selection dialog box will 
appear.

5 Click to select the desired bead type 
and material.

6 Click the Color drop-down menu and 
use the Colors dialog box to select a 
color, or choose a color in the Quick 
Colors.

7 In Size, select the desired bead size.
8 Choose the angle of rotation of the 

bead in Angle.
9 Click OK to close the Decoration Selection dialog box.

The cursor changes to the Insert cursor  to show that you may place beads.
10 Click in the work area to place the bead. Each click will place one bead.

Click and drag will have no effect while placing beads. Use Undo to remove the last bead.
11 When you have placed all the beads as desired, right-click and select "Finish placing individual" in the 

Context menu to end.
12 Repeat the process to place more beads as desired.
13 Use File, Export Decoration Template  to create a crystal transfer template (or rhinestone 

template) for pressing hotfix crystals and nailheads directly onto your work. See “Export Decoration 
Template” on page 27.

Decoration Lines
Use Draw Line  to place lines of decorations on your project with Freehand Line  
or Point Line . Select a bead, sequin, crystal or nailhead using your preferred material, 
size and color in the Decoration Selection dialog, and then draw your line.

Select the angle of Rotation, and choose whether the line of decorations will follow the line drawn (Follow 
Line), or if they will use the angle set in rotation (Stepped).
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Draw a Line of Decorations
1 In the Category section of the Embellish tab, select Decoration .
2 In the Draw Line  drop-down menu, choose Freehand Line . The 

Decoration Selection dialog box will appear.
3 Scroll down and select a decoration type, material, color, size and 

spacing, then click OK to close the Decoration Selection dialog box.
The pointer changes to the pen pointer .

4 Draw a line for the beads.
5 Right-click when you have placed the beads and select "Finish placing 

line" from the Context menu.

Place Points for a Line of Decorations
1 In the Category section of the Embellish tab, select Decoration .
2 In the Draw Line  drop-down menu, choose Point Line . The Decoration Selection dialog box 

will appear.
3 Scroll down and select a decoration type, material, color, size and spacing, then click OK to close the 

Decoration Selection dialog box.
The pointer changes to the Point pointer .

4 Click to place points for a line for the beads.
5 Right-click when you have placed the beads and select "Finish placing line" from the Context menu.

Draw a Decoration Shape
1 In the Category section of the Embellish tab, select Decoration .
2 Click the drop-down arrow to the right of the shapes gallery and 

select a shape from the list. 
3 Click Place Shape . The Decoration Selection dialog box will 

appear.
4 Scroll down and select a decoration type, material, color, size 

and spacing, then click OK to close the Decoration Selection 
dialog box. The shape is shown in a selection box.

5 Click and drag on one of the corner handles to enlarge or shrink 
the shape.
Hold down Shift to retain the original proportions. Hold down Ctrl 
to resize from the center.

6 Move the pointer over the shape. The pointer 
changes to the move pointer . 

7 Click and drag the shape to the desired position.
To change the shape later, use Edit Points  and 
Properties . See “Edit Points” on page 225.
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Decoration Gallery Designs
With Decoration  selected, use Insert from Gallery  to insert a Decoration design into 
your current project. Change the size, color and decoration type to complement your 
project.

Click Insert from Gallery  and in the 
File Viewer dialog box, scroll down and 
click to highlight the desired design. 
Click Open to load the decoration 
design.

Use Edit Points  and Properties  or the 
Context menu to change the size, color and 
style of individual decorations in the design.
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Decoration Selection
Use the Decoration Selection dialog box to choose beads and sequins.

Decorations
Select a decoration shape and material. Scroll down for other shapes.

All decorations are available in the following materials: Hi-Sheen, Lo-Sheen, Matt, Pearl, Glass and 
Transparent.

Preview
Preview the selected decoration from above, and in perspective.

Color
Choose a color in the Colors dialog, or select a color and theme from the Quick Colors.

Click the drop-down color menu to choose a color in the Colors dialog, or pick a Quick 
Color. Click the drop-down menu to the right of the Quick Colors to see other Quick Color 
themes, or to create a new theme.

See “Colors Dialog Box” on page 63 and “Quick Color Themes” on page 60.

Size
Select the decoration size from the drop-down menu.

The available sizes are different for each type of decoration. See “Decorations” on page 224.

Rotation
Use the up and down arrows or enter an Angle from 0 to 359 degrees in the Angle box. 
The preview shows the selected angle.

Line of Decorations
Set the Spacing between the decorations in the line or shape, and select whether the 
decorations will follow the line drawn, or if they will use the angle set in Rotation 
(Stepped).

Choose a decoration shape and material

Preview the decoration

Choose a color

Select the decoration size

Set the decoration angle

Set spacing & angle for
lines of decorations
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Decorations
The following types of decorations are available, in a variety of colors, materials and sizes:

The Preview shows the decorations in two orientations so you can visualize their placement accurately.

Sizes for Crystal Round and Nailhead Round Decorations
1.0, 1.5 (SS 3-4, PP 7-10), 2.0 (SS 5-6, PP 11-15), 2.5 (SS 7-9, PP 16-20), 3.0 (SS 10-12, PP 21-24), 3.5 (SS 
13-14, PP 25-28), 4.0 (SS 15-17, PP 29-32), 4.5, 5.0 (SS 18-22), 6.0 (SS 23-28), 7.0 (SS 29-33), 8.0 (SS 34-
38), 9.0 (SS 39-42), 10.0 (SS 43-45), 12.0 (SS 46-50)
When purchasing round crystals, nailheads or rhinestones, manufacturers’ sizes may use the term SS 
(stone size) or PP (pearl plate).

Shape Size (in mm) Shape Size (in mm)

Round 4, 5, 6, 7, 8, 9, 10 Crystal 
Rectangular

3, 4, 5, 6, 7, 8, 9, 10

Oval 4, 5, 6, 7, 8, 9, 10 Crystal Round 1.0, 1.5, 2.0, 2.5, 3.0, 3.5, 
4.0, 4.5, 5.0, 6.0, 7.0, 8.0, 
9.0, 10.0, 12.0

Seed 1.0, 1.5, 2.0, 2.5, 3.0 Crystal Square 3, 4, 5, 6, 7, 8, 9, 10

Bugle 4, 5, 6, 7, 8, 9, 10 Crystal 
Triangle

3, 4, 5, 6, 7, 8, 9, 10

Bugle Twisted 4, 5, 6, 7, 8, 9, 10 Nailhead 
Diamond

3, 4, 5, 6, 7, 8, 9, 10

Sequin Cup 2, 3, 4, 5, 6, 7, 8, 9, 
10

Nailhead Heart 3, 4, 5, 6, 7, 8, 9, 10

Sequin Flat 2, 3, 4, 5, 6, 7, 8, 9, 
10, 15, 20

Nailhead Petal 3, 4, 5, 6, 7, 8, 9, 10

Sequin Flower 2, 3, 4, 5, 6, 7, 8, 9, 
10, 15, 20

Nailhead 
Rectangular

3, 4, 5, 6, 7, 8, 9, 10

Sequin Heart 2, 3, 4, 5, 6, 7, 8, 9, 
10, 15, 20

Nailhead 
Round

1.0, 1.5, 2.0, 2.5, 3.0, 3.5, 
4.0, 4.5, 5.0, 6.0, 7.0, 8.0, 
9.0, 10.0, 12.0

Sequin 
Snowflake

2, 3, 4, 5, 6, 7, 8, 9, 
10, 15, 20

Nailhead Star 3, 4, 5, 6, 7, 8, 9, 10

Sequin 5-Point 
Star

2, 3, 4, 5, 6, 7, 8, 9, 
10, 15, 20

Nailhead 
Teardrop

3, 4, 5, 6, 7, 8, 9, 10

Sequin 6-Point 
Star

2, 3, 4, 5, 6, 7, 8, 9, 
10, 15, 20

Nailhead 
Triangle

3, 4, 5, 6, 7, 8, 9, 10

Crystal Oval 3, 4, 5, 6, 7, 8, 9, 10
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Editing Embellishments
Use Edit Points  to select ribbon, yarn, strings of beads, single decorations positioned 
with Place Individual , or lines placed with Draw Line  or Place Shape . You can 
adjust, insert or delete points along lines of all types of embellishments, and delete lines of 
embellishments. You can also adjust, insert or delete individual decorations, and break up 
lines of decorations.

Use the Context menu to change embellishments when in other mySewnet™ Embroidery tabs.
For a quick and easy way to change decorations, right-click a decoration subdesign and select all 
decorations of a specific type from the Context menu. The Decoration Selection dialog box opens.

Edit Points
Use Edit Points  to select ribbon, yarn, strings of beads, individual decorations, or lines 
of decorations for editing or deleting.

Click Edit Points , then click the desired embellishment. The decoration or line of 
embellishments will be selected. Adjust or remove the selected item as desired. To change 
the properties for embellishments, click Properties  after selecting. See “Ribbon 
Selection” on page 213, “Yarn Selection” on page 216, “String of Beads Selection” on 
page 219 and “Decoration Selection” on page 223.

Editing Decorations
When a line or shape is enlarged, the number of decorations increases. It decreases as the line or shape is 
made smaller.
Use Ctrl and click to select a number of individual decorations, for instance to change the 
color for some beads in a Gallery design.

Use the arrow keys on the keyboard to nudge a decoration.

Shortcuts

■ Edit Embellishment, Embellish Tab: 
■ Keys: Alt, D, E

Resizing and Reshaping Single Decorations and Lines
1 In the Category section of the Embellish tab, select Decoration .
2 Click Insert from Gallery  and in the File Viewer select ’Bear Lg 1’ in the Faces folder. Click Open to 

load it in the work area, then close the File Viewer.
3 Click Edit Points , then click one of the beads in the bear’s ears. This 

selects a single bead, as the bead has been placed individually.
Edit Points enables you to change individual beads and lines in any 
Decoration subdesign.

4 Click one of the beads in the outline of the bear’s face. This bead is part of 
a line of beads.

5 Right-click, and select "Finish selection decoration" in the Context menu.
6 Click and drag one of the green corner handles for the Decoration design 

to make it larger.
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The beads placed individually become more widely spaced. If desired, place individual additional 
decorations, or adjust the size. The line forming the outline of the bear’s face shows an increased 
number of beads as the circle enlarges.
When a line or shape is enlarged, the number of decorations increases. It decreases as the line or shape is 
made smaller.

Insert Points
Use Insert Points  to add new points to the currently selected line of embellishments. 

Select the desired line of embellishments, then click Insert Points . The pointer changes 
to the plus pointer . Click to add a point to the line. Right-click to finish adding points.

Hold down Shift to place a straight line or corner point. Click Undo  to remove the new point.

Shortcuts
■ Edit Embellishment, Embellish Tab: 
■ Keys: Alt, D, R

Delete Points
Use Delete Points  to delete points from the currently selected line of embellishments. 

Select the desired line of embellishments, then click Delete Points . The pointer 
changes to the minus pointer . Click to remove a point from the line. Right-click to 
finish deleting points.

Click Undo  to replace a deleted point.

Shortcuts
■ Edit Embellishment, Embellish Tab: 
■ Keys: Alt, D, E

Delete Selection
Use Delete Selection  to delete the currently selected ribbon, yarn, string of beads, 
individual decoration, or line of decorations. 

Select the desired embellishment, then click Delete Selection . The selected item is 
removed from the work area.

Shortcuts
■ Edit Embellishment, Embellish Tab: 
■ Keys: Alt, D, Y

Break Up Line
Use Break Up Line  to break up the currently selected line of decorations into individual 
decorations for independent editing.

Select the desired line of decorations, then click Break Up Line . The selected line of 
decorations now consists of individual decorations which can be changed separately.
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Use Break Up Line to create a line or shape with alternating colors. Once the line or shape has been broken 
into individual decorations, use Ctrl and click to select alternate decorations, then right-click the selected 
decorations and select Properties in the Context menu to change their color.

Shortcuts
■ Edit Embellishment, Embellish Tab: 
■ Keys: Alt, D, K

Exporting Decorations
Use File, Export Decoration Template  to save a template for all your decorations in a 
format for your cutter. This can be used to create a Crystal Transfer Template (Rhinestone 
Template) for pressing hotfix crystals and nailheads directly onto your work.

See “Export Decoration Template” on page 27.

Center or Line Placement
Center or Line placement stitches are created automatically for decorations according to 
the options set in mySewnet™ Configure, which may be altered when you export the 
embroidery. Alternatively, create a crystal transfer template (rhinestone template) for 
automated cutters for pressing hotfix crystals and nailheads directly on your work with 
File, Export Decoration Template. See “Export Decoration Template” on page 27.

Center placement stitches are recommended when most decorations are individual and 
symmetrical. Line placement stitches are recommended when most decorations are 
individual and asymmetrical (such as bugle beads) or lines of closely spaced beads or 
sequins.

Decorations are placed on top of the background, appliqué and embroidery. 

Using and Adjusting Decorations
Sequin Snow

1 In the Quick Access toolbar, click Change Hoop . In the Hoop Selection 
dialog box select 170mm x 100mm - Universal Midsize Hoop 1.

2 Set Orientation to Natural and click OK.
3 In the Quick Access toolbar at the top of the screen, click Insert .
4 Browse to \mySewnet\Samples\Embroidery\Stitch.
5 Scroll down until you see "Snowman".
6 Click Open to load the embroidery into the work area.
7 Click the Embellish tab.
8 In the Category section of the Embellish tab, select Decoration .
9 Click Place Individual . The Decoration Selection dialog box appears.
10 At the top, select the Pearl Round decoration.

Place the pointer over the decorations to see the names. The other Round bead materials are Hi-Sheen, Lo-
Sheen, Matt, Glass and Transparent.
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11 In the drop-down menu to the 
right of the Quick Colors, ensure 
that the theme Standard is 
selected.

12 Click the turquoise in row 1, 
column 8 to select it.

13 In the Size drop-down menu, 
select 6.0mm.
In Rotation, ensure that Angle is set 
to zero. The settings for Line are not 
relevant as you will be placing beads 
individually.

14 Click OK to select the turquoise 
round bead, and the Decoration 
Selection dialog box will close.

The pointer changes to the Insert pointer  to show that you may place decorations.
15 Click in the center of the lower button on the snowman’s coat. A large bead is placed for the button.
16 Click to place a bead on the top button.

If you place a bead in the wrong position, use Undo to remove the last decoration in the current sequence.
17 When you have placed the two beads, click Place 

Individual . The Decoration Selection dialog box will appear 
again.

18 Scroll down to the Nailhead Teardrop decorations and select Hi-
Sheen Nailhead Teardrop.

19 In the Quick Colors, click the deep green in row 2, column 6.
20 In the Size drop-down menu, select 4.0mm.
21 Click OK to close the Decoration Selection dialog box.
22 Click to place several green teardrops on the tree, like melting 

snow.
23 Click Place Individual  to open the Decoration Selection 

dialog box again.
24 Scroll up to the Sequin Snowflake decorations, and select Hi-

Sheen Sequin Snowflake.
25 In the Quick Colors, click white in row 4, column 1.
26 In the Size drop-down menu, select 6.0mm, and click OK to 

close the Decoration Selection dialog box.
27 Click to place snowflakes around and above the snowman.
28 Right-click when you have placed the snowflakes and select 

"Finish placing individual" from the Context menu.
29 Click outside the embroidery and decorations. There is no selection box.
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30 Click on the snowman. The snowman embroidery 
is surrounded by a box with white handles. This is 
the selection box for the embroidery.

31 Click on one of the snowflakes well above the 
snowman.

32 The decorations are surrounded by their own 
selection box with green handles. This shows the 
current decoration subdesign.
If you deselected Place Individual and started again, 
you may have two or more decoration subdesigns.

33 Right-click the decoration subdesign. A Context 
menu appears.

34 Select Hi-Sheen Nailhead Teardrop in the Context 
menu.
The Decoration Selection dialog box appears, with 
this decoration type selected.

35 Click the Hi-Sheen Nailhead Star above the 
teardrop, then click OK to close the dialog.
All of the teardrops have been replaced by stars.
You could also change the decorations using Edit Points and Properties, 
but you would have to use Ctrl to Multiple Select the individual teardrops. 
The Context menu is a quick way to change all of a specific type of 
decoration in the subdesign.

36 Click Undo . The teardrops return.
37 In the Quick Access toolbar click Save As .
38 In the Save As dialog box, save the snowman as Decorated Snowman.

The snowman embroidery and the decoration subdesign are saved as 
the .vp4 file Decorated Snowman.
When you next open the file the decorations will be present.

39 Click Life View  to see the embroidery and decorations without a 
grid or hoop.

Decorated Bells
1 In the Quick Access toolbar at the top of the screen, click Change 

Hoop . In the Hoop Selection dialog box select 100mm x 100mm - 
Universal Square Hoop 1 and click OK.

2 In the Quick Access toolbar, click Insert .
3 Browse to \mySewnet\Samples\Embroidery\Stitch and select the 

embroidery ’Bells’.
4 Click Open to load the embroidery into the work area.
5 Click the Embellish tab.
6 In the Category section of the Embellish tab, select Decoration .
7 Click Place Individual . The Decoration Selection dialog box will 

appear.
8 In the third row, select the Pearl Seed decoration.
9 In the drop-down menu to the right of the Quick Colors, ensure that the theme Standard is selected.
10 Click the orange in row 4, column 7 to select it.
11 In the Size drop-down menu, select 3.0mm, and ensure that the Angle is 

set to 0.
12 Click OK to select the pearl seed bead, and the Decoration Selection 

dialog box will close. 
The pointer changes to the Insert pointer  to show that you may place 
decorations.

13 Click on top of the clapper in the bell on the left. A seed bead is placed 
over the gold clapper.

14 Click on the clapper for the bell on the right to place a bead there as well.
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15 Right-click when you have placed the beads and select "Finish placing individual" from the Context 
menu.
The two individually placed beads form a subdesign in the work area.

16 Click outside the subdesign.
17 In the Draw Line  drop-down menu, choose Freehand Line . The Decoration Selection dialog 

box will appear.
18 Scroll down and select the Glass Nailhead Rectangular decoration.
19 Click the green in row 2, column 7 to select it.
20 In the Size drop-down menu, select 3.0mm.
21 In the Spacing in Line of Decorations, select 3.0mm, and ensure that Follow Line is selected.
22 Click OK to close the Decoration Selection dialog box. The pointer is the pen pointer .
23 Draw a line along the green ribbon of the bell on the left.
24 Right-click when you have placed the beads and select "Finish placing 

line" from the Context menu.
25 In the Draw Line  drop-down menu, choose Point Line . The 

Decoration Selection dialog box will appear.
26 You will use the same beads for the second ribbon as for the first, so click 

OK to close the dialog box. The pointer is the Point pointer .
27 Click three points in a line along the green ribbon of the bell on the right, 

then right-click to finish the line.
Another line of green rectangular beads appears.

28 Right-click again and select "Finish placing line" from the Context menu.

If desired, use Edit Points  to select the bead ribbon lines for adjustment. See “Edit Points” on page 225.
29 Click outside the embroidery and decorations.

This will start a new decoration subdesign.
30 Click the drop-down arrow to the right of the Shapes gallery and select shape 1, a circle, in the list. 
31 Click Place Shape . The Decoration Selection dialog box will appear.
32 In the third row, select the Hi-Sheen Seed decoration.
33 In the Quick Colors, click the orange in row 4, column 7 to select it.
34 In the Size drop-down menu, select 2.0mm.
35 In the Spacing in Line of Decorations, select 2.0mm, and ensure that 

Follow Line is selected.
36 Click OK to close the Decoration Selection dialog box. A circle of 

beads is placed in the center of the work area.
The circle is inside a selection box with green handles.

37 Hold down Ctrl and Shift, then click and drag on one of the corner 
handles to enlarge the circle proportionally and from the center so 
that it will fit around the design.

38 Move the pointer over the circle. The pointer changes to the move pointer . 
39 Click and drag the circle so that it fits neatly around the 

embroidery.
40 Press the Tab key slowly several times. The selection boxes 

for the embroidery and the other decoration subdesigns are 
shown in turn.

41 With the bead circle highlighted, right-click. The Hi-Sheen 
Seed beads are listed in the Context menu.
The Context menu only shows the decorations within the 
selected subdesign.
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42 In the Quick Access toolbar click Save As .
43 In the Save As dialog box, save the bells as Decorated Bells.

The bells embroidery and the decoration subdesigns are saved 
as the .vp4 file Decorated Bells.
When you next open the file the decorations will be present.

44 Click Life View  to see the embroidery and decorations 
without a grid or hoop.
You could display the design on a fabric with the Background 
Wizard. See “Background Wizard” on page 163.

Edit a Bead Crescent
This exercise uses items from the full set of Backgrounds. See “Backgrounds” on page 11.

1 In the Quick Access toolbar at the top of the screen, click Change Hoop . In the Hoop Selection 
dialog box select 260mm x 200mm - Universal Large Hoop 3, set Orientation to Rotated, and click OK.

2 In the View tab, start the Background Wizard . 
3 In Garments select Bags & Hats, Mini Reporter Bags, Red_Dk 

as your background.
4 Click the Embellish tab.
5 In the Category section of the Embellish tab, select 

Decoration .
6 Click the drop-down arrow to the right of the shapes gallery 

and select the crescent moon (31) shape from the list. 
7 Click Place Shape . The Decoration Selection dialog box 

will appear.
8 Scroll down and select the Hi-Sheen Seed bead, using the 

orange in row 4, column 7 of the Quick Colors, 3mm in size, with a spacing of 3.5mm.
9 In Line of Decorations, select (check) Follow Line. 
10 Click OK to close the Decoration Selection dialog box. The 

crescent is shown as a line of beads in a selection box with 
green handles.

11 Hold down Ctrl, then click and drag on one of the corner 
handles to enlarge the crescent to suit the size of the front of 
the bag.
Hold down Shift to retain the original proportions.

12 Move the pointer over the crescent. The pointer changes to 
the move pointer . 

13 Click and drag the crescent to the desired position.
The beads at the point at the top overlap. The design can be 
adjusted to prevent this.

14 Click Edit Points , then click the crescent. The shape is 
shown as a curved line with points showing the curve, and with each 
decoration in its own box.

15 Click the round point at the top of the crescent.
16 Drag to move this point slightly. The shape becomes a line with two 

ends.
All of the decoration shapes are closed lines (a line where the two ends 
are closed to form a shape).

17 Click Delete Points .
18 Move the pointer towards the point that you dragged.

As the pointer approaches the point it becomes the minus pointer .
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19 Click the point. That point, and the beads between it and the next point are 
removed.
Use Delete Points to remove some of the points defining a line of decorations. 
You can use Insert Points to add points to a line.

20 Right-click and in the Context menu select "Finish deleting points".
21 Click outside the shape to view the beads. There is a gap where the two 

ends of the line meet.
This gap could be minimized if you could change the position of the beads 
individually.

22 Click the line of beads so that it is selected.
23 Click Undo  until you can see the original shape again.
24 Click Break Up Line . Every bead is now 

an individual decoration, forming part of a 
subdesign.
While the whole subdesign is still selected it 
can be moved as one unit.

25 Click outside the selection box, then click 
the overlapping bead.
The beads can now be moved or deleted 
independently.

26 Click Delete Selection . The bead is 
removed from the work area.

27 Delete and move beads until you have a 
smooth line.

Bear on Beanie Hat
This exercise uses items from the full set of Backgrounds. See “Backgrounds” on page 11.

1 In the Quick Access toolbar at the top of the screen, click Change Hoop . In the Hoop Selection 
dialog box select 260mm x 200mm - Universal Large Hoop 3, set Orientation to Rotated, and click OK.

2 In the View tab, start the Background Wizard . 
3 In Garments select Bags & Hats\Beanie 

Hat\Medium\Beanie Hat 1 Med Gold as your 
background.

4 If needed, use the Zoom bar to zoom out, and 
use Move and Rotate Background  to drag the 
brim of the hat to the center of the screen.

5 Click the Embellish tab.
6 In the Category section of the Embellish tab, 

select Decoration .
7 Click Insert from Gallery , and in 

DecorationDesigns\Faces select Bear Lg 1.
8 Click Open to place the bear design in the work 

area, then close the File Viewer.
9 Click the View tab.
10 Click Realistic 3D . The bear design can be 

seen on the brim of the hat.
The brown crystals and sequins go well with this 
gold colored hat, but what if the hat was blue?

11 Start the Background Wizard , and in 
Garments select Bags & Hats\Beanie 
Hat\Medium\Beanie Hat 1 Med Blue_Lt.

12 Use Move and Rotate Background  to drag 
the brim of the hat to the center of the screen.

13 Use the Zoom Bar to zoom in on the 
Decoration design.
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14 Click to select, then right-click the design. Near the top of the Context menu several decoration types 
are listed.

15 A medium brown round crystal is used for the outline of the bear’s head. Select Matt Crystal Round 
3.0 mm at the top of the Context menu. The Decoration Selection dialog box opens.

16 In the Quick Colors, click the medium blue in row 1 column 3, then click Apply. The outline of the 
bear’s head is now blue. Click OK.

17 Right-click the design again, and select Matt Crystal Rectangular 4.0 mm. These crystals form the 
bear’s neck.

18 Change these beads to the medium blue in 
the Quick Colors, row 1, column 4, then 
click OK.

19 Right-click again and select the dark brown 
Matt Crystal Round 3.0 mm decorations.

20 Change these to the dark blue in row 1 
column 5, then click OK.
The colors of the other decorations will go 
well with the blue hat.

21 Zoom out to view the hat.
22 You can change individual elements of the 

Decoration design. Click 3D View , then 
click the Decoration tab.

23 Click Edit Points , then click the outline of the bear’s head. This is a line of beads.
24 Click one of the beads in the bear’s ears. These are individual beads.

Decoration Gallery designs are a single subdesign containing lines of decorations and individual 

decorations. Adjust decorations using Edit Points  and Properties  or the Context menu.
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13Split Project Wizard
Use the Split Project Wizard  to split a large embroidery project into sections for 
stitching out.

Split Project Wizard
Select Split Project on the Create tab to split a large embroidery project into sections for 
stitching out.

Select a hoop, then preview the embroidery, before splitting and saving or stitching it.

Ribbon, Yarn and String of Beads lines cannot be split.

Shortcuts
■ Home Tab: 
■ Keys: Alt, H, SP

Using the Split Project Wizard
1 With a large project open, 

click Split Project  on the 
Create tab. The Split 
Embroidery page opens.

2 Click Change Hoop to select 
your desired hoop (here, 
240mmx150mm - Universal 
Large Hoop 2).

3 Select a Hoop Group, a Hoop 
Size, and the Orientation.
To minimize the number of 
hoopings when stitching out, 
select the largest single-part 
hoop for your embroidery 
machine.

4 In many circumstances, the 
initial setting for the other 
options on this page will work best, so make an initial split using these settings. If important features 
in the embroidery are split, click Back and adjust your settings.

5 Adjust your settings on the Split Embroidery page, testing the results, until you are satisfied with the 
split lines. Use the preview when adjusting the hoop and Overlap.
Increase or decrease Overlap to fit your embroideries within the hoop.
For Connection, use Running Stitch, not Trim if you have to split large stitch areas.
Use Corner alignment stitches if lightly embroidered areas are split, and Baste if heavily embroidered areas 
are split. Some machines have special positioning features which do not require alignment stitches.
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6 Click Next. The Save 
Embroidery page appears.

7 Use the View Previous  and 
Next  buttons to preview 
the splitting of the 
embroidery and, if necessary, 
go back to the Split 
Embroidery page to adjust 
your settings.

8 Click Export All Sections  
to save the split embroidery. 
Browse to your My Designs 
folder, and name the project. 
The split sections will be 
numbered automatically.

9 Click Next. The Print Options 
page appears.

10 Print a plan and worksheets 
for your project:
• Overview prints a plan of the 
split sections, with section 
names.
• Complete 2D Template 
prints a full size 2D template 
of the split embroidery 
sections, with an outline 
around each section to 
indicate how to join them 
together.
• Worksheets prints a 
worksheet for each section. 
The worksheet gives the 
dimensions of the design, the 
total number of stitches, a full 
list of the threads used, and the number of stitches for each thread.
The Overview and Complete 2D Template may only be printed from the Split Project Wizard.

11 Click Finish to close the wizard. 
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Split Embroidery

The Split Embroidery page is displayed when the Split Project Wizard opens. Use the Split 
Embroidery page to select the desired hoop size, the splitting method, the overlap 
between hoop areas, what type of alignment stitch to use, the level of compensation, and 
the type of connection for your project.

Experiment with the embroidery splitting options. This will give you the best possible split.
To define split lines with complete control, use Split Design in mySewnet™ Stitch Editor.
Multipart hoops are not available for the Split Project Wizard. Use the largest single-part hoop for your 
embroidery machine.

Hoop Size
The currently selected hoop, and its size and orientation, are shown here. Set the hoop 
size according to the size of your project or the hoop you wish to use for stitching out, or 
enter any other desired size.

Generally, you should choose the largest single-part hoop size for your machine. This will 
reduce the number of split sections. This then reduces the number of split lines to be 
adjusted, the number of times you will need to hoop your fabric, and the number of color 
changes. The minimum recommended hoop size is 100mm x 100mm.

Select a hoop for stitching out

Set the overlap 

How to split stitch areas
Set the type of alignment 

Reduce pull on the fabric 

Travel method between 
(straight line split only)

stitch areas

stitch

between sections
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Change Hoop
Click Change Hoop to choose the size of the hoop you wish to use for splitting the 
embroidery project. Select any available hoop in the Hoop Selection dialog box.

Hoop Group
The drop-down list of Hoop Groups shows all the machine Hoop Groups, and the My 
Hoops group, if used.

Hoop Size
The drop-down Hoop Size list shows the hoops in the chosen Hoop Group. Select the 
desired hoop size and a picture of the hoop will be shown in the Preview.

Included in My Hoops
Select (check) Included in My Hoops to add the selected hoop to the My Hoops list. Use 
the My Hoops list to create a list of your favorite hoops.

The selected hoops will be displayed in the My Hoops group in the order that they were selected.

Orientation
Select Natural or Rotated orientation according to the shape of the embroidery that is to 
fit in the hoop. Natural orientation is similar to the way the hoop would appear when you 
sit in front of your machine; note the position of the bracket.

It is recomended to use natural hoop orientation for designs with Twin Needle colors.

Enter Size
To enter a hoop size that is not listed in any of the Hoop Groups, click the Enter Hoop Size 
box so that it is selected (checked). The Width and Height boxes will become available. 
You can enter any size from 10mm to 4000mm. The preview shows the shape of the hoop 
you enter.

If you position the arrow pointer over the box without clicking, the alternative units and range will be 
shown.
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Split Method
To split automatically, use Intelligent or Straight Line Split.

Intelligent Split
Where possible, use Intelligent Split. This automatically calculates a split line that is routed 
through gaps or across jumps, cuts across the minimum number of stitches, and 
minimizes cuts through solid sections of embroidery. For example, a large embroidery will 
be split at a narrow section, and an embroidery that fits in one stitch area of the hoop will 
be left in one piece.

Straight Line Split
Straight Line Split cuts the embroidery straight across the center line of the overlap zone. 
Straight Line Split will only split an individual embroidery if it does not fit entirely into one 
stitch area of the hoop.

Lettering will be split straight down the middle. This may cut through characters rather 
than gaps and spaces. In such cases, it is recommended to use Intelligent Split instead.

Overlap
Set the desired overlap between each hoop area. The minimum overlap is 9mm. The 
maximum overlap is half the shortest side of the chosen hoop. This means that hoops may 
not overlap more than 50%. This is so that adjacent horizontal split lines or adjacent 
vertical split lines may not cross each other.

It is recommended to make the overlap as large as is practical so that you have maximum 
flexibility for adjusting the split lines. However, increasing the overlap may add 
unnecessary extra hoop sections, so a balanced choice is needed.

Alignment Stitch Style
Select the type of alignment stitch that you wish to use to help with lining up the split 
sections of the embroidery.

None
When None is selected, no alignment stitches are added to the split sections.

Select None if you wish to use a hoop template to align the split sections, or you have 
fabric that you do not wish to mark with the alignment stitches. This is also appropriate 
when you can split an embroidery project without cutting through any design elements.

Some machines have special positioning features which do not require alignment stitches.

Corner
When Corner is selected, trims are added at the beginning and small L-shaped corners of 
three long loose stitches are added at the end of each split section. The alignment stitches 
go to the corners, halfway across the overlap between the hoop areas.

Use the trims at the beginning to align to previously stitched sections. The alignment 
points for subsequent sections are the corners of each L.
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Corner is useful for lightly stitched embroideries, and where there are only a few splits 
within design elements.

Baste
When Baste is selected, trims are added at the beginning and a box of long single stitches 
is added at the end of each split section. The alignment stitches go to the corners, half way 
across the overlap between the hoop areas.

Use the trims at the beginning to align to previously stitched sections. The alignment 
points for subsequent sections are the corners of the box of basting stitches.

Baste is useful for a heavily stitched embroidery that may be difficult to line up owing to 
pull on the fabric.

Compensation
Use Compensation in conjunction with Straight Line Split. Compensation adds 
overlapping stitches along the edges where the embroidery is split. This compensates for 
pull on the fabric.

Compensation is initially set to None.

None
Use None if you can split an embroidery without cutting through any of the design 
elements.

Low
Use Low when cutting through a lightly stitched embroidery or when the split lines go 
through only a few stitch areas.

High
Use High when the embroidery is dense, when the split lines make long splits through 
stitch areas, or when stitching onto materials such as knitted or stretchy fabric.

Connection
Choose how to connect separate areas of the same color along the edges of the split 
sections. The initial setting is Trim.

Trim
Use movement stitches to travel along the edges of the split sections. This option is the 
most suitable choice when an embroidery project can be split without cutting through 
large stitch areas.

Running Stitch
Use Running Stitch when the split lines cross large stitch areas.

Next
Go to the Save Embroidery page.

The Design Separator animation plays while the embroidery is split.
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Save Embroidery

Use the Save Embroidery page to preview the split sections, and to export the split 
embroidery sections automatically. 

The Design Separator and ColorSort animations play while the design is split.

Zoom
Use the Zoom functions to change the view of the embroidery.

Use Zoom In  to magnify the view. Move the pointer over the embroidery and the 
pointer changes to the zoom in pointer . Then either click a point you want to zoom in 
towards, or click and drag a rectangle around the area you want to zoom in to and release 
the mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the embroidery and the 
pointer changes to the zoom out pointer . Then click a point you want to zoom out 
from.

Click Zoom To Fit  to fit the embroidery to the preview area.

Click Real Size  to view the embroidery at a magnification as close as possible to the 
Real Size setting you chose in mySewnet™ Configure.

Information
The information on the left shows the zoom level compared to Real Size, the stitch 
count , dimensions (height  and width ) and number of color changes  in the 
current section.

View
The number of the section, and the total number of sections, is shown to the left of the 
preview.

Click the navigation icons to browse through the split sections.

Use Previous  and Next  to step through the split sections one at a time.

Use First  to jump to the first split section.

Information for this 

Zoom in and out

Browse the split sections

Export the embroidery 

split section

sections
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Use Last  to jump to the last split section.

Export All Sections
Click the Export All Sections  button to export all the split embroidery project sections, 
as shown in the Save Embroidery preview pane, as a .vp4 file or in an alternative 
embroidery format. 

The Split Project Wizard displays the Export dialog so you can select the embroidery 
format, then the Save or Save As dialog box so you can name your design. For more 
information on using Export, see “Export” on page 20.

Export in any of the following embroidery file formats: Brother/Baby Lock/Bernina PEC 
(.pec), Brother/Baby Lock/Bernina PES (.pes version 2 - 11), Compucon/Singer PSW (.xxx), 
Husqvarna Viking / Pfaff (.vp4, .vp3 and .vip), Husqvarna (.hus, .shv), Janome (.jef and .sew), 
Melco (.exp), Pfaff (.pcs), Tajima (.dst) and Toyota (.10*).

Note: The preferred file format for saving embroideries is .vp4, as this will preserve thread color information 
and notes.

File Name
When you save a split embroidery, you provide a single name which is used for all parts of 
the split embroidery. The split parts are distinguished by a two digit suffix that is 
automatically added to the file name.

Suffixes for Multi-Hoop Splits
For a multi-hoop split, the split parts are suffixed with two digit numbers. The numbers 
start at 01 for the top left hoop, then increase across and down, for example Three Flowers 
Exported_01 to Three Flowers Exported_03. The numbers are used only to distinguish the 
individual sections. You can stitch out the sections in any order, as required.

Back
Return to the Split Embroidery page.

Next
Go to the Print Options page.
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Print Options

Use the Print Options page to print information on stitching and aligning your project.

Back
Return to the Save Embroidery page.

Finish
Accept the final embroidery project layout and close the Split Project Wizard.

Worksheets
Print a worksheet for each embroidery section.

The worksheets illustrate the embroidery section, and list the threads to be used, and the 
quantity of each thread.

Page Setup

Select the information to be printed with the embroidery, such as the Dimensions, Color 
Information and Technical Information. In addition, the scale may be altered and a grid 
turned on or off. Set the Units of Measurement for the Dimensions and Technical 
Information to millimeters or inches, as desired.

Print a plan of the split 

Print a worksheet for each

Information used in worksheet

Full-size template for each 
section

section

sections
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Print Setup
Use Print Setup to select the destination printer and its connection. See “Print Setup” on 
page 508.

Print
The Print dialog box appears, where you may specify number of copies, the destination 
printer, and other printer setup options. See “Print Setup” on page 508.

Overview
Print a plan of the splitting of the embroidery, with the name of each section, and the 
number of stitches in each.

Print
The Print dialog box appears, where you may specify number of copies, the destination 
printer, and other printer setup options. See “Print Setup” on page 508.

Complete 2D Template
Print a full size 2D template of the split embroidery sections, with an outline around each 
section to indicate how to join them together.

See “Using the 2D Template” on page 244.

Print
The Print dialog box appears, where you may specify number of copies, the destination 
printer, and other printer setup options. See “Print Setup” on page 508.
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Stitch Out and Align Split Project Sections
Deciding the Stitchout Order
Generally, the split sections should be stitched out from the center. However, if the 
embroidery project only uses a few hoop areas, stitch out the section with the heaviest 
stitching first, as this will be the section which pulls the fabric the most.

As with all projects, it is best to try some test stitchouts before stitching the final version. It 
is particularly important to make test stitchouts of some adjacent sections if you think 
they may be difficult to align. For example, it may be difficult to align sections if the split 
line across a fully stitched area is very irregular, or when one of the sections has very heavy 
stitching.

General Alignment Considerations
Some designs will require less precise alignment than others. If you have split an 
embroidery so that the split lines go between all the stitch areas, (for example, if no 
connectors were used), it is unlikely that you will need to have perfect alignment between 
sections. The main consideration would be to ensure the fabric is straight each time it is 
re-hooped.

However, when any stitch areas are split, alignment is crucial to achieving a good 
stitchout. Using alignment stitches and compensation of Low or High will help to align 
sections and eliminate gaps between them.

The alignment stitches are created in a medium gray color.
There are also various alignment aids including:

■ The printed full size 2D template
■ Worksheets for each section, optionally printed on transparency paper
■ The hoop template supplied with the hoop for your machine
■ Light sensitive pens that can be used to mark fabric, and other temporary fabric marks
■ Fabric stiffening aids and stabilizers that combat pull and make alignment easier
■ The needle and embroidery positioning controls on your embroidery machine

Using the 2D Template
This is the most useful alignment aid. The 2D template shows the whole embroidery at the 
size it will be stitched out. Each hoop area is marked by corners and a large + in the center.

The hoop area corners show the extreme points of the stitchable area within the hoop. If 
you have a hoop template supplied with your hoop, this corresponds to the stitchable 
area shown on the hoop template, usually marked as a grid.

The template starts in the top left corner and works across and down to the bottom right 
corner. When cutting out and joining the pages together, you may find it easier to leave 
the first page uncut, then cut the dashed edge of the next page before aligning it to the 
first page and taping it in place. Continue like this until all the pages are joined together.
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You can also use the template as a guide to the size of your piece of fabric. The template shows the overall 
stitchable area that will be hooped, but you will need to allow extra fabric around the edges for physically 
hooping up the fabric.
Use the template to mark hoop centers on the fabric. Use a pin to punch a hole through 
the template at each hoop center. Pin the template to the fabric and mark the fabric 
through each hole. If the point that is marked will be stitched over and hidden, use a 
pencil or a pen to mark the center point. If the point will be on open fabric, use a light-
reactive fading pen.

Using Other Alignment Aids

Fabric Choice, Stiffeners and Stabilizers
In general, stiffer fabrics will resist pull and distortion better.

Fabric stiffening aids and stabilizers will combat pull and make alignment easier. In 
particular, iron-on backing helps to resist fabric distortion. You may wish to apply this to 
the fabric before marking the hoop centers or making any other alignment marks.

Hoop Templates and Printed Worksheets
When hooping up each section, align the center marked on the fabric against the hoop 
template to guide the position of the fabric in the hoop. If you do not have a hoop 
template, use the printed worksheet at 100% scale for the section. You could also print the 
worksheet on transparency paper.

Center Lines
You may also wish to mark lines between the hoop center points so you can line up the 
fabric to the center marks on the frame of the hoop. This is especially helpful if you do not 
have a hoop template. Use a light-reactive fading pen to mark temporary lines just before 
you hoop the fabric. An alternative is to iron creases into the fabric as lines between the 
center points.

Stitching Out the First Section
First, ensure the fabric is straight in the hoop, according to the marked positions of the 
hoop centers. After selecting the embroidery on the machine, use the machine controls to 
position the needle over the center point marked on the fabric.

If you are unable to do this on the machine, this means that you have not hooped up your fabric with 
sufficient accuracy. You will need to move the fabric in the hoop and try again.
If you did not generate alignment stitches, simply start stitching out.

If you have alignment stitches in your split embroidery sections, each section starts with a 
sequence of movement stitches. These movement stitches jump to the corner of a 
rectangle within the stitchable area of the hoop, that is half way across the overlap 
between the hoop areas. For the first section, skip past these movement stitches and then 
start stitching out.
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Aligning a Section to Previous Sections
First, ensure the fabric is straight in the hoop, according to the marked positions of the 
hoop centers. After selecting the embroidery on the machine, use the machine controls to 
position the needle over the center point marked on the fabric.

Aligning With No Alignment Stitches
Use the 2D template or full size worksheet to confirm that the embroidery will connect 
correctly to previous sections. This is easier to do if you have printed the template or 
worksheet on transparency paper. If you created test stitchouts, this will help you judge 
the positioning according to the effect of the fabric properties.

Aligning With Corner or Baste Alignment Stitches
The previous sections will have placed alignment stitches that mark the corner positions, 
either as a small set of corner stitches or lines of basting stitch that meet at the corner. Use 
the machine controls to step through the sequence of movement stitches that should 
match up to the corners.

Adjust the machine so that the needle is over the appropriate corner for each movement 
stitch position. If there are no split stitch areas around the edges of the section that need 
joining to previous sections, your alignment should now be accurate enough to start 
stitching.

As the number of sections that must be stitched out increases, the type of fabric and embroidery become 
even more relevant for obtaining a good stitchout. Accurately hooped fabric and the alignment aids will 
help, but test stitchouts are also important.
If the section must join to stitch areas in previous sections, use the 2D template or full size 
worksheet to confirm that the embroidery will connect correctly. This is easier to do if you 
have printed the template or worksheet on transparency paper. If the alignment is too far 
out, it may be necessary to hoop up your fabric again.

Before starting to stitch, check the alignment stitches of the previous sections, and trim 
any that may be overlapped by the section you are about to stitch out. New alignment 
stitches will be added at the end of this section, to replace any that you trim.
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Split Project Wizard Examples
Use the Split Project Wizard to split very large projects, or use it to split smaller projects 
that are still too large to fit into your largest hoop.

Split a Flower Embroidery
1 Click File, Open .

The hoop size shows the whole project, not the actual hoop size which will be 
selected before stitching out.

2 Browse to the folder \mySewnet\Samples\Embroidery\Stitch and select the 
file Three Flowers.

3 Click the Home tab.
4 Click Split Project . The Split Embroidery page of the Split Project Wizard 

will appear.
5 Click Change Hoop to select the hoop and its orientation. The Hoop 

Selection dialog box will appear.
6 In the Hoop Selection dialog box select Universal from the Hoop Group 

drop-down list.
7 From the Hoop Size drop-down list, select 240 x 150mm - Universal Large 

Hoop 2. 
It is not necessary to choose the hoop orientation, as this will be set automatically to create the least 
number of hoopings. However, the split lines may be more pleasing in one orientation, so it is worth 
checking the results with both orientations.

For a large embroidery that is to be split into several sections, use the largest single-part hoop available for 
your machine.

8 Click OK.
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9 Now select the settings for 
splitting the embroidery.
When splitting your project, 
settings can be adjusted to 
minimize cutting the 
embroidery.
Use the preview when selecting 
the hoop and Overlap.

10 Check that the Intelligent Split 
Method is selected.
Intelligent Split calculates a split 
line that cuts through the 
minimum number of stitches.
When Intelligent Split is in use, 
the Compensation settings are 
unavailable (grayed out).

11 For Alignment Stitch Style, 
select None.
Depending on your machine, you may prefer to choose no Alignment stitches (many machines with this 
hoop type have special positioning features; for example HUSQVARNA VIKING® Designer Diamond Royale 
or PFAFF® creative sensation Pro).
For other machines, use Corner alignment, as these are lightly stitched embroideries, and there are few 
splits within design elements.

12 Check that Connection is set to Trim, as the split lines will not cross large stitch areas.
13 Leave Overlap at the default of 50mm. 
14 Click Next. The Save Embroidery page appears.
15 Use the View Next  and View Previous  buttons to step through the sections and check the split 

lines for the whole design.
16 The split line has cut through 

the middle flower. Click Back 
to change the overlap.

17 Set the Overlap to 57mm, then 
click Next. The split line no 
longer cuts the red petals of 
the flower.
You can adjust the Overlap to 
avoid splitting an area. 
Increasing or decreasing 
overlap may make it easier for 
Intelligent Split to fit all of an 
embroidery into one section, or 
to cut the embroidery in an 
inconspicuous place.

18 Click Export All Sections  to 
save the project as numbered 
sections. The Export dialog box will appear.

19 In File Format, ensure that .vp4 is selected, then click OK. The Save As dialog box will appear.
The preferred file format for saving embroideries is .vp4, as this will preserve thread color information and 
Notes.

20 In the Save In box, browse to the folder \mySewnet\My Designs.
21 Click "New Folder", and name the new folder Three Flowers. Then browse to the new folder.
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22 In the File Name box, enter the name ’Three FlowersExported’, then click Export.

The files will be saved as the files Three Flowers_Exported_01 to Three Flowers_Exported_03. Creating a 
new folder makes it easier to find all the sections.

23 Click Next. The Print Options 
page will appear.
If you have not saved the files a 
warning message will be 
displayed.

24 In the Overview area, click 
Print . 

25 To print, in the Print dialog box 
click OK. An overview of how 
the embroidery has been split 
will be printed.
The Overview shows how the 
embroidery has been split, how 
each split section has been 
named, and the number of 
stitches involved. Use this to 
determine the order which you 
think is best for stitching out the split sections.

26 In the Complete 2D Template area click Print, and then OK. (If necessary, use Properties to change 
printing to single side.) A full-size 2D template of the split embroidery sections is printed, with an 
outline around each section to indicate how to join them together.
Cut out the 2D template and attach the sections as a guide for positioning fabric within the hoop.

27 In the Worksheets area, click Page Setup.
28 In the Page Setup dialog box, set Design Scale to 50%, and click OK.
29 Click Print and then OK to print the worksheets.

The worksheets give the dimensions of the section, the number of stitches, information on the thread 
colors used and the Notes and Settings for the embroidery.

30 Click Finish to close the Split Project Wizard.
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14Using the PhotoStitch Wizard
Use the PhotoStitch Wizard  to create new embroidered PhotoStitch portraits 
automatically from photos. Also browse to a photo on your computer, or acquire pictures 
from a digital camera or scanner.

Create a color, sepia, monochrome or color tile embroidery, or a linear embroidery using a 
single thread. Remove the picture background to enhance the subject.

After creating a PhotoStitch embroidery, use the Frame and Border features to surround 
the whole embroidery.

Color PhotoStitch Embroidery
Create a PhotoStitch embroidery from a color photo, generating a 
randomized pattern of stitches, using multiple threads for a full color 
result.

Color PhotoStitch works best when using pictures with a good color 
range, and a well defined, differently colored or transparent, 
background.

Sepia PhotoStitch Embroidery
Create a sepia embroidery from an old sepia or black and white 
picture, or create a sepia effect embroidery from a color picture, to 
give a heritage look, similar to old photos. PhotoStitch generates a 
randomized pattern of stitches, using sepia colored threads.

Sepia PhotoStitch works best when using pictures with good 
contrast, and a well defined or transparent background.

Monochrome PhotoStitch Embroidery
Create a PhotoStitch embroidery from a black and white photo, 
generating a randomized pattern of stitches, using threads in 
grayscale color ways.

Monochrome PhotoStitch works best when using pictures with 
good contrast, and a well defined or transparent background.

Color Tile PhotoStitch Embroidery
Create a PhotoStitch embroidery from a color photo, generating 
small blocks of stitches in varying shapes with a tiled effect, using 
multiple threads for a full color result. PhotoStitch automatically 
generates tiled blocks of stitching in the selected colors. Select from 
diamond, square or hexagon shaped blocks.

The color tile method is ideal for achieving artistic, impressionistic 
embroideries. Color Tile PhotoStitch Embroidery works best when using pictures with 
good contrast, and a well defined or transparent background.
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Linear PhotoStitch Embroidery
Create a PhotoStitch embroidery from a color or monochrome 
photo, generating a linear pattern of stitches, or a Maze or Spiral 
artistic effect, using one thread for a single color result. There are six 
effects available.

Linear PhotoStitch works best when using a photo with good 
contrast on the face, and without areas of deep shadow. If the 
background is transparent, parallel scan lines will be created.

PhotoStitch Wizard
Select the PhotoStitch Wizard in the Create tab to create an embroidery from a photo. The 
Choose Embroidery Type page of the PhotoStitch Wizard will appear.

PhotoStitch Into Hoop
Use the PhotoStitch Into Hoop  option to create a new embroidery in the PhotoStitch 
Wizard that is a best-fit to the currently selected hoop. 

If desired, click Change Hoop  and choose a different hoop size before using PhotoStitch Into Hoop.

Click PhotoStitch Into Hoop  and the Choose Embroidery Type page of the PhotoStitch 
Wizard will appear. Choose the desired design type, then choose a picture and step 
through the rest of the PhotoStitch Wizard. When you Finish, the new embroidery will be 
placed in the center of the hoop. Depending on its shape, it will fit in the hoop vertically 
and/or horizontally. Use Save  to keep the new embroidery in multipart .vp4 format, 
together with any other embroideries in the work area, and use Export  to save in other 
formats, and optimized for stitching.

Shortcuts

■ Create Tab: 
■ Keys: Alt, C, P, H

PhotoStitch Into Rectangle
Use the PhotoStitch Into Rectangle  option to create a new embroidery in the 
PhotoStitch Wizard that is a best-fit to a rectangular area you draw.

Click PhotoStitch Into Rectangle  and the mouse pointer will change to the draw 
rectangle pointer . Click and drag on the work area to draw a rectangle of the desired 
size. When you release the mouse button, the Choose Embroidery Type page of the 
PhotoStitch Wizard will appear.

If the rectangle is wrong and you wish to try again, click Cancel when the PhotoStitch Wizard appears. 
Then click PhotoStitch Into Rectangle again.
Choose the desired design type, then choose a picture and step through the rest of the 
PhotoStitch Wizard. When you Finish, the new embroidery will be placed where you drew 
the rectangle, and will fit the rectangle proportionally, depending on the picture shape. 
Use Save  to keep the new embroidery in multipart .vp4 format, together with any 



252          mySewnet™ Embroidery   Using the PhotoStitch Wizard 

other embroideries in the work area, and use Export  to save in other formats, and 
optimized for stitching.

Shortcuts
■ Create tab, PhotoStitch Wizard Drop-Down: 
■ Keys: Alt, C, P R

Selecting and Editing Pictures 
In many cases the cropping, background removal, autolevel, red eye, color saturation, and 
detail enhancement features included in the PhotoStitch Wizard will be all that you need 
when editing photos to make embroideries.

It is recommended to keep your original picture in case you wish to adjust it again with 
different options. Also, save the adjusted picture, particularly if you have spent some time 
removing the background.

Additional effects and tools are available in mySewnet™ Draw & Paint.

General Considerations
The PhotoStitch Wizard is most easily used with photos in which the person’s face is well 
defined, and the background color contrasts well with the face and hair.

For PhotoStitch, best results may be obtained where the background is almost completely 
removed. Removing the heavily contrasting background colors may bring out subtle color 
variations in the person’s features.

Try removing the background in mySewnet™ Draw & Paint, or other picture editing software. Save the 
picture before making the PhotoStitch.
Removing the background can not only remove objects that draw attention from the 
subject of the picture, but can also enable Autolevel to enhance the color. 

This photo was first cropped, then Flood Erase and the Erasers used to remove the background. Autolevel 
adjusted the color, brightening the picture.

Cropping Pictures
The Rotate and Crop Picture page of the PhotoStitch Wizard can be used to crop the 
picture to the desired proportions.

To obtain more detail on an individual’s face it is often helpful to crop so that only the head and part of the 
shoulders are shown.

Before tidying: there are unwanted items in 
the background of the picture

After tidying: the building is now the main 
point of focus
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Keeping and Removing Parts of the Picture
Use Flood Erase  to remove an evenly colored background. If the photo has a graduated 
background, such as a cloudy sky, use Flood Erase repeatedly, followed by cleaning with 
the Large Eraser  to remove remaining specks. Very detailed backgrounds with varied 
coloring, such as a street scene, are best removed with the Large , Medium  and 
Small  Erasers. 

If the face or hair are the same color as the background, Flood Erase may remove them as 
well. To prevent this, break the area into two parts with the Small Eraser , then remove 
the part that you don’t want.

The face is the same color as the 
background, so Flood Erase removes part of 

it

Two short lines drawn with the Eraser 
separate the face from the background, so 

it will no longer be removed
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Improving Contrast and Color
Autolevel improves brightness and contrast in most photos, and can be used to bring out 
the color in underexposed pictures.

Autolevel does not make new adjustments each time a picture is loaded. 

Occasionally Autolevel does not improve the appearance of a picture, and may need to be switched off.
Use Red Eye Removal  to reverse the red eye effect caused when flash is reflected back 
by the retina of the eye.

Click the Select Eye button  and draw an ellipse round the affected area.

Increasing saturation enhances the intensity of colors, for instance to make pale skin tones 
appear ’warmer’.

Enhancing Details
The significance of details in a picture is dependent on the overall size of the picture after 
it is cropped. Cropping the picture may bring out the required detail, as may increasing 
the size of the embroidery.

Even so, very small details in a picture may sometimes be ignored. To enhance these 
details, select Enhance Detail in the PhotoStitch Embroidery Options page of the 
PhotoStitch Wizard.

The effect of Enhance Detail varies with each picture, and it is always off by default.

Photos for Color PhotoStitch
A wide range of picture types are suitable for creating a Color PhotoStitch. The primary 
factor, however, is to use photos where the face is well defined, especially the eyes, and 
the color is good.
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An imperfect photo can still make a very good embroidery. Red eye can be removed, and the color in 
underexposed photos brought out by Autolevel. Slight overexposure and cold lighting can be improved by 
adjusting saturation.
A plain, well contrasted background will be easy to remove, for example a picture taken 
against a blue sky, or a brightly painted wall. If the picture was taken against a patterned 
background, the background color may blend in with the person’s hair. This type of 
background may take a little longer to remove.

Photos for Sepia and Monochrome PhotoStitch
When using old sepia or monochrome pictures for a sepia or monochrome PhotoStitch, 
choose a photo with good contrast and detail. A plain and well defined background will 
be easier to remove.

To improve definition and contrast on old photos, temporarily remove the photo from its frame, and use a 
high resolution when scanning it. Where possible, avoid grainy prints. A scan from the negative may work 
better.
When using color photos for a sepia or monochrome PhotoStitch, choose a photo with 
good contrast and a well defined background, or one that can be easily removed.

A picture with good contrast, but poor color, may work well as a sepia or monochrome PhotoStitch.

Photos for Color Tile PhotoStitch
Use a strong image with contrasting color areas for a Color Tile PhotoStitch Embroidery, as 
fine details and color changes will probably not show. Use a well defined photograph with 
varied areas of color.

The color tile method is ideal for achieving artistic, impressionistic embroideries.

A slightly blurred picture with good color areas may make a good tile embroidery.

Photos for Linear PhotoStitch
Pictures for Linear, and Linear Artistic, PhotoStitch work best when they have strong 
contrast on the facial features, and no areas of shadow on the face.

Photos with face to camera tend to work better than those taken from the side, as the other side of the face 
is in shadow.
A pale background is often better than a dark background. Try removing the background in mySewnet™ 
Draw & Paint, or other picture editing software. Save the picture before making the PhotoStitch.
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Using the PhotoStitch Wizard
1 Start the Wizard. It opens at the Choose Embroidery Type page.

2 Click the desired option. Choose from:
• Create Color PhotoStitch Embroidery
• Create Sepia PhotoStitch Embroidery
• Create Monochrome PhotoStitch Embroidery
• Create Color Tile PhotoStitch Embroidery
• Create Linear PhotoStitch Embroidery.

3 Click Next. The Choose Picture page appears.

4 Click the desired option from:

• Load a Picture , to select an existing picture file.

• Paste Picture  to load the picture in the Clipboard Block.

• From Scanner or Camera  to obtain a picture directly from a scanner or digital camera.

• Create New Picture  to create a picture in mySewnet™ Draw & Paint.

• Edit Picture  to edit a picture in mySewnet™ Draw & Paint.
5 Select your picture. The picture will appear in the preview pane.
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6 Click Next. The Rotate and Crop Picture page appears.
7 If required, rotate the picture to any angle from 0 to 359 degrees. This can be useful when 

straightening scanned pictures.
8 If required, adjust the crop lines to select the desired area of the picture, or use Perspective 

Correction. Click Automatic to start again.
Click and drag anywhere inside the crop box to move it.
The dotted lines show the crop size.
Alternatively, crop to a fixed orientation, selecting from square, portrait and landscape.

9 Click Next. The Remove Background page appears.
10 Use Flood Erase  to remove adjacent areas with a similar color. Use the Large , Medium  and 

Small  Erasers to ’wipe out’ background areas.

Use Undo  to reverse the last action, and Reset to go back to the original picture.

For a linear PhotoStitch it is unimportant if a few small specks of background remain, as the background 
stitch lines will be unaffected. When making a color PhotoStitch it is best to remove all specks of 
background as they may lead to ’stray stitches’.

11 Click Next. The Picture Options page appears.
12 Autolevel is initially enabled. It adjusts brightness and contrast automatically. Deselect it if the colors 

appear distorted.
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13 To remove the red eye effect caused by flash photography, select Red Eye Removal  and draw an 
ellipse around the affected area. 

14 Increase saturation to make colors more intense, for example to make pale skin tones appear 
’warmer’.

Save the picture if desired, in order to adjust the project later.
15 Click Next. The Design Size page appears. Set the size for the embroidery, using Height or Width. The 

picture proportions are kept as you resize.
16 Click Next. If Linear PhotoStitch Embroidery was selected in the Choose Embroidery Type page, the 

Choose Thread Colors page for Linear PhotoStitch will appear.
17 To change the thread color, click Thread Color , then select a new color in the Color Selection 

dialog box.
18 Select an artistic effect from the drop-down list. The available options are Linear, Spiral and four Maze 

effects.

19 Use the Shade Range slider to adjust the range of light and dark in the picture.
This page also displays the number of stitches in the embroidery, its height, width, and the total number of 
color changes.

20 Select Enhance Detail to bring out detail in the picture, for example in a photo where the face is clear, 
but the contrast is poor.
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Scan Depth refers to the distance between the lines that produce an embroidery from a picture. The lower 
the Scan Depth figure, the finer the detail in the embroidery, and the more stitches produced.
Density changes the density of the stitching along each line, where 1 is the standard default density and 40 
is the most open, with the fewest stitches.

21 Click Finish to close the wizard.

Creating a Color PhotoStitch
22 In the Choose Embroidery Type page, select an option and click Next.
23 Progress through the following pages, setting options as desired and clicking Next:

• Choose Picture
• Rotate and Crop Picture 
• Remove Background 
• Picture Options
• Design Size

24 The Choose Thread Colors page appears.
25 Adjust the number of colors with the arrows in the Color Selection box, or type in the required 

number of colors.
If desired, Focal Area can be used to concentrate on the flesh tones in a face, rather than the color of the 
hair or clothes.

26 To change a particular thread color, select the color, click Change Thread, then select a new color in 
the Color Selection dialog box.
Remove the selected color from the list with Delete, or all colors in the list with Delete All. Go back to the 
original color list with Reset.

Delete All enables you to control the exact colors used. Delete all of the colors, then choose new colors with 
Pick.

27 Click Next. The PhotoStitch Embroidery Options page appears.
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28 Select Enhance Detail to bring out detail in the picture, for example in a photo where the face is clear, 
but the contrast is poor.

Enhance Detail does not change the colors used, it affects the way that those colors are used.
Density changes the density of the stitching where 1 is the standard default density and 9 is the most open, 
with the fewest stitches.
This page also displays the number of stitches in the embroidery, its height, width, and the total number of 
color changes.

29 Click Finish to close the wizard.
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Choose Embroidery Type

Create Color PhotoStitch Embroidery
Create a PhotoStitch embroidery from a color photo, generating a 
randomized pattern of stitches, using multiple threads for a full 
color result.

Color PhotoStitch works best when using pictures with a good color 
range, and a well defined, differently colored or transparent, 
background.

Create Sepia PhotoStitch Embroidery
Create a sepia embroidery from an old sepia or black and white 
picture, or create a sepia effect embroidery from a color picture, to 
give a heritage look, similar to old photos. PhotoStitch generates a 
randomized pattern of stitches, using sepia colored threads.

Sepia PhotoStitch works best when using pictures with good 
contrast, and a well defined or transparent background.

Create Monochrome PhotoStitch Embroidery
Create a PhotoStitch embroidery from a black and white photo, 
generating a randomized pattern of stitches, using threads in 
grayscale color ways.

Monochrome PhotoStitch works best when using pictures with 
good contrast, and a well defined or transparent background.

Create a full color embroidery

Use monochrome or sepia
Use a color tile effect
Use a single thread to create a
single color embroidery
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Create Color Tile PhotoStitch Embroidery
Create a PhotoStitch embroidery from a color photo, generating 
small blocks of stitches in varying shapes with a tiled effect, using 
multiple threads for a full color result. PhotoStitch automatically 
generates tiled blocks of stitching in the selected colors.

Select from diamond, square or hexagon shaped blocks.

The color tile method is ideal for achieving artistic, impressionistic 
embroideries.

Color Tile PhotoStitch Embroidery works best when using pictures with good contrast, 
and a well defined or transparent background.

Create Linear PhotoStitch Embroidery
Create a PhotoStitch embroidery from a color or monochrome 
photo, generating a linear pattern of stitches, or a Maze or Spiral 
effect, using one thread for a single color result. There are six effects 
available.

Linear PhotoStitch works best when using a picture with good 
contrast on the face, and without areas of deep shadow. If the 
background is transparent, parallel scan lines will be created.

Next
Go to the Choose Picture page.

Choose Picture

Use the Choose Picture page to select the picture you wish to convert to a PhotoStitch. 

Select a picture file on
your computer

Paste a copied picture

Import a file from a scanner
or camera

The picture is previewed

Create a picture in Draw & Paint

Edit a picture in Draw & Paint
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Load a Picture
Click Load a Picture  to open a picture from your My Pictures folder. Alternatively, 
browse to a folder elsewhere on your computer. After selecting a picture, the preview box 
will show the selected picture with its name underneath.

The following file formats may be loaded: Windows or OS2 Bitmap (.bmp), JPEG-JFIF 
Compliant (.jpg, .jif, .jpeg), PatternCAD (.4dq), Portable Network Graphics (.png), Tagged 
Image File Format uncompressed (.tiff., tif ), Windows Meta File (.wmf), Windows Enhanced 
Meta File (.emf ) and Windows Icon (.ico).

Load a Picture with the Viewer
1 Click Load a Picture  and the Picture Viewer dialog box appears.
2 Double-click to expand the folders until the desired folder is highlighted.
3 If desired, change the icon size to see more or fewer pictures.
4 Click on a picture to select it.
5 Click OK to open the picture with its name underneath.
6 Click Cancel to exit without selecting a picture.

Paste Picture
Click Paste Picture  to load the picture in the Clipboard Block. The picture is shown in 
the preview area.

Paste Picture is not available if the Clipboard Block is empty.

From Scanner or Camera
Use From Scanner or Camera  to display the program that is used to acquire pictures 
from a scanner, a digital camera or another suitable device. Only devices that use Windows 
Image Acquisition (WIA) can be used to obtain pictures.

WIA is a standard method for transferring pictures from the device’s scanning or downloading program to 
another program. If the manufacturer provides the appropriate software components needed for WIA 
compliance, these should have been installed when the device was installed. 
Each scanner or digital camera has its own program that is used to scan or download 
pictures. Refer to the manual or online help provided with the program for instructions, if 
required. When the device and its software finish processing the picture, it will be shown 
in the Choose Picture page.

Choose a picture folder

Scroll to view more pictures

Click to select a picture

Scroll to view more folders

Change the icon size

Load the selected picture
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Create New Picture and Edit Picture
Create a new picture  or edit an existing picture  in mySewnet™ Draw & Paint.

Preview and Name
Under the preview pane is a box for the name of the chosen file. If the picture is a scanned 
image then the box will contain the words Scanned Picture.

Back
Return to the Choose Embroidery Type page.

Next
Go to the Rotate and Crop Picture page.
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Rotate and Crop Picture

If required, rotate the picture to any angle from 0 to 359 degrees. This can be useful when 
straightening scanned pictures. 

Use the Crop lines to select the section of the picture that is to be used to create the 
PhotoStitch. If required, click and drag the handles on the boundary line of the crop area 
to select the desired part of the picture. Use Perspective Correction to adjust for 
perspective or skew.

To obtain more detail on an individual’s face it is often helpful to crop so that only the head and part of the 
shoulders are shown. 
Sometimes, the automatic crop area may not appear to remove as much background color as possible. 
This can happen when the background color appears to be a plain color, such as white, but actually has 
minor variations that are not immediately visible. For example, this often happens with the JPEG-JFIF 
Compliant (*.jpg, .jif, .jpeg) picture format.
Click and drag anywhere inside the crop box to move the crop box.

If you need to expand a crop box again, make sure it is not touching the edge of the frame, as this will stop 
it expanding.

Select All
Click the Select All button to select the whole picture. Alternatively, double-click the 
picture to select the whole picture.

Automatic
Click Automatic to set the crop lines back to the default position for the current picture.

Orientation
Use Orientation to crop the picture to a fixed orientation. Choose from: Square, Portrait 
and Landscape.

Change the angle of the picture

Zoom in and out

Adjust the crop lines as desired

Select all of the picture or use 

Crop the picture to a set shape
the default crop settings
Correct the perspective in the picture
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Perspective Correction
To remove the effects of perspective in a picture, or to correct skew, select Perspective 
Correction . When using Perspective Correction, the crop handles are red.

Move the red handles so that the crop lines frame the picture. Use the Zoom tools to view 
the outline of the picture more clearly. Drag the Stretch Picture  slider to make the 
picture in the Preview wider or narrower.

Zoom
Use the Zoom functions to change the view of the picture or embroidery.

Use Zoom In  to magnify the view. Move the pointer over the picture or embroidery 
and the pointer changes to the zoom in pointer . Then either click a point you want to 
zoom in towards, or click and drag a rectangle around the area you want to zoom in to and 
release the mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture or embroidery and 
the pointer changes to the zoom out pointer . Then click a point you want to zoom out 
from.

Click Zoom To Fit  to fit the picture or embroidery to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen. Alternatively, view the embroidery at a 
magnification as close as possible to the Real Size setting you chose in mySewnet™ 
Configure.

Back
Return to the Choose Picture page.

Next
Go to the Remove Background page.
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Remove Background

Use the Remove Background page to remove the background from the photo, so as to 
emphasize the person’s face, or other subject.

Best results may be obtained if the background is completely removed, leaving only the face itself. 
Removing heavily contrasting colors in the background brings out the subtle color variations in the 
person’s features.
For a Linear PhotoStitch it is unimportant if a few small specks of background remain, as the background 
stitch lines will be unaffected. When making a color PhotoStitch it is best to remove all specks of 
background as they may lead to ’stray stitches’.

Flood Fill
Select Flood Fill  to remove sections of similarly colored background automatically.

Flood Fill looks for areas with a similar color shade, and replaces them with a transparent 
background.

Use Flood Fill in conjunction with Undo on varied backgrounds such as a cloudy sky. A small change in the 
position of the click may remove desired parts of the picture along with the background.
Flood Fill works best on relatively evenly colored areas. Areas with gradations of colors can 
be removed in several pieces, but patterned areas may be easier to remove with the Large 
Eraser.

Some backgrounds may be a similar color to the hair or skin of the person in the foreground. Draw a line 
around the person with the Small Eraser, then remove the background with Flood Fill.
When Flood Fill is used to remove a very brightly colored background, for example a bright blue sky, there 
may be a colored edge around the subject of the picture. This can affect the final embroidery. Use the Small 
Eraser to carefully remove the colored edge.

Eraser
The Eraser removes any part of the image that it is used on, leaving a transparent 
background. Three sizes are available.

Lift the mouse button or graphics tablet pen frequently when using one of the erasers. Then if you make a 
mistake, and need to Undo, you will not lose much work.

Zoom in and out

Remove areas of a similar shade

Remove background areas
with one of the erasers

Undo the last action
Start again
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Large Eraser
Use the Large Eraser  to remove large areas of background, and to clean remaining 
fragments of background from a picture.

Patterned backgrounds often contain pixels of widely varying colors, and a few of these may remain when 
the area has been cleaned with Flood Fill. Remove these with the Large Eraser.

Medium Eraser
Use the Medium Eraser  to clean relatively detailed areas.

Small Eraser
Use the Small Eraser  to remove fine details, or to draw a line to separate a desired area 
from an unwanted one.

Defining Areas with the Small Eraser
Open your chosen picture in the Remove Background page of the ExpressDesign Wizard, 
and start removing the background with Flood Fill.

Repeat this process where other parts of the picture are the same color as the adjoining 
background.

Undo
Use Undo  to reverse the last action.

Reset
Use Reset to reverse all changes made to the picture on the current wizard page. Changes 
made on previous pages are retained.

Zoom
Use the Zoom functions to change the view of the picture or embroidery.

If a desired area of the picture is 
removed, click Undo. 

Select the Small Eraser .

Draw a line to separate the 
background area from the picture.

You may need to do this in more 
than one place.

Select Flood Fill again.
Continue removing the 

background area with Flood Fill.
Use Undo if required parts of the 

picture are removed.
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Use Zoom In  to magnify the view. Move the pointer over the picture or embroidery 
and the pointer changes to the zoom in pointer . Then either click a point you want to 
zoom in towards, or click and drag a rectangle around the area you want to zoom in to and 
release the mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture or embroidery and 
the pointer changes to the zoom out pointer . Then click a point you want to zoom out 
from.

Click Zoom To Fit  to fit the picture or embroidery to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen. Alternatively, view the embroidery at a 
magnification as close as possible to the Real Size setting you chose in mySewnet™ 
Configure.

Back
Return to the Rotate and Crop Picture page.

Next
Go to the Picture Options page.
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Picture Options

Use the Picture Options page to remove Red Eye from your picture, and to adjust 
saturation and contrast in the picture.

Autolevel
Autolevel improves brightness and contrast in most photos, and can be used to bring out 
the color in underexposed pictures.

By default Autolevel is enabled.

Autolevel does not make new adjustments each time a picture is loaded. 

Occasionally Autolevel does not improve the appearance of a picture, and may need to be switched off.

Red Eye Removal
Use Red Eye Removal  to reverse the red eye effect caused when flash is reflected back 
by the retina of the eye.

Zoom in on the picture

Remove red eye effect

Return to the original picture

Adjust grays and flesh tones

Improve brightness & contrast

Save the edited picture



mySewnet™ Embroidery   Using the PhotoStitch Wizard              271

Red Eye Removal can also be used to remove other intrusive reds, such as red lights.

Select Eye
Use Select Eye  to select Red Eye removal.

Remove Red Eye Effect from a Picture
1 Click Select Eye .
2 Use Zoom In  to magnify the affected area.
3 Draw an ellipse around the affected eye in the Source Picture panel. Any bright red in that part of the 

picture has a blue cast added to it, to counteract the red effect.
If you make a mistake, use Reset to reverse red eye removal, then try again.

4 Check the result in the Preview panel.
5 Remove any other examples of red eye in the picture.

Reset
Use Reset to reverse the effects of red eye removal.

Saturation
Adjust saturation to change the amount of gray in your picture.

Saturation is best used on Color PhotoStitch and Color Tile PhotoStitch embroideries.
Move the Saturation slider bar to the desired setting, or enter a value directly in the box.

Adjust Saturation between -10 and 20 by typing in a number, clicking on the left or right of 
the slider bar or by clicking and dragging the slider bar. To make the image more gray, 
move the slider to the left or type a lower number in the box. To make the image warmer, 
move the slider to the right or type a higher number in the box.

The initial value for Saturation is 0.

To reverse changes to Saturation, set the value back to 0.

Save Picture
Use Save Picture  to save changes to a picture you have edited. The Save Picture dialog 
box appears.

The following file formats may be saved: Windows or OS2 Bitmap (.bmp), JPEG Low Quality 
(.jpg), JPEG High Quality (.jpg), Tagged Image File Format uncompressed (.tif ) and 
Portable Network Graphics (.png).

Portable Network Graphics (.png) is recommended as it is relatively compact, yet preserves the colors of 
the photo.

Source Picture
The panel on the left shows the original picture. 

Preview
The preview picture on the right shows the result of applying Autolevel, Red Eye Removal, 
and adjusting saturation.

Zoom
Use the Zoom functions to change the view of the picture or embroidery.
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Use Zoom In  to magnify the view. Move the pointer over the picture or embroidery 
and the pointer changes to the zoom in pointer . Then either click a point you want to 
zoom in towards, or click and drag a rectangle around the area you want to zoom in to and 
release the mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture or embroidery and 
the pointer changes to the zoom out pointer . Then click a point you want to zoom out 
from.

Click Zoom To Fit  to fit the picture or embroidery to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen. Alternatively, view the embroidery at a 
magnification as close as possible to the Real Size setting you chose in mySewnet™ 
Configure.

Back
Return to the Remove Background page.

Next
Go to the Design Size page.
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Design Size

Use the Design Size page to set the height or width of your embroidery, with the other 
dimension calculated from the picture.

Enter Design Size
Set the height or width of your embroidery, with the other dimension calculated from the 
picture.

Zoom
Use the Zoom functions to change the view of the picture or embroidery.

Use Zoom In  to magnify the view. Move the pointer over the picture or embroidery 
and the pointer changes to the zoom in pointer . Then either click a point you want to 
zoom in towards, or click and drag a rectangle around the area you want to zoom in to and 
release the mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture or embroidery and 
the pointer changes to the zoom out pointer . Then click a point you want to zoom out 
from.

Click Zoom To Fit  to fit the picture or embroidery to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen. Alternatively, view the embroidery at a 
magnification as close as possible to the Real Size setting you chose in mySewnet™ 
Configure.

Back
Return to the Picture Options page.

Next
Go to the Choose Thread Colors page.

Set the height or width
of the embroidery



274          mySewnet™ Embroidery   Using the PhotoStitch Wizard 

Choose Thread Colors

The Choose Thread Colors page of the PhotoStitch Wizard only appears when you are 
creating a color, sepia, monochrome or color tile PhotoStitch.

A different version of this page appears when creating a linear embroidery, see “Choose Thread Colors 
(Linear PhotoStitch)” on page 278.
Use the Choose Thread Colors page to set the number of colors, and to match thread 
colors to colors in the picture. Thread color effects are available for frames and borders, 
but not for the PhotoStitch embroidery.

Color Selection

Number of Colors
The Number of Colors is initially set to the recommended number of colors. When this 
number is changed, the list of thread colors and the preview are updated.

The maximum Number of Colors is 256.

With Sepia an initial palette of 7 colors is provided, and with Monochrome an initial palette of 11 colors is 
provided.
It is not necessary to match the Reduced Colors Preview exactly to the source picture, as long as the effect is 
pleasing. The color PhotoStitch effect provides an impression of a photo. Use the Number of Colors and the 
Thread Color Options on the following page to achieve a good effect with a reasonable number of threads.

Apply
When the number of colors has been changed, click Apply to adjust the threads and the 
preview.

Reset
Use Reset to return the color list to the initial set of picture colors. The picture colors will be 
matched to thread colors from the thread range shown in the Change All To box. Any 
custom thread matches that are required must be re-selected with Change Thread.

Select a Thread Range

Delete all colors

Change a thread color

Choose a color from the picture

Zoom in and out

Choose a thread

Delete a color

Return to the original color list
Set the number of colors
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Change All To
Click the drop-down arrow to choose a different thread range. When a thread range is 
chosen, each picture color in the list will be assigned the nearest matching thread color 
from the chosen thread range.

When a new thread range is chosen, all custom thread matches set by Change Thread will be lost.

Picture and Thread Color List
The list shows a sample of each color currently selected from the picture. The colors are 
shown with each picture color automatically matched to a thread color from the thread 
range shown in Change All To.

The same thread color may be matched to two or more colors in the picture. Each thread 
color can be individually changed with Change Thread. When thread colors are changed 
in the list, the Thread Color Preview is updated.

When more than one color in the picture is matched to the same thread color, the number of color changes 
in the final embroidery is reduced.

Change Thread
Click a color in the list, then click the Change Thread button. The Color Selection dialog 
box will appear so that a different thread color can be chosen. Alternatively, double-click a 
color in the list and the Color Selection dialog box will appear. See “Change an Existing 
Thread Color” on page 53.

It is recommended only to use Change Thread after the main thread range has been selected.

Pick
Click Pick to add thread colors to the list by clicking the desired colors in the Source 
Picture.

When Pick is selected, the pointer changes to an eyedropper  over the source picture. 
Click the picture to pick up the color under the tip of the eyedropper, and the nearest 
matching thread color from the selected Thread Range will be automatically selected and 
added to the thread color list. Because the PhotoStitch effects use a color blending 
process, the colors are recalculated.

The thread color is picked for the clicked color according to the RGB (red, green, blue) value at the point 
clicked. If there is already a thread color assigned to that exact RGB value, it will be highlighted in the list 
instead of adding a thread color to the list.

Delete
Delete the picture color currently highlighted in the list. Because the PhotoStitch effects 
use a color blending process, the colors are recalculated. The Thread Color Preview is 
displayed again, with the reduced set of thread colors.

Delete All
Click Delete All to remove all the thread colors from the list if you wish to use Pick Color to 
choose colors from the Source Picture.
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Focal Area
The Focal Area allows you to focus on the area of the picture that you want used when the 
color palette is selected.

Focal Area can be used to concentrate on the flesh tones in a face, rather than the color of the hair or 
clothes.

Define a Focal Area
Use this option to enable the selection of a Focal Area. Then click and drag to select the 
area. By default this option is not selected.

Low
Color palette influenced by the Focal Area.

Medium
Color palette heavily influenced by the Focal Area.

High
Color palette taken mainly from the Focal Area.

Previews

Source Picture
This shows the original picture, after being rotated and cropped, in full color.

Thread Color Preview
This shows how the thread colors have been chosen to replace colors in the picture. This 
gives an approximate indication of where thread blocks will be in the final design.

If variegated threads have been selected, only the first color is shown in the preview.

Zoom
Use the Zoom functions to change the view of the picture or embroidery.

Use Zoom In  to magnify the view. Move the pointer over the picture or embroidery 
and the pointer changes to the zoom in pointer . Then either click a point you want to 
zoom in towards, or click and drag a rectangle around the area you want to zoom in to and 
release the mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture or embroidery and 
the pointer changes to the zoom out pointer . Then click a point you want to zoom out 
from.

Click Zoom To Fit  to fit the picture or embroidery to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen. Alternatively, view the embroidery at a 
magnification as close as possible to the Real Size setting you chose in mySewnet™ 
Configure.
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Back
Return to the Design Size page.

Next
Create a PhotoStitch embroidery and show it on the PhotoStitch Embroidery Options 
page, or the Color Tile Options page.

The Create Stitches animation plays while the embroidery is created.
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Choose Thread Colors (Linear PhotoStitch)

The Linear PhotoStitch version of the Choose Thread Colors page of the PhotoStitch 
Wizard only appears when you are creating a linear embroidery.

Use the Choose Thread Colors page to choose the color for the embroidery. Optionally, 
select an artistic stitch effect, choose whether or not to change the angle of the stitching, 
and enhance detail and contrast in the picture.

Thread Color
Thread Color enables you to select the color used for stitching the linear embroidery.

Click the Thread Color icon  to open the Color Selection dialog box.

See “Thread Colors” on page 53.

Artistic Effect
Select an artistic effect from the drop-down list. The available options are Linear, Spiral 
and four Maze effects.

Monochrome Linear
Use Monochrome Linear  to use straight lines of thread for the basic stitch pattern. The 
lines are smooth for light areas of the picture. Zigzag stitches on either side of the lines 
emphasize the detail of the picture. 

Monochrome Spiral
Use Monochrome Spiral  to use circular lines of thread for the basic stitch pattern. The 
lines are smooth for light areas of the picture. Zigzag stitches on either side of the lines 
emphasize the detail of the picture.

Monochrome Maze
Use the Monochrome Maze ( , ,  and ) modes to use one of four patterns to 
build up the picture. The stitching is sparse for light areas of the picture, which also reveals 
the basic shape used by the Maze mode you have chosen. Increased density of stitching 
emphasizes the detail of the picture.

Change the embroidery color

Use a spiral or maze effect
Alter the stitch line angle

Bring out detail in the picture
Adjust distance between lines
Change the stitch density

Change the contrast

Place on the work area
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Angle
Use Angle to change the angle at which the stitches are created for the embroidery.

Enter an Angle from 0 to 359 degrees. The initial setting is 0.

Alter the Angle by typing a number in the box, or use the up and down arrows to change the number. The 
computer will recalculate how to stitch the picture.
Changes in Angle are visible in the preview pane.

Shade Range
Change the contrast in the picture. Negative values make the picture darker, and positive 
values make the picture lighter.

Enhance Detail
Enhance Detail makes details in the picture more prominent. For example, it can be used 
to improve definition in a photo with good detail, but little contrast.

Scan Depth
Scan Depth refers to the distance between the lines that produce an embroidery from a 
picture. The lower the Scan Depth figure, the finer the detail shown in the embroidery, and 
the more stitches produced. Scan Depth may be altered from 1 to 20 (recommended 
setting 2). The default setting is 2.

Changes in Scan Depth are visible in the preview pane.

Density
Density of stitching along each line may be set from 1 to 40. The lower the number, the 
closer together the stitches and the more stitches are produced.

Depending on the fabric and machine used, a lower number may produce more detail in 
the embroidery. However, the recommended (and default) setting is 2.

Changes in Density are visible in the preview pane.

Zoom
Use the Zoom functions to change the view of the picture or embroidery.

Use Zoom In  to magnify the view. Move the pointer over the picture or embroidery 
and the pointer changes to the zoom in pointer . Then either click a point you want to 
zoom in towards, or click and drag a rectangle around the area you want to zoom in to and 
release the mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture or embroidery and 
the pointer changes to the zoom out pointer . Then click a point you want to zoom out 
from.

Click Zoom To Fit  to fit the picture or embroidery to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen. Alternatively, view the embroidery at a 
magnification as close as possible to the Real Size setting you chose in mySewnet™ 
Configure.



280          mySewnet™ Embroidery   Using the PhotoStitch Wizard 

Design Information
The design information boxes show the dimensions (Width  and Height ) and Stitch 
Count  for the embroidery. The design information may change when the embroidery is 
exported, depending on the Optimize for Sewing Options.

Back
If desired, use the Back button to go back through the PhotoStitch Wizard and modify 
settings before previewing the design again.

Finish
Accept the final design and close the PhotoStitch Wizard.
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PhotoStitch Embroidery Options

The PhotoStitch Embroidery Options page allows you to view and check the final design 
in 3D before closing the PhotoStitch Wizard. Optionally, choose whether or not to 
enhance detail in the picture.

After creating a PhotoStitch embroidery, use the Frame tab to complete your project. Add 
lettering too, if you wish.

Stitch Options
Select Enhance Detail to bring out the detail in the picture or Density to change the 
number of stitches.

Enhance Detail
Enhance Detail makes details in the picture more prominent. For example, it can be used 
to improve definition in a photo with good detail, but little contrast.

Enhance Detail does not change the colors used, it affects the way that those colors are used.

Density
Select the density of the stitching. 1 is the standard default density, 9 is the most open.

Zoom
Use the Zoom functions to change the view of the picture or embroidery.

Use Zoom In  to magnify the view. Move the pointer over the picture or embroidery 
and the pointer changes to the zoom in pointer . Then either click a point you want to 
zoom in towards, or click and drag a rectangle around the area you want to zoom in to and 
release the mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture or embroidery and 
the pointer changes to the zoom out pointer . Then click a point you want to zoom out 
from.

Click Zoom To Fit  to fit the picture or embroidery to the preview area.

View the design information

Preview the embroidery

Make further edits
Place on the work area

Enhance detail in the picture
Change the stitch density
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Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen. Alternatively, view the embroidery at a 
magnification as close as possible to the Real Size setting you chose in mySewnet™ 
Configure.

Design Information
The design information boxes show the dimensions (Width  and Height ), Stitch 
Count , and number of colors  for the embroidery. The design information may 
change when the embroidery is exported, depending on the Optimize for Sewing 
Options.

Back
If desired, use the Back button to go back through the PhotoStitch Wizard and modify 
settings before previewing the design again.

Finish
Accept the final design and close the PhotoStitch Wizard.
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Color Tile Options

The Color Tile Options page of the PhotoStitch Wizard only appears when you are creating 
a color tile embroidery. Use the Color Tile Options page to select tiles, and set the stitch 
options for them.

Tiles
Select a tile shape from the drop-down list. The available shapes are:

■ Diamond
■ Square
■ Hexagon

The default tile shape is Diamond.

The tile size is based on the width of the tile at its widest point.

Width
Select the width of the tiles from 2mm to 5mm in steps of 1mm.

The default tile size is 3mm.

Stitch Options
The stitch options selected here are retained until the wizard for a different embroidery type is chosen, or a 
new picture is loaded.

Zoom in and out

Select Satin or Fill tiles

Set the stitch angle

Choose a tile shape & size

View the design information
Place on the work area
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Satin
Use Satin stitch for the tiles. Select Satin, and click the Options button, to see the Density 
options.

Satin Density

Set Density from 2 to 12. The lower the number, the closer 
together the stitches and the more stitches are produced.

The initial setting is 4.

Fill
Use Fill for the tiles. Select Fill, and click the Options button, to 
see the Density options.

Fill Density

Set Density from 2 to 12. The lower the number, the closer 
together the stitches and the more stitches are produced.

The initial setting is 2.

Stitch Angle
Select from Side to Side, where the stitches are parallel to the 
sides of the shape, and Point to Point, where the stitches are from corner to corner of the 
shape. 

The default setting is Side to Side.

Side to Side Point to Point
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Design Information
The design information boxes show the dimensions (Width  and Height ), Stitch 
Count , and number of colors  for the embroidery. The design information may 
change when the embroidery is exported, depending on the Optimize for Sewing 
Options.

Zoom
Use the Zoom functions to change the view of the picture or embroidery.

Use Zoom In  to magnify the view. Move the pointer over the picture or embroidery 
and the pointer changes to the zoom in pointer . Then either click a point you want to 
zoom in towards, or click and drag a rectangle around the area you want to zoom in to and 
release the mouse button to zoom. When zoomed in, use the scroll bars to move around.

Use Zoom Out  to shrink the view. Move the pointer over the picture or embroidery and 
the pointer changes to the zoom out pointer . Then click a point you want to zoom out 
from.

Click Zoom To Fit  to fit the picture or embroidery to the preview area.

Click Real Size  to view the picture at its real size in pixels. This means that one pixel of 
the picture uses one pixel of the screen. Alternatively, view the embroidery at a 
magnification as close as possible to the Real Size setting you chose in mySewnet™ 
Configure.

Back
If desired, use the Back button to go back through the PhotoStitch Wizard and modify 
settings before previewing the design again.

Finish
Accept the final design and close the PhotoStitch Wizard.
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Using the PhotoStitch Wizard
Ryan - Using the PhotoStitch Wizard

1 Click the Create tab.
2 Click the drop-down arrow beneath the PhotoStitch Wizard icon , then click PhotoStitch into 

Hoop. The Choose Embroidery Type page of the PhotoStitch Wizard appears.

3 Select Create Color PhotoStitch Embroidery and click Next. The Choose Picture page appears.
4 Click Load a Picture , to select an existing picture file. The Picture Viewer appears.
5 Browse to \mySewnet\Samples\Embroidery\Photos.
6 Scroll to Ryan.PNG.

If you position the arrow pointer over a thumbnail without clicking, the name of the picture will be shown.
7 Click the 'Ryan.png' thumbnail, then click OK. The photo is loaded onto the Choose Picture page, with 

its name shown below the preview area.

8 Click Next and the Rotate and Crop Picture page will appear.
9 Select "Crop to a fixed orientation", and then select Portrait.
10 Move the handles on the corner of the crop box on the left so that the crop frame encloses Ryan’s 

head and chin, showing a little of his shoulders.
11 Move the pointer over the crop box so that the arrow pointer changes to a four-arrow pointer. Drag 

the box so that it is centered over the face.
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12 Take care to leave enough space at the top of the picture for a balanced portrait. A slightly larger 
selection would be needed for a square PhotoStitch, compared with this rectangular one.
If necessary at any time while cropping, click Automatic and start again.

13 Click Next. The Remove Background page will appear.
It is recommended to use a graphics tablet and pen, if available, for the Remove Background functions.

14 Click Flood Erase . 
The pointer changes to the Flood Erase pointer  while positioned over the picture.

15 Click the blue background to the top right of Ryan’s head. The blue background is replaced by a check 
pattern, to show where there will be no stitches. Small differently colored areas are left behind.
Flood Erase removes a particular color, and very similar colors.

16 Continue using Flood Erase  to roughly remove the dark blue background on the right.
If you make a mistake, click Undo to reverse your last action. If necessary, use Reset to start again. Undo 
reverses the last action, while Reset returns to the original version of the picture.

17 Click the dark area to the left, close to Ryan’s head. 
18 The line of the hair above the ear will affect the appearance of the embroidery. Click Undo.
19 Click Zoom In . The pointer changes to the zoom in pointer.
20 Click and drag to draw a rectangle around the area to the left of Ryan’s head, then release the mouse 

button.
21 Select the Small Eraser  and draw a smooth line to the left of Ryan’s head. 
22 Remove the curl of hair by the ear, and leave a small amount of the background color near the hair 

above.
23 Click Zoom to Fit  to see the full picture again.
24 Use Flood Erase  to remove the hair by the ear.

Lift the mouse button or graphics tablet pen frequently. Then if you make a mistake, and need to Undo, you 
will not lose much work.

25 Use Zoom In  to magnify the area to the right of Ryan’s head.
26 Use the Small Eraser  to draw a line to remove the curl by the right ear. 
27 Remove the area with Flood Erase .
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28 Click Zoom to Fit  to view.

29 Use Zoom In  to magnify the areas of the face where the skin is adjacent to the blue background. 
30 Then use the Small  or Medium  Eraser to remove the blue edge.

It does not matter if you go a little into the skin tones as a slightly rough outline will not affect the final 
embroidery.

31 Click the Large Eraser , and try to clean all remaining specks from the background. 
The Medium Eraser is better for cleaning areas close to Ryan’s head.
It is best to remove all specks of background as they may lead to ’stray stitches’.

32 Use Zoom In  and Zoom to Fit  when tidying up the outline and background.

33 Click Next. The Picture Options page will appear.
34 Leave Autolevel on. There is no red eye to correct in this picture.

Autolevel adjusts brightness and contrast automatically. This improves results for most pictures.
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35 Set Saturation to 2, to enhance the tones of the lips and cheeks.
Increasing saturation enhances the intensity of colors, for instance to make pale skin tones appear 
’warmer’. If desired, use Save Picture  to save a copy of your edited picture.

36 Click Next and the Design Size page will appear.
37 Set Height to 119mm.
38 Click Next. The Choose Thread Colors page will appear.
39 Note the number in the Color Selection box. This gives the number of colors in the picture. In this 

example it is 26.
If you use a photo that you edited the number will vary, depending on exactly how you cropped and 
edited the photo.
Each time you run the PhotoStitch Wizard on the same picture, the results may differ. A slight change in 
cropping a picture, or in removing the background, will affect the balance of colors, and the type and 
number of threads used.

40 To emphasize the eyes and mouth in the selection of colors, click Define a Focal Area.

41 Ensure that High is selected in Focal Area. (The default is Low.)
42 Move the handles on the corner of the crop box, and the crop box itself, so that the circle encloses the 

eyes and mouth.
To reposition the crop box, move the arrow pointer so that it changes to a four-arrow pointer, then 
move the box. The number of colors changes as you move and resize the Focal Area crop box. 

43 Make a note of the new number. (In this example it is 24.)
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You can often slightly reduce the number of colors with little visible effect, but a further reduction will badly 
affect the color quality.

44 Scroll down the list of threads. If there is more than one deep blue in the thread color list on the left, 
select and delete one of the shades of blue and check the result. 
The computer will recalculate how to stitch the picture, based on the reduced thread list, and the 
number of stitches will be reduced.
The small amount of deep blue in the picture mainly comes from remaining traces of the background 
color. The number of shades can be safely reduced.
Similarly, you can change a thread color. The computer will recalculate the stitches, based on the threads 
now in use.

45 Click Next. The PhotoStitch Embroidery Options page will appear.

Use Enhance Detail to bring out detail in the picture. Enhance Detail does not change the colors used, it 
affects the way that those colors are used. A higher number for Density will produce looser stitching and 
fewer stitches than the standard setting of 1. 
Leave Enhance Detail unchecked and Density at 1 for this PhotoStitch.

46 Click Finish to close the wizard. 
The PhotoStitch embroidery appears in the work area.
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15Family Tree Wizard
Use the Family Tree Wizard  to create an embroidered family chart of up to three 
generations of ancestors or descendents for an individual.

Enter the names and 
relationships of other 
family members, and 
select lettering, a frame 
and connectors to use for 
the family chart.

On the work area use 
Save or Save As to save 
the family tree 
embroidery as a grouped 
.vp4 file for later use.

The most recently created 
family tree is stored by the wizard. It is reopened the next time the wizard is used.
For more information on the Family Tree Wizard, see the mySewnet™ Embroidery 
Reference Guide.

Family Tree Wizard
Select the Family Tree Wizard  in the Create tab to create a family tree for an individual. 
The Family page of the Family Tree Wizard will appear.

Enter the family members for a Descendants Chart or for an Ancestors Chart, and choose 
how the names will be presented. Select a font style, thread color, shape and size. 
Surround the names with a frame or flourish. Choose Connectors to link the partners in 
the chart.

Progress through the pages using Next  and Back  to alter each setting, or click 
Finish  at any time. Click Cancel  to close the wizard without creating a family tree.

Any existing family tree will be retained in the work area.

Shortcuts

■ Create Tab:  
■ Keys: Alt, C, F

Overview
1 In the Create tab, click Family Tree  to start the Family Tree Wizard.
2 In the Family page, choose whether to start a Descendants Chart , or an Ancestors Chart .

A Descendants Chart shows the partner, children, grandchildren and great-grandchildren of the selected 
individual. This example uses a Descendants Chart.
An Ancestors Chart shows the father and mother, grandparents, and great-grandparents of the selected 
individual.
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3 If you have previously created a family tree chart, you will be asked if you want to remove the family 
data that you previously entered. Click Yes to continue. The First Individual dialog box opens.

To save an existing family tree as a .ged file, in the Family page click Send to mySewnet™ Family Tree .
4 In the First Individual dialog box, enter the Given Name and Family Name of the person the tree is for, 

and indicate if they are Male or Female.
5 Click Next to enter further individuals in the family tree.

The family chart embroidery appears as you enter the data.
6 Enter the names and gender of the partner and children of the first individual, adding the oldest first.
7 Click Next to add grandchildren (the children of the oldest child).

Click Next again to add grandchildren for each of the other children, and then to add great-grandchildren 
for each of the grandchildren.

8 When you have finished entering information for the family tree, click Close to view the tree in the 
Family page of the wizard.

Use the First Individual , Children , Grandchildren , and Great-Grandchildren  buttons to 
change the details for the individuals that you entered. The dialog box opens at the oldest; click Next to 
view the other siblings.

9 Use the Display Names As options to show only the Given Names, or to also view the Family Names.
10 Click Next  to change the lettering used in the family tree.
11 In the Lettering page select the style for the text in the family tree. Choose the font, size, color, 

spacing and stitch type options for the names.

12 Click Next  to change the frames used in the family tree.

Enter the details for the First 
Individual in the family tree.

Add the details for the children of 
the First Individual.

Add the details for grandchildren 
of the First Individual.

Choose a font

Set the font size and layout

Set the connection type

Set the stitch type options Change the thread color

Adjust other settings or finish
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13 In the Frame page choose whether to use frames, and select a frame, corners, side pieces or a flourish 
for each individual. Change the color and stitch options for the frame.

14 Click Next  to change the connectors used between partners in the family tree.
15 In the Connectors page select satin line or a running stitch line for connectors, or use no connectors. 

16 Choose a single or double line connector for partners. Change the thread color used for connectors.

17 Check your work by clicking the wizard tabs or by using Next  and Back  to view the Family Tree 
Wizard pages. Adjust your settings as desired.

18 Click Finish  to place the family tree chart in the work area as a grouped .vp4 file with fixed lettering 
and frames.

Place a frame around each name

Use a Frame, Corners or Side Pieces

Use flourishes Select a frame
Choose the flourish position

Change the thread color for the frame

Change the appearance of the stitching in the frame

Adjust other settings or finish

Adjust other settings or finishChange the thread colorChoose a line type for the connectors

Use double stitch lines to indicate a partnershipChange the settings for the connectors
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Family
In the Family page, choose a Descendants or Ancestors Chart, and then add and adjust the 
details for a First Individual, and for other family members. Choose whether just Given 
Names, or Given and Family names will be displayed, and how they will be placed.

Create New Chart
Choose from Descendants Chart  and Ancestors Chart . Click to select the desired 
option. The First Individual dialog box opens. See “First Individual” on page 296.

■ A Descendants Chart shows the partner, children, grandchildren and great-grandchildren 
of the selected individual.

■ An Ancestors Chart shows the father and mother, grandparents, and great-grandparents 
of the selected individual.

Edit Individuals
After creating a family tree, use the Edit Individuals options to change the details for family 
members. The options for the Descendants Chart and the Ancestors Chart are different.

■ First Individual  opens the First Individual dialog box (the box for the key person in the 
family tree). See “First Individual” on page 296.

Descendants Chart

■ Children  opens the Children 
dialog box (the box for the partner of 
the first individual, and any of their 
children). See “Children” on page 296.

■ Grandchildren  opens the 
Grandchildren dialog box for the first entered child (the box for the partner of the first 
child, and any of their children). See “Grandchildren” on page 297.
Click Next to view the Grandchildren dialog boxes for the other children.

■ Great-Grandchildren  opens the Great-Grandchildren dialog box for the first entered 
grandchild (the box for the partner of the first grandchild, and any of their children). See 
“Great-Grandchildren” on page 297.
Click Next to view the Great-Grandchildren dialog boxes for the other children.

Create a chart of descendants

Create a chart of ancestors
Adjust the details for the first individual

Adjust the details for the First Individual’s relatives

Choose how to display the names

Adjust other settings or finish
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Ancestors Chart

■ Parents  opens the Parents dialog box for the first individual). See “Parents” on 
page 298.

■ Grandparents  opens the Grandparents dialog box for the father’s father for the first 
individual, and their partner. See “Grandparents” on page 298.
Click Next to view the Grandparents dialog boxes for the other parents.

■ Great-Grandparents  opens the Great-Grandparents dialog box for the great-
grandfather on the father’s side. See “Great-Grandparents” on page 299.
Click Next to view the Great-Grandparents dialog boxes for the other great-grandparents.

Display Names As
Select how to display the names of the individuals in the family tree.

■ Given Name Only shows only the first name for the family 
members.

■ Given Above Family Name shows the first name above the 
family name.

■ Given Beside Family Name shows the first name alongside the 
family name.

Next 
Go to the Lettering page.

Alternatively, click the Lettering tab.

Finish 
Accept the final family tree and close the Family Tree Wizard.

Cancel 
Close the Family Tree Wizard without creating a family tree.
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First Individual
Use the First Individual dialog box to enter the names for the First Individual, and indicate 
their gender.

Given Name
Enter the Given Name (first name) for the First Individual.

Family Name
Enter the Family Name (surname) for the First Individual.

Gender
Select Male or Female for the gender of the First 
Individual.

Descendants Chart
Use a Descendants Chart to show the partner, children, grandchildren and great-
grandchildren of the first individual.

Children
Use the Children dialog to enter the names of the partner and children of the First 
Individual. Use Enter Another Partner to add a second partner and their children.

Partner
Enter the Given Name and the Family Name for the First 
Individual’s partner.

Children
Enter the Given Name and Family Name for each of the 
family’s children, and indicate their gender.

Enter the names of the children in order of age, with the oldest first.

Enter Another Partner
Click the Enter Another Partner button to open a second 
Children dialog box. Enter the details for a second family 
here.
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Grandchildren
Use the Grandchildren dialog to enter the names of the partner and children of a child of 
the First Individual. Use Enter Another Partner to add a second partner and their children.

The children of the First Individual are displayed in the order in 
which they were entered. So, if the oldest was entered first, they will 
be displayed first. Click Next to view the details for the other 
children.

Partner
Enter the Given Name and the Family Name for the 
child’s partner.

Children
Enter the Given Name and Family Name for each of the 
family’s children, and indicate their gender.

Enter the names of the children in order of age, with the oldest first.

Enter Another Partner
Click the Enter Another Partner button to open a second 
Grandchildren dialog box. Enter the details for a second family here.

Great-Grandchildren
Use the Great-Grandchildren dialog to enter the names of the partner and children of a 
grandchild of the First Individual. Use Enter Another Partner to add a second partner and 
their children.

The grandchildren of the First Individual are displayed in the order 
in which they were entered. So, if the oldest was entered first, they 
will be displayed first. Click Next to view the details for the other 
grandchildren.

Partner
Enter the Given Name and the Family Name for the 
grandchild’s partner.

Children
Enter the Given Name and Family Name for each of the 
family’s children, and indicate their gender.

Enter the names of the children in order of age, with the oldest first.

Enter Another Partner
Click the Enter Another Partner button to open a second 
Great-Grandchildren dialog box. Enter the details for a second family here.
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Ancestors Chart
Use an Ancestors Chart to show the father and mother, grandparents, and great-
grandparents of the first individual.

Parents
Use the Parents dialog to enter the names of the parents 
of the First Individual.

Father
Enter the Given Name and the Family Name for the First 
Individual’s father.

Mother
Enter the Given Name and the Family Name for the First 
Individual’s mother.

Grandparents
Use the Grandparents dialog to enter the names of the 
grandparents of the First Individual. 

The father’s parents are displayed first. Click Next to view the 
mother’s parents.

Father
Enter the Given Name and the Family Name for the First 
Individual’s grandfather.

Mother
Enter the Given Name and the Family Name for the First 
Individual’s grandmother.



mySewnet™ Embroidery   Family Tree Wizard              299

Great-Grandparents
Use the Great-Grandparents dialog to enter the names of 
the great-grandparents of the First Individual. 

The father’s father’s parents are displayed first. Click Next to view 
the other grandparents in the order father, mother, father, mother.

Father
Enter the Given Name and the Family Name for the First 
Individual’s great-grandfather.

Mother
Enter the Given Name and the Family Name for the First 
Individual’s great-grandmother.
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Lettering
Use the Lettering page to select the style for the text in the family tree. Choose the font, 
size, color, spacing and stitch type options for the names.

Lettering is created from the fonts available in the mySewnet™ Embroidery Software. Set 
lettering styles in the Lettering page of the Family Tree Wizard. Font means lettering style. 
The current font is shown in the Font gallery.

As the lettering is changed, the preview below reflects the changes made.

Change the Appearance of Lettering
Follow these steps to change the appearance of the lettering in a family tree:

For more on lettering, see “Creating Lettering” on page 351.

Choose a font

Set the font size and layout

Set the connection type

Set the stitch type options Change the thread color

Adjust other settings or finish
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Select a Font
1 Click the arrow to the right of the font drop-down menu and the 

font gallery appears.
2 Scroll up or down to select a font from one of the 18 themed 

font categories.
Alternatively, use the up and down arrows on the Font section of 
the Lettering page to see fonts one at a time.
The font name specifies the recommended size range for each font. 
For example, Rian 10-30mm has a recommended size range of 
10mm to 30mm. Font names with UC are uppercase only fonts (that 
is, they have no lowercase characters), and with LC are lowercase 
only.

For more information on fonts, see “Font Selection” on page 354.

Set the Size and Layout
3 Set the font Size  in millimeters or inches as desired, from 3mm to 200mm.

This sets the height of the 'A' character in the font. All other characters and symbols are sized relative to the 
height of 'A'. The size is initially set to the minimum recommended size for the chosen font. 
Fonts appear best when using the recommended size range. See “Font Size” on page 355.

4 If desired, change the proportions of the lettering in the percentage Width  box. Change the width 
from one quarter to four times the default setting. See “Height and Width” on page 356.

5 If desired, change the Gap from -99 to 99. Negative values move characters closer together, and 
positive values move them farther apart. See “Gap” on page 356.
Lowercase characters in Script fonts are not affected by the Gap setting.

6 To change the distance between multiple lines of text, adjust Spacing from 1.0 to 5.0.
Spacing is relative to the height of the ’A’ character. The default spacing is 1.2.

Choose a Connection Method
7 To choose the connection method, click Trim  (joined by movement stitches that are 

automatically trimmed by compatible machines) or Running Stitch  (joined with small stitches), as 
desired. See “Connection” on page 356.
Trim is recommended for most fonts. Running Stitch is recommended for very small text using Nearest 
Point fonts.

Change Letter Properties and Color
8 Select a line or fill type from the Stitch Type drop-down list. The properties dialog box for the stitch 

type will appear. See “Choosing Stitch Properties” on page 454.
9 Use the properties dialog box to change the lettering properties, for example the density, and the 

stitch length, angle and pattern.
If the Stitch Type area is grayed out (unavailable), this means that the font was designed with properties 
that cannot be edited. This is usually because the properties are not the same throughout the font. For 
instance, different letters may use different fill patterns.
For example, in the Modern category, Bremen UC 10 -25mm has Satin Column stitches, therefore the Satin 
Column drop-down is available. Bremen UC 15-60mm has Pattern Fill stitches, therefore the Pattern Fill 
option is available. In the Monogram category, Athletic Square 2C UC 30-80mm has both Satin Column 
and Pattern Fill stitches, therefore both options are available. In the Floral category Acorn 6C UC 35-60mm 
uses more than one type of Pattern Fill. Therefore the Stitch Type area is unavailable.

10 Set the Thread Color to use when embroidering the text. Click one of the thread color blocks to open 
the Color Selection dialog box. See “Changing Colors” on page 53.
Scroll down to see the other font colors.

Back 
Go to the Family page.
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Alternatively, click the Family tab.

Next 
Go to the Frame page.

Finish 
Accept the final family tree and close the Family Tree Wizard.

Cancel 
Close the Family Tree Wizard without creating a family tree.
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Frame
Use the Frame page to choose whether to use frames, and to select a frame, corners, side 
pieces or a flourish for each individual. Change the color and stitch options for the frame.

Choose from the categories of corners, frames and side pieces. Then choose a frame set, 
and select a design. Alternatively, select Flourish and choose a flourish to be placed above, 
below or as a duo above and below the selected name.

In the text below corners, flourishes, frames and side pieces are referred to collectively as frames.
As the frames are changed, the preview below reflects the changes made.

Frame Each Individual
Choose whether to use a frame, corners, side pieces, or a flourish for each individual’s 
name, or to use the name alone.

Frames and flourishes are placed at a size to suit the names.

Category
Frames, corners, flourishes or side pieces are placed around the names. Click Frame and 
select one of corners, frames or side pieces from the Category drop-down list, or click 
Flourish.

Place a frame around each name

Use a Frame, Corners or Side Pieces

Use flourishes Select a frame
Choose the flourish position

Change the thread color for the frame

Change the appearance of the stitching in the frame

Adjust other settings or finish
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Frame or Flourish
Select a frame or flourish from one of the sets in the 
drop-down gallery.

Flourish
Choose a position for the Flourish:

Above: Place the flourish above the name.

Below: Place the flourish below the name.

Duo: Place vertically mirrored flourishes above and 
below the name.

Thread Colors
Set the Thread Color to use when embroidering the frame. Click one of the thread color 
blocks to open the Color Selection dialog box. See “Changing Colors” on page 53.

Stitch Type
Use Stitch Type  to alter the appearance of the stitching used in the frame. 

Changes made to the stitch properties for a frame set are retained until a new frame set is selected.
To change the Stitch Type, select a stitch type from the drop-down menu to open the 
properties dialog for the stitch type. See “Choosing Stitch Properties” on page 454.

Back 
Go to the Lettering page.

Alternatively, click the Lettering tab.

Next 
Go to the Connectors page.

Finish 
Accept the final family tree and close the Family Tree Wizard.

Cancel 
Close the Family Tree Wizard without creating a family tree.
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Connectors
Use the Connectors page to choose the line type and color for connectors between family 
members, or to use no connectors; and use single or double line connectors for partners. 

A single running stitch line is used between partners when No Line is selected.

Select a satin line or running stitch line for connectors between family members, or use no 
connectors. Choose the thread color used for all connectors. Choose a single or double 
line connector for partners.

Connector Type
Choose Satin Line  or Running Line  for connectors between family members, or 
choose No Line  to place connectors only between partners.

If No Line is selected for connectors between family members, a single running stitch line will be placed 
between partners.
Click Options  to set the stitch properties for the family connector lines. The properties 
dialog box for the stitch type opens. See “Satin Line” on page 497 and “Running Stitch” on 
page 493.

Click Thread Color  to set the color for all connectors in the Color Selection dialog box. 
See “Changing Colors” on page 53.

Adjust other settings or finishChange the thread colorChoose a line type for the connectors

Use double stitch lines to indicate a partnershipChange the settings for the connectors
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Partner Connectors
Choose Use Single Line to place a single line connector between partners, and choose Use 
Double Lines to place a double line connector between partners.

Back 
Go to the Frame page.

Alternatively, click the Frame tab.

Finish 
Accept the final family tree and close the Family Tree Wizard.

Cancel 
Close the Family Tree Wizard without creating a family tree.

Use Single Line Use Double Lines
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Create a Family Tree Embroidery
Before you start, run Reset All Modules in mySewnet™ Configure  to use the initial settings for the fonts, 
frames and connectors in the family tree embroidery.

1 In the Create tab, click Family Tree  to start the Family Tree Wizard.
2 In the Family page, click Ancestors Chart . The First Individual dialog box opens.
3 In Given Name, enter "John", and in Family Name enter "Green".
4 Ensure that Gender is set to Male and click Next.

5 In the Parents dialog box, enter "Robert" as the Given Name for Father.
6 For Mother, enter "Jane" as the Given Name and "White" as the Family Name. Click Next.
7 In the Grandparents dialog box for Robert Green, enter "Simon" as the Given Name for Father, and 

"Agnes" and "Grey" as the Given Name and Family Name for Mother. Click Next.
8 In the Grandparents dialog box for Jane White, enter "Thomas" as the Given Name for Father, and 

"Susan" and "Black" as the Given Name and Family Name for Mother. 
9 Click Close to finish entering names for the family tree.

When you click Close the family tree is saved. If you shut down mySewnet™ Embroidery, and then reopen it 
and the Family Tree Wizard, the family tree you entered will be displayed.

10 Click to select Given Beside Family Name. The family names are now also displayed.
At the bottom of the Family Tree Wizard window the number of stitches and the design dimensions 
change. Use this information to check whether the design will fit in the desired hoop.
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11 Click Grandparents . The Grandparents dialog box for Robert Green is opened.
12 Click Next to view the other Grandparents dialog box.
13 In the Family Name field for Mother, change "Black" to "Brown". The family tree design behind the 

dialog box is updated with the name Susan Brown.
You can correct mistakes and add information to the family tree after creation.

14 Click Close.

If desired, click Send to mySewnet™ Family Tree to create a design with both ancestors and descendents, 
and to add PhotoStitch designs for individuals in the family.
The family tree design is rather wide. To use the design on a cushion or in a frame, a taller format 
would look better.

15 Click Given Name Above Family Name. The design 
is now even wider! These frames were better suited 
to the side by side format.

16 Click the Frame tab.
17 Click the drop-down arrow in the Frame or Flourish 

area to view the Frames gallery.
18 In the Light 1 category, select the rectangular 

horizontal frame 7 to change the design 
proportions.

19 Click the Lettering tab to change the font used.
Note that the Adina font used in the wizard theme is 
brown rather than the standard pink, and is used at 
Size 12mm.

20 For a more contemporary look, click the drop-down 
arrow for fonts, and scroll up to the Modern Category and select Gaudy 12 - 30mm.
This is the same size as the Adina font previously used.

21 The top and bottom lines of lettering touch with some names. Click the up arrow for Spacing once, to 
set it to 1.3.

22 Click the Frame tab again to select a satin frame to go with the lettering.
23 Click the drop-down arrow in the Frame or Flourish area, and in the Frames gallery scroll up to the 

Classical 1 category.
24 Click to select frame 9.
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25 Click the blue thread color, and in the Color Selection dialog box enter the number 2216 to select 
Robison-Anton Rayon 40, 2216 Marigold. Click OK.

26 Click the Connectors tab.
27 The connectors are too prominent. Click Thread Color  and in the Color Selection dialog box enter 

the number 2408 to select Robison-Anton Rayon 40, 2408 Star Gold. (This is the color used by the 
lettering.) Click OK.

28 In Connector Type, select Running Stitch .

Alternatively, you could have changed the width and density of the satin line connectors with Options .
29 Click Finish  to place the family tree chart in the work area as a grouped .vp4 file with fixed lettering 

and frames.
30 Click Change Hoop , and in the Enter Size area of the Hoop Selection dialog box deselect Enter 

Hoop Size.
31 In the Universal Hoop Group, set the Hoop Size to 360mm x 260mm - Universal Large Hoop 5, Rotated 

orientation. Click OK.

You could also use the Split Project Wizard  to split the design for a smaller hoop.
When you next open mySewnet™ Embroidery, your family tree will be available for further editing, or to 
create a completely different embroidery design.
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16Word Sculpt Wizard

Overview
Use the Word Sculpt Wizard  to create a word design 
automatically using your choice of outline, words, and 
fonts.

The initial size is set by the hoop. The most recently used values 
are kept within a session. Information about the outline, words 
and font used is stored in the settings of the embroidery that is 
created.

Word Sculpt Wizard
Use the Word Sculpt Wizard to create a word design 
automatically. The Word Sculpt Wizard opens at the Select Outline page.

Shortcuts

■ Create Tab: 
■ Keys: Alt, C, W

Select Outline
Use the Select Outline page to select a shape for your word design, set its size and angle, 
choose a stitch type for the outline and adjust its settings.

Shape
Select one of over 300 shapes from the drop-down list, load a shape with Open Shape , 
or use New Shape  or Edit Shape  to create or edit a shape in mySewnet™ Draw & 
Paint.

If you might want to use a shape created in mySewnet™ Draw & Paint again, Save it there before returning.

Select one of over 300 shapes

Set the design size

Set the design angle

Mirror the design outline

Choose & adjust a stitch type

View the design information

Load, create or edit a shape
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If your shape has multiple parts in mySewnet™ Draw & Paint, the first closed shape in the FilmStrip will be 
used. If needed, move the intended shape to the top of the design in the FilmStrip.

Select Size
Enter the desired size for your design.

The default dimensions will depend upon the shape selected, and the current hoop. The minimum size for 
a design is 20mm and the maximum size is 2000m.

Angle
Use Angle to change the angle at which the outline shape is created and displayed.

Enter an Angle from 0 to 359 degrees. The initial setting is 0.

Alter the Angle by typing a number in the box, or use the up and down arrows to change the number.
Changes in Angle are visible in the preview pane.

Mirror
Select the Mirror checkbox to reflect the design from left to right.

Stitch Type
Select the type of outline to create around the word design from one of the following:

■ Satin Line : see “Satin Line” on page 497.

■ Motif Line : see “Motif Line” on page 498.

■ Running Stitch : see “Running Stitch” on page 493.

■ Triple Stitch : see “Triple Stitch” on page 496.

Stitch Options
After selecting the type of outline, click the Stitch Options button to show the properties 
for that outline type. If desired, adjust the properties and click OK.

Preview
A preview of the design, and its stitch count , width , height  and number of color 
blocks  is displayed.

Zoom Bar
Use the zoom bar at the bottom of the screen to zoom in or out from the center of the 
design.

Use the slider to zoom in or out of the design, or click on the Zoom Out  or Zoom In  
icons. The current magnification is displayed to the left of the zoom bar.

Click the center of the zoom bar to view the design at a magnification as close as possible to the Real Size 
setting you chose in mySewnet™ Configure.

Next
Go to the Select Words page.
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Select Words

The Select Words page enables you to enter words, and place them inside the outline you 
selected. Enter the words, select the case and if they will be used more than once. Choose 
a font or random fonts, select a color theme, and select the orientation of the words in the 
design. Use Refresh Preview to view changes in the preview area.

Words
Enter the words or phrases to use in the design, separated by a comma. The words are 
used in a random order.

Either enter the words in the text box, or copy and paste them in from a text editor.

Upper Case Only
Select this option to use only capital letters for your words.

If a lower case font is selected, the words will use lower case.

Use Words Only Once
Use each word entered only once.

If a particular word is entered more than once, it will be used more than once.

Margin
Set the margin between the words in the design from 0mm to 20mm in steps of 1mm. The 
initial margin is 1mm.

Font Size
Set the size of the font to be used in the design. The initial setting is 12mm.

The fonts that are used will be within their recommended size range. View your fonts in 
Font Manager  to check the recommended size range.

Enter words for the design

Use each word once

Choose one font for the design

Set the orientation of the words

Use only capital letters

Set the font size and margin
Use a random variety of fonts

Select a color palette

Show or refresh the preview
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If a large Font Size and Margin are selected, no words may appear within the design outline, as there may 
be insufficient space.

Random Fonts
Select the Random Fonts option to use a varying selection of fonts that are available to 
use at the selected Font Size.

By default the random size range used will be from 3mm (the lower end of the recommended size range for 
fonts) to 12mm (the initial size for a Word Sculpt Wizard font). Any font within this range may be used at 
the selected Font Size.

Select a Font
Use the Select a Font option to choose a font from the font Gallery.

For best results, use a font whose recommended size range includes the Font Size you selected above.

Color Theme
Use Color Theme to select the colors for your word sculpture. The Original setting will use 
the default colors for the design outline and the selected fonts. If you select another 
theme, the fonts and outline will use the colors in that theme.

The default Color Theme is Original. 

The available themes are: Original, Rose, Red, Orange, Yellow, Green, Teal, Light Blue, Blue, Purple, Pink, 
Gray, Cold, Warm, Grass, Earth, Lipstick, Primary, Complementary 1, Complementary 2 and 
Complementary 3.

Orientation
Use Orientation to select the positioning of the words in your sculpture. Choose from:

■ Random
■ Horizontal
■ Vertical
■ Horizontal and vertical
■ Diagonal
■ Horizontal, vertical and diagonal

The default setting is Random.

Refresh Preview
Click Refresh Preview to update your design using any new settings, and to change the 
random distribution of the words in the sculpture.

Click Refresh Preview repeatedly to view different arrangements of the words in the design.

Design Information
The design information boxes show the dimensions (Width  and Height ), Stitch 
Count , and number of colors  for the embroidery. The design information may 
change when the embroidery is exported, depending on the Optimize for Sewing 
Options.

Finish
Click Finish to close the Wizard.
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Word Sculpt Wizard Examples
Create a Fish Word Sculpt Design

1 In the Create tab, click Word Sculpt . The Select Outline 
page of the Word Sculpt Wizard appears.
A large hoop is best when creating a word sculpture.

2 Click the drop-down arrow for the Shape list. There are over 
300 shapes to select from.
You can also load, create or edit a shape.

3 In the Shape drop-down list scroll down to the Animals - 
Underwater category, and select the shape Fish 3.
The size of the design is set by the currently selected hoop. 
There is no need to change the settings in Select Size for this 
design.

4 Ensure that Angle is set to 0, and that Mirror is not selected.
Use Angle and Mirror to adjust the position of the outline.

5 In Stitch Type ensure that Satin Line  is selected.
For a different effect, you can select Motif Line , and click 
Options to choose a different motif and its settings.

6 Click Next and the Select Words page of the wizard will appear. 
7 In the Words text box, enter the words or phrases to use in your design, separated by a comma.

Not all of your words may be used. Use a word twice in your list if you want it to be frequent in the design.
You may find it easier to create the list in a text editor and paste it in.
If desired, deselect Upper case only to use upper and lower case letters, and select Use words once 
only if you do not want words repeated.

8 Set Margin to 1mm to place the words close to each other.
9 Reduce Font Size to 11mm to enable more words to fit into the fish outline.
10 Ensure that Random fonts is selected.

Random fonts will use a variety of fonts recommended for the selected Font Size. For example, both 
Antonia 10-20mm and Arial 08-14mm may be used when the Font Size is set to 11mm.

11 In Color Theme, select Blue from the drop-down menu. The outline and words now use various 
shades of blue.

12 In Orientation ensure that Random is selected.
For a different effect, choose Horizontal and Vertical or one of the other options.

13 Click Refresh Preview to use your updated settings.
14 Click Refresh Preview again. The arrangement of the words and the number of words used changes.
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15 Change the settings and use Refresh Preview until you are happy with the results.

16 Click Finish to place the design in the work area. Save  this original version, if desired.
The design is loaded as a Group, and each word is a lettering Block with Curve line types at Top and 
Bottom, and Constraint set to Free. You can mould each Block to almost any shape you wish.

17 At the bottom of the FilmStrip, click Reveal Groups , then click the yellow handle on one of the 
lettering Blocks. You can see the settings for the Block.

For more information on adjusting lettering Blocks, see Creating Lettering in the mySewnet™ Embroidery 
Reference Guide or Help.

18 Click and drag the handles on the block to mould it to the desired shape.
You can select different lettering Blocks in the FilmStrip. Use the Tab key, or Shift + Tab to move between the 
designs in the Group.

19 To change the font in a lettering Block, 
right-click the Block and select Properties in 
the Context menu.
If you want to mould a lettering Block to a 
larger size, a different font may look better. 
Check the size range before changing.

20 To add a word to the design, Copy  then 
Paste  one of the words, and move it to 
the desired position on the work area and in 
the FilmStrip. 
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21 Right-click the new word, and in the Letter Properties dialog box change the text and font. Click OK.
22 In the Color Select area on the Design Panel, click the thread color and set it to match the theme. 
23 Mould the new word to shape.

Add words to your design and mold them to shape, then Save  your finished design.
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17Project-in-the-Hoop Wizard

Overview
Use the Project-in-the-Hoop Wizard  to create an in-the-hoop design using your 
choice of project type, style and dimensions. Follow the PDF instructions to stitch out your 
project.

Project-in-the-Hoop Wizard
Use the Project-in-the-Hoop Wizard to create an in-the-hoop design using your choice of 
project type, style and dimensions.

Shortcuts

■ Create Tab: 
■ Keys: Alt, C, I

Using the Project-in-the-Hoop Wizard
Select a design Category and a Style, then enter the Dimensions of your project. Click the 
View PDF Instructions button to view and print a copy of the PDF stitchout instructions.

Select a project Category

Preview the project type

Select a project Style

Preview the project design

Set the Dimensions for your project

Click to view and print the PDF stitchout instructions
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After you click OK to select the project, read the instructions in 
the PDF, view how the project is constructed in the Design 
Player , and then make any customizations to the main 
design in the work area.

Ensure that you change only the decorative embroidery, and not the 
construction stitching. Preserve the order of the sections of the project.
Use the Tab key to step between the sections of the project.
Change the color of the construction stitching, and the 
decoration, to suit your fabric.

Save  your project, and then stitch it out in a suitable hoop, 
following the instructions.

Create a Phone Case Project
1 Click File at the top left to open the Welcome screen.
2 In the Welcome screen, click Blank Canvas  to start a new 

project. The Hoop selection dialog opens.
3 Set the hoop size to 260mm x 200mm - Universal Large Hoop 3, 

and set Orientation to Natural. Click OK.
4 Click the Create tab.
5 In the Create tab, click Project-in-the-Hoop . The Wizard 

opens.
6 In the Category drop-down menu, choose Phone Case.
7 In the Style drop-down menu, choose Multiwave. The phone case 

style is displayed.
8 Click the View PDF Instructions button. A PDF of the instructions 

is displayed.
9 Scroll down to view the instructions, and if desired print or save a 

copy.
To view the instructions again later, reopen the Wizard, select the 
same Category, and click View PDF Instructions.

10 Measure the phone, then enter the Width, Height and Thickness 
of the phone in the text boxes.

11 Click OK to load the project into the work area.
The hoop is considerably larger than the design. You can use a 
smaller hoop.
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12 In the Quick Access toolbar click Change Hoop , and set the hoop size to 
240mm x 150mm - Universal Large Hoop 2, with Orientation set to Natural.

13 On the FilmStrip, click Reveal Groups . The handles on the project become 
green, and contents of the Group can be seen in the FilmStrip.
The project is created as a Group. Use Reveal Groups to customize part of it.

14 In the FlimStrip, click to select the letter A embroidery.
The thread colors in the Color Select panel indicate whether a gray structural section, 
or a red decorative section is selected.

15 Right-click the A embroidery, and choose Properties in the context menu. The 
Letter Properties dialog box is displayed.

16 In the Letters text box, change the initial to that of the phone’s owner.
17 Click the drop-down arrow below Font, and in the font gallery scroll up to the 

Modern Category.
18 Select the font Rian 10-30mm. 

To squeeze more letters into the space, choose a smaller font, and adjust the lettering 
shape with the Handles menu.

19 Click OK to close the Letter Properties dialog box.
The pink for the letter is too similar to the color of the other 
stitching. A darker color would work better.

20 In the Design Panel, double-click the pink for the letter. The 
Color Selection dialog box opens.

21 Select a stronger color in the Quick Colors, and choose a final 
color among those near to the color that you selected.

22 Click OK to view the changed color.
23 Click the red MultiWave Fill stitching in the FilmStrip. It is 

selected in the Color Select area.
24 Right-click the stitching, and in the context menu select 

MultiWave Fill, and MultiWave Fill 1.
This is the fill for the bottom part of the phone case.

25 In the MultiWave Fill properties dialog box, select (check) Use 
Motifs, then click the Motif tab.

26 Select a motif Category and Pattern.
27 Reduce the size of the motif to suit the small size of the phone 

case., then click OK to view your changes.
28 Right-click the stitching, and in the context menu select 

MultiWave Fill, and MultiWave Fill 2.
This is the fill for the top part of the phone case.

29 In the MultiWave Fill properties dialog box, select (check) Use 
Motifs, then click the Motif tab.
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30 Select a motif Category and Pattern, and set the size 
as desired. Click OK.

31 In the Quick Access toolbar, click Design Player .
32 Play through the design to see how it will be 

stitched out.
You can also print a worksheet to view the structure of 
the project.
Click Save  to save your project, Export  it for 
your embroidery machine, then stitch it out.
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18Spiro Wizard

Overview
Use the Spiro Wizard  to create intricate spiral designs in multiple colors, using 
Running, Double or Triple stitch lines.

Spiro Wizard
Use the Spiro Wizard to create intricate spiral designs in multiple colors, with Running, 
Double or Triple stitch lines.

Shortcuts

■ Create Tab: 
■ Keys: Alt, C, S

Using the Spiro Wizard
Use the sliders to create your own unique spiral design. Select a number of petals (lobes). 
Add colors and lines to make your design more complex. Select a line type for your 
stitching from Running, Double and Triple stitch. Click OK to place your design on the 
work area.

Drag the sliders to create a unique design.

Your previous design will still be available if you re-open the Spiro Wizard during the same session.

Set the design size

Percentage size of design

Number of petals

Type of petal

Reset to the defaults

Select, add, move and delete colors

Change the design color

Use random settings

Curvature of the lines
Angle

Space between the lines

Offset the lines

Number of lines

Play through the designFade the other colors
Choose a stitch line type

Place the design 
on the work area
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Maximum Diameter
Use Maximum Diameter  to set the maximum size for your design. Use this to fit it to 
your chosen hoop, or to set the size of a spiral design element. Enter a number, or use the 
up and down arrows.

Random and Reset
• Click the Random button to show a different preset Spiro design for you to 

adjust. 
• Click Reset to return to the original default design.

If you have adjusted the existing design, a message will appear: "This will lose any changes. Do you want to 
continue?" Click OK to start on a new design, or Cancel to save your design.

Add, Move and Delete Colors
Select a color in the Color Select area to adjust the settings for that part of the spiral design.
Use Add Color  to add a new color spiral to your design, and use Remove Color  to 
delete the selected color from the design. Use Move Up  and Move Down  to 
change the position of colors within the design.

Thread Color
Use Thread Color  to change the selected color in the Color Selection dialog. See 
“Change an Existing Thread Color” on page 53.

Sliders
Use the sliders to transform the selected spiral design, or enter a number in the box.

Percent of Diameter
Use the Percent of Diameter  slider to set the size of the selected spiral design as a 
percentage of the value that you set in Maximum Diameter.

This option is only available when more than one color is in use.

Number of Petals
Use Number of Petals  to choose the number of petals for your design.

Petal Type
Use the Petal Type  slider to select the configuration of the petals for your design.

The number of Petal Types can vary considerably, depending on how many petals are in your design.

Curvature
Use Curvature  to change the curvature of the lines towards the center of the design.

The higher the Curvature, the more the lines will curve towards the center of the design.

Rotation
Use Rotation  to control the angle of the petals within the design.

This can be useful when offsetting one color from the next.
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Multiple Line Settings
Use the following sliders to change the settings in a multiple line design.

Number of Lines
Use Number of Lines  to set the number of lines using the path described by the 
settings above.

Number of Lines can be used to create a braided effect.

Curvature Spacing
Use Curvature Spacing  to adjust the distance from each other of the lines chosen with 
Number of Lines, and from the center of the design.

Rotation Offset
Use Rotation Offset  to rotate the design around the circle, so as to increase or 
decrease the overlap for the selected lines. 

Stitch Options
Click the Stitch Options button to select a line type for your spiral design. See “Stitch 
Options” on page 323.

Ghost Mode
Use Ghost Mode  to Fade the stitch colors that you are not adjusting.

Design Player
Use Design Player  to play through the design. See “Design Player” on page 46.

Stitch Options
Use the Stitch Options dialog box to select a line type for your spiral design.

Choose a stitch type

Set the stitch length

Set the maximum gap where a trim is not used
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Create a Spiral Design
1 Click the Create tab.
2 In the Create tab, click Spiro . The Wizard 

opens.
If you previously used the Spiro Wizard in this 
session it will open with the design that you 
created, otherwise the default settings are used. 
You can click Reset to return to the defaults.

3 At the top left of the Spiro Wizard dialog note 
that Maximum Diameter  is set to 100mm. 
This is the width of the design.

4 Look at the panel on the right, noting the 
default settings.
The top setting Thread Color  enables you to 
change the color of the selected line. Percent of 
Diameter  below it is only available when your 
design uses two or more colors.

5 Drag the Number of Petals  slider slowly to the far left, to the number 2. Petal Type  below is set 
to 1, now the only choice.
The number of options for a setting depends on the other settings used. If Number of Petals is set at 50, 19 
Petal Type options are available.

6 At the top, click Reset. There is a warning: "This will lose any changes. Do you want to continue?".
7 Click OK to return to the default settings.
8 Leaving the Number of Petals at the default 12, drag Petal Type  so as to see all of the four variants, 

finishing with setting 3.
9 Drag the Curvature  slider to the right from 50 to 73 (a flower), to 90, and then to 200. Move slowly 

so as to see the changing patterns.
You could also enter the number into the number box for a precise value.

10 Drag Rotation  a small distance to the left or 
right. The whole design rotates.

11 Set Number of Lines  to 3. The single line for 
the design is replaced by three parallel lines.

12 Drag Curvature Spacing  (now -8) to the 
right to 0. The three lines merge.
There is now zero space between the lines.

13 Drag Curvature Spacing further right to 20.
14 Then drag Rotation Offset  to the right very 

slowly. The lines rotate relative to each other.
15 Drag Rotation Offset to 15 to complete the first 

color for your design.
16 Below the color select box, click Add Color .
17 In the Color Selection dialog, choose yellow in 

the Quick Colors and click OK. There are now 
two colors in the color select, and the design is 
yellow.
For more information on color selection, see 
“Change an Existing Thread Color” on page 53.

18 Drag the Percent of Diameter  slider to 75% 
(from 100%). The new yellow design becomes 
smaller, revealing your original red design 
underneath.
The new color initially uses the same design as 
the color above. The original color is faded.

19 Click Ghost Mode . The red threads are now 
their original brightness.
Ghost Mode enables you to focus on the thread color that you are currently adjusting.
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20 Use the sliders to adjust your second design.
You can add more colors, or delete colors, and move colors up and down the color 
(stitch) sequence.

21 Click Stitch Options.
22 In the Stitch Options dialog, choose Triple Stitch.
23 Set Stitch Length to 2mm.

Use Maximum Gap to Trim to use Trims or stitches between your stitch lines. For 
example, use 2mm or 3mm for trims between spiral lines rather than stitches. 

24 Click OK to close Stitch Options.
25 In the Spiro Wizard dialog, click Design Player .

For more information on Design Player, see “Design Player” on page 46.
26 Click Play  to play through the stitches in your design, and 

click Cancel to finish.
27 In the Spiro Wizard dialog, click OK to place the design on the 

work area.
28 Click Settings  in the Notes and Settings area of the Design 

Panel.
29 Click Edit . The Settings dialog opens with the complete 

settings for your design.
You can use these settings to recreate the design in Spiro Wizard. 
Use File, Print to print a worksheet with these settings.

30 In the Create tab, click Spiro  again. The Spiro Wizard opens 
with your settings preserved.
If you previously used the Spiro Wizard in a session it will open 
with the design that you created.
If you close mySewnet™ Embroidery, the default settings will be 
used the next time you open Spiro Wizard.

31 Click Random. The warning message about losing settings is 
displayed.

32 Click OK to view a randomly created Spiro design.

To add a color within a Spiro Wizard design, use Insert Color Command  in the Modify tab or in 
mySewnet™ Stitch Editor to add a Color Change. See “Insert Color Command” on page 109.
To change the line type to a Motif Line, open the Spiro Wizard design in mySewnet™ Stitch Editor and in the 
Object tab select the line, then use Convert to change the line to use the motif of your choice.
Use the Morphing tools in mySewnet™ Stitch Editor to change your spiral into a swirl!
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19ExpressMonogram Wizard
Use the ExpressMonogram Wizard  to 
create a monogram of up to three letters. 
Select a font style, thread color, shape and 
size. Surround the monogram with a 
border. Alternatively, create a monogram 
with no border, then in the Frame tab add 
a Frame or Flourish, or a motif underline.

On the work area, use Save or Save As to save the 
monogram in a .vp4 file for later use.
Unless the monogram has been fixed as 
Embroidery Stitches, right-click at any 
time and choose Properties from the 
Context menu to return to the 
ExpressMonogram Wizard for 
adjustments.

If you resize the monogram it will be fixed as a group of embroideries.

ExpressMonogram Wizard
Select the ExpressMonogram Wizard  to create a monogram from a set of initials. The 
Monogram page of the ExpressMonogram Wizard will appear.

Select a font style, thread color, shape and size. Surround the monogram with a border. 
Alternatively, create a monogram with no border, then in the Frame tab add a Frame or 
Flourish, or a motif underline.

Progress through the pages using Next  and Back  to alter each setting, or click 
Finish  at any time.

Any existing monogram will be retained in the work area.

Shortcuts

■ Create Tab:  
■ Keys: Alt, C, M



mySewnet™ Embroidery   ExpressMonogram Wizard              327

Overview
1 In the Wizard tab, click ExpressMonogram Wizard  to start the Monogram Wizard.
2 In the Monogram page, select a monogram type for an embroidery. Enter the initial letters for the 

monogram, and select Full, Small or a combination of both from the letters gallery, then choose an 
envelope.

3 Use the Full Letter and Small Letter pages to select the style for the letters in the monogram. Choose 
the font, size, color, spacing and stitch options for the letters.

The Monogram fonts are recommended for use with the Classic envelopes that use SFS (small, full, small 
characters), as they are designed with mainly even width characters.
Check the size in the status bar as you progress, to ensure the embroidery will fit in the desired location.

4 Create a border automatically from the envelope. The border can have rounded or square corners, 
and if the spacing is large enough, letters can be bordered individually. The available border types are 
satin or motif line, and running or triple stitch. Optionally, add appliqué fabric and placement lines.
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You can set the properties for each, and select the thread color for stitching it.

5 Click Finish  to place the monogram in the work area. Its selection box will have pale green handles.
6 If desired, right-click at any time and choose Properties from the Context menu to return to the 

ExpressMonogram Wizard for adjustments.
On the work area, use Save or Save As to save the monogram in a .vp4 file for later use.
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Create a Monogram
1 Start the ExpressMonogram Wizard . The Monogram page opens.

2 Choose a monogram type from the gallery on the left. Select how many letters to use, and whether 
they are Full or Small.
The size of a Small letter is proportional to the Full monogram letter. You can use different fonts and colors 
for Small letters.

3 Enter the letters for your monogram in the boxes A, B and C.
For traditional monograms, letters are used in the order of given name, family name, middle name.
If the box for the letter is blank, a question mark will be inserted instead.

4 Select a monogram Envelope category and type from the 
gallery.
All the envelopes available use the number of Full and Small 
letters that you have chosen.
Choose an Envelope that uses the desired size ratio for your 
Full and Small letters.
You can return to this page later if you want to adjust the 
choices you made.
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5 Click Next . The Full Letter page appears.

In this page you can adjust the style and size of the large letters in the monogram, and the space between 
all letters.

6 In Font, select a font category and an individual font from the gallery. For example, select the font 
Curly UC 25-50mm in the Monogram category in the displayed list of fonts.

7 Select a Height  for the letter(s).
For best results, choose a size within the recommended range shown in the font name. The size is initially 
set to the middle of this range.

8 Change Width  to make the letters wider or narrower.
The Width setting is a proportion of the overall size.

9 You can click the Stitch Type drop-down list and change the properties for the stitching in the font. 
The drop-down list may be grayed out (unavailable), depending on which stitch types are present in 
the font.
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10 Click on a thread color to display the Color 
Selection dialog box. Here you can select 
another shade by clicking on it, or by entering 
the thread number in the Find Thread text box. 
Optionally, add a thread or needle effect to the 
selected color block. Click OK to close.

11 Use Spacing 1 and Spacing 2 to adjust the 
amount of space in millimeters between the 
letters. Use negative values to interlock letters, if 
desired.
You may need to adjust the spacing after selecting 
the font for the small letters. 
Spacing will affect whether individual borders are 
created around the letters in the monogram.

12 Click Next . If you selected a monogram that included small letters, as well as large ones, the Small 
Letter page will appear. Otherwise the Border page will appear.

13 In this page, adjust the style and color of the small letters in the monogram.
Deselect ’Alternative style’ to use the same font, color and thread as for the Full letters.

14 Make any desired changes to the font and color of the small letters.
To match the color of a Small letter to a Full letter, click the Full Letter tab, or Back , to return to the Full 
Letter page, place the arrow pointer over the desired thread color and note its number. Then return to the 
Small Letter page, click the thread color to be changed, enter the color number for the other color in the 
Find Thread box, and click OK. The colors will now match.

15 Click Next . The Border page appears.
16 Increase Margin to give more room around the letters (the amount of space around letters is also 

affected by the Spacing settings in the Full Letter page).
17 Choose whether to use rounded corners and individual letter borders for the monogram letters.

The individual borders will only show if there is enough space between the letters.
18 Select a Stitch Type, and use Options  to set its properties. 
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19 Add Appliqué  if desired and select an appliqué fabric and style.

You can also change the border thread color.
20 Click Finish  to close the wizard and place the embroidery in the work area.
21 The monogram on the work area has pale green handles. Click Save As  to save it as a .vp4 file.
22 To edit the placed monogram, right-click it and select Properties from the Context menu. The 

ExpressMonogram Wizard reopens.
If you resize the monogram it will be fixed as a group of embroideries.
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Monogram

In the Monogram page, select the number and size of letters for the monogram 
embroidery. Enter the letters for those initials, and select an envelope category and type.

A preview of the Monogram is shown at the bottom of the screen.

Letters
Select the number of letters, and whether they are to be small or full. Then enter the 
letters for the monogram.

For traditional monograms, letters are used in the order of given name, family name, middle name.
If you use a Monogram font, only upper case letters will be used in the embroidery, even if you entered 
lower case letters.

Envelope
Select an envelope category and type from the gallery.

The envelope that you choose affects the relative size of the full and small letters. For example, the small 
letters in the Small, Full, Small (SFS) Straight1 category are relatively smaller than those in the SFS 
Straight2 category.

Preview
A preview of the embroidered monogram, and its stitch count , width , height  and 
number of color blocks  is displayed.

Zoom Bar
Use the Zoom Bar at the bottom of the screen to zoom in or out from the center of the 
monogram.
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Use the slider to zoom in or out of the monogram, or click on the Zoom Out  or Zoom 
In  icons.

Back 
Go to the Border page.

Next 
Go to the Full Letter page.

Alternatively, click the Full Letter tab.

Finish 
Accept the final design and close the ExpressMonogram Wizard.

Cancel 
Close the ExpressMonogram Wizard without creating a monogram.
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Full Letter

Use the Full Letter page to select how the large letters in the monogram are to be 
displayed.

Choose the font, size, stitch type, thread color and spacing of the letters.

Font
Select a font category, and an individual 
font, from the gallery. The font name 
specifies the recommended size range 
for each font.
The initial font size for Full letters is in the 
middle of the recommended range.
The Monogram fonts are recommended for 
use with the Classic envelopes that use SFS 
(small, full, small characters), as they are 
designed with mainly even width 
characters.

Height
Set the Height  in millimeters as 
desired, from 3mm to 200mm.

This sets the height of the 'A' character in 
the font. All other characters and symbols are sized relative to the height of 'A'. The size is initially set to a 
medium size for the chosen font.

Width
If desired, change the Width percentage  of the Full letters. Change the width from 25% 
to 400% of the default setting.
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Stitch Type
Select one of the stitch types  for the font from the drop-down list. The properties dialog 
for the stitch type appears. Use the properties dialog box to change the border and fill for 
the lettering. See “Choosing Stitch Properties” on page 454.

When you have finished, click OK to apply your changes to the lettering.

The Stitch Type drop-down will only be available if the font contains at least one stitch type with editable 
properties.

Thread Colors
Thread Colors enables you to select the color used when embroidering the letters. Click 
the thread to open the Color Selection dialog box. Optionally, add a thread or needle 
effect to the selected color block.

For information on changing thread colors, see “Change an Existing Thread Color” on page 53.

Spacing
Use Spacing to set the distance in millimeters between the letters in the monogram. Use 
negative values to interlock letters, if desired.

Spacing will affect whether individual borders are created around the monogram letters when a border is 
used.
The minimum is -51.0mm and the maximum is 51.0mm. The initial setting is 2.0mm.

Zoom Bar
Use the Zoom Bar at the bottom of the screen to zoom in or out 
from the center of the monogram.

Use the slider to zoom in or out of the monogram, or click on the Zoom Out  or Zoom 
In  icons.

Preview
A preview of the embroidered monogram, and its stitch count , width , height  and 
number of color blocks  is displayed.

Back 
Return to the Monogram page.

Next 
Go to the Small Letter page if you are also using small letters, otherwise go to the Border 
page.

Finish 
Accept the final design and close the ExpressMonogram Wizard.

Cancel 
Close the ExpressMonogram Wizard without creating a monogram.
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Small Letter

The Small Letter page is displayed if you selected an envelope with small letters in the 
Monogram page.

Use the Small Letter page to select how the small letters in the monogram are to be 
displayed.

The relative size of the small and large letters is set by the envelope selected in the Monogram page.

You can check that your small letters are within the recommended range by looking at the Height  for 
the small letters. The small letter height can be viewed, but not edited.
Choose the font, width, stitch type and color of the letters.

Alternative Style
If this option is selected, the small letters in the monogram can be a different font, color 
and size from the other letters. 

If this option is not selected, the color and style of the small letters in the monogram will 
be identical to the other letters, and all other options on this page will be grayed out.

This option is selected by default.
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Font
Select a font category, and an 
individual font, from the gallery. The 
font name specifies the 
recommended size range for each 
font.

Height
Use Height  to view the height of 
the small letters in millimeters.

This shows the height of the 'A' character in 
the font, as calculated from the Full Letter 
size and the selected envelope. All other 
characters and symbols are sized relative to 
the height of 'A'

Width
If desired, change the Width percentage  of the small letters. Change the width from 
25% to 400% of the default setting.

Thread Color
Thread Color enables you to select the color used when embroidering the letters. Click the 
thread to open the Color Selection dialog box. Optionally, add a thread or needle effect to 
the selected color block.

For information on changing thread colors, see “Change an Existing Thread Color” on page 53.

Stitch Type
Select one of the stitch types  for the font from the drop-down list. The properties dialog 
for the stitch type appears. Use the properties dialog box to change the border and fill for 
the lettering. See “Choosing Stitch Properties” on page 454.

When you have finished, click OK to apply your changes to the lettering.

The Stitch Type drop-down will only be available if the font contains at least one stitch type with editable 
properties.

Zoom Bar
Use the Zoom Bar at the bottom of the screen to zoom in or out from the center of the 
monogram.

Use the slider to zoom in or out of the monogram, or click on the Zoom Out  or Zoom 
In  icons.

Preview
A preview of the embroidered monogram, and its stitch count , width , height  and 
number of color blocks  is displayed.
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Back 
Return to the Full Letter page.

Next 
Go to the Border page.

Finish 
Accept the final design and close the ExpressMonogram Wizard.

Cancel 
Close the ExpressMonogram Wizard without creating a monogram.
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Border

Use the Border page of the ExpressMonogram Wizard to place a border around a 
monogram, to select the thread color, and to add appliqué fabric to the monogram. 

The border can have rounded or square corners, and letters can be bordered individually. 
The available border types are satin border, running stitch, triple stitch and motif line. 
Optionally, add appliqué fabric and placement lines. Click Options  to set the properties 
for each.

Margin
Use Margin to leave space between the monogram and the border around it. 

The minimum Margin is zero. The maximum Margin is 20mm. The initial setting is 6mm.

Rounded Corners
Select this option to smooth the corners of the border around the monogram.

By default, this option is selected.

Individual Letter Border
Select this option to place a border between the individual 
letters in the monogram.

Borders will not appear between the letters in the monogram if they are 
too close together. 
To make the individual letter borders visible, select the Full Letter tab, or 
click Back until you reach the Full Letter page, and increase Spacing 1 and Spacing 2. Click the Border tab 
to return to the Border page.
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Stitch Types
The stitch types available for automatically created borders are:

■ Satin Line: see “Satin Line” on page 497.
■ Motif Line: see “Motif Line” on page 498.
■ Running Stitch: see “Running Stitch” on page 493.
■ Triple Stitch: see “Triple Stitch” on page 496.

Click Options  to set the properties for each.

Appliqué
Click Add Appliqué  to use an appliqué piece for the monogram. Use Select Fabric  
to choose the fabric for the monogram, and click Options  to select the appliqué type.

See “Appliqué Selection” on page 192 and “Appliqué Options” on page 205.

Thread Color
Thread Color enables you to select the color used for the border.

Click the Thread Color icon  to open the Color Selection dialog box. Optionally, add a 
thread or needle effect to the selected color block.

For information on changing thread colors, see “Change an Existing Thread Color” on page 53.

Zoom Bar
Use the Zoom Bar at the bottom of the screen to zoom in or out 
from the center of the monogram.

Use the slider to zoom in or out of the monogram, or click on the Zoom Out  or Zoom 
In  icons.

Preview
A preview of the embroidered monogram, and its stitch count , width , height  and 
number of color blocks  is displayed. The design information may change when the 
embroidery is exported, depending on the Optimize for Sewing Options.

Back 
Return to the Small Letter or Full Letter page.

Next 
Go to the Monogram page. 

Finish 
Accept the final design and close the ExpressMonogram Wizard.

Cancel 
Close the ExpressMonogram Wizard without creating a monogram.
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Adjusting Monograms
When a monogram is placed on the work area it has pale 
green handles. These indicate that it can still be adjusted in 
the ExpressMonogram Wizard.

To open a monogram in the ExpressMonogram Wizard, 
right-click it and select Properties in the Context menu.

A monogram can be saved, rotated and copied in its original 
form. However if it is resized, it will be fixed as a group of 
embroideries, and the lettering properties cannot be 
changed. After resizing a group, the percentage size change from the original cannot be 
seen in the Modify Design dialog box.

A monogram saved as part of a group can be selected using Reveal Groups and reopened in the 
ExpressMonogram Wizard. When a monogram is exported it is fixed as stitches and uses the Combine and 
ColorSort settings in the Export dialog box.
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Create a Monogram with a Border
1 Click File at the top left to open the Welcome screen.
2 In the Welcome screen, click Blank Canvas  to start a new project. The Hoop selection dialog 

opens.
3 In the Universal Hoop Group, set the Hoop Size to100mm x 100mm - Universal Square Hoop 1. Click 

OK.
4 In the Create tab, click ExpressMonogram . The Monogram page of the ExpressMonogram Wizard 

will appear.

5 In the gallery at the top left, select the Small - Full - Small layout. This 
will produce a monogram with characters sized proportionally: small, 
full, small (SFS).

6 Enter the letters ’E’, ’S’ and ’J’ in boxes A, B and C.
E, S and J represent the name Elizabeth Jane Smith, using traditional 
monogram style where letters are used in the order of given name, family 
name, middle name. If the letters were all full size, EJS could be used as an 
alternative.

7 In the Envelopes gallery, select the second envelope in the Classic 1 
category. Its name is SFS_Classic02.
If you position the arrow pointer over a thumbnail without clicking, the 
name of the envelope will be shown.
The name stands for Small-Full-Small, using the second envelope in the 
Classic1 category. 
In this envelope the small characters are relatively larger than those in 
the envelope to the left, proportions which are well suited to the curly 
initials to be used.
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8 Click Next , or click the Full Letter tab. The Full Letter page will appear.

9 Click to open the Font gallery at the top left.
10 Click and drag the scroll bar on the side of the font list to see all the fonts in the Monogram category.

This category includes fonts that are recommended for the Classic envelopes using SFS (small, full, small 
characters).

11 Click to select the font Curly UC 15-30mm.

12 Leave the font size at 23mm.
The initial size of a font is in the middle of the recommended font size range.

Notice the Height  and Width  measurements at the bottom of the window have changed. Use these 
as a guide to the size of your final monogram as you try different options. 
If you have a desired final size you may need to alter the font size.

13 Move the arrow pointer over the pink thread in the Thread Colors box and a popup description 
appears.

14 Click the pink thread color, and in the Thread Range drop-down list select Robison-Anton Rayon 40. 
The thread will change to Floral Pink, number 2415. Click OK.
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This only affects the letter S as it is the only ’Full’ letter.
15 Click Next , or click the Small Letter tab, and the Small Letter page will appear.

16 Ensure that ’Alternative style’ is selected.
If  Alternative style is not selected, the same font will be used for small letters as for the full letters.

17 In the Font gallery, select Curly UC 15-30mm in 
the Monogram category for the small letters.
Notice the Height  measurement at the top of 
the window has changed. This is the height of the 
letter ’A’ for the small letter font. It should be 
within the recommended size range for the font 
(as mentioned in the font name). If the height is 
outside the recommended range, you may need 
to return to the Monogram page and change the 
envelope, or use the Full Letter page to change the 
full letter size.

18 Click the pink color and the Color Selection 
dialog box appears.

19 In the Thread Range drop-down list select 
Robison-Anton Rayon 40.

20 Click pale pink in the Quick Colors (the second 
color square in the bottom row) and 2501 (Petal 
Pink) will be selected.

21 Click OK. The smaller letters are now a pale pink.
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22 Click Next , or click the Border tab, and the Border page will appear.

You can use a Motif Line , a Satin Line , or a Running Stitch  or Triple Stitch  line. The default 
border is a green satin line.

23 Select Motif Line . The solid green border is replaced by a line of stars.
24 Select Satin Line  and the satin stitches appear again.
25 Click the Thread Color icon  to display the Color Selection dialog box.
26 Ensure that ’Robison-Anton Rayon 40’ is selected.
27 Click pale pink in the Quick Colors (the second color square in the bottom row) 

and 2501 (Petal Pink) will be selected.
28 Click OK to close the Color Selection box. The satin border of the monogram is now pink.
29 Click Add Appliqué . A gray fabric is placed behind the letters in the monogram. A matching fabric 

would enhance the embroidery.
30 Click Select Fabric  to open the Appliqué Selection dialog box.
31 Click the Color button above the Quick Colors palette. The Colors dialog box 

appears, with the Standard tab selected.
32 In the hexagonal matrix, click the medium pink hexagon sixth from the right 

(just to the right of the central white hexagon), then click OK. The new color 
is shown on the Color button and in the fabric preview. 

33 Click OK to select the new fabric color.
Use Quick Fabric colors to preview your embroideries on a color similar to the 
fabric that you will use. Alternatively, select a patterned fabric.

34 Click the ’Individual Letter Border’ checkbox to place lines between the 
letters in the monogram.
Although ’Individual Letter Border’ is now checked, The borders do not appear between the letters as they 
are relatively closely spaced.

35 To see individual letter borders in the monogram, the spacing must 
be increased. Click the Full Letter tab to return to the Full Letter page.

36 Click the up arrow next to 1 in the Spacing section (the distance 
between the first and second letters) to increase it to 15mm. 

37 Click the up arrow next to 2 in Spacing (the distance between the 
second and third letters) to increase it to 15mm. The letters now have 
individual borders.
This format may be desired when embroidering badges.
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Notice that if you position the arrow pointer over a measurement box without clicking, the alternative 
measurement will be shown. You may also enter the alternative measurement with units of mm or " 
(including fractions) and it will be automatically converted.

38 For a traditional monogram effect, the letters may interlock. In the Full Letter page, set Spacing 1 to -3 
mm, and set Spacing 2 to -4 mm.
The new positions of the letters can be seen in the Preview pane below. The border adjusts to fit.

39 Click Finish  to close the wizard. The monogram is then displayed in the work area.

40 In the Notes and Settings box, click Settings .

If you cannot see all the text, click Edit .
The Settings give information on the letters, dimensions and font used in the monogram, including the 
font size for the large letter, and any patterns and fills used. This information can be used to recreate the 
monogram later, if it becomes fixed as embroidery.
Click the Edit button if you wish to edit these notes. The Settings dialog box is displayed. Amend the 
Settings as desired, then click OK to save your edits.

41 Click Save As  to save the monogram in an adjustable form. 
42 In the Save As dialog box, browse to \mySewnet\My Designs, and save it as EJS_Curly.

When you reopen this .vp4 file, right-click the monogram and select Properties in the Context menu to 
open the ExpressMonogram Wizard. 

43 Click Export  to export the monogram according to the desired Optimize for Sewing Options, for 
example to ColorSort the monogram to use the minimum number of thread changes.

44 In the Export dialog box, ensure that .vp4 is selected and click OK.
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45 In the Save As dialog box, browse to \mySewnet\My Designs, and save the embroidery as 
EJS_Curly_exported.
When a monogram is exported it is fixed as an embroidery, and can no longer be adjusted in the 
ExpressMonogram Wizard.
You could use the Background Wizard to preview the use of this monogram on a blouse or towel. See 
“Backgrounds” on page 162".

Create a Two Letter Monogram
1 Click File at the top left to open the Welcome screen.
2 In the Welcome screen, click Blank Canvas  to start a new project. The Hoop selection dialog 

opens.
3 In the Universal Hoop Group, set the Hoop Size to150mm x 150mm - Universal Square Hoop 1. Click 

OK.
4 In the Create tab, click ExpressMonogram Wizard . The Monogram page of the ExpressMonogram 

Wizard will appear.
5 In the gallery at the top left, select the Full - Full layout. This will produce a monogram with two equal 

sized characters: full, full (FF).
6 Enter the letters ’A’ and ’D’ in boxes A and B.
7 In the Envelope gallery, scroll down to the third envelope in the Straight1 category. Its name is 

FF_Straight03.

This is for Full-Full, using the third envelope in the Straight1 category.
8 Click Next , or click the Full Letter tab. The Full Letter page appears.
9 Click to open the Font gallery at the top left.
10 Click and drag the scroll bar on the side of the font list to see all the fonts in the Display category.
11 Click to select the font Revue UC 25-120mm MW.

The MW suffix indicates that this font uses a MultiWave Fill.
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12 Leave the font size at 73mm.

13 Click the Stitch Type  drop-down list and select MultiWave Fill. The MultiWave Fill options dialog 
appears.
The MultiWave Fill options dialog box enables you to edit the properties of the fill for this font.

14 Select the Use Motifs checkbox.
15 Click the Motif tab. The motif properties appear, with the 

motif set to a star.
16 Set the Group to Universal and the Category to 

Candlewicking 1. 
17 In the Pattern drop-down list, ensure that Pattern 1 is 

selected.
18 Ensure that Proportional is deselected, and set the 

Height to 1.8mm. 
19 Set the Width to 2.0mm.
20 Click OK to close the MultiWave Fill options dialog box.

The fill now has a striking candlewick pattern.
21 Ensure that Spacing 1 and Spacing 2 are both set to 

2mm.
22 Click Next . The Border page appears.

As there are no small letters, the Small Letter page is not 
displayed.
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23 Click Border  to remove the border around the monogram.

24 Click Finish  to close the wizard. The monogram is displayed in the mySewnet™ Embroidery work 
area.

25 Click Save As  to save the monogram in an adjustable form.
26 In the Save As dialog box, browse to \mySewnet\My Designs, and save the embroidery as AD.

You can now add a frame to the monogram in the Frame tab.
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20Creating Lettering
You can create lettering to personalize your embroidery project using single or multicolor 
fonts (lettering styles) and fonts of special characters in the Letter tab.

Choose the font, line format, size, stitch type and thread color. Display the lettering as if 
ColorSorted, or vary the colors of some characters. Place lettering around your 
embroidery, or anywhere on the work area. Lettering can be altered, including the font, 
resized with constant stitch density, and the stitch properties adjusted, even after saving 
until it is fixed as embroidery. 

Font means lettering style. The current font and the category where it is stored are shown in the Font 
section of the Letter tab.
Lettering is created using the settings on the Letter tab from the fonts available in 
mySewnet™ Embroidery. Alternatively use the ExpressMonogram Wizard . 

Use Name Changer  to create a series of embroideries with varied lettering 
automatically from the same template design.

Use Font Manager  to search for fonts by name or size, and to create, rename, duplicate 
and delete user generated fonts. Use the QuickFont Wizard  to create new fonts for 
mySewnet™ Embroidery from any TrueType® or OpenType® font on your computer. Import 
embroidered letters to create a font with Import Font From Embroideries . Additional 
fonts may be created and edited using the mySewnet™ Font Digitizing  module. 

When first starting mySewnet™ Embroidery, Georgia 20-40mm in the Traditional category is selected. If 
you have used the Letter tab previously, the last font is remembered.
For more information on the Line, Satin and Fill properties for fonts and SuperDesigns, see “Choosing 
Stitch Properties” on page 454.

Choose a font

Manage, create & delete fonts

Enter some text
Place the lettering in the work areaSet the font size & layout

Choose a Shape for your lettering

Set the connection type

Set the stitch type options

Set alignment
and spacing

Minimize the number of colors

Create many designs from a template
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Create Lettering
1 Click File, Preferences  and ensure Check 

Spelling is selected and the language is set 
to English US. 

2 Click the Letter tab.
3 Click the arrow to the right of the font, and 

the font gallery appears.
4 Scroll up or down to select a font from one 

of the font categories.
Alternatively, use the up and down arrows on 
the Font section of the Letter tab to see fonts 
one at a time.
For more information on fonts, see “Font 
Selection” on page 354.

5 Set the Size in millimeters as desired, from 
3mm to 200mm.
This sets the height of the 'A' character in the 
font. Other characters and symbols are sized 
accordingly. See “Font Size” on page 355.

6 Click in the Letters text box and the pointer changes to the I-bar pointer.
If needed, click and drag to highlight any existing text and overwrite it. 

7 Enter your desired text, pressing Enter to create more than one line of text.
Right–click to view alternatives for words underlined in red by the spelling checker.
Some Lettering Shapes can only use one line of text. See “Lettering Shapes” on page 360.

8 Adjust Gap to change the spacing between the letters. Click the arrows, or enter a value.
Negative values move letters closer together, and positive values move them farther apart. 

9 Click the arrows for percent Width  and Height  to change the proportions of the lettering from 
25% to 400%. Alternatively, enter a size in the number box.

10 Choose a Lettering Shape. See “Lettering Shapes” on page 360.
You can reverse the order of letters, position (or kern) letters individually, or use Step to rotate the 
letters at a different angle from the line. See “Fit Lettering to a Line” on page 363.

11 Select Trim  or Running Stitch  as the connection method.
Use Running Stitch connection for small single-color lettering with Nearest Point fonts.

12 Ensure that ColorSort is selected, to display the lettering as if ColorSorted, with the minimum number 
of color blocks.
Only deselect ColorSort if you want to change the color for some letters.

13 Choose a line or fill type from the Stitch Type  drop-down menu, and the properties dialog box for 
the stitch type opens. See “Choosing Stitch Properties” on page 454.

14 Change the stitch properties for the lettering in the properties dialog box, for example the density, 
pattern, angle or stitch length. Click OK to close the dialog.

15 Select the alignment of the line of lettering. Click Left , Center  or Right , as desired.
16 Click the arrows for Line Spacing to set the distance between multiple lines of text.

Alternatively, enter a size in the number box.
17 Click Apply . The lettering appears in the work area, leaving any existing lettering unchanged. 

New lettering is added to the work area each time you click Apply. Any previous lettering is left unchanged. 
The circular Lettering Shapes are centered around the selected embroidery(ies) or group when they are 
added to the work area. Other Lettering Shapes are placed below the selected embroidery(ies) or group.

18 Right–click the lettering and choose Properties to adjust the lettering properties. See “Letter 
Properties” on page 374.
To change lettering after you have clicked Apply, use the Letter Properties dialog box. See “Letter 
Properties” on page 374.

19 Drag the handles on the lettering to resize the lettering, or adjust the proportions for the lettering. 
Hold the Shift key for most lettering shapes to keep the proportions as you resize. Hold the Ctrl key 
for most lettering shapes to resize from the center. See “Lettering Shapes” on page 360.
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Alternatively, use the ExpressMonogram Wizard  to create a one, two or three letter monogram, and 
add a border automatically.

Searching for Lettering
1 Click File, Preferences  and ensure Check 

Spelling is selected and the language is set to 
English US. 

2 Click the Letter tab.
3 Click Font Manager .
4 To search for a font by name, at the bottom of the 

Font Manager dialog in the Search box, enter the 
name of the font or font category that you want 
to find.
Part of the name will narrow the list of fonts 
displayed, so a search for ’Athletic’ will display fonts 
from the Applique, Foam, Fun and Monogram 
Categories. 

5 Click Clear to remove the text from the search 
box.

6 To search for a font by size, select (check) the Size 
checkbox to enable searching by size.

7 Enter the desired Size for the font in the Size 
number box.

8 To choose a size range, adjust the number in the 
Range  box. The list of displayed fonts will 
change.
For example, set Size to 5mm, and the Range to 
5mm, to select a small font for a quilt label. You 
could also set an exact size (Range 0mm) to find an 
imported embroidery font.
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Font Selection
Font means lettering style. The font currently selected is displayed in the box in the Font 
section of the Letter tab. While mySewnet™ Embroidery remains open, the most recently 
used font is remembered.

Samples are shown in the Font Guides, together with keys for alternative alphabets used 
in some fonts in the National category. The Font Guides also indicate the underlay 
(packing) used by each font.

The category called MyFonts is the default category for fonts you create. It is initially empty until you create 

new fonts with the QuickFont Wizard .

Font Category
Click the drop-down arrow on the right of the font gallery and scroll through the list of 
fonts by category. There are 18 themed font categories, in addition to My Fonts: 

Shortcut
■ Font Gallery - Keys: Alt, L, F

Appliqué Fonts for use with appliqué fabrics.

Children Child–themed and "cute" fonts such as fonts similar to children’s writing and animal 
fonts.

Display Decorative fonts using specialty and pattern fills, often used in large sizes.

Effects Fonts using special thread colors and needles such as needle felting, twin needle and 
wing needle.

Elegant Stylish fonts with a heritage feeling, such as gothic and illuminated alphabets.

Floral Fonts with leaves and flowers decorating the letters.

Foam Fonts for use with puffy foam for a raised 3D effect.

Fun Informal fonts, such as athletic or party fonts.

Future Informal fonts with a hi-tech theme.

Modern Fonts with 'clean' designs in modern styles.

Monogram These fonts have most characters of equal width, designed for use in monograms. 
They are all uppercase only.

My Fonts My Fonts is the default category for fonts you create.

National Fonts associated with particular cultures, or alternative alphabets such as Greek and 
Hebrew.

Nearest Point Nearest point fonts use special logic to determine the best way to join characters 
together. There are four versions of each character to enable the special joining 
method. Nearest Point fonts are ideally used with Running Stitch connection.

Retro Classic Art Nouveau and Art Deco style fonts.

Scary Informal fonts with a spooky or horror theme.

Script Script fonts have a special joining method where all adjacent lowercase characters 
are directly joined together and are not affected by the Gap setting. This is used to 
give an appearance of handwriting in different styles.

Traditional Old-fashioned fonts.

Wild West Informal fonts with a cowboy theme.
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Font Name
Font names include information in addition to the name of the lettering style. All font 
names include the recommended size range, and other information is often included.

Font Type

Recommended Font Size
A recommended font size is included in the name. For instance, 25-120mm indicates the 
font is recommended for use at sizes from 25mm to 120mm.

SuperFonts
For SuperFonts provided in different stitch type variations, a stitch type abbreviation is 
also present at the end of the name, for example SF for Spiral Fill.

Examples
• Revue 2C UC 25-120mm SF in the Display category: this font uses two colors (2C), is 

uppercase only, has a recommended size range of 25mm to 120mm, and uses Spiral Fill.
• Antonia NP 05-10mm in the Nearest Point category: this font is a Nearest Point font and 

has a recommended size range of 5mm to 10mm.

Font Size
Font size can be set from 3mm to 200mm. This is the height of the uppercase 'A' character 
in the font, and all other characters are sized relative to the height of 'A'. Fonts are initially 
set at the minimum recommended size for the font.

The recommended font size forms part of the name. For instance, Corinthian 15-35mm 
should be used with Size set from 15mm to 35mm. 

In the National fonts using alternative alphabets, the character in the 'A' is used as the 
basis for sizing the characters.

If you set a satin font to a very large size, use Satin Properties to choose a pattern which 
will prevent loose stitching that may catch and pull easily. See “Satin Column” on 
page 485.

Once lettering has been fixed (converted to an embroidery) it can only be scaled and 
resized in the same way as any other embroidery. If further adjustments are required, 
place the text again as new lettering.

2C The font uses two colors (also 3C etc.) NP Nearest Point font

LC Lowercase only font UC Uppercase only font

CF Contour Fill MW MultiWave Fill SF Spiral Fill

EF Echo Fill QS QuiltStipple Fill SH Shape Fill

MF Motif Fill RF Radial Fill XH Crosshatch Fill

CH Curved Crosshatch Fill ML Motif Line
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Height and Width
Use percentage Width  and Height  to adjust the proportions of new lettering. For 
example, to make characters taller without increasing the width, increase the Height.

Set percentage Width  and Height  from 25% to 400%, in steps of 1%. The settings 
stay the same until you change them or mySewnet™ Embroidery is closed. Both Width and 
Height are set to 100% each time mySewnet™ Embroidery is started. 

Use Letter Properties to adjust Height and Width for individual blocks of lettering. See “Letter Properties” on 
page 374.

Gap
Use Gap to change the spacing between characters in a line of lettering. A negative value 
brings the letters closer together and a positive value moves them farther apart. 

Lowercase characters in Script fonts are not affected by the Gap setting.
Set the Gap from -99 to +99. Type in numbers, or use the arrows to increase or decrease 
the Gap. Click Apply  to see the effect on lettering. If you have used the Letter tab 
previously the last setting is remembered. The Gap may be adjusted for individual blocks 
of lettering in Letter Properties.

The Gap is initially set to 0 each time mySewnet™ Embroidery is started.

Increasing the Gap setting is recommended for Perspective lettering.

Automatic Kerning
Characters are spaced by automatic kerning according to the way that adjacent pairs of 
characters fit together. For example, the letters 'AV' need less space between them than 
'AB' because of the shape of the characters. The Gap setting then increases or decreases 
the spacing set by automatic kerning.

Script fonts have a special joining method where all adjacent lowercase characters are directly joined 
together and are not affected by the Gap setting.
The Gap is based on the width of the A character. A Gap of 1.0 is equal to 6% of the width 
of the A character.

To set the spacing between specific letters, set the letters to Individual in the Letter 
window. See “Individual Letter Monogram” on page 390.

Connection
The connection method selects how the characters are joined together. Choose Trim  
or Running Stitch , as desired.

Running Stitch connection is recommended for small lettering using Nearest Point fonts.

Shortcut
Keys: Alt, L, C

Trim
When Trim  connection is selected, the letters are joined with movement stitches.
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Running Stitch
When Running Stitch  connection is selected, the letters are joined with small stitches. 
Use Running Stitch connection for small lettering with Nearest Point fonts.

ColorSort
Use ColorSort to display the lettering with the minimum number of color blocks. By 
default ColorSort is selected.

Ensure that ColorSort is selected unless you want to vary the color of specific characters in the lettering.

Shortcut
Keys: Alt, L, O

Stitch Type
Use Stitch Type to alter the appearance of the stitching used in the lettering.

If desired, select a line or fill type from the Stitch Type  drop-down menu to open the 
properties dialog box for the stitch type. Use the properties dialog box to alter the 
appearance of stitching in the lettering. See “Choosing Stitch Properties” on page 454.

If there is more than one stitch area of a particular type in the font, the drop-down menu 
will show that stitch type in a numbered list; for example, Pattern Fill 1, Pattern Fill 2.

If the Stitch Type area is grayed out (unavailable), this means that the font was designed with properties 
that cannot be edited. This occurs with Foam fonts, that have special settings to ensure the embroidery 
foam is cut. It also occurs with a few very complex fonts that have many different fill patterns in different 
letters, or multigradient and multicolor fills, such as Acorn 6C UC 35-60mm in the Floral category.

Shortcut
Keys: Alt, L, I

Line Formatting
Use line formatting to control how multiple lines of text are arranged relative to each 
other.

Alignment
All text is initially created with center  alignment. Use the Alignment buttons to 
alternatively select left  or right  alignment.

The Alignment setting does not affect circular lettering shapes.

Shortcuts

Spacing
Use Spacing to change the distance between multiple lines of text. The default spacing is 
1.2, and can be adjusted from 1.0 to 5.0.

Left Keys: Alt, L, LL

Center Keys: Alt, L, LC

Right Keys: Alt, L, LR
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The Spacing is based on the height of the A character. Spacing of 1.0 is equal to the height of the A 
character, plus 6%. If you have lower case lettering with descenders (the tails below the baseline on the g, p, 
q and y characters), you may wish to increase the Spacing to 1.5.

Shortcut
Keys: Alt, L, LS

Apply
Use Apply  to place the lettering in the work area.

Shortcut
Keys: Alt, L, A

Appliqué, Effects and Foam Fonts
For appliqué fonts, SuperDesigns and Frames, the fabric can be changed as well as some 
of the border settings. For example, in Stitch Type  select Appliqué Fabric, and in the 
Appliqué Selection dialog change the fabric, angle and margin. See “Appliqué Selection” 
on page 192. The appliqué placement stitching cannot be edited, but the position of the 
placement line may be adjusted to match the appliqué piece margin.

The position of the pattern in an appliqué fabric may only be changed after fixing as stitches.
For Foam fonts and frames, only the color can be changed. The Stitch Type area is 
unavailable, and no properties can be selected in the Context menu. 

Special instructions are displayed for stitching out appliqué or foam fonts, SuperDesigns 
and frames. The instructions can be previewed in the Design Player.

For Effects such as Felting Needle, Twin Needle and Wing Needle you can change the 
stitch properties in Stitch Type  or in the Context menu after creation. Change the 
Felting Needle color from the color select area in the Design Panel. Change to the 
appropriate needle before stitching.

Stitching out Appliqué Lettering
Appliqué font characters are designed to be stitched out in a particular sequence. They 
are created with the standard appliqué options, to trim on the machine. Preview the two 
stops in the Design Player, with instructions to place the fabric and to trim it. These 
instructions are also present on the printed worksheet.

If you are using pre-cut pieces (with outlines created in Export Appliqué Pieces for a fabric cutter or 
INSPIRA® Cutwork Needles), the second stop can be ignored as there is no need to trim. It may also be 
useful to match the placement line to the appliqué piece margin, to ensure the placement line is visible.
When stitching out an appliqué embroidery, do as follows: 

1 Begin embroidering. A running line will show where to position the appliqué fabric.
2 A stop then allows you to place the fabric. The message "Place the appliqué fabric now" is displayed.
3 Stitch down the appliqué fabric with double stitch.
4 The machine stops again, and the message "Cut around the appliqué" is displayed. Trim the fabric.
5 Finally, finish the edges with the satin or motif line. 

When stitching an appliqué frame, the placement section in the appliqué is the same color as the first color 
in the frame, so it doesn’t show under the appliqué fabric. If desired, change in mySewnet™ Embroidery to 
the first color for the embroidery.
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Stitching out Foam Lettering

Stitching Out Foam Lettering
Foam characters are designed to be stitched out in a particular sequence. Preview the two 
stops in the Design Player, with instructions to place the foam and to remove any excess 
foam. These instructions are also present on the printed worksheet.

When stitching out a puffy foam character, do as follows: 

1 Begin embroidering. A running line will show where to position the puffy foam.
2 A stop then allows you to place the foam. The message "Place the puffy foam on the fabric now" is 

displayed.
3 Stitch down the foam with satin stitching.
4 The machine stops again, and the message "Remove any excess puffy foam" is displayed. Remove the 

excess foam.

Stitching out with Twin Needles
Twin Needles only work horizontally, i.e. the needles are side by side as you look at the 
machine. If the hoop orientation or the exported design is rotated, this will affect the 
stitchout of the design.

Stitching out with Wing Needles
A wing needle creates holes in the fabric, for hemstitch and other heirloom techniques. 
Use a very fine thread and a stabilizer to create evenly placed durable holes.

Stitching out with Felting Needles
Use a felting needle, optionally with a contrasting roving fiber, for the felting color chosen 
in the Color Selection dialog box. In projects without a roving fiber, choose a felting 
needle color similar to the back of the fabric.

When Exporting an embroidery with a Felting Needle effect, the option "Flip design for felting or reverse 
embroidery" is initially selected in the Export dialog box. See “Export” on page 20.

Entering Letters
Click in the Letters box and enter the desired characters. The text in the Letters box will 
remain the same until you enter new text or close mySewnet™ Embroidery.

To change existing lettering that has already been placed, including the font if desired, select the lettering 
then right-click within the lettering for Letter Properties. Letter Properties is available even after saving, but 
not after lettering has been fixed (converted to embroidery).
In an uppercase (UC) font any lowercase letters entered appear as uppercase, and in a lowercase (LC) font 
uppercase letters appear as lowercase.
If you type special characters that are not available in the font, they will not appear on the work area when 
you apply the lettering.

Multi-Line Lettering
To start a new line of text, or break an existing line of text into two lines, use Enter on the 
keyboard. Use the arrow keys on the keyboard to move around the lines of text in the 
Letters box.
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Check Spelling
If Check Spelling is selected in Preferences, unrecognized words in the Letters box will be 
underlined in red. You can select alternatives from the Context menu.

Check Your Spelling
1 Click File, Preferences  and ensure Check Spelling is selected and the language is set to English US. 
2 Click the Letter tab.
3 Click in the Letters text box and enter the words "Roses are red, vilets are blue". The word "vilets" is 

underlined in red.
4 Right–click to select the word. A Context menu appears.
5 Click Suggestions. A list of suggested alternatives appears.
6 Choose the word "violets" from the Context menu. The word is replaced in the Letters text box.

You can also use Add in the Context menu to add words to the dictionary, for example your name, or 
use Ignore to ignore the suggestion, and Undo if you chose the wrong suggestion.

Alternative Alphabets
To enter characters in other alphabets from the National font category, such as Greek and 
Hebrew, refer to the Character Sets section in the mySewnet™ Embroidery Reference 
Guide or help for the keys used. The Character Sets section shows the key to press to 
obtain the desired character.

Lettering Shapes
There are three categories of lettering shapes: Block, Line and Vertical Block.

■ Block
Starting from a template, mould the block of letters as desired. See “Block” on page 364.

■ Line
Place letters along a straight, curved or wavy line. See “Line” on page 360.

■ Vertical Block
Place lettering in a straight vertical line. See “Vertical Block” on page 364.

Using Lettering Shapes
If you have used the Letter tab previously in that session of mySewnet™ Embroidery, the 
last setting is remembered. You can adjust lettering with the handles (green squares) until 
it is fixed as stitches, for example when it is Combined. 

Reverse: When the Reverse checkbox is selected, the lettering is mirrored. Reverse is 
available for all lettering shapes.

Monograms created with the ExpressMonogram Wizard have light green handles; select Properties from 
the Context menu to adjust the Monogram settings. See “ExpressMonogram Wizard” on page 326.

Line
Place letters along a straight, curved or wavy line. Use the handles to adjust the position of 
the letters and the shape of the line.

• You cannot resize these lettering shapes with the handles. Right-click to open the Letter 
Properties dialog box, and use the Size and/or the Height and Width settings. 

• Flip handles are not available. To mirror, fix the lettering as stitches first.
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• These lettering shapes can only use one line of text, or two for Full Circle. Additional 
lines are combined with the first line, or the second line for Full Circle.

Circle Shapes
Place characters along a curved line. Circle lettering shapes always use Center alignment.

• Rotate handles are not available for the Circle lettering shapes. To rotate, fix the lettering 
as stitches first. 

Using Circular Lettering Shapes
The handles for circular lettering shapes adjust the positioning of the lettering, not the 
size.

1 Enter a short line of text in the Letter window. See “Create Lettering” on page 352.
2 In the Lettering Shape area, click Circle Clockwise.
3 Click Apply . The lettering appears in a line over the top of a circle.
4 Click and drag the square green handle at the top of the circle of lettering downwards. The pointer 

changes to the circle size pointer .
If the lettering is outside the chosen hoop, the handle will be round, not square.
The circle becomes smaller, but the size of the letters is unaffected.
You cannot resize circular lettering shapes with the handles. Right-click and use the Size and/or the height 
and width settings in Letter Properties. See “Changing Letter Properties” on page 376.

Circle 
Clockwise

Use Circle Clockwise  to place lettering clockwise 
around a circle. Click and drag the square green handle 
to adjust the radius of the circle and the position of the 
lettering. Multiple lines of text are placed in the same 
line. Hold down Shift, then click and drag the handle to 
move the lettering around the circle without changing 
the size of the circle.

Shortcut: Lettering Shape, Letter Tab: 

Circle Counter-
Clockwise

Use Circle Counter-Clockwise  to place lettering 
counter-clockwise around a circle. Click and drag the 
square green handle to adjust the radius of the circle 
and the position of the lettering. Hold down Shift, then 
click and drag the handle to move the lettering around 
the circle without changing the size of the circle.
Shortcut: Lettering Shape, Letter Tab: 

Full Circle Use Full Circle  to place two sections of text on 
opposite sides of a circle. When entering characters in the 
Letters box, press Enter to make a new line where you 
want to split the text. When the lettering is initially placed, 
the text on the first line is at the top of the circle and the 
text on the second line is at the bottom of the circle. There 
will be two square green handles. Click and drag either 
handle to adjust the radius of the circle. Hold down Shift, 
then click and drag either handle to move the attached lettering around the circle 
without changing the size of the circle.
If more than two lines of text are entered, Full Circle places all additional lines in the 
second line.

Shortcut: Lettering Shape, Letter Tab: 
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5 Undo  your change. The circle returns to its original size.
6 Hold down the Shift key and drag the green handle at the top of the circle to the right of the circle. 

The line of lettering moves to the right side of the circle.
The alignment setting does not affect circular lettering shapes.
Rotate and flip handles are not available. To rotate or mirror, fix the lettering as stitches first.



mySewnet™ Embroidery   Creating Lettering              363

Fit to Straight and Wavy Lines
Use these line types to place lettering along a straight or wavy line.

Step: When the Step checkbox is selected, the letters can be rotated to any angle. Step is 
available for Fit to Straight Line and Fit to Wavy Line. See “Fit Lettering to a Line” on 
page 363.

Fit Lettering to a Line
1 Enter a short line of text in the Letter tab. See “Create Lettering” on page 352.
2 In the Lettering Shape area, click Fit to Straight Line.
3 Click Apply. The lettering appears along a sloping line.
4 Drag the square green handle on the right upwards. The angle on the line changes, but the size of the 

lettering, and the space between the letters does not.
5 Undo your change.

Fit To Straight 
Line

Use Fit To Straight Line  to 
place lettering along a line. 
Click and drag the square 
green end handles to rotate 
the line to any angle and to extend the line. Click and drag the round green 
handle to move the text along the line. 
The text may also be rotated 
independently of the position of 
the line. Select the Step option, 
then click Apply . There will be 
an additional round green handle 
at the end of another line. Click 
and drag this handle to rotate the 
letters to any angle.
You cannot resize Fit To Straight Line lettering with the handles. Use the Size and/or 
the Height and Width settings in Letter Properties. Fit to Straight Line places multiple 
lines of text onto the same line.
Flip handles are not available. To mirror, fix the lettering as stitches first.

Shortcut: Lettering Shape, Letter Tab: 

Fit To Wavy Line Use Fit To Wavy Line  to place 
lettering along a curved line. Click and 
drag the square green handles to 
change the curve to any shape. Click 
and drag the round green handle to move the text along the line.
The text may also be rotated 
independently of the position of the 
line. Select the Step option, then click 
Apply . There an additional round 
green handle at the end of another 
line. Click and drag this handle to 
rotate the letters to any angle.
You cannot resize Fit To Wavy Line lettering with the handles. Use the Size and/or the 
Height and Width settings in Letter Properties. Fit to Wavy Line places multiple lines of 
text onto the same line.
Flip handles are not available. To mirror, fix the lettering as stitches first.
Shortcut: Lettering Shape, Letter Tab: 
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6 Drag the circular control along the line and to the right. The first letter of the lettering moves to the 
position of the circular control.

7 Delete the lettering.
8 In the Letter window, select the checkbox labeled "Step".
9 Click Apply . There is now a green circular control at the end of a line below the lettering.
10 Drag the green control downwards. The letters in the line rotate.
11 Delete the lettering.
12 In the Lettering Shape area, click Fit to Wavy Line.
13 Click Apply . The lettering is now on a wavy line with four square green handles, and two green 

circular controls.
14 Adjust the controls to change the position of the letters.

Vertical Block

Block
There are 29 Block templates available. Any Block type can be changed into any other 
Block type using the Handles menu, by adjusting the Top and Bottom line types, and by 
setting different Constraints.

Individual: When the Individual checkbox is selected, the letters can be moved and 
resized individually. Individual is available for all block types. Only one line of lettering can 
be made when Individual is selected. See “Individual Letter Monogram” on page 390.

Flip handles are not available. To mirror, fix the lettering as stitches first.

Handles Menu
Use the Handles menu to adjust the settings for the selected block of lettering. Click the 
Handles menu icon  and change the block settings.

Change Template Settings in the Block Menu
1 Enter the text "Jonathan" in the Letter window. See “Create 

Lettering” on page 352.
2 In the Lettering Shape area, click Arch Over , then click 

Apply . The lettering appears in the work area.
The top and bottom lines of the lettering use the Arch  line type, 
with a single handle in the middle.

3 Click and drag the lettering to the top of the work area.
4 Click and drag the two middle handles (top and bottom) 

upwards, to raise the height of the arch.
5 Click the Handles menu  icon, and the handles menu opens.

Note that the line type for the top line is Arch .
6 Click to deselect Match Top and Bottom Lines , then click to 

open the Bottom Line Type submenu. The line type for the 
bottom line is also Arch .

Vertical Block Use Vertical Block  to place lettering in a straight vertical line with an 
outline box that has four square green handles. Click and drag the 
handles to resize the lettering.
Hold down Shirt as you click and drag to resize proportionally, and Ctrl to 
resize from the center.
Lettering is created with Center alignment by default. For Vertical Block, 
this changes the alignment of characters in each column of lettering.

Shortcut: Lettering Shape, Letter Tab: 
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7 In the submenu, change the bottom line to Straight .
The bottom of the lettering is now a straight line with a handle at each end.

8 Open the Handles menu  again, and change the top line to Diamond .
The top line forms a point, instead of a curve. The Double Diamond  option forms a straight line with 
two peaks.

9 Open the Handles menu  again, and change the top line to Curve . The top line now has a curve 
with two handles.

10 Move the two middle handles on the top line separately.
11 Open the Handles menu  again, and select Add 3 points to curve . Three more handles are 

added to the top of the block.
The add and remove points options are only available when the line type is a Curve.

12 Adjust the top line as desired. 
While you can adjust the top and bottom as desired, the sides are still parallel straight lines, and if you 
move the handle at the top of one side, the handle at the top of the other side moves with it. This is 
Constraint - Size .
If you hold the Shift key while dragging, the proportions of the shape are locked. With Ctrl the shape is 
resized from the center.

13 In the Handles menu, select Constraint - Pennant .
14 Click and drag the handle at the top right upwards. The handle 

below it moves in the opposite direction.
With a rectangular block, this would create a shape like a 
pennant.
Hold down the Shift key to create a skewed rectangle effect.

15 In the Handles menu, select Constraint - Perspective .
16 Click and drag the handle at the top right to the left. The lines on the side of the block now form a 

slope.
17 In the Handles menu, select Constraint - Free . You can now move any of the corner handles in any 

direction you like.
Note that you can only drag the middle handles in the curve up and down.

18 In the Handles menu, deselect Force Even Distribution .
19 Drag one of the middle handles on the curve sideways. The letters move with the handle.

The functions in the Handles menu enable you to sculpt a block of lettering into almost any shape 
you like.
Take care when reshaping lettering using Satin Columns, as separate sections of the letter or the underlay 
may show.

Top and Bottom Line Types
Select a line type for the top and bottom of the block to choose how the lettering is 
displayed. 

Straight Use Straight  to create a lettering block 
with a straight line for the top and / or 
bottom, and with a handle at each end.

Diamond Use Diamond  (top) and  (bottom) to create a 
lettering block with a point at the top and / or 
bottom. Click and drag the central handle to 
change the angle of the slope.

Double 
Diamond

Use Double Diamond  (top) and  (bottom) to 
create a lettering block with straight lines between the 
four handles at the top and / or bottom. Click and drag 
the central handles to change the angle of the straight 
lines.
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Add and Remove Points
Use the Add and Remove points functions to change the number of points in a Curve. The 
points are added or removed at the right end of the selected curve.

■ Add a point to curve  adds a single point to the right end of the selected curve.
■ Add 3 points to curve  adds three points to the right end of the selected curve.
■ Remove a point from curve  deletes a single point from the right end of the selected 

curve.

The minimum number of points in a Curve is four.

Match Top and Bottom Lines
Use Match Top and Bottom Lines  to use the same line type for the top and bottom 
lines in a block.

If Match Top and Bottom Lines  is selected, the Bottom Line Type submenu is not available.

Constraints
Constraints affect how the corner handles on a block behave.

Arch Use Arch  (top) and  (bottom) to create a 
lettering block with a curve at the top and / or 
bottom. Click and drag the central handle to change 
the angle of the curve.

Curve Use Curve  (top) and  (bottom) to create a 
lettering block with curved lines between the four 
handles at the top and / or bottom. Click and drag 
the central handles to change the curves between 
the handles.
You can add and remove extra points (handles) in a Curve.

Size When Constraint - Size  is used, the two corners adjacent to the corner that is 
dragged move the same distance, in the same direction. The corner diagonally 
opposite does not move. The handles on the straight or curved lines between the 
corners move in proportion. 
This preserves the shape of the block, while the size changes.

   
If you hold the Shift key while dragging, the proportions of the shape are locked. With Ctrl 
the shape is resized from the center.
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Force Even Distribution
Force Even Distribution  distributes the handles between the two corners evenly.

Force Even Distribution affects both the top and bottom of the block.

Pennant When Constraint - Pennant  is used, the corner above or below the corner that is 
dragged moves the same distance towards or away from the dragged corner 
vertically. The other two corners do not move. This forms a pennant shape.

   
Hold down the Shift key to give a vertical skew to the lettering.

Perspective When Constraint - Perspective  is used, the corner to the right or left of the corner 
that is dragged moves the same distance towards or away from the dragged corner 
horizontally. The other two corners do not move. This gives a perspective effect.

   
If you hold the Shift key while dragging, the two handles move together as with Italic.

Italic When Constraint - Italic  is used, the corner to the right or left of the corner that is 
dragged moves the same distance, in the same direction. The other two corners do 
not move. This gives an italic look to the lettering.

  
If you hold the Shift key while dragging, the two handles move separately as with 
Perspective.

Free When Constraint - Free  is used, the corner handles can be dragged in any 
direction.

  
If you hold the Shift key while dragging, the proportions of the shape are locked. With Ctrl 
the shape is resized from the center.



368          mySewnet™ Embroidery   Creating Lettering 

Block Templates
There are 29 templates for use with lettering.

Horizontal 
Block

Use Horizontal Block  to place 
lettering in a straight line with an outline 
box that has four square green handles. 
Click and drag the handles to resize the lettering.
Hold down Shift as you drag to resize proportionally, and Ctrl to resize from the center.
Template Settings: Straight, Straight; Constraint - Size, Force Even Distribution

Shortcut: Lettering Shape, Letter Tab: 

Rounded Use Rounded  to place lettering in an envelope 
with an outwardly curving top and base. There are 
six square green handles. Click and drag the 
handles to resize the lettering and the curvature of 
the arches.
Template Settings: Arch, Arch; Constraint - Size, Force Even Distribution
Shortcut: Lettering Shape, Letter Tab: 

Double Arch Use Double Arch  to place 
lettering in an envelope with an 
inwardly curving top and base. 
There are six square green handles. 
Click and drag the handles to resize the lettering and the curvature of the arches.
Template Settings: Arch, Arch; Constraint - Size, Force Even Distribution
Shortcut: Lettering Shape, Letter Tab: 

Diamond Use Diamond  to place lettering in a diamond 
envelope. There will be six square green 
handles. Click and drag the handles to resize the 
lettering and the distance between vertical pairs 
of handles. Hold down Shift, then click and drag the handles to move the vertical 
pairs of handles while keeping the same distance between them.
When the Individual checkbox is 
selected, each letter is created in a 
diamond-shaped envelope and 
can be moved and resized 
individually.
Template Settings: Diamond, Diamond; Constraint - Pennant, Force Even 
Distribution

Shortcut: Lettering Shape, Letter Tab: 
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Italic Use Italic  to place lettering in an envelope that is 
slanted to the right. There will be four square green 
handles. Click and drag the handles to resize the 
lettering. Hold down Shift, then click and drag the 
handles to the left or right to change the slant of the text.
When the Individual checkbox is 
selected, each letter is created in an 
italic envelope and can be moved and 
resized individually.
Template Settings: Straight, Straight; 
Constraint - Italic, Force Even Distribution
Shortcut: Lettering Shape, Letter Tab: 

Freeform Use Freeform  to place lettering in a fully 
adjustable straight envelope. There will be 
4 square green handles. Click and drag the 
handles to resize the lettering and change 
the shape as desired.
Template Settings: Straight, Straight; Constraint - Free

Shortcut: Lettering Shape, Letter Tab: 

Flag Use Flag  to place lettering in a curving 
envelope. There will be eight square green 
handles. Click and drag the handles to resize 
the lettering and change the shape.
Template Settings: Curve, Reflect Top and 
Bottom Lines; Constraint - Perspective, Force Even Distribution

Shortcut: Lettering Shape, Letter Tab: 

Free Sculpt Use Free Sculpt  to place 
lettering in a fully adjustable 
curved envelope. There will be 14 
square green handles. Click and 
drag the handles to resize the 
lettering and change the shape as 
desired.
Template Settings: Curve, Curve; Constraint - Free

Shortcut: Lettering Shape, Letter Tab: 

Arch Over Use Arch Over  to place lettering in an 
envelope with straight sides and an 
outwardly curving top and an inwardly 
curving base. There will be six square green 
handles. Click and drag the handles to resize the lettering and the curvature of the 
top and base.
Template Settings: Arch, Arch; Constraint - Size, Force Even Distribution
Shortcut: Lettering Shape, Letter Tab: 
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Arch Under Use Arch Under  to place lettering in an 
envelope with straight sides and an inwardly 
curving top and an outwardly curving base. There 
will be six square green handles. Click and drag the 
handles to resize the lettering and the curvature of the top and base.
Template Settings: Arch, Arch; Constraint - Size, Force Even Distribution

Shortcut: Lettering Shape, Letter Tab: 

Fan Use Fan  to place lettering in an envelope with 
an outwardly curving top and an inwardly 
curving base. There will be six square green 
handles. Click and drag the handles to resize the 
lettering, and the angle and curvature of the top 
and base.
Template Settings: Arch, Reflect Top and Bottom Lines; Constraint - Perspective, 
Force Even Distribution
Shortcut: Lettering Shape, Letter Tab: 

Bowl Use Bowl  to place lettering in an 
envelope with an inwardly curving 
top and an outwardly curving base. 
There will be six square green 
handles. Click and drag the handles 
to resize the lettering, and the angle and curvature of the top and base.
Template Settings: Arch, Reflect Top and Bottom Lines; Constraint - Perspective, 
Force Even Distribution
Shortcut: Lettering Shape, Letter Tab: 

Pennant Right Use Pennant Right  to place lettering 
in an envelope that is larger on the right 
side. There will be four square green 
handles. Click and drag the handles to 
change the size of each end of the 
pennant. Hold down Shift, then click and drag the handles to move one end of the 
pennant up or down.
When the Individual checkbox is selected, each letter is 
created in a pennant-shaped envelope and can be 
moved and resized individually.
Template Settings: Straight, Straight; Constraint - 
Pennant, Force Even Distribution

Shortcut: Lettering Shape, Letter Tab: 
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Pennant Left Use Pennant Left  to place lettering in an 
envelope that is larger on the left side. There 
will be four square green handles. Click and 
drag the handles to change the size of each end 
of the pennant. Hold down Shift, then click and 
drag the handles to move one end of the pennant up or down.
When the Individual checkbox is 
selected, each letter is created in a 
pennant-shaped envelope and can be 
moved and resized individually.
Template Settings: Straight, Straight; 
Constraint - Pennant, Force Even Distribution

Shortcut: Lettering Shape, Letter Tab: 

Perspective Use Perspective  to place lettering 
in an envelope that is narrower at the 
top. There will be four square green 
handles. Click and drag the handles to 
resize the lettering and change the width of the top or bottom of the text. Hold 
down Shift, then click and drag the handles to the left or right to change the slant 
of the text.
Increasing the Gap setting is recommended for Perspective lettering.
When the Individual checkbox is selected, 
each letter is created in a perspective-shaped 
envelope and can be moved and resized 
individually.
Template Settings: Straight, Straight; 
Constraint - Perspective, Force Even Distribution

Shortcut: Lettering Shape, Letter Tab: 

Bridge Convex 
Down

Use Bridge Convex Down  to place 
lettering in an envelope with a flat top 
and an outwardly curving base. There 
will be five square green handles. Click 
and drag the handles to resize the 
lettering and the curvature of the base.
Template Settings: Straight, Arch; Constraint - Perspective, Force Even Distribution
Shortcut: Lettering Shape, Letter Tab: 

Bridge 
Concave Down

Use Bridge Concave Down  to place lettering 
in an envelope with a flat top and an inwardly 
curving base. There will be five square green 
handles. Click and drag the handles to resize the 
lettering and the curvature of the base.
Template Settings: Straight, Arch; Constraint - Perspective, Force Even Distribution
Shortcut: Lettering Shape, Letter Tab: 
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Bridge Convex 
Up

Use Bridge Convex Up  to place lettering in an 
envelope with a flat base and an outwardly 
curving top. There will be five square green 
handles. Click and drag the handles to resize the 
lettering and the curvature of the top.
Template Settings: Arch, Straight; Constraint - Perspective, Force Even Distribution
Shortcut: Lettering Shape, Letter Tab: 

Bridge 
Concave Up

Use Bridge Concave Up  to place lettering in 
an envelope with a flat base and an inwardly 
curving top. There will be five square green 
handles. Click and drag the handles to resize the 
lettering and the curvature of the top.
Template Settings: Arch, Straight; Constraint - Perspective, Force Even Distribution
Shortcut: Lettering Shape, Letter Tab: 

Octagon Use Octagon  to place lettering in a octagonal envelope. 
There will be eight square green handles. Click and drag the 
handles to resize the lettering and the distance between 
vertical pairs of handles.
Template Settings: Double Diamond, Reflect Top and 
Bottom Lines; Constraint - Size, Force Even Distribution

Shortcut: Lettering Shape, Letter Tab: 

Zigzag Use Zigzag  to place lettering in an angled line 
envelope. There will be eight square green 
handles. Click and drag the handles to resize the 
lettering and the angle of the sides.
Template Settings: Double Diamond, Reflect Top 
and Bottom Lines; Constraint - Italic

Shortcut: Lettering Shape, Letter Tab: 

Chevron Use Chevron  to place lettering in a peaked 
envelope. There will be six square green 
handles. Click and drag the handles to resize 
the lettering and the angle of the sides.
Template Settings: Diamond, Reflect Top and 
Bottom Lines; Constraint - Perspective, Force Even Distribution

Shortcut: Lettering Shape, Letter Tab: 

Slope Use Slope  to place lettering in a curved sloping 
envelope. There will be eight square green 
handles. Click and drag the handles to resize the 
lettering and change the shape.
Template Settings: Curve, Reflect Top and Bottom 
Lines; Constraint - Italic

Shortcut: Lettering Shape, Letter Tab: 
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Using Block Lettering
1 Enter the text "Backwards" in the Letter window. See “Create Lettering” on page 352.
2 In the Lettering Shape area, click Horizontal Block.
3 Click Apply . The lettering appears in the work area.
4 Drag the text a short distance to the right. A four–arrow pointer appears as you drag.

Butte Use Butte  to place lettering in a straight sided envelope 
with eight square green handles. Click and drag the handles 
to resize the lettering and the distance between the sides.
Template Settings: Double Diamond, Reflect Top and 
Bottom Lines; Constraint - Perspective

Shortcut: Lettering Shape, Letter Tab: 

Gem Use Gem  to place lettering in an envelope with seven 
square green handles. Click and drag the handles to resize the 
lettering.
Template Settings: Double Diamond, Diamond; Constraint - 
Perspective, Force Even Distribution

Shortcut: Lettering Shape, Letter Tab: 

Slide Use Slide  to place lettering in a sloping rectangular 
envelope. There will be six square green handles. Click 
and drag the handles to resize the lettering and the 
distance between vertical pairs of handles.
Template Settings: Diamond, Reflect Top and Bottom 
Lines; Constraint - Italic

Shortcut: Lettering Shape, Letter Tab: 

Pentagon Use Pentagon  to place lettering in an envelope 
with a peaked top, a straight base, and sloping sides. 
There will be five square green handles. Click and drag 
the handles to resize the lettering and change the 
angle of the sides and top.
Template Settings: Diamond, Straight; Constraint - 
Size; Force Even Distribution

Shortcut: Lettering Shape, Letter Tab: 

Ramp Use Ramp  to place lettering in an envelope with 
a curved top, a straight base, and sloping sides. 
There will be six square green handles. Click and 
drag the handles to resize the lettering and change 
the angle of the sides and top.
Template Settings: Curve, Straight; Constraint - Italic

Shortcut: Lettering Shape, Letter Tab: 

Rocket Use Rocket  to place lettering in an envelope with 
a peaked top and an arched base. There will be six 
square green handles. Click and drag the handles to 
resize and reshape the lettering.
Template Settings: Diamond, Arch; Constraint - 
Perspective

Shortcut: Lettering Shape, Letter Tab: 
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5 Place the pointer over one of the square green handles at the corners of the lettering. The Adjust/
resize pointer  appears.

6 Use the handles to adjust the size and shape of the lettering.
Hold the Shift key to keep the proportions.

7 Use the round handle on the right to rotate the lettering.
8 Undo  the rotation.
9 Right-click and choose Delete  to remove the lettering from the work area.
10 In the Letter window, select the checkbox labeled 

"Reverse".
11 Click Apply . The lettering appears on the work area 

with the text mirrored.
12 Delete the lettering and deselect Reverse.
13 In the Letter window, select the checkbox labeled 

"Individual", and change the text in the box to "SINGLE".
14 Click Apply . The lettering appears on the work area 

with each letter in its own selection box, and a multiple 
selection box with a dotted outline and orange handles.

15 To use a different lettering shape, choose a new lettering shape in the Letter window and click Apply 
again.

Letter Properties
Use the Letter Properties dialog to alter the font, text, proportions, connection, shape and 
line formatting when editing lettering. 

Letter properties may not be changed once the lettering has been converted to embroidery.
For letter properties, right-click the lettering, and select Properties from the right-click 
menu.

To change stitch type properties, choose the desired line or fill type from the Context menu.

To change lettering before you have clicked Apply, use the Letter tab. See “Font Selection” on page 354.

Change the lettering text. Use Ctrl+Enter to add a line.

Change the font size
Change the height and width proportions of the lettering 
Change the spacing between the letters

Select a connection method

Set alignment and spacing

Preview the font

Select a font

Minimize the number of colors in the lettering

Choose another lettering shape
Reverse or rotate the letters in the line

Rotate the lettering
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Font
The font used for this lettering is shown. Click the arrow below the font preview and the 
font gallery appears. Scroll up or down to select a font from one of the font categories, or 
use the up and down arrows to see fonts one at a time. For more information on fonts, see 
“Font Selection” on page 354.

Letters
This shows the current text. Click in the box and amend the text as desired. Use Ctrl+Enter 
to insert additional lines of text. Use the scroll bar at the side of the text box to show 
additional lines of text when there are too many lines to show them all at once.

Size
Font size can be set from 3mm to 200mm. This is the height of the uppercase 'A' character 
in the font, and all other characters are sized relative to the height of 'A'. Fonts are initially 
set at the minimum recommended size for the font.

The recommended font size forms part of the name. For instance, Corinthian 15-35mm 
should be used with Size set from 15mm to 35mm. 

In the National fonts using alternative alphabets, the character in the 'A' is used as the basis for sizing the 
characters. This will also apply if you create new fonts with the QuickFont Wizard from TrueType® or 
OpenType® symbol fonts.
If you set a satin font to a very large size, use the Satin Column properties dialog box to 
choose a pattern which will prevent loose stitching that may catch and pull easily. See 
“Satin Column” on page 485.

Height and Width
Use Height  and Width  to adjust the proportions of the lettering. For example, to 
make characters taller without increasing the width, increase the Height.

Set Height and Width from 25% to 400%, in steps of 1%.

Gap
Use Gap to change the spacing between characters in a line of lettering. A negative value 
brings the letters closer together and a positive value moves them farther apart. 

Lowercase characters in Script fonts are not affected by the Gap setting.
Set the Gap from -99 to +99. Type in numbers, or use the arrows to increase or decrease 
the Gap. 

Increasing the Gap setting is recommended for Perspective lettering.

Automatic Kerning
Characters are spaced by automatic kerning according to the way that adjacent pairs of 
characters fit together. For example, the letters 'AV' need less space between them than 
'AB' because of the shape of the characters. The Gap setting then increases or decreases 
the spacing set by automatic kerning.
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Script fonts have a special joining method where all adjacent lowercase characters are directly joined 
together and are not affected by the Gap setting.
The Gap is based on the width of the A character. A Gap of 1.0 is equal to 6% of the width 
of the A character.

Rotate
Use Rotate  to change the angle of the lettering.

Angle
Use the up and down arrows or enter an angle from 0 to 359 degrees in the Rotate box.

If desired, move the center of rotation  before rotating.

Connection
Change the connection type between Trim  or Running Stitch , as desired.

ColorSort
Ensure that ColorSort is selected to display the lettering with the minimum number of 
color blocks.

Only deselect ColorSort if you want to vary the color of some characters in the lettering.

Shape
Select a different Shape for your lettering from the drop-down menu. Use Reverse to 
reverse the order of letters, or use Step to rotate the letters at a different angle from the 
line. For more information on lettering shapes, see “Lettering Shapes” on page 360.

When you change the lettering shape, any adjustments that you made to the shape of the lettering will be 
lost.

Line Formatting
Use line formatting to control how multiple lines of text are arranged relative to each 
other.

Alignment
All text is initially created with center  alignment. Use the Alignment buttons to 
alternatively select left  or right  alignment.

Spacing
Use Spacing to change the distance between multiple lines of text. The default spacing is 
1.2, and can be adjusted from 1.0 to 5.0.

The Spacing is based on the height of the A character. Spacing of 1.0 is equal to the height of the A 
character, plus 6%. If you have lower case lettering with descenders (the tails below the baseline on the g, p, 
q and y characters), you may wish to increase the Spacing to 1.5.

Changing Letter Properties
Use Letter Properties to change lettering after it has been placed, but before it has been 
fixed as an embroidery.
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To change the stitch type, right-click the lettering and select the stitch type from the Context menu. If there 
is more than one stitch area of a particular type in the font, the drop-down menu will show that stitch type 
in a numbered list; for example, Pattern Fill 1, Pattern Fill 2. See “Choosing Stitch Properties” on page 454.

1 Right-click the lettering and select Properties from the Context menu. The Letter Properties dialog 
box appears.

2 Click the arrow below the font preview to select a different font from the gallery.
3 Edit the text of the lettering in the Letters text box. Use Ctrl+Enter to add extra lines or break up 

existing lines of text.
You can check the spelling of the text. See “Check Your Spelling” on page 360.

4 Adjust Size to change the basic size of the lettering. It is recommended to use a size within the range 
indicated in the font name.

5 Click the arrows for Height  and Width  to change the proportions of the lettering. Alternatively, 
enter a size in the number box.

6 Use Rotate  to change the angle of the lettering.
7 Adjust Gap to change the spacing between the letters. Click the arrows, or enter a value.
8 Select Trim  or Running Stitch  as the connection method.
9 Click the arrow below the current lettering shape to select a different lettering shape from the gallery. 

If desired, set Reverse or Step for the Lettering Shape.
10 Select the alignment for multiple lines of lettering. Click Left , Center  or Right , as desired.
11 Click the arrows for Spacing to set the distance between multiple lines of text.
12 Click OK to apply your changes to the selected lettering.

Lettering Color
When ColorSort is selected, the lettering is displayed with one color block for a single 
color in the lettering. For single-color fonts, this will be one color, for multicolor fonts this 
will be as many colors as there are in the font. ColorSort is selected by default, but is not 
available if Individual lettering is selected, as each character is created separately.

If ColorSort is not selected, each character in the lettering for a single-color font is 
displayed as a separate color block. For multicolor fonts, each character will have its own 
sequence of color blocks. This allows you to use different colors for some characters in a 
piece of lettering.

If the Running Stitch Connection option is selected, lettering is created as a single design and always uses a 
single color block.

Varying the Colors for Specific Characters
1 In the Letters tab, ensure that ColorSort is not selected (is unchecked).
2 Create a block of lettering.

The thread colors for each letter can be seen in the Color Select area. For multicolor lettering there will be a 
color block for each color in every letter.

3 You can use Color Select to change the color of any characters in your lettering. Double-click the top 
color in the list. The Color Selection dialog box opens. 
See “Change an Existing Thread Color” on page 53 for more information.

4 Change the color to a contrasting color.
5 Click OK to close the dialog box. In the work area the color for the first letter in the text has changed. 
6 Change other letters as desired.
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Fixing Lettering as an Embroidery
Lettering is fixed as an embroidery when the Modify tab is selected, when it is ColorSorted 
using the Export functions, when it is fixed using Fix as Stitches in the Home tab or 
Context menu, or when it is Combined with another design. The stitches are then created, 
and any further resizing of the embroidery may affect stitch density and length. The font 
and text, and stitch properties, for example the density, pattern, angle or stitch length, 
may not be changed after it is fixed. Appliqué fabric cannot be changed in the Context 
menu after the lettering is fixed, but you may use the Select Appliqué features on the 
Appliqué tab.

When lettering is fixed as stitches, the handles change from green to white. After lettering has been 
converted to embroidery, it can no longer be changed with Letter Properties, and the stitch types cannot be 

adjusted. If the Resize  mode is selected, the handles will become blue.

To reverse fixing as an embroidery, click Undo .
To fix lettering as an embroidery deliberately (for example to mirror some lettering shapes), right-click it 

and select Fix as Stitches  from the Context menu, or select Fix as Stitches in the Combine drop-down 
menu in the Home tab.
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Font Manager
Use Font Manager  to search for fonts and to arrange, rename, create, duplicate and 
delete user fonts.

Use mySewnet™ Font Digitizing for advanced editing of your fonts.

When a system font is selected, only the search functions are available in Font Manager.

Font Search
Use Font Search to search for a font by name or size.

Search
Search for a font by name.

Enter the desired text in the Search box and press Enter. Click Clear to remove the search 
text, and use the drop-down menu to reuse previous searches.

Click Clear search before browsing for fonts by Category, or for searching by Size.

Size
Search for fonts by their recommended size.

Ensure that the Size checkbox is selected (checked), then enter the desired size in the Size 
number box.

Selected font

Name of the selected font
Move to a different font Category 

Click to select a font

View the size range

Search for a font by name or size

Apply your changes to the font
Duplicate or delete a font

Import embroidered letters for a font

Create a font with QuickFont

Create or edit a font in mySewnet 
Font Digitizing

Search for a font by name

Search for a font by size
Set the size range for the font search

Show only user created fonts

Clear the font search text
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The Size is based on the height of the uppercase 'A' character in the font. The recommended font size forms 
part of the name, for example Corinthian 15-35mm. See “Font Size” on page 355.

Range
To choose a size range, adjust the number in the Range  box, increasing the number to 
give a larger size range.

For example, if the Size is 15mm and the Range is 5mm, then fonts with ranges 5-15mm, 15-25mm, 12-
16mm and 5-50mm will be visible, but fonts with ranges 3-8mm & 30-60mm will not. An imported 
embroidery font within this range will also be found.

Hide All System Installed Fonts
Check this box so that only fonts that you created in the QuickFont Wizard, in Import Font 
from Embroideries, or in mySewnet™ Font Digitizing are displayed, sorted by Category.

Only fonts within the Fonts folder structure will be shown.

Font Preview
The selected font is previewed, showing its type, name, category and size range.

Font Types
■ User generated font - fonts created by you or another user in QuickFont Wizard or 

mySewnet™ Font Digitizing, or imported with Import Font from Embroideries.
■ System installed font - the fonts supplied with your mySewnet™ Embroidery Software can 

be viewed and searched for, but they cannot be copied or deleted.

Name
Use the Name text box to change the name of the selected user font. 

Edit the font name in the text box, then click Apply to save your changes.

Remember to preserve the size range information when changing the name. The recommended size can 
only be changed in mySewnet™ Font Digitizing. Changing the name does not change the size range.

Category
Use Category to select a different Category for the font, or enter the name for a new font 
Category. 

Select a Category from the drop-down menu, and click Apply to confirm the change. The 
font then moves to its new Category.

If the selected Category already contains a font with the same name, an error message is displayed: "A font 
already exists in this category with this name." Rename the font, or select another font.

Duplicate
Use Duplicate to create a copy of the selected user font. 

The copy is placed in the same Category as the original font, using the same name suffixed 
with "Copy of  ".

Make a Copy of a Personal Font
1 In the Letter tab, click Font Manager . The Font Manager dialog box opens
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2 At the bottom of the font list, use Search to find the font you want to copy. See “Font Search” on 
page 379.
You can only copy a personal (User) font using Duplicate.

3 Click the desired font in the font list. The font appears in the preview on the right.
4 Click the Duplicate button. The font name changes to the original name with "Copy of "in front.

Your original font and its copy are now in the font category, with your new font selected.
The Duplicate button will be grayed out (not available) if the font is a system font.

5 In Name:, change the text to give your copied font a new name.
Take care not to remove the part of the name indicating the font size.

6 Click Apply to save the copied font under the new name.
7 If desired, use the Category drop-down menu to place the font in a different Category, then click 

Apply again to confirm this change.
Alternatively, enter the name for a new font Category, then move the font.

Delete
Use Delete to remove the selected user font from your computer. 

You cannot delete system fonts using Delete.
Select the font that you want to delete, and click Apply.

If you delete a font that you used in an embroidery, the lettering will be fixed as an embroidery, and will no 
longer be available for editing when you open the embroidery again.

Delete a Font
Make a backup of your fonts before using Delete, as you cannot Undo font removal. Copy the contents of 
the folder ProgramData\mySewnet\Embroidery1\\Fonts\MyFonts, and any other folder you used.

1 In the Letter tab, click Font Manager . The Font Manager dialog box opens
2 At the bottom of the font list, use Search to find the font you want to remove from your computer. See 

“Font Search” on page 379.
You can only Delete a User generated (personal) font.

3 Click the desired font in the font list. The font appears in the preview on the right.
4 Click the Delete button. A message is displayed "This will remove your font and cannot be undone. 

Do you want to continue?".
The Delete button will be grayed out (not available) if the font is a system font.
If you have recently used or viewed the font, you may not be able to delete it as it is still locked by the 
system. Close and reopen mySewnet™ Embroidery, and then delete the font.

5 Click Yes to remove the font from your computer.
If you deleted the wrong font, recover the copy of the font from backup.

Size
Size shows the Minimum and Maximum recommended size for the font.

This is the size range used by Font Search. The recommended size can only be changed in mySewnet™ Font 
Digitizing.

Font Tools

Import Font From Embroideries
Use Import Font From Embroideries  to import individual embroidered letters to create 
a font in the Import Font From Embroideries dialog box. Use the Edit Imported Font 
button to make changes to an imported font. See “Import Font from Embroideries” on 
page 382.
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QuickFont
Use QuickFont  to launch the QuickFont Wizard to create new fonts for mySewnet™ 
Embroidery automatically from any TrueType® or OpenType® font on your computer. See 
“Creating Fonts Automatically” on page 395.

Digitize New Font
Use Digitize New Font  and the Edit Digitized Font button to create or edit a font in 
mySewnet™ Font Digitizing. See the mySewnet™ Font Digitizing Reference Guide and 
Help for more information.

Use mySewnet™ Font Digitizing to change the colors of a font that you created in QuickFont, or Import 
Font From Embroideries.

QuickFont
Use the QuickFont  wizard to create new fonts for mySewnet™ Embroidery 
automatically from any TrueType® or OpenType® font on your computer. See “Creating 
Fonts Automatically” on page 395.

Use Delete in Font Manager to remove unwanted QuickFont fonts from your computer. See “Delete” on 
page 381.

To Launch QuickFont
■ Click QuickFont  in Font Manager, see “Font Manager” on page 379.

■ Click QuickFont  in the Utilities tab of mySewnet™ Configure.

Import Font from Embroideries
Use Import Font From Embroideries  to import individual embroidered letters to create 
a font. Browse to the letters individually, or drag them from an Explorer window.

For best results, remove any stray stitches in mySewnet™ Stitch Editor before importing the letters.
As the imported letters are stitch files, rather than fully adjustable design files, they work 
best at their original size, with the minimum of reshaping.

Imported fonts work best with the Line, Vertical Block and Horizontal Block lettering shapes. 

Select a character set for the font
Code for the selected letter

View more characters
Created letters are highlighted

The selected letter is orange,
and created letters are green

Replace the selected letter
Move the Baseline for the letter

Delete the selected letter

Embroidery information

Font name and size
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Name
The name that the font was given in the Select a Name dialog box is displayed.

This name is unique. An error message is displayed if an existing name is used.

Size
The size of the font. This is taken from the size of the Upper Case ’A’, which is the first letter 
in the font to be created.

Character Set
Choose a character set for the font. The available options are: Extended, Super Extended, 
Latin 1, Western 1, Western 2, Western 3, Western 4, Cyrillic 1, Cyrillic 2, Cyrillic 3, Hiragana 
1, Hiragana2, Greek 1 and Hebrew 1. The default character set is Extended.

For more information on character sets, see “Select Font” on page 398.

Character
The ASCII character code for the selected letter is given.

Defined Characters
The letters that have already been created are highlighted in green, and the selected letter 
is highlighted in orange. Click the Previous  and Next  buttons to view more letters 
(for example Lower Case letters).

Click to select a letter to create, replace or delete in the letter panel.

Use the Page Up and Page Down keys on the keyboard to move between the letters.

Load
Click Load to reload the selected character. Use Load to replace the current character with 
a different embroidery. For example, reload if an incorrect character was selected, or to 
reload the embroidery at its original settings.

Delete
Click Delete to remove the selected character from the letter panel. Use Delete if a 
character was created in error, such as if a Lower Case letter was added to an Upper Case 
font.

Baseline
Enter a number for the Baseline of the selected character, or use the up and down arrows 
to adjust the positioning of the character on the Baseline.

You can also drag the solid red Baseline to position the character.
Adjust the Baseline for descender characters like Lower Case g, p, and y, or where a 
decoration on the character descends below the natural Baseline for the character.

A dashed top red line indicates the position of the top of the Upper Case A. Use this when adjusting the 
postion of letters and punctuation symbols.
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Design Information
The Design Information shows the stitch count , dimensions (Width  and 
Height ),and number of colors  for the character embroidery.

Zoom Bar
Use the Zoom Bar at the bottom of the screen to zoom in or out from the center of the 
embroidered letter.

Use the slider to zoom in or out, or click on the Zoom Out  or Zoom In  icons.

Select a Name
Use the Select a Name dialog box to give 
your imported font a name.

An error message is displayed if the name has 
already been used.
Name the font, then click OK to select the 
letter ’A’ for the font in the Open dialog box.

Create a Font from Embroidered Letters
1 Place your embroidered letters in a folder on your computer.
2 In the Letter tab, click Font Manager . The 

Font Manager dialog box opens.
3 Click Import Font from Embroideries . A 

dialog box opens for you to name your font.
4 Enter a name for your font, and click OK.

The font naming dialog box closes and an Open 
dialog box appears.
The font illustrated here is Vintage Floral 
Monogram from the mySewnet™ Library.

5 In the Open dialog box, browse to the folder with 
your embroidered letters.
The Tiles option in the Open dialog box is useful when selecting letters.

6 Select the Upper Case letter ’A’, then click Open. The Import Font from Embroideries dialog box opens 
with the letter ’A’ selected.
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Note the red baseline under the letter ’A’. The Baseline sets where the letter will be placed along the line 
relative to the other letters in the font.

When using Import Font from Embroideries to create a font from individual embroideries, the Upper Case 
’A’ is always created first. The size of the letters in the font is taken from the letter ’A’.

7 In the Letter panel on the left, click the letter ’B’. The Open dialog box opens for you to load the letter 
’B’.

8 Click to select the letter ’B’, then click Open to load it in the Import Font from Embroideries dialog box.
Note the red dashed line above the ’B’. This line indicates the position of the top of the letter ’A’.

9 Click to select the letter ’C’ and load it.
10 Without closing Import Font from Embroideries, open a File Explorer window and browse to the 

letters for your font.
11 In the File Explorer window, click the letter ’D’ and drag it to tile D in the Import Font from 

Embroideries dialog box.

12 Click to select the letter ’G’, and drag it to the E tile.
The letter ’E’ is highlighted, but the letter ’G’ is in the preview.

13 Click and drag ’E’ to place it in the correct position.
You can also use Load and Delete to replace and remove unwanted letters.

14 Click and drag to load the other upper case letters in your alphabet, then load the lower case letters 
up to the letter ’f’.
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15 Click and drag the small ’g’ onto its tile.
16 The solid red line across the preview is 

the Baseline for the selected letter. 
Click and drag the Baseline upwards so 
that the body of the ’g’ rests on it, and 
the tail hangs below.  The line moves 
up across the letter.
You can also use the up and down 
arrows by the Baseline number box to 
adjust the Baseline, or enter a number.
The Baseline sets where the letter will be 
placed along the line relative to the other 
letters in the font.

17 In the Import Font from Embroideries 
dialog box, click Next  to view more 
letters.

18 Click and drag the apostrophe onto its 
tile.
You can use the comma for an 
apostrophe.

19 Click and drag the Baseline 
downwards to place the apostrophe 
just below the dashed line at the top.
You may need to zoom out using the 
slider to adjust the position of the lines.

20 Load the remaining embroideries for 
the font, and adjust the Baseline for 
the letters.

21 Click Close when you have finished, 
and also close the Font Manager.
If you need to take a break, click Close to 
save the font, and Font Manager, then browse to it in the My Fonts Category to load it again with the Edit 
Imported Font button.

Adjust your Imported Font
22 Select your new font in the Letter tab.
23 In the Letters text box, enter a series of letters to view their position relative to the Baseline, for 

example "abcdefghijklm".
24 In Shape, select Fit to Straight Line , then click Apply.
25 If needed, adjust the hoop size and orientation so that your lettering will fit across the bottom of the 

hoop.
For larger letters, use a custom hoop size.

26 Drag the green handle on the right up or down so that the lettering lies horizontally along one of the 
grid lines.

27 Open the Font Manager .
28 Drag the dialog box up towards the top of the screen.
29 Ensure that your imported font is selected, and click Edit Imported Font.
30 Move the Import Font from Embroideries dialog box upwards so that you can see your line of 

lettering.
31 Select a letter that needs adjusting. In this example I will adjust ’f’.
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32 Click and drag the solid red Baseline below the ’f’ upwards so that the bottom of the ’f’ will be below 
the Baseline.

33 Release the mouse button. The letter ’f’ in the text below the dialog box moves downwards.
34 Adjust the Baseline again so that the letter ’f’ is aligned correctly with the other letters.
35 Select the small letter ’j’.

Either click on the ’j’, or use the Page Up and Page Down keys on the keyboard to move through the letters 
in the dialog box.

36 Adjust the ’j’, then adjust any other letters in that line.

37 Adjust the other letters in your alphabet.
If you want to start again with a particular letter, click Load and reload the embroidery.
Many Upper Case fonts will need little Baseline adjustment.
Lower Case letters are likely to need more adjustment, particularly letters like p, g, and y with descenders.

38 When you have adjusted all of your letters, click Close to save your 
font, and then in Font Manager click Close again.

39 Use your new font in the Letter tab.
To fine tune the placing of your letters in the work area, use the 
Individual option. You can adjust the colors of an imported font in 
mySewnet™ Font Digitizing.
Imported fonts work best with the Line, Vertical Block and Horizontal 
Block lettering shapes. 
As the imported letters are stitch files, rather than fully adjustable 
design files, they work best at or near to their original size, with the 
minimum of reshaping.
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Lettering Examples
Use lettering to enhance an embroidery, or create a monogram.

Create a Circle of Letters: I Love the Sunshine
1 In the Quick Access toolbar, click Change Hoop . In the Hoop Selection dialog box select 260mm x 

200mm - Universal Large Hoop 3.
2 Set Orientation to Natural and click OK.
3 In the View tab, ensure that the Grid size is set to 10mm.
4 In the Quick Access toolbar at the top of the screen, click Insert .
5 Browse to \mySewnet\Samples\Embroidery\Stitch.
6 Scroll down until you see "Sunshine Applique Large".
7 Click Open to load the embroidery into the work area.

The embroidery has white handles on its selection box, showing 
that it is initially in Scale rather than Resize  mode (blue 
handles).

8 Click the Letter tab.
9 In the font gallery on the left, scroll down to the Traditional font 

category.
10 Select the font Georgia 20-40mm.

It will be automatically selected if this is a new mySewnet™ 
Embroidery window.

11 Enter the words "I love the" in the Letters text box.
12 In the Lettering Shape area, click Circle Clockwise.
13 In Stitches, ensure that ColorSort is selected (checked).
14 Click Apply . The lettering appears in the center of the work area above the embroidery. Its handle 

is green.
The green handle indicates that the lettering has not yet been fixed as stitches.

If the lettering does not surround the embroidery, the embroidery was not selected. Click Undo , click to 
select the embroidery, then click Apply again.

15 Press the Tab key so that the sun embroidery is selected.
16 In the Letters text box, enter the word "Sunshine".
17 In the Lettering Shape area, click Circle Counter-Clockwise, and ensure that ColorSort is selected 

(checked).
18 Click Apply . The lettering appears in the center of the work area surrounding the embroidery. Its 

handles are green.
If the thread color for both lines is identical, you can use Full Circle instead of Circle Clockwise and Circle 
Counter-Clockwise.
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19 Drag the square green handle at the bottom of the circle of 
lettering upwards half a grid square.
The circle becomes smaller, but the size of the letters is 
unaffected.

20 Click the "I Love the" text, and drag the square green handle 
at the top of the circle of lettering downwards half a grid 
square

21 Look at the Design Panel on the right. The phrase has a single 
color block in the Color Select area.

22 Select the Sunshine text, then move the arrow pointer over 
the color block and pause for a moment. The word ’Sunshine’ 
is highlighted, and a popup description of the thread is 
displayed.

23 Double-click the color block. The Color Selection dialog box 
appears.

24 In Thread Range choose Show All Thread Ranges, then select 
Solar Active Ultra Violet 40 from the drop-down list.

25 Select thread color 0002 (White/Orange). Click OK to change 
the color.
The word Sunshine is now white.

26 Select the "I love the" text.
27 Double-click the blue (number 1) in the Color Select and in the 

Color Selection dialog box choose Show All Thread Ranges, then 
select Solar Active Ultra Violet 40 from the drop-down list.

28 Select thread color 0001 (White/Yellow) and click OK to change the 
color.

29 Click the Home tab.
30 Click Select All , then in Alignment, click Center in Hoop . 

Both the sun embroidery and the lettering are centered in the 
hoop.

31 In the Quick Access toolbar, click Life View .
32 Click Solar Reactive . The sun’s face and the lettering change 

from white to yellow and orange.
Solar Reactive simulates the sun shining on the photochromic threads 
in the design. The threads change shade to show the colors they will 
become in sunlight.

33 In the Quick Access toolbar, click Save As  and save 
the embroidery as ’I love the Sunshine’.
The sun and lettering will be stored separately within this 
multipart embroidery, making further adjustment easier.

34 Click Export  in the Quick Access toolbar to export 
the sunshine embroidery.

35 In the Export dialog box, ensure that .vp4 is selected 
and click OK.

36 In the Save As dialog box, browse to \mySewnet\My 
Designs, and save the embroidery as ’I love the 
Sunshine_exported’ (a .vp4 file extension is added 
automatically).
When exported, the embroidery is automatically 
combined and ColorSorted if those options are selected.
To add appliqué to this embroidery, see “Add Appliqué to a 
Sun Embroidery” on page 189’.
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Individual Letter Monogram
1 Click the Letter tab and in the Font drop-down gallery, scroll to the Monogram font category.

These fonts have most characters of equal width, designed for monograms created using the lettering 
functions or the ExpressMonogram Wizard. They are all uppercase only.

2 In the Monogram font category, select Athletic Square 2C UC 30-80mm.
This is a two–color monogram font.

3 Enter the letters "OTG" in the Letters text box.
Since this is an uppercase font, it is not required to enter uppercase letters.

4 In the Lettering Shape area, click Horizontal Block.
5 Select the checkbox labeled "Individual".

Note that the ColorSort checkbox is unavailable, as each character is created separately.
6 In the Stitch Type  drop-down menu, select Pattern Fill.

The stitch type can be changed in the Letter tab before the lettering is created. To change the stitch type for 
lettering placed in the work area, right-click each letter separately and select the stitch type from the 
Context menu.

7 In the Patterns gallery of the Pattern Fill properties dialog box, scroll to the Diamonds Category.
8 Click the pattern in row 1, column 1 (number 97).
9 Click OK to return to the Letter window.
10 Click Apply . Each letter forms a separate block, with its own handles.

11 Drag the lettering towards the top of the screen. The pointer changes to the Move  pointer, and 
the lettering moves as a block.

12 Click outside the lettering. None of the letters are now selected.
13 Click the "T". It alone is surrounded by a selection box.
14 Drag the top right green handle up and to the right, until the T is 

approximately twice the height, and one and two-thirds the width, of the 
other two letters.

15 Drag the T to the left so that it is midway between the two letters.
Alternatively, use the arrow keys to nudge the T into position.
This forms a simple three-letter monogram.

16 Click the Home tab.
As only the T is selected, only the two threads for the T can be seen in 
Color Select.
When Individual is used, there is a color block for each color in every letter.

17 Click Select All . All three letters are surrounded by selection boxes again. See “Select All” on 
page 67.
The threads for all three letters are now visible in Color Select.

18 Click Group . The three letters are grouped as a single design. See “Group” on page 69.
The design will be ColorSorted (if desired) when it is exported for stitching. See “Export” on page 20.
You could change the thread colors for single letters in the monogram. See “Varying the Colors for Specific 
Characters” on page 377.
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Change Lettering Fills: Camp Pine Diary
1 Ensure mySewnet™ Embroidery  is open.
2 In the File menu, click Configure, then click the Appearance tab.
3 For Background, click the drop-down arrow and then click 

More Colors on the drop-down panel. The Colors dialog box 
appears, with the Standard tab selected.

4 In the hexagonal matrix, click the medium pink hexagon sixth 
from the right (just to the right of the central white hexagon). 
The color sample on the right will show the old and new 
colors.

5 Click OK. The new color is shown on the Color button. 
6 Click Apply and the new color will be seen in mySewnet™ 

Embroidery. Click OK.
Alternatively, you could load a fabric using the Background 
Wizard.

7 Click the View tab.
8 Click Change Hoop  and in the Hoop Selection dialog box 

select 240mm x 150mm - Universal Large Hoop 2, with 
Orientation set to Natural. Click OK.

9 Ensure that the Grid Size is set to 10mm.
10 Click File, Preferences  and ensure Check Spelling is selected and the language is set to English US.
11 Click the Back arrow at the top of the File menu, then click the Letter tab.
12 In the font gallery on the left, scroll to the Display font category.
13 Select the font Revue 2C UC 25-120mm SF. It will be shown as the selected font on the Letter page.

Font names include information in addition to the name of the lettering style. 2C means that the font uses 
two colors. UC indicates the font has only uppercase characters (LC would indicate lowercase characters).
Following the font type is the recommended size range. For instance, 25-120mm indicates the font is 
recommended for use at sizes from 25mm to 120mm. A stitch type abbreviation may be present at the end 
of the name, in this case SF for Spiral Fill.

14 Click in the Letters box and enter the following text 
(press Enter as indicated, to create more than one 
line of lettering):
CAMP<Enter>
PINE<Enter>
DIARY

15 Leave Size at the 25mm default, ensure Lettering 
Shape is set to Horizontal Block , that Individual 
is deselected (unchecked), and that ColorSort is 
selected (checked).

16 Click Apply  and the lettering will appear on the 
work area.

17 Right-click the lettering and select Spiral Fill from 
the right-click menu. The Spiral Fill Properties dialog 
box appears.
The Density settings are displayed. A Gradient 
Density of 6-24 is used.

18 Click OK to close the dialog box.
19 Right-click the lettering again and select Satin Line 

from the right-click menu.
20 Ensure that the Density is 4, Width of the Satin Line 

is set to 2.0mm, and Underlay is selected. Click OK to 
close the dialog box.
You will adjust the colors of the lettering when all text 
has been created.
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21 In the font gallery on the left, ensure that the Display Category is selected, and select the font Revue 
2C UC 25-120mm MF.
The MF suffix indicates that this font uses a Motif Fill.

22 Click and drag in the Letters box to highlight the previously entered text, and enter the following text 
to replace it:
ANNE

23 Set Size to 43mm.

24 In the Stitch Type drop-down list, select Motif Fill. The Motif Fill properties dialog box appears, with 
the motif set to a heart.
When using Motif Fill fonts, you may choose from hundreds of motifs, including those similar to your own 
embroidery machine stitches.

25 In the Motif 1 tab, set the Group to Universal and the Category to Candlewicking 1. 
26 Click the drop-down arrow for Pattern, scroll down the list and select Pattern 18.
27 Ensure that Proportional is selected, and set the Height to 8.0mm. 

The Width will automatically be set to 10.2mm.

28 Click the Spacing tab.
29 Ensure the Horizontal Gap is set to 15%, and set the 

Horizontal Offset to 50%.
30 Click the Options tab.
31 Ensure that the Angle is set to 350.

This will make the linking stitches between the flower 
motifs less noticeable than if set to 0.

32 Click OK to close Motif Fill properties.
33 Ensure Lettering Shape is set to Horizontal Block .
34 Click Apply  and the lettering will appear on the 

work area, below the CAMP PINE DIARY lettering, if 
that was selected.

35 Click the CAMP PINE DIARY lettering to select it, and 
move it up one and a half grid squares (15mm) to allow 
for a border. 

36 Click the Frame tab, then click Border .
37 Ensure that Margin is set to 6mm, that Rounded Corners is deselected (unchecked), and that Group is 

selected (checked).
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38 In Border Options select Motif Line .
39 In the Stitch Type  drop-down menu on the right, 

select Motif Line.
40 In the Motif Line Properties dialog box, set the Motif 

Group to Universal, and the Category to 
Candlewicking 1.

41 Click the drop-down arrow for Pattern, scroll down the 
list and select Pattern 18.

42 Set Minimum Gap to 0.2mm.
43 Ensure that Proportional is selected, and set the 

Height to 10.5mm. The Width will automatically be set 
to 13.5mm.

44 Ensure that stitch type is set to Running, and that 
stitch Length is set to 6.0mm.

45 Click OK to close the Motif Line Properties dialog box.
46 Click Apply . A border will be placed around the lettering.

The border uses the same motif as the fill for the ANNE lettering.
47 In the FilmStrip, click Reveal Groups . Alternatively, choose 

Reveal Groups from the context menu
This will enable you to modify the Camp Pine text and border 
separately.

48 Press the Tab key to select the Diary text, or select it in the 
FilmStrip.

49 In the Design Panel move the arrow pointer over the brown 
color in the color worksheet (Robison-Anton Rayon 40, 2334 
Terra Cotta) and pause for a moment. The areas of brown 
thread in the embroidery are highlighted, and a popup 
description of the thread is displayed.
This is the thread for the Spiral Fill.

50 Double-click the thread to open the Color Selection dialog box, 
and set the thread range to Sulky Metallic 30 in the drop-down 
list.

51 Then select thread 7013 (Rose) and click OK to 
close the box. The Spiral Fill thread is now 
metallic.

52 In the color worksheet, double-click the orange 
thread (Robison-Anton Rayon 40, 2327 
Honeydew).
This is the thread for the satin border around 
each letter.

53 In the Color Selection dialog box, select Sulky 
Rayon 40 from the Thread Range drop-down 
list.

54 Click in the Find Thread box and enter '1011'. 
Thread color 1011 (Steel Gray) will be found in 
the list. Click OK to change the color.

55 Click the border in the FilmStrip.
56 In the color worksheet, double-click the blue 

color (Robison-Anton Rayon 40, 2527 Soldier 
Blue). This is the thread for the motif border 
around the lettering.

57 In the Color Selection dialog box change this color to Sulky Rayon 40, thread color 1109 (Hot Pink).
58 Click Reveal Groups  to deselect it.
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59 Click the ANNE lettering. A box with green handles 
surrounds the text.

60 In the color worksheet in the Design Panel, double-click 
color 1 (the motif fill).

61 In the Color Selection dialog box, select Sulky Rayon 40 
from the Thread Range drop-down list and change the 
color to thread color 1109 (Hot Pink).

62 In the color worksheet, double-click color 2 (the satin 
border around each letter) and in the Color Selection 
dialog box, change the color to Sulky Rayon 40, thread 
color 1192 (Fuchsia).

63 Adjust the texts until you are happy with the result.
64 In the Home tab, click Select All .
65 In the Alignment drop-down list, click Horizontal 

Alignment, Align Center . The embroideries are aligned 
along the same vertical line.

66 Click Center in Hoop .
67 Click Group . 

This will enable you to keep the project elements together, but modify the lettering again in future. For 
example, you could use Reveal Groups and edit the text to change ANNE to JANE.

68 In the Quick Access toolbar, click Life View . View the 
embroidery as it will be exported, then click Cancel.

69 Click Save  and the Save As dialog box will appear.
70 In the Save In box, browse to the folder \mySewnet\MyDesigns.
71 In the File Name box, change the name to 'Camp Pine Diary', then 

click Save. A .vp4 extension is added automatically.
This will save the title and year lettering separately, making further 
adjustment easy.

72 Click Export  in the Quick Access toolbar to export the 
embroidery optimized for stitching.

73 In the Export dialog box, ensure that .vp3 is selected, and in the 
Save As dialog box, save the embroidery as \mySewnet\My 
Designs\Camp Pine DiaryExported.

74 Click File, Print to see the Print Preview.
75 In Worksheets, ensure that 

Design Scale is set to 75% and 
that Grid and all the Print 
Information boxes are 
checked.
With these settings the design 
and color guide will be on one 
page, but the printout will not 
be used as a placement 
template.

76 In the Multiple Pages  
drop-down list, select two 
pages. You can now view the 
design and the rest of the 
worksheet.
Note that settings information 
for the lettering has been added automatically.

77 Click Print to print the worksheet.
After completing this exercise, you can use the Appearance tab of mySewnet™ Configure to set the 
Background Color back to the default blue (RGB 211, 233, 255) in the Colors dialog box Custom tab.
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21Creating Fonts Automatically
Use mySewnet™ QuickFont to create fonts automatically for use with your mySewnet™ 
Embroidery Software, or your embroidery machine.

How to Create a Font
Select Font

1 Start mySewnet™ QuickFont . The Select Font page appears.
The initial settings in mySewnet™ QuickFont are remembered from the last time it was used.

2 Click the Font drop-down arrow and select the desired font name in the list. The previews to the right 
of the window will change according to the font choice.

3 Click the drop-down arrow for 
the Style and select Regular, 
Bold, Italic or Bold Italic in the 
list. The previews to the right of 
the window will change 
according to the style choice.

4 Select a File Type. Choose 
between: 
• A font to use in the mySewnet™ 
Embroidery Software
• A font to use on your 
embroidery machine.

5 Click the drop-down arrow for 
the Character Set and choose 
the desired set.
The choice of character set will 
vary, depending on the File Type 
chosen above.

6 Click Next. The Set Stitch 
Options page will appear.

Set Stitch Options
7 Select the desired Stitch Type 

from the drop-down list. The 
Output Size may change 
according to the selected Stitch 
Type. 
The previews to the right of the 
window will change according to 
the selected Stitch Type. For a 
mySewnet™ Embroidery Software 
font, the preview is in the middle 
of the range. 
The first three uppercase 
characters, lowercase characters 
and numbers are previewed. 
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The size for the 'A' and 'a' characters are set half way between the Minimum and Maximum output size for 
a mySewnet™ Embroidery Software font, or the characters are set as near as possible to the Output Size for 
a machine font. 
The Real Size % box shows the size of the previews, compared to the Real Size setting in mySewnet™ 
Configure.

8 If desired, click Stitch Options and/or Border Stitch 
Options and change the settings for the selected 
Stitch Type, such as the fill pattern or satin border 
width.

9 If desired, adjust the Output Size (for a machine 
font), or Output Size Range (for a mySewnet™ 
Embroidery Software font).

10 In Joining Point, select Baseline to join letters at the 
bottom, select Nearest Point to join letters at the 
place where they are closest for fast stitchout of a 
small font, and use Continuous for a flowing 
handwriting effect with a script font.
Joining Point options are only available with a 
mySewnet™ Embroidery Software font.

11 To change the thread color used for satin columns 
or pattern fill areas, click the Thread Color icon . 
The Color Selection dialog box will appear for you to 
choose a new color.

12 To change the thread color used for satin borders, appliqué stitching and outlines, click the Border 
Thread Color icon . The Color Selection dialog box will appear for you to choose a new color.
After you have chosen a new thread color, the previews will be shown with the new color.

13 To change the appliqué fabric color, click the Appliqué Color icon . The Appliqué Selection dialog 
box will appear for you to choose a new fabric. See “Stitch and Appliqué Colors” on page 416.

14 Click Next. A progress bar will appear, showing that the font is being created. The Output Options 
page will then appear.

Output Options
15 The Font Name is automatically generated to show the TrueType® font name, then the style (R for 

Regular, B for Bold, I for Italic or BI for Bold Italic), then the Stitch Type (S for Satin, F for Fill, FSB for Fill 
+ Satin Border, SB for Satin Border, A for Appliqué or O for Outline), then the character set (E for 
Extended, SE for Super Extended, and so on). At the end is the minimum and maximum 
recommended sizes in millimeters (for a mySewnet™ Embroidery Software font), or the Output size 
(for a machine font). If desired, click in the Font Name box to change the name.

16 The mySewnet Embroidery 
Software Font Category is 
initially set according to your 
choice of Joining Point. It will 
be set to MyFonts for Baseline 
joining, Nearest Point for 
Nearest Point joining or Script 
for Continuous joining. If 
desired, select a different 
category from the drop-down 
list.
mySewnet Embroidery Software 
Font Category is not available 
when creating a machine font.
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17 Machine fonts are saved to \mySewnet\My Designs by default. If desired, you can choose a different 
folder, or save to a USB stick. Click the button with three dots to choose a new folder or drive.

18 To view the complete font, use the Previous and Next buttons below the preview to step through the 
character set.

19 To print a reference sheet showing the characters in the font, click Print Catalog.
20 To start a new font after creating the current one, select the New Font checkbox.
21 Click Finish and mySewnet™ QuickFont will close. The font will be saved according to the selected 

options.
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Select Font
Use the Select Font page of mySewnet™ QuickFont to select the font, style and character 
set on which to base a new font. Also select the File Type to make a font to use in the 
mySewnet™ Embroidery Software, or to use on your HUSQVARNA VIKING® or PFAFF® 
embroidery machine.

Font
Click the drop-down arrow for the Font and select the desired font name in the list. The 
previews to the right of the window will change according to the font choice.

Style
Click the drop-down arrow for the Style and select Regular, Bold, Italic or Bold Italic in the 
list. The previews to the right of the window will change according to the style choice.

File Type
Select a file type. 

For using in the mySewnet™ Embroidery Software: Use this option to create a font file 
for use with mySewnet™ Embroidery and other mySewnet™ Embroidery Software 
modules.

For using on my embroidery machine: Use this option to create a font file for use with 
your embroidery machine.

Machine
This option is only available if ’For using on my embroidery machine’ was selected in File Type.
Choose which machine type the font is for:

■ Husqvarna Viking
■ Pfaff
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Character Set
The available character sets are: Extended, Super Extended, Latin 1, Western 1, 2, 3 and 4, 
Cyrillic 1 and 2, Hiragana 1 and 2, Greek 1 and Hebrew 1.

Different character sets are available, depending on the selected file type.

The more characters in a font, the greater the amount of time needed to create that font. Nearest Point 
fonts require four versions of each character. Therefore, such a font will take four times as long to be 
created.

Extended
The following characters are in the Extended character set:

ABCDEFGHIJKLMNOPQRSTUVWXYZ

abcdefghijklmnopqrstuvwxyz

0123456789

!"@$£€%&*()-+_\=/?':;.,

ÀÁÂÃÄÅÆÇÈÉÊËÌÍÎÏÐÑÒÓÔÕÖØÙÚÛÜÝÞß

àáâãäåæçèéêëìíîïðñòóôõöøùúûüýþÿ

Super-Extended
The following characters are in the Super-Extended character set:

ABCDEFGHIJKLMNOPQRSTUVWXYZ

abcdefghijklmnopqrstuvwxyz

0123456789

!"@$£€%&*()-+_\=/?':;.,

ÀÁÂÃÄÅÆÇÈÉÊËÌÍÎÏÐÑÒÓÔÕÖØÙÚÛÜÝÞß

àáâãäåæçèéêëíìîïðñòóôõöøùúûüýþÿ

ŠŒŸŽšœž

#<>[]{|}~`´‘’“”™̃§¿¡¢¥©®°ˆ_

Font Format Character Set Default Set

mySewnet™ Embroidery 
Font

Extended
Super Extended
Latin 1
Cyrillic 3
Hiragana 2
Greek 1
Hebrew 1

Extended

HUSQVARNA VIKING® Font Western 1
Western 2
Western 3
Cyrillic 1
Hiragana 1

Western 1

PFAFF® Font Western 4
Cyrillic 2
Hiragana 1

Western 4
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Latin 1
The following characters are in the Latin 1 character set:

The Latin 1 character set includes all the characters in the Super-Extended set, and additional special 
characters for Turkish, Dutch, Polish, Azerbaijani, Bosnian, Croatian, Czech, Estonian, Hungarian, Latvian, 
Lithuanian, Maltese, Romani, Romanian, Serbian, Slovak, Slovene, and Welsh.

Western 1
The following characters are in the Western 1 character set:

ABCDEFGHIJKLMNOPQRSTUÜVWXYZÅÄÖ- <

abcdefghijklmnopqrstuüvwxyzåäö,.

1234567890ÆæØøàáçëèéêíóùúÑñß&?!’@

Western 2
The Western 2 character set contains fewer characters. Generally, it will convert to a font 
more quickly than the other character sets. The following characters are in the Western 2 
character set:

ABCDEFGHIJKLMNOPQRSTUÜVWXYZÅÄÖ-.

abcdefghijklmnopqrstuüvwxyzåäö,.

1234567890ÆæØø?!-,.

Western 3
The following characters are in the Western 3 character set:

ABCDEFGHIJKLMNOPQRSTUÜVWXYZÅÄÆÖ-

abcdefghijklmnopqrstuüvwxyzåäæö.

1234567890ØøàáçëèéêíóùúÑñß&?!’@,.

Western 4
The following characters are in the Western 4 character set:

ABCDEFGHIJKLMNOPQRSTUVWXYZ.,-

abcdefghijklmnopqrstuvwxyz.,-

ÅÄÖÜÆOEØÉÇÑ€$§ß&?!¿¡

åàáäâãèéëêìíïîòóöôõæoeøùúüûçñ@©

1234567890.,:;-+=%\/*°ˆ?~`´'"_
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Cyrillic, Hiragana, Greek and Hebrew fonts
Cyrillic, Hiragana (Japanese), Greek and Hebrew fonts are also available.

Creating Cyrillic, Hiragana, Greek and Hebrew fonts requires a TrueType font with the relevant set of 
Unicode characters.

Cyrillic 1
The following characters are in the Cyrillic 1 character set:

Cyrillic 2
The following characters are in the Cyrillic 2 character set:

Cyrillic 3
The following characters are in the Cyrillic 3 character set:

Hiragana 1
The following characters are in the Hiragana 1 character set:
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Hiragana 2
The following characters are in the Hiragana 2 character set:

Greek 1
The following characters are in the Greek 1 character set:

ΑΒΓΔΕΖΗΘΙΚΛΜΝΞΟΠΡΣΤΥΦΧΨΩ

αβγδεζηθικλμνξοπρςστυφχψω

ΆΈΉΊΪΌΎΫΏ

άέήίϊΐόύϋΰώ

0123456789

!"@€¢%&*()-+_\=/?―«»'‘’“”:;.,·

Hebrew 1
The following characters are in the Hebrew 1 character set:
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Set Stitch Options
Use the Set Stitch Options page of mySewnet™ QuickFont to select the type of stitching 
used to create the characters, the recommended size range or font size, the joining 
method and the default font colors.

Stitch Type
Select the Stitch Type from the drop-down list according to how you wish to embroider 
the characters in the font. The choices are:

■ Satin 
Create characters using satin columns.

■ Pattern Fill 
Create characters using Pattern Fill areas.

■ Pattern Fill + Satin Border 
Create characters using Pattern Fill areas outlined with a Satin Border.

■ Satin Border 
Create characters using satin borders.

■ Appliqué 
Create characters with appliqué fabric and placement lines, finished with a satin border.

■ Outline 
Stitch an outline around the characters using a running, double or triple stitch outline.

After selecting the desired Stitch Type, click the Options button to choose the stitch 
settings for creating lettering with the font. 
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Stitch Options
Click the Stitch Options button to choose the settings for Satin Column or Pattern Fill in 
the font. These are used with the following stitch types:

■ Satin
■ Pattern Fill
■ Pattern Fill + Satin Border

See “Stitch and Appliqué Colors” on page 416.

Most properties may also be changed when placing the lettering from these fonts in mySewnet™ 
Embroidery.

Border Stitch Options
Click the Border Stitch Options button to choose the settings for creating the Satin Border, 
Appliqué or Outline for the border around letters in the font. These are used with the 
following stitch types:

■ Pattern Fill + Satin Border
■ Satin Border
■ Appliqué
■ Outline

See “Stitch and Appliqué Colors” on page 416.

Most properties may also be changed when placing the lettering from these fonts in mySewnet™ 
Embroidery.
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Satin

Create characters using satin columns.

Plain fonts without serifs may give better results.
Use the Column options to set the satin density, gradient, pattern and underlay methods.

Density
Set the standard Density from 2 to 80. The lower the number, the closer together the 
stitches and the more stitches are produced. Density is initially set to 5.

Gradient and multicolor density are not available in mySewnet™ QuickFont.

Pattern
Choose from more than 250 patterns for satin (for areas wider than around 8-10mm). Click 
a pattern sample or set the Pattern number to select a pattern. Click No Pattern  for 
standard satin with no pattern. The Pattern is initially set to 0 (No Pattern).
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Underlay
Zigzag creates zigzag lines of running stitch as underlay. Use zigzag underlay for larger 
fonts which have wide areas of satin. Edge walk places lines of running stitch just inside 
the edges of the satin columns. Use edge walk for larger fonts when the satin columns are 
not very wide. For larger bold characters, which give very wide areas of satin, select both 
underlay types. The underlay options are initially deselected.

Edge Walk Zigzag Edge Walk plus 
Zigzag
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Pattern Fill
Create characters using pattern fill areas. 

Use the Pattern Fill options to select the 
fill pattern, fill density, stitch angle and 
underlay type. 

Gradient and multicolor density are not 
available in mySewnet™ QuickFont.
See “Pattern Fill Options” on page 411.

Pattern Fill + Satin Border
Create characters using Pattern Fill areas 
outlined with satin borders.

Use the Pattern Fill options to select the 
fill pattern, fill density, stitch angle and 
underlay type for the fill.

Gradient and multicolor density are not 
available in mySewnet™ QuickFont.
See “Pattern Fill Options” on page 411.

Use the Satin Border options to select 
the satin border density and width. 

See “Satin Border” on page 413.

Satin Border
Create the characters using satin 
borders. 

Use the Satin Border options to select 
the satin border density and width. 

See “Satin Border” on page 413.
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Appliqué

Create characters as appliqué pieces. Click Stitch Options to set the Appliqué Options, and 
click Border Stitch Options to set the Satin Line options.

Use the Appliqué Options to choose an appliqué method, set the Appliqué Piece margin, 
and whether to match the placement line to the margin.

Use the Satin Line options to select the satin border density and satin border width.

Appliqué Method
Choose the method for placing and securing the appliqué fabric.

■ Standard Appliqué
Stitch a running line to show where appliqué fabric should be placed, then stop to 
position the fabric. Stitch down the appliqué fabric with double stitch, then stop so the 
fabric may be trimmed. Finish the edges with the selected border stitching.

■ Pre-cut Piece
Use a pre-cut appliqué piece; created, for example, using an automatic cutter or cutwork 
needles.

Stitch a running line to show where the pre-cut appliqué piece should be placed, then 
stop to position the appliqué piece. Stitch down the appliqué piece with double stitch, 
then finish the edges with the selected border stitching.
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■ Pre-placed Piece
Place the appliqué fabric before stitching.

Place the appliqué layer in position, then stitch down the appliqué fabric with double 
stitch. Stop so the fabric may be trimmed. Finish the edges with the selected border 
stitching.

■ Cut-out
Use the appliqué placement line as a guide to where the fabric should be cut; for example 
for reverse appliqué.

Stitch a double stitch line. Stop so the fabric may be cut to form a hole defined by the 
stitched outline. Finish the edges with the selected border stitching.

Appliqué Piece Margin
Set the margin for appliqué placement relative to the drawn border shape from -10mm to 
10mm. The initial value is 1.0mm.

Use a positive value when trimming the appliqué fabric before the border is stitched, for example with 
Standard Appliqué and Pre-placed Appliqué. A negative value is recommended for cut-out and reverse 
appliqué.

Match Placement Line
Adjust the position of the first running stitch line for either Standard Appliqué or Pre-cut 
Piece so that it matches the outline of the appliqué piece after the Appliqué Piece Margin 
has been applied.

This may be useful for precise positioning of appliqué pieces that have been pre-cut with an automated 
cutter, to ensure the placement line is visible.
To change the appliqué fabric, see “Stitch and Appliqué Colors” on page 416.
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Outline

 

Stitch an outline around the characters using running, double or triple stitch outline.

Use the Outline options to select the outline method and stitch length.

Stitch Length
The same stitch length is used by all methods. Set the stitch length from 1 to 12mm in 
0.1mm steps. The initial setting is 1.5mm.

Method
Select Running, Double or Triple stitch for the outline of the characters. Running Stitch is a 
single continuous line of stitches. Double stitch stitches the full length of a line and then 
retraces the same path back to the starting point, resulting in a double strand of stitching. 
Triple stitch places three stitches at a time for each stitch that would be placed by running 
stitch (one forward, one back and another forward) resulting in a triple strand of stitching. 
The initial setting is Running Stitch.

Running Double Triple
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Pattern Fill Options
Use the Pattern Fill options to select the fill pattern, fill density, stitch angle and underlay 
type.

Changes to the Pattern Fill settings will affect the fill options for Pattern Fill as well as for Pattern Fill + Satin 
Border.

Pattern
Select the desired pattern number. There are several ways to select patterns:

• Click the drop-down arrow below the pattern sample and scroll down to choose a 
pattern Category, and a pattern. Click the desired pattern sample and the Pattern 
number is shown.

• Enter a favorite Pattern number directly in the Pattern box. As you type the number, the 
correct pattern sample is selected immediately.

• Use a My Fill pattern created with Manage My Fills in mySewnet™ Digitizing. View the 
patterns in the pattern gallery.

Patterns in categories other than Standard are recommended for use in relatively large fill areas, as they 
have repeating patterns which work well when 'tiled' together. Pattern 36 produces a 'satin effect' fill stitch.
For a complete reference to all the fill patterns that can be used for fonts, see the Fill Patterns Sample Guide. 
This is provided as a PDF for viewing and printing.

Density
Set the standard Density from 2 to 80. The lower the number, the 
closer together the stitches and the more stitches are produced. 
The Density is initially set to 2.

Gradient and multicolor density are not available in mySewnet™ QuickFont.

Choose a Category
and Pattern

Search for a Pattern
by number

Set the pattern Angle

Choose Underlay 
densityUse a My Fills pattern
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Options
Use the Options area to change the angle and underlay for the Pattern Fill.

Angle
The angle of the fill pattern, as shown by the arrow. The thread is at a 
right angle to the fill pattern. Set the Angle from 0 to 359 degrees. 
The Angle is initially set to 350 degrees.

Underlay
Choose from None, Low, Medium or High density underlay. Underlay 
is a low density fill that is perpendicular to the stitches of the actual 
fill area. Underlay is useful for stabilizing large fill areas. The Underlay is initially set to Low.
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Satin Border
Use the Satin Line options to select the satin border density, width and taper.

Changes to the Satin Line settings will affect the satin options for Satin Border as well as for Pattern Fill + 
Satin Border.

Satin Width
Set width for satin border from 1 to 12mm in 0.1mm steps. The Satin Width is initially set to 
2.0mm.

Satin Density
Set the standard Density from 2 to 15. The lower the number, the closer together the 
stitches and the more stitches are produced. The Satin Density is initially set to 5.

Satin Underlay
Use this option to place edge walk underlay inside each edge of the satin border. Underlay 
will not be generated if the Satin Width is set below 2mm.

Tapered Ends
Tapered Ends are not available in mySewnet™ QuickFont.

Output Size and Output Size Range
The size may change according to the chosen Stitch Type. The initial settings are within 
the recommended range. The sizes available are:

Stitch Type
Recommended 

Sizes
Smallest and 
Largest Sizes

Satin 12 to 30mm 7 to 50mm

Fill 20 to 120mm 10 to 200mm

Fill + Satin Border 80 to 120mm 50 to 200mm
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Output Size
The Output Size setting is available if the font was selected for using on an embroidery 
machine. Set it as desired.

Output Size Range
The Output Size Range settings are available if the font was selected for using in the 
mySewnet™ Embroidery Software. 

The Minimum and Maximum sizes are the recommended sizes for the font, and are set 
according to the stitch type used. Set them as desired.

The preview shows the middle size in the range.

Joining Point
Set the joining method for the font.

This option is only available for fonts created for use in the mySewnet™ Embroidery Software. It is not 
available for fonts for use on an embroidery machine.

Baseline
This is the standard joining method. The characters are joined along the 'baseline' on 
which the characters sit. Use Trim Connection on the Letter tab to insert trim commands 
that trim the long connecting stitches between characters while the lettering is stitched 
out.

Nearest Point
Nearest point fonts use special logic in mySewnet™ Embroidery to determine the best way 
to join characters together. Nearest Point is recommended for faster stitchout of small 
fonts, where connection stitches will be left untrimmed. Choose Running Connection on 

Satin Border 80 to 120mm 50 to 200mm

Appliqué 80 to 120mm 50 to 200mm

Outline 50 to 120mm 25 to 200mm

Stitch Type
Recommended 

Sizes
Smallest and 
Largest Sizes
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the Letter tab to avoid the need for trimming with small characters. Each character has 
four versions to give different start (on the left) and end (on the right) points as follows:

When placing lettering, the correct character versions are automatically selected to give 
the shortest joining distances between each character. Here, the two Ms are connected in 
different ways (top left to bottom right and bottom left to top right):

Continuous
Continuous fonts are typically used to give a flowing handwriting effect for script. When 
continuous fonts are used for lettering, no space is added between the lowercase letters. 
(The Gap setting is not used.) Therefore, select Continuous for Script fonts where the 
lowercase letters are joined. All other characters are connected the same way as baseline 
fonts.

Bottom Left to Bottom Right Top Left to Top Right

Top Left to Bottom Right Bottom Left to Top Right
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Stitch and Appliqué Colors
Click Thread Color  to change the thread color used for continuous satin and pattern fill 
areas. The Color Selection dialog box will appear for you to choose a new color.

Click Border Thread Color  to change the thread color used for satin borders, appliqué 
and outlines. The Color Selection dialog box will appear for you to choose a new color.

After you have chosen a new thread color, the previews will be shown with the new color.
Click Appliqué Color  to change the appliqué fabric color. The Appliqué Selection 
dialog box will appear for you to choose a new fabric.

Only Quick Appliqués are available in mySewnet™ QuickFont, to optimize font creation and loading time.

Select a thread range
Show chosen thread ranges

Search for a thread number

Click a thread color
to select a thread

View the thread information

Click a Quick Color to select
a matching thread color

Choose a Quick Color Theme

Puffy Foam depth

Twin needle
stitch size & color

Second thread
color

Wing needle

Felting needle

Cutwork needle
angle

Open Thread Cache

Select a Quick Color & texture

Preview the appliqué fabric

Reuse a recent fabric
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Output Options
Use the Output Options page of mySewnet™ QuickFont to review the font, to name it, and 
to select where it will be saved.

Font Name
The Font Name is automatically generated to show the TrueType® font name, then the 
style (R for Regular, B for Bold, I for Italic or BI for Bold Italic), then the Stitch Type (S for 
Satin, F for Fill, FSB for Fill + Satin Border, SB for Satin Border, A for Appliqué or O for 
Outline), then the Character Set (E for Extended; SE for Super Extended; L1 for Latin 1; W1, 
W2, W3 and W4 for Western 1, 2, 3 and 4; C1, C2 and C3 for Cyrillic 1, 2 and 3; H1 and H2 for 
Hiragana 1 and 2; G1 for Greek 1; and Hb1 for Hebrew 1); then the minimum and 
maximum recommended sizes in millimeters (or the Output Size for a machine font).

You may change the Font Name as desired. 

The font name will be reset to the automatic name if you click Back and then return to the Set Font Name 
page.

mySewnet Embroidery Font
The categories are the same as the categories on the Letter tab in mySewnet™ 
Embroidery.

The Category is initially set according to your choice of Joining Point. It will be set to 
MyFonts for Baseline joining, Nearest Point for Nearest Point joining or Script for 
Continuous joining.

You may select any Category as desired. 

The Category will be reset to the default selection according to Joining Point if you click Back and then 
return to the Set Font Name page.

Save to USB Stick or Folder
This option is only available if the font was selected for using on an embroidery machine.
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Save the font as a .vf3 (font) file on your computer, or to a USB stick. By default the font is 
saved to \mySewnet\My Designs\.

To save to a different folder, or to a USB stick, click the button with three dots  and 
browse to the desired location.

Click OK to save the font.

To use the font on your embroidery machine, do as follows:

■ Browse from the embroidery machine using File Manager or Files & Folders and download 
the font from your computer.

■ Save the .vf3 file to a USB Embroidery Stick (or copy using Windows® Explorer); then 
transfer it to your embroidery machine.

Print Catalog
Click the Print Catalog button to print a reference sheet showing the characters in the font.

The Print dialog box appears, where you may specify number of copies, the destination 
printer, and other printer setup options. Click OK to print the catalog.

Printer
Select the printer you want to use.
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Properties
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Print to File
When this option is checked, you will be prompted for a file name after you click OK. The 
print job will then be saved with the file name you specify and can be sent to the printer at 
a later time.

This is an advanced Windows® printing option.

Print Range
Select the range of pages you wish to print.

Copies
Select the number of Copies you wish to print. If you choose to print more than one copy, 
you can choose to Collate the copies.

New Font
Select the New Font checkbox to start a new font when the current font has been created. 
mySewnet™ QuickFont displays the Select Font page.

Preview
The 3D view boxes allow you to browse through the converted font, showing three 
uppercase letters, three lowercase letters, and three numbers or symbols. The character 
order is the same as the selected character set. 

You can change the 3D background with mySewnet™ Configure.

Previous
View the previous nine characters.

Next
View the next nine characters.

Real Size%
This box shows how big the 3D view you can see is as a percentage of the real size of the 
generated stitch files. This depends on the Real Size setting being correct in mySewnet™ 
Configure.
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Create a Pattern Fill Font
1 In mySewnet™ Embroidery, click the Letter tab, and in Font Manager  click the QuickFont Wizard 

icon . Alternatively, use mySewnet™ QuickFont from the Utilities tab of mySewnet™ Configure. You 
can also start mySewnet™ QuickFont in the Windows® Start Screen, Start Menu, or on the Desktop.
The Select Font page will appear.

2 Click the drop-down arrow for Font and choose Trebuchet MS from the list of fonts. The previews will 
show the appearance of the 'ABC', ’abc’ and '123' characters in the font.

3 Ensure the Style is set to Regular.
4 If you are creating a font for use in mySewnet™ Embroidery, choose ’For using in the mySewnet™ 

Embroidery Software’.
If you are creating a font for a machine, select ’For using on my embroidery machine’, and choose your 
machine brand.
The pictures here illustrate using mySewnet™ QuickFont to create a font for mySewnet™ Embroidery.

5 Select a character set:
• If you are using mySewnet™ 
QuickFont for mySewnet™ 
Embroidery, ensure that 
Extended is set as the 
Character Set.
• If you are creating a font for a 
HUSQVARNA VIKING® 
embroidery machine, ensure 
that Western 1 is set as the 
Character Set.
• If you are creating a font for a 
PFAFF® embroidery machine, 
ensure that Western 4 is set as 
the Character Set.
These character sets are 
appropriate for general English 
text, with letters, numbers and 
some punctuation.

6 Click Next and the Set Stitch 
Options page will appear.

7 Set the Stitch Type to Pattern Fill . The previews now show the pattern fill, and the Output Size and 
Output Size Range values change, as Pattern Fill is suitable for larger letter sizes than the default Satin.

8 Click the Stitch Options button and the Pattern Fill dialog box will appear.
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9 Ensure the Pattern is set to 3 from the Standard 1 
Category.

10 In the Density area, ensure the Density is set to 2 
and click OK.

11 Click the Thread Color icon  and the Color 
Selection dialog box will appear. 

12 Ensure the Thread Range is set to Robison-Anton 
Rayon 40. 

13 Click in the Find Thread box and enter '2409'. 
Thread color 2409 (Yellow Mist) will be found in 
the list.

14 Click OK and the previews will 
be updated with the new 
thread color.

15 Ensure the Joining Point is set 
to Baseline, which is the 
recommended setting for most 
lettering.
Nearest Point is recommended 
for faster stitchout of small fonts, 
where connection stitches will be 
left untrimmed. Continuous is 
used for Script fonts where the 
lowercase letters are joined.
The Joining Point options are 
only available when creating a 
font for use in mySewnet™ 
Embroidery. They are not 
accessible when creating a 
machine font.

16 Click Next. The font is 
generated, and the Output Options page will appear.

17 Use Next and Previous to preview the other letters in the font.
18 Leave the Font Name unchanged.

The Font Name is automatically generated to show the TrueType® font name, then the style (R for Regular), 
then the Stitch Type (F for Pattern Fill), then the Character Set (here E for Extended), then the minimum and 
maximum recommended sizes in millimeters (or output size for a machine font). Other letter combinations 
are used for different style and stitch type choices.

19 If you are creating a font in mySewnet™ QuickFont for use in mySewnet™ Embroidery, leave the 
Category as MyFonts. This will save the font to the MyFonts folder on your computer.

20 If you are creating a font for use on a machine, save the font to the My Designs folder on your 
computer (the default location), or to a USB embroidery stick.

21 If desired, click Print Catalog to print a reference sheet that shows the font details and the characters 
in the new font.

22 Click Finish to close mySewnet™ QuickFont.
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To use the font in mySewnet™ Embroidery, click the drop-down arrow on the right of the font gallery, and 
scroll to the MyFonts category. The font Trebuchet MS_R_F_E_20_120 will be previewed in the MyFonts 
section of the font gallery. 
The Font Gallery will automatically detect and preview any new fonts you add to MyFonts, and the font 
can be used in the same way as the system fonts.
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22Name Changer
Use Name Changer  to create a series of embroideries with varied lettering 
automatically from a template that you designed. Use a delimiter to place your text on two 
different lines.

Use Name Changer to create customized embroideries for a child’s clothing, a sports team or company 
shirt, a wedding place name or hanky, or for a set of labels.

Shortcuts

■ Letter Tab: 
■ Keys: Alt, L, N

Using Name Changer
Design a template embroidery with some lettering, then select the piece of lettering to be 
changed, and use Name Changer  to create multiple versions of this design with 
varying words. Export the designs as individual embroideries.

Enter the desired names, or paste in a list of names. Then use the Previous  and Next  
buttons to view the created designs.
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Name List
Type a list of names, or paste in a list from a word processor or spreadsheet.

Your word list will still be available if you re-open Name Changer during the same session.

Line Delimiter
Choose a delimiter to break the text onto two lines. Choose from a Comma, Tab, Space or 
None.

In the picture above, the space was used as a delimiter to place the names on two lines.

Edit in a New Window
Use Edit in a New Window  to open the selected design in a new window, for example 
if a frame needs adjusting around a name that is too long, or too short.

Save the edited embroidery from that window.

Previous and Next
Use Previous  and Next  to view the automatically created designs. The Design 
Information shows the number of stitches and other details for the previewed design.

Design Information
View the design information for the selected design.

Export
Export the complete set of designs.

The design name will be created from the name of your template design, followed by the text for the name 
concerned.

Enter or paste in a list of names

View the details for the selected design

Preview the selected design

Select a delimiter

Edit the selected design in a new window
Preview your designs

Export the designs 
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Create a Template Design for use with Name Changer
First, create the base design for your changing text, and save it as a template. This design 
uses two SuperDesigns to frame the lettering to be changed. Use a 100 x 100 hoop.

1 In the SuperDesign tab, select the first design in the Corners Category, and click Apply twice.
2 On the upper of the two copies, click the 

horizontal and vertical flip handles to form the 
upper part of a frame. Then move the 
SuperDesign copies to create the frame.

3 Click the Letter tab.
4 In the Font Gallery, scroll down to the Script 

Category, and select the font Nimbus 15-
45mm.

5 In the Letters text box, enter the name 
"Andrew".

6 Press the Return key to start a new line, and 
then enter "Cooper".

7 Press Apply.
8 Move the text to between the two parts of 

your frame.
The two lines of text here can be used as two lines 
of text in your designs. They could also be used 
with the Full Circle lettering shape to place text 
above and below an embroidery.

9 Make any other edits to the template, such as 
matching the design and lettering colors.

10 Save your design as "Place Name Template" for 
future use.

Use your Template Design with Name Changer
11 Select the lettering to be changed in your design. Then, in the Letter tab, click Name Changer .

If the design was Grouped, use Reveal Groups  and then select the lettering.

Note that the design as it was loaded only contains the first name - this is because the second name 
has been used for the second design. Use Line Delimiter to change this.

12 In the Line Delimiter drop-down menu select "space".
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13 Then, in the Name List place a space after "Andrew", and press the Delete key to remove the line break 
before "Cooper". Both names are now shown.

14 Enter several more names in the Name List text box, with a space between the two parts of the name.
Use the comma or tab delimiter when pasting in a list of names from a spreadsheet, or a formal word 
processed document.

15 Use the Previous  and Next  buttons to move through the designs.

Note that the design information for each design is shown below the preview.
16 If a design does not look right, for example if it touches the frame, click Edit in a New Window , 

and adjust it in the new mySewnet™ Embroidery window. Then save your adjusted design.
You can remove the name from your list, or remove the automatically created embroidery from the set of 
Exported embroideries before you stitch out.

17 If several embroideries look wrong, close Name Changer and adjust your template so that the names 
will fit better. Save the template, then open Name Changer again.

18 When you are happy with your automatically created set of embroideries, click Export. See “Export” 
on page 20.

19 In the Export dialog box, choose your file format (for example .vp3) and then click OK. The Save As 
dialog box is displayed.

20 In the Save As dialog the name of your template design is shown - here "Place Name Template". 
Shorten the name, for example to "Place Name", as the name in your list will be added to that design’s 
name.

21 Click Save to generate the designs, one for each name.
22 Use Windows Explorer to check that the designs have been created, and to look at them.
23 Before closing down mySewnet™ Embroidery, open Name Changer again.
24 Select your list of names, then use Ctrl+C to copy it. Close Name Changer.
25 Select the lettering in your template embroidery, and ensure that Notes  is selected in the Design 

Panel.
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26 Click Edit , then paste the list of names into the Notes (Ctrl+V). Click OK to close the Notes.
Reopen the template file and add more names, or use a completely different set of names with that 
template for a different collection of designs.

27 Save the template embroidery with your list of names.
You can use the Alignment tools to place the embroideries together in a large hoop for stitching out 
together on non-fraying fabric, then trim as desired.
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23Creating SuperDesigns

Using SuperDesigns
Create SuperDesigns from the SuperDesign sets available in mySewnet™ Embroidery. 
SuperDesigns are special designs that can be resized with constant stitch density.

Some SuperDesigns are multicolored, and the stitch type and style for many can be 
changed. Alter the size, proportions, stitch type and thread color. A SuperDesign can be 
resized with constant stitch density, and the stitch properties adjusted even after saving, 
until it is fixed as embroidery.

When first starting mySewnet™ Embroidery the Animals category is selected. If you have used the 
SuperDesign tab previously, the most recent category is remembered.
SuperDesign sets are grouped into categories. Each set contains 9 SuperDesigns, each of 
which may have multiple styles. The SuperDesign gallery shows thumbnails of all the 
SuperDesigns in the currently selected SuperDesign set. SuperDesigns have names and 
keywords, to allow you to search easily in all categories.

Create a SuperDesign
1 Click the SuperDesign tab.
2 Search for a SuperDesign, or choose a SuperDesign Category from the drop-down menu on the left. 

The preview will show the first design set in that category.
Select a single Category, or browse All categories.

3 Click the arrow to the right of the set drop-down menu and choose a SuperDesign set, then click a 
design to select it.

4 Set the Size in millimeters as desired, from 5mm to 200mm. This sets the height of the SuperDesign, 
and the width is set proportionally.

5 Click the arrows for width  and height  to change the proportions of the design from 25% to 
400%. Alternatively, enter a size in the number box.

6 If desired, select a line or fill type from the Stitch Type  drop-down menu to open the properties 
dialog for the stitch type. See “Choosing Stitch Properties” on page 454.

7 Change the stitch properties for the SuperDesign in the properties dialog, for example the density, 
and the stitch length, angle and pattern. Click OK to close the dialog.

8 Click Apply . The SuperDesign appears in the work area, leaving any existing SuperDesigns 
unchanged.

Search
Search for a SuperDesign by name, folder name, or keyword. 

Choose a SuperDesign Category

Choose a SuperDesign Set

Place the design in the work area

Select a design

Adjust the size of your chosen design

Change the stitching and appliqué in the design
Adjust the proportions of the design

Search for a SuperDesign
Change the style for the SuperDesign
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Enter the desired text in the Search box and press Enter. Click Clear Search to remove the 
search text, and use the drop-down menu to reuse previous searches.

Click Clear Search before browsing SuperDesigns by Category.

Shortcuts
■ Search - Keys: Alt, S, E
■ Clear Search - Keys: Alt, S, X

Search for a SuperDesign
1 Click the SuperDesign tab.
2 Enter a search term in the Search box, for example ’christmas’, and press Enter.
3 Click the drop-down menu on the right to view all of the Christmas designs.

These include designs from Christmas categories, and single designs with a Christmas theme.
4 Note that the SuperDesign Category drop-down menu is not available, as the Search uses all 

categories. Click the Clear Search button on the left. The most recently used category becomes 
available.

5 In the Search box enter ’dog’, then press Enter.
Besides 18 household pets, there are also three pictures of a sausage in a roll (a hotdog). Searching may 
sometimes produce unexpected results!

6 Click the Clear Search button to return to Category view.
7 In the Search box enter ’lion’, then press Enter. There are twelve different Lion designs.
8 Place the pointer over the first four lions in turn.

The first two are from the Cute Animals set, the next three are from the Animals set in the Appliqué 
Category, and the fourth is from Tassels. They are all named Lion. The Search checks Category and 
SuperDesign names, in addition to keywords.

9 Place the pointer over the next six lions.
Click on the drop-down arrow on the right 
to see more lions.
The remaining lions are from Zodiac, and 
are named Leo. The term "Lion" is from the 
keywords for these SuperDesigns.

10 Click to select the first Leo, then click the Stitch Type drop-down menu. The stitch types for this 
individual SuperDesign are listed.
The Search function finds all varieties of a particular SuperDesign, so there is no need to check the Styles 
for a SuperDesign set individually when using Search. In the example above, the appliqué lions using Satin 
Line, and two styles of Motif Line are found.

SuperDesign Categories
There are 29 SuperDesign categories: Animals, Appliqué, Borders, Buttonholes, Cartoons, 
Celebrations, ChildStyle, Corners, Effects, Encore, Fantasy, Flowers and Leaves, Food and 
Drink, Hearts, Holidays, Home, Music, People, Redwork, Religious, Scallop, Sports, Sports 
Symbols, Stars, Tassels, Transport, Trees, Wreath and Zodiac.

Shortcut
Keys: Alt, S, G

SuperDesign Set
Each SuperDesign category contains numbered SuperDesign sets. Each set contains 9 
SuperDesigns.
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A set of SuperDesigns has its own default size. This size is used each time the SuperDesign 
set is first selected.

Select Style
Some SuperDesign sets have varied styles, for example the size variations in Fantasy 
(Small, Medium, Large), the border variations in Appliqué (Satin Border, Motif Border 1, 
Motif Border 2), or the Fill and Outline variants in Cartoons.

Use the Select Style drop-down menu to choose between these variants. The selected set 
is displayed in the Gallery.

SuperDesign Effects
Some SuperDesigns use effects such as appliqué, felting needle, twin needle, wing needle 
and tassels.

SuperDesign Size
When selected, a SuperDesign is set at its recommended size, representing the height of 
the SuperDesign. You can change the SuperDesign dimensions in the Size area of the 
SuperDesign tab. SuperDesign size can be set from 5mm to 200mm. 

If you set a satin SuperDesign to a very large size, use Satin Properties to choose a pattern which will 
prevent loose stitching that may catch and pull easily. See “Satin Column” on page 485.
Once a SuperDesign has been converted to an embroidery it can only be scaled and 
resized in the same way as any other embroidery. If further adjustments are required, 
place the design again as a new SuperDesign.

Height and Width
Adjust height  and width  separately to change the proportions of the SuperDesign. 
For instance, increase height to make the design taller without increasing the width.

Height and width can be set from 25% to 400% of the original size, in steps of 1%.

Stitch Type
Use Stitch Type  to alter the appearance of the stitching used in the selected 
SuperDesign. 

If there is more than one stitch area of a particular type in the design, the drop-down menu will show that 
stitch type in a numbered list; for example Pattern Fill 1, Pattern Fill 2.

Appliqué SuperDesigns for use with appliqué fabrics. (Appliqué Category)

Felting Needle SuperDesigns with a design embellished by using a felting needle and, optionally, 
a contrasting roving fiber. (Effects Category)

Twin Needle SuperDesigns stitched out using a twin needle. This creates a horizontal offset 
between the original thread color in the left-hand needle, and a second thread 
color in the right-hand needle. (Effects Category)

Wing Needle SuperDesigns using a wing needle to create holes in the fabric for hemstitch and 
other heirloom techniques. (Effects Category)

Tassels SuperDesigns using tassels. (Tassels Category)
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If desired, select a line or fill type from the Stitch Type  drop-down menu to open the 
properties dialog box for the stitch type. Use the properties dialog box to alter the 
appearance of stitching in the lettering.

Change the Stitch Type in a SuperDesign
1 In the Quick Access toolbar, click Change Hoop  and change to hoop to Universal, 170mm x 

100mm - Universal Midsize Hoop 1, Rotated and click OK.
2 Open the SuperDesign tab and choose "Animals" from the SuperDesign Category drop-down menu.
3 Click the arrow to the right of the SuperDesign set drop-down menu and choose Dinosaurs 1.
4 Select design 3, the Stegosaurus, and set Size 

to 70mm.
5 Click Stitch Type , and in the drop-down 

menu select Pattern Fill 2. The Pattern Fill 
dialog box opens.

6 Change the pattern to 174 (column 6 row 1 in 
Polygons), then click OK.

7 Click Apply , and the embroidery of the 
Stegosaurus appears in the work area, with a 
pattern similar to scales on the upper body.

8 Click the Frame tab, and place a frame around 
the Stegosaurus.

9 Click the SuperDesign tab. Your settings have been retained.
10 Click Undo  to remove the frame.
11 Click the Modify tab, and you are warned that the design will be fixed as an embroidery. Edit it as 

desired.
12 Click the SuperDesign tab again. The settings for the Stegosaurus are still as you set them.
13 Click Apply  to place another copy of the Stegosaurus.
14 Click the Triceratops (number 6). The Size has changed to 45mm (the default size for this design).
15 In Stitch Type , select Pattern Fill 2. The settings are the default settings for this SuperDesign 

(Pattern 3, and Angle 0).
Adjusting the settings before placing the SuperDesign is useful if several versions of the same design are to 
be used. When a different SuperDesign is selected, the default settings are used.

16 Right-click the second copy of the Stegosaurus, and in the Context menu select Pattern Fill, Pattern 
Fill 2. The Pattern Fill dialog box appears, enabling you to further adjust the design.
You could create a number of Stegosaurus designs with the same pattern, but different colors, or angle. 
You could also duplicate the adjusted SuperDesign, and then make further adjustments to the copy.

17 In the Category drop-down list, select Celebrations, design 3, some bells.
18 Click Stitch Type , and look at the drop-down menu. There are nine types of pattern fill. 

For this design, you would need to find out where each of many pattern fills were used. It would probably 
be easier to place the design and adjust it afterwards. See “Changing SuperDesign Stitch Types” on 
page 433.

Edit SuperDesigns
You can adjust SuperDesigns after they are placed in the work area, and before they have 
been fixed as stitches, even after saving.

A SuperDesign that has not been fixed as an embroidery has green handles. A SuperDesign fixed as an 
embroidery has white handles or blue handles. See “Resize and Scale” on page 73.
To Adjust SuperDesigns:
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■ Drag the green handles to change the shape of a SuperDesign. Hold the Shift key while 
dragging to retain the original proportions, or the Ctrl key to resize from the center. See 
“Reshaping a SuperDesign” on page 432.

■ Right–click a SuperDesign and select an option from the Context menu:
• Choose Properties to change the size, height and width. See “Changing SuperDesign 

Properties and Stitch Type” on page 433.
• Choose a stitch type and open its properties dialog to alter properties such as density, 

stitch length, angle and pattern. See “Choosing Stitch Properties” on page 454.
If there is more than one stitch area of a particular type in the design, the drop-down menu will show that 
stitch type in a numbered list; for example Pattern Fill 1, Pattern Fill 2.
• For Appliqué SuperDesigns, in the Context menu select Appliqué Fabric, then choose a 

fabric from the submenu. The Appliqué Selection dialog box opens. See “Change the 
Fabric in an Appliqué Embroidery” on page 183, and “Appliqué Selection” on page 192.

The position of the pattern in an appliqué fabric may only be changed after fixing as stitches.
■ To change the thread colors in the SuperDesign, click a thread color in the Design Panel. 

See “Change an Existing Thread Color” on page 53.

To fix the SuperDesign as stitches, see “Fixing SuperDesigns as Embroideries” on page 436.

Reshaping a SuperDesign
1 Choose a SuperDesign in the SuperDesign window. See “Create a SuperDesign” on page 428.
2 Click Apply . The SuperDesign appears in the work area.
3 Drag the design a short distance to the right. A four arrow pointer appears as you drag.
4 Place the pointer over one of the square green handles at the corners of the design. The Adjust/resize 

pointer  appears.
5 Drag the handle to change the shape of the SuperDesign.
6 Hold the Shift key and drag one of the handles. The size changes, but the shape remains the same. 

Hold down Ctrl to resize from the center.
Alternatively, you can right-click and select Properties. In the Options dialog change the size and 
proportions and click OK.

7 Right-click the SuperDesign, and in the Context menu select Fix as Stitches . The handles on the 
design are now white, indicating that the SuperDesign has been fixed as an embroidery.
The SuperDesign will also be fixed as an embroidery if you adjust it in the Modify tab.

8 Click Undo. The green handles reappear. You can adjust the design again.

SuperDesign Options
Use the SuperDesign options dialog box to change the size, and the percentage width  
and height  of a SuperDesign that has been placed on the work area.

To change SuperDesigns before you have clicked Apply, use the SuperDesign tab. See 
“Create a SuperDesign” on page 428.

SuperDesign properties may not be changed once the design has been converted to embroidery.

Change the SuperDesign size

Adjust the proportions of the design

Rotate the design



mySewnet™ Embroidery   Creating SuperDesigns              433

To open SuperDesign properties, right-click the SuperDesign, and select Properties from 
the Context menu.

Size
SuperDesign size can be set from 5mm to 200mm. This is the height of the SuperDesign.

Height and Width
Use height  and width  to adjust the proportions of the SuperDesign. For instance, to 
make the design taller without increasing the width, increase the height.

Height and width can be set from 25% to 400% of the original size, in steps of 1%.

Changing SuperDesign Properties and Stitch Type
Use the SuperDesign options dialog to change a design after it has been placed, and even 
after saving, but before it has been fixed as an embroidery.

You cannot change the design itself with SuperDesign Properties. Create a new design instead. To change 
the stitch type, right–click the SuperDesign and select the stitch type from the Context menu. See 
“Choosing Stitch Properties” on page 454.

1 Right-click the SuperDesign and select Properties from the Context menu. The SuperDesign Options 
dialog appears.

2 Adjust Size to change the basic size of the SuperDesign. It is recommended to use a size within the 
range suggested in the SuperDesign guide.
Each SuperDesign has its own default size. The default size is set automatically each time a SuperDesign is 
selected.

3 Click the arrows for percentage width  and height  to change the proportions of the 
SuperDesign. Alternatively, enter a size in the number box.
You can change each proportion from 25% to 400% of the default setting in steps of 1%.

4 Click OK to apply your changes to the selected SuperDesign.
To change the stitch types or appliqué pieces within the SuperDesign, right-click the SuperDesign and 
select the desired stitch type area or appliqué fabric from the Context menu. The properties dialog for the 
stitch type, or the Appliqué Selection dialog box for that appliqué appears. See “Choosing Stitch 
Properties” on page 454 and “Appliqué Selection” on page 192.

Changing SuperDesign Stitch Types
1 Open the SuperDesign tab and choose "Holidays" 

from the SuperDesign Category drop-down 
menu.

2 Click the arrow to the right of the SuperDesign set 
drop-down menu and choose Christmas 1.

3 Click the sixth design in the set, Reindeer.
4 Set Size to 120mm, and click Apply .
5 Right-click the SuperDesign.
6 Near the top of the Context menu three stitch 

types are listed. Click Satin Column. The Satin 
Column properties dialog box opens.

7 Change the density to 10 and click OK. The stitch 
density of the antlers, and detail on the eyes and 
nose has become less dense. 

8 Right-click the reindeer again and click Pattern Fill 
in the Context menu. A submenu with three 
options appears.
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9 Click Pattern Fill 1, and change the pattern in the fill to 230. 
Then click OK. The upper body is now patterned, with the 
curves following the contours of the deer.

10 Open the Pattern Fill submenu again, and click Pattern Fill 2. 
Change the pattern in the fill to 237 and click OK. The lower 
body is now patterned with broad curves.
Try different effects on different stitch types and see how the 
SuperDesign changes. You can add a pattern, change the stitch 
density, or make other changes to personalize the design.

Changing SuperDesign Appliqué
1 Open the SuperDesign tab and choose "Appliqué" 

from the SuperDesign Category drop-down menu.
2 Click the arrow to the right of the SuperDesign set 

drop-down menu and choose Children 1.
3 Click the fifth design in the set, Blocks, and click 

Apply .
4 Right-click the SuperDesign.
5 Near the top of the Context menu Appliqué Fabric 

and Satin Line are listed. Click Appliqué Fabric in 
the Context menu. A submenu with three options 
appears.

6 Click Appliqué Fabric 1. The Appliqué Selection 
dialog box appears.

7 Click Load Previously Saved Fabric  and choose a different colored fabric.
8 Change the other fabrics in the blocks.

You can also change the angle of the fabric pattern, and use the Color Select area to change the thread 
color for the border. See “Appliqué Selection” on page 192.

SuperDesign Color
You can change the colors of SuperDesigns before or after they have been fixed as 
embroideries.

Change SuperDesign Color
1 Open the SuperDesign tab and choose "Borders" from the SuperDesign Category drop-down menu.
2 Click the arrow to the right of the SuperDesign set drop-down menu and 

choose Borders 1.
3 Click the final design in the set and click Apply .
4 Click the Home tab.

The thread colors for the SuperDesign can be seen in the Color Select area.
5 Double-click the top color in the list. The Color Selection dialog opens. See 

“Change an Existing Thread Color” on page 53 for more information.
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6 Change this pale green to a deeper green.
7 Click OK to close the dialog.

The green has changed in the Design window and in 
the SuperDesign in the work area.

8 Undo  the color change. The SuperDesign has 
returned to its original colors.
If you plan to create many of the same SuperDesigns 
using Duplicate  or Encore, it is recommended to 
change colors before creating the additional ones. 
Alternatively, you may Combine  and ColorSort , 
and then change the colors.

SuperDesigns with Appliqué and Effects
For appliqué fonts, SuperDesigns, and frames the fabric can be changed as well as some of 
the border settings. For example, in Stitch Type  select Appliqué Fabric, and in the 
Appliqué Selection dialog change the fabric, angle and margin. See “Appliqué Selection” 
on page 192. The appliqué placement stitches cannot be edited, but the position of the 
placement line may be adjusted to match the appliqué piece margin. 

The position of the pattern in an appliqué fabric may only be changed after fixing as stitches.
For effects such as Felting Needle, Twin Needle and Wing Needle you can change the 
stitch properties in Stitch Type  or in the Context menu after creation. Change the 
Felting Needle color from the color select area in the Design Panel. Change to the 
appropriate needle before stitching.

Stitching out an Appliqué SuperDesign
Appliqué SuperDesigns are designed to be stitched out in a particular sequence. They are 
created with the standard appliqué options, to trim on the machine. Preview the two 
stops in the Design Player, with instructions to place the fabric and to trim it. These 
instructions are also present on the printed worksheet.

If you are using pre-cut pieces (with outlines created in Export Appliqué Pieces for a fabric cutter or 
INSPIRA® Cutwork Needles), the second stop can be ignored as there is no need to trim. It may also be 
useful to match the placement line to the appliqué piece margin, to ensure the placement line is visible.
When stitching out an appliqué embroidery, do as follows: 

1 Begin embroidering. A running line will show where to position the appliqué fabric.
2 A stop then allows you to place the fabric. The message "Place the appliqué fabric now" is displayed.
3 Stitch down the appliqué fabric with double stitch.
4 The machine stops again, and the message "Cut around the appliqué" is displayed. Trim the fabric.
5 Finally, finish the edges with the satin or motif line. 
6 Stitch out any other appliqué pieces in the SuperDesign.

When stitching out an appliqué frame, the placement section in the appliqué is the same color as the first 
color in the frame, so it doesn’t show under the appliqué fabric. If desired, change in mySewnet™ 
Embroidery to the first color for the embroidery.

Stitching out with Twin Needles
Twin Needles only work horizontally, i.e. the needles are side by side as you look at the 
machine. If the hoop orientation or the exported design is rotated, this will affect the 
stitchout of the design.
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Stitching out with Wing Needles
A wing needle creates holes in the fabric, for hemstitch and other heirloom techniques. 
Use a very fine thread and a stabilizer to create evenly placed durable holes.

Stitching out with Felting Needles
Use a felting needle, optionally with a contrasting roving fiber, for the felting color chosen 
in the Color Selection dialog box. In projects without a roving fiber, choose a felting 
needle color similar to the back of the fabric.

When Exporting an embroidery with a Felting Needle effect, the option "Flip design for felting or reverse 
embroidery" is initially selected in the Export dialog box. See “Export” on page 20.

Fixing SuperDesigns as Embroideries
Fixing SuperDesigns as Embroideries
SuperDesigns are fixed as an embroidery when the Modify tab is selected, Fix as 
Stitches  is used, or they are Combined with another design. The stitches are then 
created, and any further resizing of the embroidery may affect stitch density and length. 
The stitch properties, for example the density, pattern, angle or stitch length, may not be 
changed after it is fixed. Appliqué fabric cannot be changed in the Context menu after the 
SuperDesign is fixed, but you may use the Select Appliqué features on the Appliqué tab.

When SuperDesigns are fixed as stitches, the handles change from green to white. After a SuperDesign has 
been converted to embroidery, it can no longer be changed with SuperDesign properties, and the stitch 

types cannot be adjusted. If the Resize  mode is selected, the handles will become blue. 

To reverse fixing as an embroidery, click Undo .

To fix a SuperDesign as an embroidery deliberately, right-click it and select Fix as Stitches  from the 
Context menu, or select Fix as Stitches in the Combine drop-down menu in the Home tab.
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Create a SuperDesign Daisy Chain
Use Encore to create a circle of SuperDesigns.

1 Open the SuperDesign tab.
2 Choose "Borders" from the SuperDesign Category drop-down menu.
3 In the SuperDesign set drop-down menu, ensure that the Borders 1 set is selected.
4 Click the flower design number 3.
5 Ensure that Size is set to 18mm.
6 Click Apply  and the flower SuperDesign appears on the work 

area.
7 Click the Encore tab. See “Encore” on page 83.
8 Ensure that the Encore Type is set to Circle .
9 Ensure that Position is set to Standard .
10 Set Repeats to 6.
11 Ensure that Group is selected.

Use Combine, ColorSort and Remove Overlap when exporting to reduce the number of thread color 
changes, and to prevent areas of stitches building up if repeated embroideries overlap. See “Export” on 
page 20.

12 Click Preview and a circle of daisy designs appears on the work area.
The daisy designs appear a little sparse. More designs would create a better circle.

13 Increase the number of Repeats to 10 and click Preview again. The 
circle now looks more balanced.

14 Drag the top of the circle downwards until the daisy designs meet.
15 Click Apply . The daisy design now forms a group.
16 Look at the Design Panel. There are three colors for each 

embroidery in the group.
Use Reveal Groups  on the FilmStrip or context menu to adjust 
individual daisies in the chain. When exported, your chain may have 
three or more colors, depending on the amount that the flowers 
overlap.



438          mySewnet™ Embroidery   Frames, Borders and Motifs 

24Frames, Borders and Motifs
Use the Frame tab to use a frame , corners , side pieces , flourish  or 
border  with your embroidery, or a motif underline  under your embroidery.

Frames
In the Frame section of the Frame tab you can create a frame , corners , side-
pieces  or flourish  which is placed at a size to fit around the currently selected 
embroidery(ies), group, lettering or SuperDesigns, or at its designed size.

The frame and the design it surrounds are usually created as a group. Use Reveal 

Groups  on the FilmStrip or the context menu to select and adjust the frame, or one of 
the embroideries within it.

Creating Frames
Select corners, frames and side pieces to place around your embroidery.

In the text below corners, flourishes, frames and side pieces are referred to collectively as frames.
Choose from the categories of corners, frames and side pieces. Then choose a frame set, 
and select a design. Place the frame around your embroidery, or anywhere on the work 
area. 

Alternatively, select Flourish and choose a flourish to be placed above, below or as a duo 
above and below the selected embroideries.

Some frames are multicolored, and the stitch type for many can be changed. A frame 
around a single embroidery can be resized with constant stitch density, and the stitch 
properties adjusted even after saving, until it is fixed as embroidery.

The frame is generally placed earlier in the stitch order than the originally selected embroidery, so that any 
appliqué fabric may be placed before the embroidery that is being framed. However, if Crop is selected, the 
frame will be added after the embroidery. 

Use a Frame, Corners or Side Pieces

Use a Flourish, Border or Motif Underline
Select a design for your frame or flourish Place a Border around the embroidery

Place one or more MotifsChoose the settings for a Flourish
Change the appearance of the stitching

Place the framing around your embroidery

Use a Frame, Corners or Side Pieces

Use Flourishes

Choose a design set

Choose a frame design Group the embroidery and frame

Crop to the frame, or set the Margin

Choose Flourish settings
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For an appliqué frame if crop is selected, the placement stitches will be added before the embroidery, and 
the border stitches after the embroidery. Whenever Crop is used, if the embroidery contains lettering or a 
SuperDesign, it will be fixed as stitches. 
If multiple embroideries are surrounded by a frame with the Crop option selected, the inner embroideries 
will be combined automatically.
The Frame Surround options stay the same until you change them, or close mySewnet™ Embroidery.

Create a Frame
1 Load one or more embroideries in the work area and select them.
2 Click the Frame tab.
3 Choose a frame Category (corners , frames  or side pieces ).

The gallery will show the first frame set in that category. 
4 Choose a set of frames from the drop-down list to the right of the frame gallery, then click a frame to 

select it. It will be highlighted.
5 If desired, select Group to group the frame with the embroidery(ies).
6 Select to use a margin or to crop the embroidery when placing the frame.

• Margin leaves a space between the embroidery and the frame around it. 
• Crop leaves no margin visible, and will cut the embroidery to the shape of the frame.

7 If you selected Margin, set the Size in millimeters from -50 mm to 50 mm.
When one or more embroideries are selected, the frame is placed around that selection. If no embroidery is 
selected, the original design size is used.

8 If desired, select a line or fill type, or the appliqué fabric for an appliqué frame, from the Stitch 
Type  drop-down menu on the right to open the properties dialog for the stitch type or fabric.See 
“Choosing Stitch Properties” on page 454.
Change the stitch properties for the frame in the properties dialog, for example the density, and the 
stitch length, angle and pattern. Click OK to close the dialog.

9 Click Apply  to view your framed embroidery.

To change the properties in the framed embroidery, select Reveal Groups  on the FilmStrip or context 
menu, and then adjust the frame or the enclosed design.

Create a Flourish
1 Load an embroidery in the work area and select it.
2 Click the Frame tab.
3 Select Flourishes . The gallery will show the first flourish set. 

 The gallery will show the first flourish set. 
4 Choose a set of flourishes from the drop-down list to the right of the frame gallery, then click a 

flourish to select it. It will be highlighted.
5 Choose whether to place the flourish Above, Below, or as a Duo above and below the embroidery.
6 Set the Size of the Margin in millimeters from -50mm to 50mm.

If a negative margin is used the flourish may overlap the embroidery.
7 Set the percentage width  relative to the size of the embroidery.
8 If desired, select Group to group the flourish with the embroidery.

When one or more embroideries is selected, the flourish is placed above or below that selection. The 
original design size will be used if no embroidery is selected.

9 If desired, select a line or fill type, or the appliqué fabric for an appliqué frame, from the Stitch 
Type  drop-down menu to open the properties dialog for the stitch type or fabric. See “Choosing 
Stitch Properties” on page 454 or “Appliqué Selection” on page 192.
Change the stitch properties for the flourish in the properties dialog, for example the density, and the 
stitch length, angle and pattern. Click OK to close the dialog.

10 Click Apply  to view the finished result.

To change the properties in the embellished embroidery, select Reveal Groups  on the FilmStrip or 
context menu, and then adjust the flourish or the design.
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Appliqué Frames and Foam Frames
For appliqué fonts, SuperDesigns and frames, the fabric can be changed as well as some of 
the border settings. For example, in Stitch Type  select Appliqué Fabric, and in the 
Appliqué Selection dialog change the fabric, angle and margin. See “Appliqué Selection” 
on page 192. The appliqué placement stitches cannot be edited, but the position of the 
placement line may be adjusted to match the appliqué piece margin. 

The position of the pattern in an appliqué fabric may only be changed after fixing as stitches.
For Foam fonts and frames, only the color can be changed. The Stitch Type area is 
unavailable, and no properties can be selected in the Context menu. 

Special instructions are displayed for stitching out appliqué or foam fonts, SuperDesigns 
and frames. The instructions can be previewed in the Design Player.

Stitching out an Appliqué Frame
Appliqué frames are designed to be stitched out in a particular sequence. They are created 
with the standard appliqué options, to trim on the machine. Preview the two stops in the 
Design Player, with instructions to place the fabric and to trim it. These instructions are 
also present on the printed worksheet.

If you are using pre-cut pieces (with outlines created in Export Appliqué Pieces for a fabric cutter or 
INSPIRA® Cutwork Needles), the second stop can be ignored as there is no need to trim. It may also be 
useful to match the placement line to the appliqué piece margin, to ensure the placement line is visible.
When stitching out an appliqué embroidery, do as follows: 

1 Begin embroidering. A running line will show where to position the appliqué fabric.
2 A stop then allows you to place the fabric. The message "Place the appliqué fabric now" is displayed.
3 Stitch down the appliqué fabric with double stitch.
4 The machine stops again, and the message "Cut around the appliqué" is displayed. Trim the fabric.

If desired, you can change the color to that for the first color of the embroidery. 
5 Finally, finish the edges with the satin or motif line. 

The placement section in the appliqué is the same color as the first color in the frame, so it doesn’t show 
under the appliqué fabric. If desired, change in mySewnet™ Embroidery to the first color for the 
embroidery.

Stitching out a Foam Frame
Foam frames are designed to be stitched out in a particular sequence. Preview the two 
stops in the Design Player, with instructions to place the foam and to remove any excess 
foam. These instructions are also present on the printed worksheet.

When stitching out a puffy foam frame, do as follows: 

1 Begin embroidering. A running line will show where to position the puffy foam.
2 A stop then allows you to place the foam. The message "Place the puffy foam on the fabric now" is 

displayed.
3 Stitch down the foam with satin stitching.
4 The machine stops again, and the message "Remove any excess puffy foam" is displayed. Remove the 

excess foam.
The thread color is changed, and the framed design is stitched.
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Frame Selection
When starting mySewnet™ Embroidery the first available frame set is selected. If you have used the Frames 
and Flourishes page previously in the current window of mySewnet™ Embroidery, the last frame set and its 
settings are remembered.

Select a Frame or Flourish
Frames, corners, flourishes or side pieces are placed around the currently selected 
embroidery(ies) or group, or placed at a default size on the work area.

The frame is placed around the selected embroidery, or embroideries. If no embroidery is selected, a frame 
using the default dimensions is placed on the work area. 
In the Frame tab, select one of Corners , Frames , Side pieces  or Flourish . 
Select a frame set from the drop-down gallery. Then select an individual design.

Side pieces are available in three sizes.
Corners, frames and flourishes are available in three styles: square, portrait and landscape.

Frame Category
There are three frame Categories: corners , frames  or side pieces .

In this chapter these frame types are referred to collectively as frames.

Frame Set
Each frame type (Category) contains several named frame sets. Each set contains 9 
designs.

Side pieces are available in three sizes. Corners, frames and flourishes are available in three 
styles: square, portrait and landscape.

Each frame set has its own default size. The default size is set automatically each time a frame set is 
selected.

Frame Surround Options
The frame is placed at a size to fit around the selected embroidery(ies). If there is no 
selected embroidery, the frame default size is used.

Margin
Margin leaves a space between the embroidery and the frame around it. Frame margin 
can be set from -50mm to 50mm.

Crop
Crop the embroidery when placing the frame, so that no margin is visible. If the 
embroidery contains letters or a SuperDesign, it will be fixed as stitches. If required, the 
embroidery will be cut to fit the shape of the frame. The frame will usually be added after 
the embroidery. However, for an appliqué frame, the placement stitches will be added 
before the embroidery, and the border stitches after the embroidery.

For example, a circular frame will crop a rectangular embroidery to a circle, with no visible margins. If the 
original embroidery is portrait shaped, it is recommended to use a portrait style frame. If more than one 
embroidery is selected, they will be combined before the frame is created.
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Group
Group the frame and embroidery(ies) when they are placed on the work area.

It is recommended to use Group. If Group is chosen, after creation use Reveal Groups  on the FilmStrip 
or context menu, then select the item that you wish to adjust. If Group is not selected, the frame can be 
moved separately, and stitch properties may be adjusted immediately after creation.

Flourish Surround Options
The flourish is placed at a size to suit the selected embroidery(es). If there is no selected 
embroidery, the flourish default size is used.

Above: Place the flourish above the selected embroidery (or embroideries).

Below: Place the flourish below the selected embroidery (or embroideries).

Duo: Place vertically mirrored flourishes above and below the selected embroidery (or 
embroideries).

Margin
Margin leaves a space between the embroidery and the flourish. Flourish margin can be 
set from -50mm to 50mm.

Percent Width
Adjust width  to change the size of the flourish.

Percent width can be set from 10% to 200% of the original size, in steps of 1%. The 
properties stay the same until you change them or close mySewnet™ Embroidery.

Group
Group the flourish with the embroidery(ies) when they are placed on the work area.

It is recommended to use Group. If Group is chosen, after creation use Reveal Groups  on the FilmStrip 
or context menu, then select the item that you wish to adjust. If Group is not selected, the flourish can be 
moved separately, and stitch properties may be adjusted immediately after creation.

Stitch Type
Use Stitch Type  to alter the appearance of the stitching used in the frame, and the 
fabric for the appliqué. 

Changes made to the stitch properties for a frame set are retained until a new frame set is selected.
To change the Stitch Type, select a stitch type from the drop-down menu to open the 
properties dialog for the stitch type. See “Choosing Stitch Properties” on page 454.

Apply
Click Apply  to place the frame on the work area around the selected embroidery(ies), 
or at the specified size if no embroidery is selected.
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Editing Frames
After a frame has been placed in the work area, you can change its size and stitch types 
until it is fixed as an embroidery. If it was grouped, use Reveal Groups  on the FilmStrip 
or context menu, then select the frame to adjust it.

Change a Frame in the Work Area
1 There are four green handles on the corners of the frame. Move the mouse pointer over one of the 

corner  handles. The Adjust/resize pointer  appears. 
2 Click and drag the handle to adjust the size of the frame. 

Hold Shift while dragging a handle to keep the frame in proportion.
3 To adjust the frame properties, right-click the frame. 
4 From the right-click menu, select Properties to change the frame size in the Frame Properties dialog 

box, or select a stitch type to adjust it in its stitch properties dialog box.
5 Click and drag the frame to place it as desired.

You can also rotate the frame with the rotate handle , or flip it with the horizontal  and vertical  
mirror handles.

Frame Properties
Use the Frame or Flourish properties dialog box to change the size, and the percentage 
width  and height  of a frame that has been placed on the work area.

The Frame Properties dialog box will only appear if Group was not used when the frame was created, or if 
Reveal Groups is used temporarily.
Frame properties may not be changed once the design has been converted to embroidery.
To open the frame properties dialog box, right-click the frame, and select Properties from 
the Context menu.

Size
Frame size can be set from 5mm to 200mm. This is the height of the frame.

Height and Width
Use height  and width  to adjust the proportions of the frame. For instance, to make 
the frame taller without increasing the width, increase the height.

Height and width can be set from 25% to 400% of the original size, in steps of 1%.

Angle
Use the up and down arrows or enter an angle  from 0 to 359 degrees in the box.

Change the frame size

Adjust the proportions of the frame

Change the frame angle
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Changing Properties and Stitch Type
Use the properties dialog box to change a frame after it has been placed, but before it has 
been fixed as an embroidery.

You cannot change the frame style with Frame properties. Create a new frame instead. To change the 
stitch type, right-click the frame and select the stitch type from the Context menu. See “Choosing Stitch 
Properties” on page 454.

1 Right-click within the frame and select Properties from the Context menu. The Options dialog box 
appears.
The Options dialog box will not appear if Group was used when the frame was created. Use Reveal Groups 
temporarily to change properties.

2 Adjust Size to change the basic size of the frame.
3 Click the arrows for percentage width  and height  to change the proportions of the frame. 

Alternatively, enter a size in the number box.
4 Click the arrows for angle to rotate the frame. Alternatively, enter a size in the number box.
5 Click OK to apply your changes to the selected frame.
6 To change the stitch types within the Frame, right-click the Frame and select the stitch type from the 

Context menu. The properties dialog for that stitch type appears. See “Choosing Stitch Properties” on 
page 454.

Frame Color
You can change the colors of frames before or after they have been fixed as embroideries.

Change Frame Color
1 Load an embroidery in the work area and select it.
2 Click the Frame tab and choose Frame .
3 Click the arrow to the right of the frames gallery and scroll down to the Classical 6 MC frame set.
4 Click the first design in the gallery, number 1.
5 Ensure that Margin is selected, and click Apply .
6 Look at the Design Panel. The thread colors for the frame can be seen in the Color Select area.

If Group was selected the frame colors will be at the top of the list, below the colors for the embroidery, and 
the selection box handles will be orange, indicating a group.
If Group was not selected, only the colors for the frame will be shown, and the selection box handles will be 
green.

7 Double-click the second frame color. The Color Selection dialog opens. See “Change an Existing 
Thread Color” on page 53 for more information.

8 Change this deep yellow to a pale yellow.
9 Click OK to close the dialog box.

The yellow has changed in the Design Panel and in the frame in the work area.
10 Undo  the color change. The frame has gone back to its original colors.

Fixing Frames and Flourishes as Embroideries
Frames and flourishes are fixed as an embroidery when the Modify tab is selected, Fix as 
Stitches  is used, or they are Combined with another design. The stitches are then 
created, and any further resizing or rescaling of the embroidery may affect stitch density 
and length. The stitch properties, for example the density, pattern, angle or stitch length, 
may not be changed after it is fixed. Appliqué fabric cannot be changed in the Context 
menu after the frame is fixed, but you may use the Select Appliqué features on the 
Appliqué tab.
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When frames are fixed as embroideries, the handles change from green to white. After a frame has been 
converted to embroidery, it can no longer be changed with Frame properties, and the stitch types cannot 

be adjusted. If the Resize  mode is selected, the handles will become blue. To reverse fixing as an 

embroidery, click Undo .

To fix a frame as an embroidery deliberately, right-click it and select Fix as Stitches  from the Context 
menu, or select Fix as Stitches in the Combine drop-down menu in the Home tab.

Using Frames
Frame one or more embroideries.

Changing Frame Properties: Grapes and Birds
1 Clear the work area or open a new window.
2 In the Quick Access toolbar, click Insert .
3 Browse to \mySewnet\Samples\Embroidery \Stitch.
4 Click to load "Grapes and Birds" into the work area. 

The embroidery has white handles on its selection box, showing 
that it is initially in Scale rather than Resize  mode (blue 
handles).

5 Click the Frame tab.
6 Click Corners .
7 Click the arrow to the right of the frames gallery and scroll 

down to the Ornamental 2 MC set.
8 Click the first set of corners in the gallery, number 1.

These corners are designed to frame a square embroidery. 
Corners 4–6 and 7–9 are for portrait and landscape formats.

9 In Frame Surround, select Margin and ensure that it is set to 2.5 mm. (This is the default size.)
10 Ensure that Group is selected.
11 Click Apply . The set of corners is placed around 

the embroidery as a frame. It has orange handles, 
and a solid outline.

12 Drag the frame a short distance. The embroidery 
and frame move as a unit.
If the embroidery does not move with the frame, 
Group was not selected. Group makes the embroidery 
and frame act as one unit. To adjust the embroidery or 
frame, select Reveal Groups  on the FilmStrip or 
the context menu, then make the adjustments.

13 The frame would look better if it fitted a little more 
snugly. Click Undo  until only the Grapes and 
Birds embroidery remains.

14 In the Frame tab, click the down arrow to change 
Margin to 0.5 mm.

15 Click Apply . The frame now fits closely around 
the embroidery, but does not overlap it.
The satin line on the outside of the corners is a little 
heavy. Its width can be changed, and its ends can be tapered.
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16 Right-click the frame, then click Reveal Groups .
17 Right-click the frame again and select Satin Line from 

the Context menu. The Satin Line properties dialog 
appears. See “Satin Line” on page 497.
Alternatively, you could have used Stitch Type to change 
the satin properties before placing the frame.

18 In the Satin Line properties dialog, click the down arrow 
to change Width to 2.5 mm.

19 Click to select Right Taper for both Start Point  and 
End Point .

20 Click OK. The frame is now more delicate.
21 Click outside the frame to view the design without the 

selection box.
Alternatively, click Realistic 3D mode  or Life View  
to see the design without the selection box and grid.

Create a Framed Badge: Champion Dad
1 In the Quick Access toolbar, click Change Hoop . In the Hoop Selection dialog box select 180mm x 

130mm - Universal Large Hoop 1.
2 Set Orientation to Natural and click OK.
3 In the Quick Access toolbar at the top of the screen, click Insert .
4 Browse to \mySewnet\Samples\Embroidery\Stitch.
5 Scroll down until you see "Biplane", and click to select it.
6 Click Open to load the embroidery into the work area.

The embroidery has white handles on its selection box, showing that 
it is initially in Scale rather than Resize  mode (blue handles).

7 Click the Frame tab.
8 In Category, ensure that Frames  is selected.
9 Select the second (round) frame in Applique Shields 1 (the top set 

in the list).
10 In the Stitch Type drop-down menu at the far right, select 

Appliqué Fabric. The Appliqué Selection dialog box opens.
11 Click Load Previously Saved Fabric . The Picture Viewer opens.
12 Browse to the folder General\Checkerboard.
13 Scroll down and select the fabric Checkers Round 1 - 18, then 

click OK. The Picture Viewer will close and the fabric will be 
shown in the Appliqué Selection dialog box.

14 Click OK to close the Appliqué Selection dialog box.
15 Ensure that the embroidery is still selected and click Apply  

to place the frame around the embroidery.
16 In the Color Select on the right, double-click the top color in 

the list. This is the blue for the frame.
17 In the Quick Colors click the dark yellow in row 4 column 7.
18 In the Color Selection dialog box keep this gold color, or 

choose a slightly darker color.
19 Click OK to close the Color Selection dialog. The frame border is 

now a gold color.
20 Click the Letter tab.
21 In the font gallery on the left, scroll to the Modern font category.
22 Select the font Carlton UC 15-45mm.
23 Enter the word "Champion" in the Letters text box and press Enter on the keyboard for a new line.
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24 In the line below enter the word "Dad".
25 Set Gap to 10.
26 In the Lettering Shape area, click Full Circle .
27 In Stitches, ensure that ColorSort is selected 

(checked).
28 Click Apply . The lettering appears around the 

embroidery. Its handles are green.
If the lettering does not surround the embroidery, the 
embroidery was not selected. Click Undo , click to 
select the embroidery, then click Apply again.

29 Drag the square green handle at the top of the circle 
of lettering downwards so that it fits well around the 
framed embroidery.

30 In the Quick Access toolbar, click Design Player  to 
see the embroidery as it will be stitched out.

31 Click Cancel to close the Design Player.
32 In the Quick Access toolbar, click Save As  and 

save the embroidery as "Champion Dad".
The various parts of this multipart embroidery will be stored separately, making further adjustment easier.
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Border
In the Border  section you can create a border to place around your embroidery(ies), 
group, lettering or SuperDesigns.

■ A border is placed at a size to fit around the selected embroidery(ies) or group, or if no 
embroidery is selected, on the work area using the current Options and Stitch Type.
Select a margin width and whether to use rounded corners, then select a border type from 
motif line, satin border, running stitch and triple stitch. In the Stitch Type drop-down 
menu, set the properties for each stitch type.

The stitch properties may only be adjusted before the border is created.

The border is placed around the rectangular "edge" of the selected 
embroidery(ies), or around the inside edge of the hoop. (In the 
ExpressMonogram Wizard the border is placed around the edge of 
the envelope area.) It is placed earlier in the stitch order than the 
originally selected embroidery, so that any appliqué fabric may be 
placed before the embroidery that is being bordered.

If more than one embroidery is selected, the border is placed around the 
selected embroideries, using the distance set in Margin.
The border is placed with white handles, showing that it is initially 
in Scale rather than Resize  mode (blue handles).

Border options are retained during the current session.

Create a Border
1 Load an embroidery in the work area and select it.
2 In the Frame tab, click Border .
3 In the Border section, select Rounded or Square corners.

Rounded corners may overlap the corners of the embroidery. Adjust the Margin for the desired effect.
4 If desired, select Group to form a group from the border and the embroidery(ies).
5 Select a Stitch Type (Satin Line , Triple Stitch , Running Stitch  or Motif Line ).
6 If desired, click Stitch Type  to the right of the ribbon bar, and select a stitch type from the drop-

down menu to open its properties dialog. See “Choosing Stitch Properties” on page 454.
Change the stitch properties for the border in the properties dialog, for example the density and 
stitch length. Click OK to close the dialog.

7 To add appliqué to the design, click Add Appliqué , and then in the Stitch Type  drop-down 
menu on the right, click Select Fabric  to audition a fabric in the Appliqué Selection dialog. See 
“Appliqué Selection” on page 192.

Select a stitch type for the border
Set the width of the margin 

Group the embroidery and border

Choose rounded or square corners

inside the border
Add appliqué to the border
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8 If desired, in the Stitch Type  drop-down menu click Appliqué Options  to open the Appliqué 
Options dialog box and choose an Appliqué Method. See “Appliqué Options” on page 205.

9 In the Border section, set the Margin size in millimeters from -50 mm to 50 mm. This is the distance 
from the selected embroidery, or from the edge of the hoop.
For a satin or motif border you may need to adjust the margin to avoid overlapping the embroidery.

10 Click Apply  to view your framed embroidery.
You can change the appliqué fabric in the Appliqué Selection dialog box after creating the border. Click 

Reveal Groups  on the FilmStrip or the context menu. Click the Appliqué tab and click Select Piece, then 
click the border on the work area. The Appliqué Selection dialog box appears. Change the fabric as desired. 
See “Appliqué Selection” on page 192.

Margin
Margin leaves a space between the embroidery and the center of the border around it. 
Margin can be set between -50mm and 50mm. The initial setting is 2.5mm.

For a satin or motif border you may need to adjust the margin to avoid overlapping the embroidery.

Rounded Corners
Use rounded or square borders. Rounded is not initially selected.

Rounded corners may overlap the corners of the embroidery. You can adjust Margin for the desired effect.

Group
Group the border and the embroidery when they are placed on the work area.

Stitch Types
Use Stitch Type to select the appearance of the stitching used in the border, and the 
appliqué settings. The stitch types available for automatically created borders are:

■ Motif Line 
■ Satin Line 

■ Running Stitch 

■ Triple Stitch 

In the Stitch Type  drop-down menu, select a stitch type to set the its properties. The 
properties dialog for that stitch type will open. See “Choosing Stitch Properties” on 
page 454.

For the individual stitch types, see “Motif Line” on page 498, “Satin Line” on page 497, 
“Running Stitch” on page 493 and “Triple Stitch” on page 496.

Add Appliqué
Use Add Appliqué  to add appliqué to the border that you create. Appliqué placement 
stitches are automatically added to the border that you draw.

A new color block, using the same color as the border is placed at the beginning of the 
embroidery for the appliqué placement stitches. The appliqué placement stitches use the 
method, appliqué piece margin, running stitch length and double stitch length set in 
Appliqué Options. A Color Change is also placed at the beginning of the border line, using 
the default border color. The border uses stitch type settings set in the Line Options for the 
selected stitch type.
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Select Fabric
Use Select Fabric  to audition a fabric for your appliqué in the Appliqué Selection 
dialog box. 

In the Stitch Type  drop-down menu, click Select Fabric  and the Appliqué Selection 
dialog box appears. See “Appliqué Selection” on page 192.

Shortcuts
■ Appliqué, Frame Tab: 
■ Keys: Alt, B, SF

Apply
Click Apply  to place the framed embroidery on the work area.

Add a Border with Appliqué to a Flower Embroidery
1 Clear the work area or open a new window.
2 In the Quick Access toolbar, click Insert .
3 Browse to \mySewnet\Samples\Embroidery \Stitch.
4 Scroll down and click to load "Pansy Stem" into the work area. 

The embroidery has white handles on its selection box, showing that it is initially in 
Scale rather than Resize  mode (blue handles).

5 In the Frame tab, click Border .
6 In Border Options, select (check) Rounded Corners and ensure that Group is 

selected.
Group creates a group from the border and embroidery, so that they can be rotated 
and resized as a single unit. See “Group” on page 69.

7 In Border Options ensure that Satin Line  is selected.
8 Click Add Appliqué  to select it.
9 In the Stitch Type  drop-down menu on the right, click Select 

Fabric . The Appliqué Selection dialog box opens. See “Appliqué 
Selection” on page 192.

10 In the Quick Colors select the turquoise in row 1 column 8, then click OK to 
select the fabric.

11 In the Stitch Type  drop-down menu, click Appliqué Options .
12 In the Appliqué Options dialog box ensure that Standard Appliqué is 

selected, then click OK. See “Appliqué Options” on page 205.
13 Click Apply . The embroidery is surrounded by an appliqué frame.

Note the orange handles and solid outline indicating that the border and 
embroidery are a group.

14 Click Undo .
15 Click the Letter tab.
16 In the Script category, select the font Chateau Uniform 20-30mm, and 

enter the words "Happy Birthday" on two lines.
17 Click Align Left , then click Apply .
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18 Move the lettering to the right of the flower.
19 Click the Home tab, then click Select All . 

(Alternatively, Ctrl + Click the designs or use Ctrl 
+ A.) Both designs are now selected.
If required, move the selection box to the left so 
that the designs are in the hoop.

20 Click the Frame tab.
21 To the right of the ribbon bar click Apply .
22 Both designs are framed, but the leaf at the top 

left is clipped by the rounded corners of the 
border. Click Undo .

23 Set the Margin to 10mm, then click the Home tab 
and select both designs again.

24 Click the Frame tab, then click Apply . The embroidery and lettering are framed by the border.
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Motif Underline
Use Motif Underline  to create a line of motifs, or a single motif below the currently 
selected embroidery(ies) or group.

Create a motif line of a chosen length or a selected number of repeats. Alternatively, place 
a single motif. 

Motifs are created from the motif sets available in mySewnet™ Embroidery. Motifs are 
relatively small single-color designs similar to machine stitches, created using single, 
running and triple stitches.

If motifs are designed to overlap each other the calculation for number of repeats may not be exact.

If you have used the Motif section previously in that session of mySewnet™ Embroidery, the last motif and 
its settings is remembered. When starting mySewnet™ Embroidery the system default star motif is selected. 

Using Motifs
The motif group, category and set are shown in the Motif Underline  section of the 
Frame tab. 

The motif line is created below the currently selected embroidery(ies), group, lettering or 
SuperDesign, and earlier than it in the stitchout order.

Additional motifs may be created using the optional mySewnet™ Digitizing module, and added to the 
My Motifs database. 
When starting mySewnet™ Embroidery the star (Pattern 5 in General Motifs 1) is selected. 
If you have used the Motif tab previously in that session of mySewnet™ Embroidery, the 
last motif and its settings are remembered.

Select Motif
Use Select Motif  to select the motif for your line. The Motif Line dialog box opens. See 
“Motif Line” on page 498.

Length
Set the Length of the line of motifs from 10 to 1000mm in steps of 1.0mm. Length is 
initially set to 100mm.

Repeats
The total number of copies of the selected motif in the line. Set the number of repeats 
from 1 to 100. 

Set the length of the motif line

Set the number of repeats for the motifChoose a motif

Create the line of motifs
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Group
Group the motif underline and the embroidery when they are placed on the work area.

Apply
Use Apply  to place the line of motifs in the work area.

Create Lines of Butterfly Motifs
1 Click the Frame tab, then click Motif 

Underline .
2 In the Motif Underline section, click Select 

Motif . The Motif Line selection dialog box 
opens.
See “Motif Line” on page 498.

3 Select Universal from the Group drop-down 
list.

4 Select General Motifs 1 from the Category 
drop-down list.

5 In the Pattern drop-down list, select motif 23, 
a butterfly.
The Height and Width are initially set according 
to the chosen motif.

6 In Size, ensure that Proportional is selected 
(checked), and set Height to 14mm. 

7 In Stitch ensure that Running is selected, and 
that Length is set to 2.0mm.
Length is initially set to the recommended value 
for the motif.

8 Click OK to select the butterfly motif.
9 In the Motif Underline section of the Frame tab, click Length to select it.
10 Use the up and down arrows to set the Length to 100mm.
11 Click Apply . A line of four butterflies is placed on the work area.

The width of the butterfly motif is 25mm, so the line contains four motifs. 
You can resize or rescale this line of motifs, or change its color, in the same way as for any other design.

12 Set Length to 120mm and click Apply  
again. There are still four motifs, but they are 
more widely spaced.
Only complete motifs are used when placing a 
motif line with Motif Underline.
Note that the second line of butterflies forms a 
group with the first line. Motif lines are grouped 
with the previously placed line, unless you click 
outside the selection box before creating the 
new line.

13 In the Motif Underline section, click Repeats.
14 Use the up and down arrows to set the number of repeats to four, then click Apply .

The motif line is the same size as the first line you created.
15 Use the down arrow to set the number of repeats to one, then click Apply . This places a single 

motif in the work area.
Use Encore to create curved motif lines, circles and shapes using single motifs, and to mirror motifs within 
a line. See “Encore” on page 83.
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25Choosing Stitch Properties
You can change the properties for many line and fill types in fonts, SuperDesigns and 
frames.

The properties for a stitch type can be changed using its properties dialog before or after 
the lettering, SuperDesign or frame is created.

■ Use the drop-down in the Options dialog box for the stitch type.
■ If required, click Reveal Groups  on the FilmStrip or context menu to enable editing 

within a group. Then right-click on the lettering, SuperDesign, or Frame, and select the 
stitch type that you wish to change in the design from the right-click menu. The properties 
dialog box for that stitch type will appear.
You can only edit the stitch properties for a design with green handles (before it is fixed as stitches).
If the Stitch Type area is grayed out (unavailable), this means that the area was designed 
with properties that cannot be edited. For example, this occurs with Foam fonts that have 
special settings to ensure the embroidery foam is cut, and it also occurs with a few very 
complex fonts that have many different fill patterns in different letters, or multigradient 
fills, such as Acorn 6C UC 35-60mm in the Floral category.

Editable Properties
Most fonts, SuperDesigns and frames will allow multiple line and fill properties to be 
changed. Where very complex properties such as multicolor gradients or many different 
properties in different characters are used, the edit properties functions are not available. 
Examples of editable properties include:

• In the Elegant category, American Gothic 25-75mm has Satin Column stitches, therefore 
the satin properties dialog is available. 

• In the Monogram category, Athletic Square 2C UC 30-80mm has both satin and pattern 
fill stitches, therefore two properties dialogs are available. 

• In the Wild West category, Decor 2C UC 45-100mm has two types of pattern fill stitch 
(the same pattern at different angles), and a Satin Column outline. Therefore the Satin 
Column dialog and a Pattern Fill properties dialog for Pattern Fill 1 and Pattern Fill 2 are 
available. 

• In the Appliqué category, Crazy Patch 2 UC 55-120mm has one stitch type, Triple Stitch, 
and two appliqué fabrics. Therefore one properties dialog is available for the outline 
stitching, and two fabric dialogs are available for the appliqués.

• In the Floral category, Acorn 6C UC 35-60mm uses many different fill patterns in 
different letters. Therefore no stitch properties settings are available.

• In the Fun category, Balloon 3C UC 25-80mm uses multicolor gradient satin. Therefore 
no stitch properties settings are available.

• In the Foam category, all the fonts have special settings to ensure the embroidery foam 
is cut. Therefore no stitch properties are available.

If there is more than one stitch area of a particular type in the design, the drop-down 
menu will show that stitch type in a numbered list; for example, Pattern Fill 1, Pattern Fill 2.
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Pattern Fill
A pattern fill area is an area of stitching where the threads all lie parallel to each other, and 
that has stitch points inserted to create different types of patterns. The density and color 
can also be changed with single gradient density and multigradient density.

Add new patterns using Manage My Fills in mySewnet™ Digitizing.

The patterns may be simple textures or decorative shapes. A satin-effect pattern (pattern 
number 36 in Standard 3) is also available.

Constant density creates a uniform fill at the chosen density. Gradient density creates a fill with varying 
density or color.

Use the Pattern Fill properties dialog box (if available) to change the pattern, density and 
stitch angle used for fill areas.

Litho UC 20-80mm, Pattern Fill Area with 
Pattern 107 from Diamonds

Choose a Category
and Pattern

Search for a Pattern
by number

Set Standard density Use gradient density

Set the pattern Angle

Adjust the area’s size

Choose Underlay 
density

Settings for Single &
Multicolor gradient

Use a My Fills pattern
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Pattern Fill — Pattern

Patterns
Use the Pattern area to select the desired 
pattern category and number.

Select the desired pattern number. There are 
several ways to select patterns:

• Click the drop-down arrow below the pattern 
sample and scroll down to choose a pattern 
Category, and a pattern. Click the desired 
pattern sample and the Pattern number is 
shown.

• Enter a favorite Pattern number directly in the 
Pattern box. As you type the number, the 
correct pattern sample is selected 
immediately.

• Use a My Fill pattern created with Manage My 
Fills in mySewnet™ Digitizing. View the patterns in the pattern gallery. See “Fill and Satin 
Patterns” on page 500.

Pattern Fill — Options
Use the Options area to see and change the settings for fill angle, underlay and 
compensation.

Angle
The angle of the fill pattern, as shown by the arrow. The thread is at a 
right angle to the fill pattern. Set the Angle from 0 to 359 degrees. 
The initial setting is 0.

The fill angle will also affect the orientation of the gradient.

The example shows pattern number 56 with the fill angle set to 315, 270 and 180 degrees.

Set the pattern Angle

Set Compensation

Choose Underlay density



mySewnet™ Embroidery   Choosing Stitch Properties              457

Underlay
Choose from None, Low, Medium or High density underlay. Underlay is a low density fill 
that is perpendicular to the stitches of the actual fill area. Underlay is useful for stabilizing 
large fill areas. Underlay is initially set to Low.

Underlay stitches are not generated for areas using gradient density, although the property can be 
selected in case you switch the area back to a standard density area.

Compensation
Compensation is used to make an area 'bolder' by increasing its relative size. Set 
Compensation from 0 to 20. The higher the number, the bolder the area appears. The 
initial setting is 0.

Pattern Fill — Density
Use the Density area to see and change the density settings and the color Gradient of the 
fill. 

The color on a fill area can change over a range, or have multiple color changes across the 
fill. This is ideal for gradual color changes such as sunsets, subtle shadow effects and so on.

Gradient is not initially selected.

Embroidery on thicker fabrics usually looks better with more stitch coverage, or a low density setting. 
Choose a low value such as 2 or 3 for heavy knit fabrics, a higher value such as 5 or 6 for a light material like 
linen or satin.

Standard Density

Set the standard Density from 2 to 40. The lower the number, the 
closer together the stitches and the more stitches are produced.

The initial setting is 2.

Single Color Gradient

Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment marker

Highlighted value marker

Set the stitch density for 
the chosen value marker

Delete the selected
marker
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Use Single Color Gradient to change the density across a fill 
with only one color. Set a value for the start and end density 
markers for the fill, and the density gradually changes between 
the two values. Add multiple markers for a more complex 
pattern.

The markers can each take a value of 2 to 80, which means you can reverse 
the gradient simply by swapping the start and end values.
The example shows a Gradient of 2 to 15, with a fill angle of 90°.

Use Density Gradient for loosely stitched areas so that the traveling stitches will go around the outside of 
the fill area. Set the start and end densities to the same number. If the Density Gradient option was not 
used the traveling stitches would cross the fill area and show through.
Use the adjustment marker above the gradient bar to change the gradient across the fill.

Reset
Reset your changes and use the initial settings.

Add Marker
Click Add Marker to add a value marker below the gradient bar, and an adjustment marker 
above the gradient bar. The initial value for the marker will be between the existing 
markers. Edit the density value, and move the value and adjustment markers as desired.

This means that you can have any combination of density values across the fill area. 
Remember, a higher value means the fill is less dense.

Density
Density is used to change the density of the stitching. Set Density from 2 to 80. The higher 
the number, the less dense the fill. The initial start marker setting is 2, and end marker 
setting is 8.
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Remove
Click Remove to delete the highlighted marker.

Use a Single Gradient Fill
1 Open the Pattern Fill properties dialog box.
2 Click (check) the Gradient checkbox. The Gradient box will become available.
3 Select Single Color Gradient.
4 Click a value maker (the marker below the gradient bar) and change the value in the Density box to 

the required density value.
5 Click Apply to view your changes.
6 Move the adjustment marker above the gradient bar to vary the change in density across the fill.
7 Click Add Marker to add another value marker and adjustment marker.
8 Change the density of the fill as desired.

9 Click OK to close the properties dialog box.

Multicolor Gradient

Use Multicolor Gradient to change the color across a fill with 
only one density. Set colors for the start and end markers for 
the fill, and the color gradually changes between the two 
values. 

Use the marker above the gradient bar to change the color 
gradient across the fill.

Reset
Reset your changes and use the initial settings.

Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment markers

Selected color marker

Choose a thread for the 
highlighted marker

Delete the selected
marker

Set the stitch density
for the whole fill
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Add Marker
Click Add Marker to add a color marker below the gradient bar, and an adjustment marker 
above the gradient bar. The initial color for the marker will be the same as the currently 
highlighted marker. Change the color and move the color and adjustment markers as 
desired.

This means that you can have any combination of colors across the fill area.

Thread Color
Use Thread Color  to change the color of the currently highlighted marker. The Color 
Selection box will be displayed.

See “Change an Existing Thread Color” on page 53.

Remove
Click Remove to delete the highlighted marker.

Use a Multicolor Gradient Fill
1 Open the properties dialog box.
2 Click (check) the Gradient checkbox. The Gradient box will become available.
3 Select Multicolor Gradient.
4 Click a color marker (the marker below the gradient bar) and click Thread Color to open the Color 

Selection dialog box.
5 Change the color to the required color and click OK.
6 Click Apply to view your changes.
7 Move the adjustment marker above the gradient bar to vary the change in color across the fill.
8 Click Add Marker to add another color marker and adjustment marker.
9 Change the color of the fill as desired.

10 Click OK to close the properties dialog box.
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Motif Fill
Motif fill areas contain repeated small stitches placed using a Universal or machine motif 
pattern. Motifs are used at any angle, at varying sizes, and alternate lines can use different 
motifs. Typically, there are spaces between the motifs in a pattern.

In the Motif Fill dialog you can select motifs, and set the motif angle, spacing, offset, stitch 
type and length when creating a motif fill area. Use Motif 1 to select the first motif and its 
size, and Motif 2 for a second optional motif.

For an example using Motif Fill, see “Create a Quilt Block with a Central Filled Shape” on page 158.

Motif Fill — Motif 1
The Motif Fill properties dialog box has tabs for setting all the properties on a motif fill 
area.

The Motif 1 tab is always shown first when the Motif Fill properties appear.

Motif
Use Motif to select the first motif and its size.

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Motif fill using a heart pattern, number 6, in the 
General Motifs 1 category, at an Angle of 350 
degrees. A satin line is used for the border. 
(Revue 2C UC 25-120mm MF, Display category)

Select a motif Group, Category and pattern

Select the motif size

Preserve motif Height / Width ratio

Flip the motif vertically or horizontally
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Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Reverse
Use this option to reverse the direction of the motif along the lines of the motif fill. Some 
motifs are symmetrical and will have no apparent change when they are reversed.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Motif Fill — Motif 2

Use the Motif 2 tab to select a second optional motif and its size. 

Use Motif 2
Select the Use Motif 2 option to use a second motif in the motif fill. The second motif will 
be placed on alternating lines with the first motif. All other options are identical to the 
Motif 1 tab.

Motif
Use Motif to select the motif and its size.

Group
Click the drop-down arrow to select the desired group of motif patterns.
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Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Reverse
Use this option to reverse the direction of the motif along the lines of the motif fill. Some 
motifs are symmetrical and will have no apparent change when they are reversed.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Motif Fill — Spacing
Use Spacing to set the relative position of the motifs in the fill.

Center Motifs 1 and 2
When this option is selected the narrower of the two motifs has extra stitches added at 
either side to make it the same width as the wider motif. This is so that the motifs can be 
centered, or so the horizontal offset between them will remain constant.

Gap
The Horizontal gap adds or removes space between motifs along the line. The Vertical gap 
adds or removes space between lines of motifs.

Space the motifs regularly

Set the distance between
motifs and lines of motifs

Set the relative position of
motifs and lines of motifs



464          mySewnet™ Embroidery   Choosing Stitch Properties 

Set the Horizontal and Vertical gaps from -50% to +100%.

Offset
The Horizontal offset moves the motifs along each line, relative to the previous line. The 
Vertical offset adjusts the position of every other line of motifs, so that it is nearer to one 
line than the next or previous line.

Set the Horizontal and Vertical gaps from -50% to 50%.

The offset is limited to 50% each way because, for instance, a 75% offset would be the same as a -25% 
offset.

Motif Fill — Options
Use the Options tab to change the settings for fill angle, stitch type and length.

Angle
The angle of the motif fill pattern, as shown by the arrow. Set the Angle from 0 to 359 
degrees.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum stitch Length 
from 1 to 12mm in steps of 0.1mm.

Adjust the motif angle

Select a line type

Set the stitch length
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Crosshatch Fill
Crosshatch fills are used in quilting, and to create free-standing lace.

Crosshatch Fill — Options
The Crosshatch Fill properties dialog box enables you to set the gap, style, line angle, 
stitch type and stitch length for the crosshatched lines of stitching in the fill. The preview 
changes according to the options chosen.

• Diamond creates a symmetrical crosshatch pattern (balanced horizontally). Diamond is 
selected by default, with an initial angle of 315 degrees.

• Square creates a crosshatch pattern of lines set at 90 degrees.
• Parallel creates a pattern of parallel lines, with an initial angle of 0 degrees.
• Enter Angles can be used to create an asymmetrical crosshatch pattern. Enter an angle 

for each of the two line directions in the crosshatch.

Spacing
Set the Gap to the preferred distance between lines of stitching.

Set the Gap from 1mm to 20mm in steps of 0.1mm. It is initially set to 5mm.

Crosshatch Fill, using Diamond style and an Angle of 45 
degrees. Double Zigzag is the stitch used in the fill and 
for the border.
(Revue Patchwork UC 50-120mm XH, Display category)

Select a style for the Crosshatch fill
Set the angle for one or both crosshatch lines

Adjust the gap between the stitch lines

Select a stitch type for the 

Set the stitch length for fill lines

Set the width for zigzag lines

Preview your settings

crosshatch lines
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Style
Choose from Diamond, Square, Parallel and Enter Angles. Diamond is selected by default, 
and creates a symmetrical crosshatch pattern (balanced horizontally). Choose Enter 
Angles to create an asymmetrical crosshatch pattern, if desired.

Diamond
Enter an Angle for the Diamond fill. The Angle is initially set to 315 degrees.

Square
There are no additional options for the Square fill.

Parallel
Enter an Angle for the Parallel fill. The Angle is initially set to 90 degrees.

The Pattern Fills 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create 
a weave effect. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm to combine 
with Pattern 258, and so on.

Enter Angles
Enter an angle for each of the two line directions in the crosshatch. Angle1 is initially set to 
the same angle as the Diamond style previously used, and Angle2 is initially set to this 
angle plus 90 degrees.

Stitch Type
Select a stitch type for the crosshatch fill. Choose from:

■ Running Stitch
■ Double Stitch
■ Double Zigzag
■ Triple Stitch

Stitch Length
Set the Stitch Length from 1 to 12mm in steps of 0.1mm. The initial setting is 2.0mm.

Zigzag Width
Set the Zigzag width for Double Zigzag stitch from 0.1 to 6mm in steps of 0.1mm. The 
initial setting is 0.6mm.

Double Zigzag is a special stitch type, recommended for lace. A running stitch line is retraced in a zigzag 
pattern to create a mesh. After embroidering on water soluble stabilizer, the mesh of stitches provides 
strength when the stabilizer is washed away.
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Curved Crosshatch Fill
Curved Crosshatch fills use curving lines in the crosshatch, which can be used to create a 
feeling of depth. They are used in quilting, and to create free-standing lace.

Curved Crosshatch Fill — Options
The Curved Crosshatch Fill properties dialog box enables you to set the curve, gap, style, 
line angle, stitch type and stitch length for the curved crosshatched lines of stitching in 
the fill.

Spacing
Set the Gap to the preferred distance between lines of stitching.

Set the Gap from 1mm to 20mm in steps of 0.1mm. It is initially set to 5mm.

Style
Choose from Diamond, Square, Parallel and Enter Angles. Diamond is selected by default, 
and creates a symmetrical crosshatch pattern (balanced horizontally). Choose Enter 
Angles to create an asymmetrical crosshatch pattern, if desired.

Diamond
Enter an Angle for the Diamond fill. The Angle is initially set to 45 degrees.

Square
There are no additional options for the Square fill which creates a crosshatch pattern of 
lines set at 90 degrees.

Parallel
Enter an Angle for the Parallel fill. The Angle is initially set to 90 degrees.

Adjust the gap between the stitch lines

Select a stitch type for the 

Set the stitch length for fill lines

curved crosshatch lines

Set the angle for one or both 
curved crosshatch lines

Select a style for the 
Curved Crosshatch fill

Set the curve for the curved crosshatch lines

Use a Motif with the fill
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The Pattern Fills 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create 
a weave effect. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm to combine 
with Pattern 258, and so on.

Enter Angles
Enter an angle for each of the two line directions in the crosshatch. Angle1 is initially set to 
the same angle as the Diamond style previously used, and Angle2 is initially set to this 
angle plus 90 degrees.

Stitch Type
Select a stitch type for the curved crosshatch fill. Choose from:

■ Running Stitch
■ Double Stitch
■ Triple Stitch
■ Motif Line

Stitch Length
Set the Stitch Length from 1 to 12mm in steps of 0.1mm. The initial setting is 2.0mm.

Curved Crosshatch
Use Lines 1 and 2 to change the curve on the crosshatch lines.

Lines 1
Change the position of the origin for one of the sets of curved lines.

Set percentage Curve In and Curve Out from -100 to 100. The initial setting for Curve In % 
and for Curve Out % is 50.

Lines 2
Change the position of the origin for the other set of curved lines.

Set percentage Curve In and Curve Out from -100 to 100. The initial setting for Curve In % 
and for Curve Out % is 50.
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Curved Crosshatch Fill — Motif
The selected Motif is only used by the Curved Crosshatch Fill if the Motif Line option is 
selected on the Options tab.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line. 

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.

Set the gap between the motifs 
Adjust the position of the motifs 

Select a stitch type for the

Set the stitch length

Set the motif size and 

Select a motif Group, Category 
and pattern

Height / Width ratio

motif lines
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Reverse
Use this option to reverse the direction of the motif along the line. Some motifs are 
symmetrical and will have no apparent change when they are reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary, 
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Size

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum stitch Length 
from 1 to 12mm in steps of 0.1mm. Length is initially set to the recommended value for 
each motif.
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MultiWave Fill
MultiWave fill areas use a wave pattern defined by a line, or lines, drawn on the fill area by 
the designer. Vary the density, or use a motif for the stitch lines.

For an example using MultiWave Fill, see “Create a Two Letter Monogram” on page 348.

MultiWave Fill — Options

Density
Set Density from 2 to 40. The lower the number, the closer 
together the stitches and the more stitches are produced.

Use Motifs
Click Use Motifs if you would prefer to use motifs instead of a plain 
line to follow the line angle selected for the fill. Click the Motif tab 
to choose a motif.

MultiWave Fill, using a density of 20 and a Triple Stitch 
border
(Revue UC 25-120mm MW, Display category)

Set the stitch line density for the fill

Use a motif line

Select a motif
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MultiWave Fill — Motif
The selected Motif is only used by the MultiWave Fill if the Use Motifs option is selected on 
the Options tab.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line. 

Set the gap between the motifs in the line

Adjust the position of the motifs in the line

Select a stitch type for the motif lines
Set the stitch length for the motif lines

Set the motif size and Height / Width ratio

Select a motif Group, Category and pattern

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.
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Reverse
Use this option to reverse the direction of the motif along the line. Some motifs are 
symmetrical and will have no apparent change when they are reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary, 
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Size

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum stitch Length 
from 1 to 12mm in steps of 0.1mm. Length is initially set to the recommended value for 
each motif.



474          mySewnet™ Embroidery   Choosing Stitch Properties 

Echo Fill
Echo Fill places echo lines within a shape. Choose from rounded, square and diagonal 
corners, and set the gap between the echo lines.

For an example using Echo Fill, see “Show an Echo Around an Embroidery” on page 156.

Echo Fill — Options
The Echo Fill properties dialog box enables you to place echo lines within a shape. Set the 
style, gap, stitch type and stitch length.

Some options used in other modules are unavailable in the Quilt Block Wizard. “Show an Echo Around an 
Embroidery” on page 156

Style
Choose from 1, 2 or 3. For a square shape:

• 1  will create rounded corners

• 2  will create square corners

Rounded corners Square corners Diagonal corners

Choose rounded, square or
diagonal corners for the fill

Select a stitch type for the lines

Select a stitch length for the lines

Set the Gap between the echo lines
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• 3  will create diagonal corners

Rounded corners (1) is initially selected.

Stitch type
Select a line type for the echo lines in the fill. Choose from:

• Running Stitch
• Double Stitch
• Triple Stitch

Spacing
Set the Gap to the preferred distance between lines of stitching.

Set the Gap from 2mm to 20mm in steps of 0.1mm. It is initially set to 5mm.

Stitch Length
Set the stitch length for the echo lines from 1 to 12mm in 0.1mm steps. The initial setting 
is 1.5mm.
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Shape Fill
Shape fill areas use one of 120 different shapes. Vary the stitch density and use motif lines 
for the fill.

The Shape Fill properties dialog box has tabs for setting all the properties on a shape fill 
area. 

Shape Fill — Options

Density

Set Density from 2 to 40. The lower the number, the closer 
together the stitches and the more stitches are produced.

Shapes
Click the drop-down arrow and select the desired shape from the 
list.

Use Motifs
Click Use Motifs if you would prefer to use motifs instead of a plain line to follow the shape 
selected for the fill. Click the Motif tab to choose a motif.

Shape Fill Area using Shape 37 and Density 12.
(SuperDesign Zodiac 3, number 3)

Select a shape for the fill 

Set the stitch density for the fill

Use motif lines in the fill

Select a motif for the fill
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Shape Fill — Motif
The selected Motif is only used by the Shape Fill if the Use Motifs option is selected on the 
Options tab.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Fit Motif To Line
Select this option to make the shape of the motifs follow the curves of the line. 

Set the gap between the motifs in the line
Adjust the position of the motifs in the line

Select a stitch type for the motif lines
Set the stitch length for the motif lines

Select a motif Group, Category and pattern

Set the motif size and Height / Width ratio

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.
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Reverse
Use this option to reverse the direction of the motif along the line. This is useful, for 
instance, if you have placed a QuickStitch™ Motif Line and wish to reverse the motif 
direction. Some motifs are symmetrical and will have no apparent change when they are 
reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary, 
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motif fill. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Size

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum stitch Length 
from 1 to 12mm in steps of 0.1mm. Length is initially set to the recommended value for 
each motif.
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Radial Fill
Radial fill areas use a pattern of radiating lines from an origin 
point. The stitch density can be varied.

Radial Fill — Options

Density
Set Density from 2 to 40. The lower the number, the closer 
together the stitches and the more stitches are produced.

The initial setting is 20.

Spiral Fill
Spiral fill areas use a spiral pattern from an origin point. Use constant or gradient density.

Spiral Fill using Gradient Density with a 
Satin Line border.
(Revue 2C UC 25-120 SF, Display category)

Set the density from 2 to 40
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Spiral Fill — Options

Density
The density on a spiral fill area can change over a range, or have multiple density changes 
from the origin to the edge of the fill. Choose from two density options: Standard and 
Gradient.

Embroidery on thicker fabrics usually looks better with more stitch coverage, or a low density setting. 
Choose a low value such as 2 or 3 for heavy knit fabrics, a higher value such as 5 or 6 for a light material like 
linen or satin. 

Standard Density

Set the standard Density from 2 to 80. The lower the number, the 
closer together the stitches and the more stitches are produced. 

The initial setting is 2.

Gradient Density

Use Gradient Density to change the density across the Spiral Fill. Set a value for the start 
and end density markers for the fill, and the density gradually changes between the two 
values. The start value is used at the origin of the spiral fill, and the end value is used at the 
edge.

The markers can each take a value of 2 to 80, which means you can reverse the gradient simply by 
swapping the start and end values.
The example shows a Gradient of 2 to 15, with a fill angle of 90°.

Set the density from 2 to 80
Select Gradient fill

Return to the
original settings
Add a marker
Adjustment marker

Highlighted value marker

Set the stitch density for 
the chosen value marker

Delete the selected
marker
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Use the marker above the gradient bar to change the gradient across the fill.

Add Marker
Click Add Marker to add a marker. The initial value for the marker will be between the 
existing markers. Edit the value and move the marker as desired.

This means that you can have any combination of density values across the fill area. Remember, a higher 
value means the fill is less dense. The marker furthest to the left affects the spiral fill at the origin, then from 
left to right to the edge of the spiral fill.

Remove
Click Remove to delete the highlighted marker.

Use Spiral Fill with a Gradient
1 Open the properties dialog box.
2 Click the Gradient option. The Gradient box will become available.
3 Click a value maker (the marker below the gradient bar) and change the value in the Density box to 

the required density value.
4 Click Apply to view your changes.
5 Move the adjustment marker above the gradient bar to vary the change in density across the fill.
6 Click Add Marker to add another value marker and adjustment marker.
7 Change the density of the fill as desired.

8 Click OK to close the properties dialog box.
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QuiltStipple Fill
QuiltStipple fill areas use stipple stitch in curved or straight lines. Vary the gap between 
stitch lines and use running or triple stitch.

QuiltStipple Fill — Options

Style
Choose between curved or straight.

Spacing
Set the Gap to the preferred distance between lines of stitching. This also, where possible, 
is the border inside the area, between the edge of the area and the fill pattern.

QuiltStipple Fill using curved and straight styles 
with a Triple Stitch border.
(Inform UC 25-120mm QS, Display category)

Curved Straight

Select curved or straight stipple lines

Set the spacing between the stipple lines

Select a stitch type for the stipple lines

Set the stitch length for the stipple lines
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Set the Gap from 1 to 20mm in steps of 0.1mm. It is initially set to 5.0mm.

Stitch
Select Running or Triple stitch for stitching out the fill. Set the Length of stitches from 1 to 
12mm in steps of 0.1mm. Length is initially set to 1.5mm.

Contour Fill
Contour fill areas use contour stitch lines. Vary the gap between stitch lines and the length 
of the stitches, and use running, double or triple stitch.

Contour Fill — Options

Spacing
Set the Gap to the preferred distance between lines of stitching. This also is the border 
inside the area, between the edge of the area and the fill pattern.

Set the Gap from 0.2 to 5mm in steps of 0.1mm. It is initially set to 1.5mm.

Stitch
Select Running, Double or Triple stitch for stitching out the fill. Set the Length of stitches 
from 1 to 12mm in steps of 0.1mm. Length is initially set to 2mm.

Contour Fill, using Triple Stitch and a 1.0mm gap, 
and with a Triple Stitch border.
(Per Gothic 25-120mm CF, Elegant category)

Set the space between the lines in the fill

Select a stitch type for the contour lines

Set a stitch length for the contour lines
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Satin Area
Satin areas contain zigzag stitches that fill the area from one end 
to the other at the same density. The stitch angle changes with 
the shape of the area, and can be adjusted as desired. Choose 
automatic edge walk and/or zigzag underlay.

Satin Area — Options
Use the Satin Area options (if available) to set density, 
compensation, pattern and underlay for satin areas.

Pattern
Choose from more than 250 patterns for satin (for areas wider than around 8-10mm). Click 
a pattern sample or enter the Pattern number to select a pattern. Set the Pattern number 
to 0 for standard satin with no pattern, or click No Pattern . The initial setting is 0.

Add new patterns using Manage My Fills in mySewnet™ Digitizing.
View the patterns in the pattern gallery. See “Fill and Satin Patterns” on page 500.

Underlay
Set the Underlay option that will be used for the satin area. Zigzag creates zigzag lines of 
running stitch as underlay. Use zigzag underlay for wide areas of satin. Edge walk places 
lines of running stitch just inside the edges of the satin areas. Use edge walk when the 
satin areas have both wide and narrow sections. For very wide areas of satin, select both 
underlay types. 

Zigzag is initially selected.

Compensation
Compensation is used to make an area 'bolder' by increasing its relative size. Set 
Compensation from 0 to 30. The higher the number, the bolder the area appears.

Set the stitch density for the satin

Select an underlay type for the satin

Adjust the area’s size
Choose a Category and pattern

Search for a pattern by number

Click to use no pattern
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Density
Set Density from 2 to 80. The lower the number, the closer 
together the stitches and the more stitches are produced.

The initial setting is 4.

Columns
Use the Column properties dialog box to edit the properties for the following column 
types:

■ Satin Column
■ Feathered Satin
■ Richelieu Bars
■ Tapered Motifs

You may edit the properties for the column type, but you cannot change between column types.

Satin Column
Satin Column forms a column of straight or curving satin.

Satin Column Options
Use the Satin Column Options to set density, compensation, 
pattern (for columns wider than around 8-10mm) and underlay.

Pattern
Choose from more than 250 patterns for satin (for areas wider than around 8-10mm). Click 
a pattern sample or enter the Pattern number to select a pattern. Set the Pattern number 
to 0 for standard satin with no pattern, or click No Pattern . The initial setting is 0.

Set the Standard density

Select an underlay type for the satin

Adjust the area’s size
Choose a Category and pattern

Search for a pattern by number

Use gradient density

Settings for Single & Multicolor gradient
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Add new patterns using Manage My Fills in mySewnet™ Digitizing.
View the patterns in the pattern gallery. See “Fill and Satin Patterns” on page 500.

Patterns should only be used for columns wider than about 8-10 mm.

Underlay
Set the Underlay option that will be used for the satin column. Zigzag creates zigzag lines 
of running stitch as underlay. Use zigzag underlay for wide areas of satin. Edge walk places 
lines of running stitch just inside the edges of the satin column. Use edge walk when the 
satin columns have both wide and narrow sections. For very wide satin columns, select 
both underlay types.

Compensation
Compensation is used to make an area 'bolder' by increasing its relative size. Set 
Compensation from 0 to 30. The higher the number, the bolder the area appears. The 
initial setting is 0.

Standard Density
Set Density from 2 to 80. The lower the number, the closer 
together the stitches and the more stitches are produced.  

The initial setting is 4.

Gradient
Use the Gradient settings to see and change the density settings 
and the color Gradient of the satin. 

The color on a satin column can change over a range, or have multiple color changes 
across the area. This is ideal for gradual color changes such as subtle shadow effects. 
Gradient is not initially selected. 

Single Color Gradient

Use Single Color Gradient to change the density across a satin column with only one color. 
Set a value for the start and end density markers for the fill, and the density gradually 
changes between the two values. Add multiple markers for a more complex pattern.

The markers can each take a value of 2 to 80, which means you can reverse the gradient simply by 
swapping the start and end values.
Use the adjustment marker above the gradient bar to change the gradient across the area.

Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment marker

Highlighted value marker

Set the stitch density for 
the chosen value marker

Delete the selected
marker
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Use Reset to cancel your changes and use the initial settings.

Click Add Marker to add a value marker below the gradient bar, and an adjustment marker 
above the gradient bar. The initial value for the marker will be between the existing 
markers. Edit the density value, and move the value and adjustment markers as desired. 
This means that you can have any combination of density values across the area. A higher 
value means the fill is less dense.

Density is used to change the density of the stitching. Set Density from 2 to 80. The higher 
the number, the less dense the satin. The initial start marker setting is 4, and end marker 
setting is 4.

Click Remove to delete the highlighted marker.

Multicolor Gradient

Use Multicolor Gradient to change the color across a satin column with only one density. 
Set colors for the start and end markers for the area, and the color gradually changes 
between the two values.

Use the marker above the gradient bar to change the color gradient across the area.

Use Reset to cancel your changes and use the initial settings.

Click Add Marker to add a color marker below the gradient bar, and an adjustment marker 
above the gradient bar. The initial color for the marker will be the same as the currently 
highlighted marker. Change the color and move the color and adjustment markers as 
desired. This means that you can have any combination of colors across the area.

Use Thread Color  to change the color of the currently highlighted marker. The Color 
Selection box will be displayed.

See “Change an Existing Thread Color” on page 53.
Click Remove to delete the highlighted marker.

Select single or
multicolor gradient

Return to the
original settings
Add a marker
Adjustment markers

Selected color marker

Choose a thread for the 
highlighted marker

Delete the selected
marker

Set the stitch density
for the whole fill
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Feathered Satin
Feathered Satin forms a column of satin that is 
feathered on one, or both sides. A Feathered Satin 
column uses zigzag stitches where the start and end 
points of the stitches are random rather than all 
parallel.

Choose whether one or both sides of the column 
will be feathered, and set the stitch length and 
density. 

Feathered Satin Options
Use the Feathered Satin Options to set density, Feather Type, and Stitch Length.

Density
Set Density from 2 to 40. The lower the number, the closer 
together the stitches and the more stitches are produced. The 
initial setting is 15.

Feather Both Sides Feather One Side

Flourish Laurel 1/8 uses Feathered Satin
for the leaves

Set the density for the feathered satin

Select which side of the column to feather

Set the length of the feathering stitches
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Feather Type
Select which side of the column to feather. The available options are Both, SideA or Side B, 
according to the side where the first (A) or second (B) point was placed.

Stitch Length
Set the Length of feathering stitches from 2 to 30mm in steps of 1mm. The initial setting is 
30mm.

Feather Both Sides
Create a satin column with both edges feathered.

The start and end points of the stitches are random rather 
than all parallel. The final width of the section is 2-2.5 
times larger than it is for standard satin, as shown.

The maximum stitch lengths of the feathered satin may 
be from 2 to 30mm and the satin density may be from 2 
to 40.

Feather One Side
Create curved satin with one edge feathered.

If desired, the feathered side may be altered in the properties dialog box.

One edge is feathered, so the start and end points of the 
stitches on the feathered are random rather than all 
parallel. The final width of the section is 1.5 to 1.75 times 
larger than it would be for standard satin, as shown.

The maximum stitch lengths of the feathered satin may be from 2 to 30mm and the satin 
density may be from 2 to 40.

Richelieu Bars
Richelieu Bars forms bars in the work area. Richelieu bars are often 
used in lace designs.

Richelieu Bars Options
Use Richelieu Bars Options to set the width and density of the 
satin bars, the gap between the bars, and the number of bars.
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Satin
Set the Width of the satin bars from 1mm to 6mm in steps of 0.1mm. The initial setting is 
2mm.

Set the Density of the satin bars from 2 to 15. The initial Density is 4.

Method
Select a method for setting the number of bars.

Select Minimum Gap Size to set the distance between the bars from 1mm to 50mm in 
steps of 1mm. The initial setting is 6mm.

Select Number of Bars to set the number of bars from 1 to 50. The initial number is 6.

Turn off Include Additional First and Last Bar if the edges of the Richelieu bar area are to be 
covered in satin. This option is initially selected.

Underlay
Choose from Edge walk, Center link with zigzag return, and Web double with zigzag 
return. All three options are initially selected.

■ Edge walk places lines of running stitch just inside the edges of the satin bars. 
■ Center link with zigzag return places a central line of running stitch, with a zigzag return 

line. 
■ Web double with zigzag return places a crosshatch pattern of stitching with a zigzag 

return line.

Vary the combination of underlay, depending on the type of design. It is recommended to use all three 
types for free-standing lace.

Set the width for the bars

Set the stitch density for the bars

Set the minimum distance 

Set the number of bars
Use a bar at both ends of the column

Set underlay for the Richelieu bars

between the bars
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Tapered Motifs
Tapered Motifs forms columns of motifs. Tapered motifs are often 
used in lace designs.

Tapered Motifs Options
Use the Tapered Motifs Options to set the motif type, stitch type, 
and placement method.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Method

Minimum Gap Size
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Number of Motifs
Set the number of Motifs from 2 to 50. The initial number is 6.

Set a stitch type for the motifs

Set the stitch length for the motifs

Adjust the position in the column

Set the gap between the motifs
Number of motifs in the column

Select a motif and its orientation

Retain proportions within column
Set the motif width
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Fit To Line
Select this option to make the shape of the motifs follow the curves of the line.

Proportional
Use this option to keep the relative height and width of the motif in proportion when 
when the column width is changed. This option is selected by default.

Width
The Width is initially set according to the chosen motif. The maximum and minimum 
values for Width are individual to each motif.

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.
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Line Types
The following line types are available:

■ Running Stitch
■ Double Stitch
■ Double Zigzag
■ Triple Stitch
■ Satin Line
■ Motif Line

Running Stitch
Running stitch is a row of small stitches going forward. Running Stitch is 
also the preferred option for traveling stitches between sections of an 
embroidery.

Lines of running stitch are used for light markout or as 
underlay.

Running Stitch Properties

Length
Set the Length of Running stitch from 0.3 to 12mm in steps of 0.1mm.

The initial setting is 2.0 mm.

Set the stitch length

Create a cutwork line

Select 2 or 4 cutwork needles

Create stability gaps in the cutwork line
Set the distance between the gaps
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Cutwork
The cutwork needle features allow you to draw a cutting line within your design, 
optimized for the INSPIRA® Cutwork Needles. Use two or four cutwork needles, and add 
secure points for fabric stability.

Create Cutwork Needle Line
Enable the cutwork needle feature. By default this feature is not selected (checked).

Method
Choose between:

• 2 Cutwork Needles
• 4 Cutwork Needles

 By default 2 needles is selected.

With 2 needles, a bladed needle set at one angle is used to cut around the shape, and then the second 
needle travels around the shape cutting at a different angle.
With 4 needles a more precise cutting method is used, where each needle is used for the section of the 
shape that closely matches its angle. This method is recommended for more delicate fabrics.

Secure Points
Select Include Secure Points to create gaps in the cutwork needle line. By default Include 
Secure Points is selected.

This allows the cut fabric to remain attached for stability while all the cutwork needle lines are created. 
Afterwards it can be easily trimmed with scissors.
Set the Distance Between Secure Points from 10mm to 100mm in steps of 1mm. The initial 
setting is 30mm.

Double Stitch
Double stitch is a row of small stitches going forward, followed by a row of 
small stitches going backward, so it ends at the same point where it 
began.

Double stitch is used for markout and for branching outlines that need to 
return to their starting points.

This Cartoons 2 SuperDesign uses Running 
Stitch, Double Stitch and Triple Stitch.
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Double Stitch Properties

Length
Set the Length of Double stitch from 1 to 12mm in steps of 0.1mm.

The initial setting is 2mm.

Double Zigzag
Double Zigzag stitch is a row of small stitches going forward, followed by a zigzag row of 
small stitches going backward, so it ends at the same point where it began.

Double Zigzag is a special stitch type, recommended for lace. A running stitch line is retraced in a zigzag 
pattern to create a mesh if sections are placed together. Alternatively, use this stitch type for crosshatch fill.

Double Zigzag Properties

Crosshatch Fill, using Diamond style and an Angle 
of 45 degrees. Double Zigzag is the stitch used in 
the fill and for the border.
(Revue Patchwork UC 50-120mm XH)

Set the stitch length from 1mm to 12mm

Set the stitch length
Set the width of the zigzag line

Use a linking stitch between sections of
Double Zigzag
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Length
Set the Length of Double Zigzag stitch from 1 to 12mm in steps of 0.1mm.

The initial setting is 2mm.

Zigzag Width
Set the Width of the Zigzag part of the stitch from 0.2 to 6mm in steps of 0.1mm.

The initial setting is 0.6mm.

Include a Linking Stitch
Use a linking stitch between sections of Double Zigzag stitch.

Triple Stitch
Triple stitch is a row of small three-part stitches, each composed of one 
stitch going forward, one going backward then one going forward. The 
stitch length can be changed from 1mm to 12mm for individual lines in 
the properties dialog box.

Use triple stitch for heavy markout or as heavy joining lines between 
sections of a character or SuperDesign.

Triple Stitch Properties

Length
Set the Length of Triple stitch from 1 to 12mm in steps of 0.1mm.

The initial setting is 2mm.

Contour Fill, using Triple Stitch and a 0.8mm gap, and 
with a Triple Stitch border.
(Per Gothic 25-120mm CF, Elegant category)

Set the stitch length
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Satin Line
Satin Line is a line of constant-width satin stitch. It can be used 
alone, or as a border to a fill. The width of the line can be set from 
1 to 12mm.

Satin Line Properties
Set density, width and taper for satin line.

Width
Set Width for satin border from 1 to 12mm in 0.1mm steps.

Density
Set Density from 2 to 15. The lower the number, the closer 
together the stitches and the more stitches are produced. The 
initial setting is 4.

Embroidery on thicker fabrics usually looks better with more stitch coverage, 
or a low density setting. Choose a low value such as 2 or 3 for heavy knit 
fabrics, a higher value such as 5 or 6 for a light material like linen or satin. 

Underlay
Use this option to place edge walk underlay inside each edge of the satin line. Underlay 
will not be generated if the Border Width is set below 2mm.

Tapered Ends
The Start Point and End Point settings can be used to taper the ends of your satin lines.

Use these options to create mitered or pointed ends for your satin lines.

Start Point
Use these options to change the type of line beginning for the satin line. Select a taper 
type, then set the angle of the taper.

■ No Taper 

■ Left Taper 

Set the stitch density for the line

Set the satin line width

Use edge walk underlay inside each 
edge of the line

Taper the ends of the satin line
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■ Central Point 

■ Right Taper 

To set the Taper Angle , click the up and down arrows or enter a number.

End Point
Use these options to change the type of line end for the satin line. Select a taper type, then 
set the angle of the taper.

■ No Taper 

■ Left Taper 

■ Central Point 

■ Right Taper 

To set the Taper Angle , click the up and down arrows or enter a number.

Motif Line
Motif line is used for decorative stitches and details.

Motif Line Properties
The Motif Line properties dialog box appears when you select a 
motif line.

Motif

Group
Click the drop-down arrow to select the desired group of motif patterns.

Category
Click the drop-down arrow to select the desired category of motif patterns.

Set the gap between the motifs in the line

Adjust the position of the motifs in the line

Select a stitch type for the motif line

Set the stitch length for the motif line

Select a motif Group, Category and pattern

Set the motif size and Height / Width ratio

Taper the end of the motif line
Taper the beginning of the motif line
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Pattern
Click the drop-down arrow to select the desired motif visually. Motifs are also numbered 
for convenient reference.

Minimum Gap
The Minimum Gap is the minimum amount of extra stitching that is placed between the 
motifs along the line. This is in addition to any spacing that is part of the selected motif.

Fit To Line
Select this option to make the shape of the motifs follow the curves of the line.

Reverse
Use this option to reverse the direction of the motif along the line. Some motifs are 
symmetrical and will have no apparent change when they are reversed.

Kern
Use Kern to automatically increase the space between adjacent motifs where necessary, 
so that the motifs fit along the line without overlapping.

Mirror
Use this option to mirror the motif across the line of motifs. Some motifs are symmetrical 
and will have no apparent change when they are mirrored.

Size

Height and Width
The Height and Width are initially set according to the chosen motif. The maximum and 
minimum values for Height and Width are individual to each motif.

Proportional
Use this option to keep the relative Height and Width in proportion when either is 
changed.

Stitch
Select Running or Triple stitch for stitching out the motifs. Set the maximum Length of 
stitches from 1 to 20mm in steps of 0.1mm. Length is initially set to the recommended 
value for each motif.

When Fit To Line is off, the ends of each 
motif are placed on the line.

When Fit To Line is on, each motif is 
adjusted to fit along the line.
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Tapered Ends
The Start Point and End Point settings can be used to taper the ends of your motif lines.

For Motif Lines, the Central Point option starts at the first stitch point in the first motif in 
the line. The precise position of the point will vary, depending on the motif used.

Use these options to create mitered or pointed ends for your motif lines.

Start Point
Use these options to change the type of line beginning for the Motif Line. Select a taper 
type, then set the angle of the taper.

■ No Taper 

■ Left Taper 

■ Central Point 

■ Right Taper 

To set the Taper Angle , click the up and down arrows or enter a number.

End Point
Use these options to change the type of line end for the Motif Line. Select a taper type, 
then set the angle of the taper.

■ No Taper 

■ Left Taper 

■ Central Point 

■ Right Taper 

To set the Taper Angle , click the up and down arrows or enter a number.

Fill and Satin Patterns
Set the Fill Pattern number for fill areas, satin areas and columns. When a pattern fill area is 
first created, for example by converting from another stitch type, the initial setting is 
pattern 3. Standard satin uses Pattern 0, which is not available for Pattern Fill areas.

Patterns in categories other than Standard are recommended for use in relatively large fill areas, as they 
have repeating patterns which work well when 'tiled' together. Pattern 36 produces a 'satin effect' fill stitch.
The first four patterns in the Gradient & Lace category (253-256) are recommended for multicolor gradient.
Patterns 257 to 264 provide banded fill patterns that combine with crosshatch parallel fills to create a 
weave effect for lace designs. Set Spacing for the parallel fill at 2.4mm to combine with Pattern 257, 2.8mm 
to combine with Pattern 258, and so on.
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For a complete reference to all the fill patterns that can be used, see the Fill Patterns Sample Guide. This is 
provided as a PDF for viewing and printing.

Animals 1 — Patterns 37 to 48

Arrows — Patterns 49 to 60

Circles 1 — Patterns 61 to 72

Circles 2 — Patterns 73 to 84

Climate — Patterns 85 to 96

Diamonds — Patterns 97 to 108
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Gradient & Lace — 
Patterns 253 to 264

Hearts — Patterns 109 to 120

Leisure 1 — Patterns 121 to 132

Mosaic 1 — Patterns 133 to 144

Mosaic 2 — Patterns 265 to 276

People — Patterns 145 to 156

Plants & Flowers 1 — 
Patterns 157 to 168
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Polygons — Patterns 169 to 180

Rope & Chains — 
Patterns 181 to 192

Squares 1 — Patterns 193 to 204

Squares 2 — Patterns 205 to 216

Standard 1 — Patterns 1 to 12

Standard 2 — Patterns 13 to 24

Standard 3 — Patterns 25 to 36
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Transport — Patterns 217 to 228

Waves 1 — Patterns 229 to 240

Waves 2 — Patterns 241 to 252
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26Printing
Use the Print page to select your print settings, and to preview and print a worksheet for 
your embroidery. You may print an overview of the embroidery on a project background 
or split into sections. The printed pages match the Export settings for the embroidery. 

To open the print page in mySewnet™ Embroidery, click File, Print .

To open the print dialog in Windows® Explorer, right-click an embroidery, or a group of selected 
embroideries, and select Print in the Context menu.

Print Page
Select the printer and page layout in print setup, and choose a scale, hoop, units of 
measurement, and details to be printed. Then click Print to print the embroidery 
worksheet and/or overview.

Shortcuts
■ Quick Access Toolbar: 

Print
Click Print to open the Print page and print the project. See “Print” on page 508.

Overview
Select the options in this section to print all embroideries (including the background if 
one has been loaded).

Print Overview
Select whether to print an overview.

Select information & grid

Select measurement units

Choose a scale

Print the worksheets

Choose information for
the Overview
Worksheet settings

Preview the printout
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Scale
Select from Hoop Real Size, Hoop Zoom to Fit, Garment/Quilt Block Real Size, and 
Garment/Quilt Block Zoom to Fit. Hoop Zoom to Fit is initially selected.

Print Hoop Grid
Select whether to show a grid in the hoop view.

Worksheet Options
Choose a hoop to display around the embroidery on the worksheet, and select a Design 
Scale. Choose the information to show for each embroidery in the worksheet (Dimension, 
Color Information, Notes and Settings and Technical Information), and whether to use a 
grid.

Worksheets
Select the format of the worksheets. Choose a full worksheet for each embroidery, or 
display several embroideries on each sheet.

Print Individual Worksheets
Print a worksheet for each piece of the embroidery.

Design Scale
Select 25%, 50%, 75%, 100% or ’to fit’ scaling when printing your embroidery. This is how 
large the embroidery will print compared to the real size of a stitched out embroidery. Use 
a reduced Design Scale if you want to ensure that the worksheet fits on one page. Look at 
the print preview pane to see how many pages will be printed.

Grid
This determines whether or not a grid will be printed with the embroidery. If you turn this 
off you will still get a rectangle representing the hoop.

Flip design for felting or reverse embroidery
Select to flip the embroidery for being stitched in reverse, or for felting effects. 

Print Information
This section determines what additional information is printed. All items are selected 
initially.

Dimensions
The size of the embroidery and the stitch count.

Hoop
The hoop used for the embroidery.

Color Information
The sequence of thread colors used and, if available, the thread specification (range and 
thread number). Stop Commands and their text (where present) are also shown.
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Decoration Information
Information on the decorations used, including their size, color and number.

Notes and Settings
Any notes or settings that are included with the embroidery.

Export Options
The Export options used for the embroidery, as set in the Export dialog box.

Technical Information
The distance of each edge of the embroidery from the center of the embroidery.

Units of Measurement
Select either Millimeters or Inches.

Print Setup
Click Print Setup to select a printer in the Print Setup dialog. See “Print Setup” on 
page 508. You can choose the units of measurement (inches or millimeters) and print 
quality. Select and enter details for a table of contents.

Preview Pane
The preview pane displays the embroidery as it would appear when printed. Other 
information, such as the Dimension, Color Information, Notes, Settings and Technical 
Information, is shown depending on the choices made in the Worksheets section of the 
Print dialog box.

The print preview toolbar offers you options to zoom in and out of the page, and to show 
multiple pages  or individual pages . If there are multiple pages, step through them 
with Next Page  and Previous Page .

If you are trying to preview an embroidery that does not lie entirely inside its hoop then the preview will not 
be shown and a message will appear instead of the Print Preview. Solve this by changing the hoop size or 
adjusting the embroidery so that it fits the hoop.

Print Preview Toolbar
The print preview toolbar offers you the following options:

Next Page
Preview the next page  to be printed. If this is grayed out when you are on Page 1 then 
there are no more pages and the print fits on one page.

Previous Page
Preview the previous page  to be printed.

Multiple Pages
Select  how many printed pages to preview at a time.

Individual Page
Preview only one  page at a time.
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Zoom In
Take a closer look at the page to be printed.

Zoom Out
Take a larger look at the page to be printed.

Print Setup
This is displayed when you click the Print Setup button in the Print dialog box.

Use Print Setup to select the destination printer and its connection.

Printer
Select the printer you want to use.

Paper Size
Select the size of paper that the embroidery is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources. Specify the tray here.

Orientation
Choose Portrait or Landscape. Generally, you should not need Landscape for the standard 
hoop sizes as the embroidery is rotated automatically by the print process when you print 
an embroidery that uses a Rotated hoop.

Properties
Displays a dialog box that provides additional printing choices, specific to the type of 
printer you have selected.

Print
Print the embroideries and background that are displayed on the mySewnet™ Embroidery 
screen. Other information, such as the Dimensions, Color Information, Notes and Technical 
Information is printed depending on the choices made in the Print page, where the scale 
may also be altered, and a grid turned on or off. If possible, the hoop will be printed with 
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the same orientation as on the screen. If a horizontal hoop is too wide to fit on the paper at 
the Design Scale chosen in the Worksheets section then the hoop will be rotated 90 
degrees when it is printed.

The Print dialog box appears, where you may specify number of copies, the destination 
printer, and other printer setup options.

Shortcut
■ Keys: Ctrl + P

Printer
Select the printer you want to use.

Properties
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Print to File
When this option is checked, you will be prompted for a file name after you click OK. The 
print job will then be saved with the file name you specify and can be sent to the printer at 
a later time.

This is an advanced Windows® printing option.

Print Range
Select the range of pages you wish to print.

Copies
Select the number of Copies you wish to print. If you choose to print more than one copy, 
you can choose to Collate the copies.
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27Preferences 
Use Preferences  to choose overlap options and adjust spelling checker settings. When 
these are changed, the new settings will be remembered when mySewnet™ Embroidery is 
closed and reopened.

Shortcut
■ File Menu: 

Remove Overlap When Combining Embroideries
When this option is selected, overlapping areas of embroidery are removed, so that there 
is no build-up of stitching where embroideries overlap. This is used for the Combine All 
and Combine Selected functions.

This option is initially selected.

Remove overlap is not used if any of the designs contain appliqué.

Spelling
When Check Spelling is selected, text entered in the Letters box on the Letter tab is 
checked for unrecognized words in the selected language. Spelling is also checked in the 
Letter Properties dialog box that appears when you right-click lettering on the work area. 
Additionally, new sentences are capitalized. To change the language, click the drop-down 
arrow and choose the desired language from the list.

Deselect Check Spelling if you prefer not to check spelling.

Unrecognized words may be added to the dictionary when they are underlined in red.
Check Spelling is initially selected, and the language is initially set to English US.

Appliqué Piece Margin
Use the Appliqué Piece Margin settings in Preferences to override the initial appliqué 
placement settings for lettering, SuperDesigns, Frames and Flourishes.

See “Appliqué Selection” on page 192 for more information on using appliqué placement margin and 
Match Placement Line.
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Override margin width
Override the appliqué placement margin for the selected design, using the width set here 
instead. Set the margin for appliqué placement relative to the selected shape from -10mm 
to 10mm. The initial value is 1.0mm.

If you prefer always to use a certain value margin width for your automated cutter, set it here.

Override Match Placement Line
Override the setting for Match Placement Line in the selected design.

If you prefer always to match the placement line to the appliqué margin (for example, to ensure the 
placement line is visible when positioning precisely cut pieces), choose this setting.
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28Troubleshooting

Error Messages
Loading Embroideries

"Cannot open embroidery."
This message appears if the desired embroidery is not where the module expects it to be, 
for example if an embroidery was loaded from a USB memory stick, then closed and the 
memory stick removed. The message would appear if you tried to load the embroidery 
from the Recent Files list on the File menu.

"Unrecognized file format."
This message appears if the embroidery you are attempting to load is corrupt. For 
example, it might have the extension .vp4, yet not be a proper Husqvarna Viking / Pfaff 
embroidery.

"Embroidery is corrupt."
The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

"Embroidery XY coordinates incorrect."
The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

"Unrecognized file extension."
This message appears if you attempt to load a file with an extension that does not belong 
to any embroidery file types. For example, it would appear if you tried to Drag and Drop a 
.doc file onto the screen.

"Embroidery not created using licensed software."
This message may appear if you attempt to load an embroidery created in third-party 
software. Such embroideries may cause unpredictable results.

"You are trying to insert a library design file. Your current project will be 
reopened in a protected state. Do you want to continue?"
This message will appear if you try to insert a mySewnet™ Library design into an existing 
project. The entire project will be reopened in a new window in a protected state.

"You are trying to insert a library design file. Your current project will be 
reopened in a protected state. Do you want to continue without saving 
first?"
This message will appear if you try to insert a mySewnet™ Library design into an existing 
project with unsaved changes. The entire project will be reopened in a new window in a 
protected state.

Click Cancel to save your project before you insert a mySewnet™ Library design.
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Using the ExpressDesign Wizard

"Problem with scanner or camera software."
This message will appear when trying to use your scanner or digital camera if the device 
has not been installed correctly. Close mySewnet™ Embroidery, follow the manufacturer's 
instructions for the WIA-compliant device, then reopen mySewnet™ Embroidery and try 
again.

"Scanner or camera is in use by another application."
This message will appear when trying to use your scanner or digital camera if another 
graphics program is already open that uses the WIA-compliant device. Close mySewnet™ 
Embroidery and the other graphics program, then reopen mySewnet™ Embroidery and 
try again.

"Your scanner or camera is no longer available for use. Close this program, 
plug in and switch on your scanner or camera, and run this program 
again."
This message will appear if the connection to your scanner or digital camera has a 
problem. Close mySewnet™ Embroidery, check the connections to your scanner or digital 
camera, then reopen mySewnet™ Embroidery and try again.

"Failure to acquire picture due to unknown causes."
This message will appear in certain circumstances when trying to use your scanner or 
digital camera, for example if the cable is disconnected during the scan or download. 
Close mySewnet™ Embroidery, check the connections to your scanner or digital camera, 
then reopen mySewnet™ Embroidery and try again.

"Could not load picture file."
This message could appear if the desired picture is not where the module expects it to be, 
for example if it was loaded from a USB memory stick, then closed and the memory stick 
removed. It could also appear if the file you are attempting to load is corrupt. For example, 
it might have an extension such as .bmp or .jpg, yet not be a proper picture file.

"Some areas were too thick to be traced."
This message may appear when creating an Express Trace design if the final picture has 
thick areas of solid color. Some or all parts of the design may not be created. Try using 
options in the wizard, on the Outline Finder and Expander page and/or the Monochrome 
Threshold page, to ensure the outlines are not too thick. Cancel the wizard, adjust the 
picture so that the outlines are easier to isolate with Monochrome Threshold, then open 
the picture in the ExpressDesign Wizard again.

"Please choose a valid motif pattern."
This message appears if you try to select a motif from My Motifs, and all the motifs have 
been deleted from My Motifs. Use mySewnet™ Digitizing to add at least one motif to My 
Motifs.
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"Error. Motif database is missing or corrupt. Cannot change motif."
This message usually means that the motif database has been deleted or corrupted. This 
may be corrected by repairing the installation.

First, delete the file named 'SystemMotifs.mdb' from 
ProgramData\mySewnet\Embroidery1\\System.

This assumes you have installed your mySewnet™ Embroidery Software software in the default location. If 
the file is not present then this is the reason for the error. The file name may simply be shown as 
'SystemMotifs'.
Put your mySewnet™ Embroidery Software software USB stick in your computer and re-
run the installation. When the choice appears, select the "Modify or remove" option and 
click Next. In the next screen, select Repair and click Next. Continue with the installation 
and follow the on-screen instructions. When the installation is complete, the motifs will be 
restored.

Using the ExpressMonogram Wizard

"Please select letters for the monogram"
This message appears if you try to create a monogram with no letters selected. Select 
some letters.

"One of your letters is not valid"
This message appears if you try to create a monogram using a character that is outside the 
available font range (ASCII 33-255). Use a valid character.

Using the PhotoStitch Wizard

"Problem with scanner or camera software."
This message will appear when trying to use your scanner or digital camera if the device 
has not been installed correctly. Close mySewnet™ Embroidery, follow the manufacturer's 
instructions for the WIA-compliant device, then reopen mySewnet™ Embroidery and try 
again.

"Scanner or camera is in use by another application."
This message will appear when trying to use your scanner or digital camera if another 
graphics program is already open that uses the WIA-compliant device. Close mySewnet™ 
Embroidery and the other graphics program, then reopen mySewnet™ Embroidery and 
try again.

"Your scanner or camera is no longer available for use. Close this program, 
plug in and switch on your scanner or camera, and run this program 
again."
This message will appear if the connection to your scanner or digital camera has a 
problem. Close mySewnet™ Embroidery, check the connections to your scanner or digital 
camera, then reopen mySewnet™ Embroidery and try again.
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"Failure to acquire picture due to unknown causes."
This message will appear in certain circumstances when trying to use your scanner or 
digital camera, for example if the cable is disconnected during the scan or download. 
Close mySewnet™ Embroidery, check the connections to your scanner or digital camera, 
then reopen mySewnet™ Embroidery and try again.

"Error. This scanned image type is not supported."
This message will appear if the scanner has created an image file that is not supported by 
mySewnet™ Embroidery. Convert the image to a supported image file format.

"Could not load picture file."
This message could appear if the desired picture is not where the module expects it to be, 
for example if it was loaded from a USB memory stick, then closed and the memory stick 
removed. It could also appear if the file you are attempting to load is corrupt. For example, 
it might have an extension such as .bmp or .jpg, yet not be a proper picture file.

"The selected dimensions will produce a large PhotoStitch and stitch 
creation may take some time. Removing background areas will reduce 
the time required."
This message will appear if you specify a PhotoStitch larger than 26,000mm square. Click 
OK to continue creating the PhotoStitch. To reduce the stitch creation time, remove the 
picture background, particularly any very detailed areas. Stitch creation time is shorter for 
Linear PhotoStitch.

Choosing Thread Colors

"The color xx has been found in your database, but the thread color is not 
exactly the same."
This message appears if the Thread Range and Color Number of the selected color are 
identical to those in your thread database, but some aspect of the color is different. It 
could be a different material or weight, or have additional colors as a variegated thread. 
This could happen if the design you are attempting to edit was supplied by someone with 
a different version of the color, for instance if they have edited it in My Threads, or if they 
have a later version of the thread database. If you click OK, the color will be replaced with 
the near match. You can alter it to any other color if desired. If you click Cancel, the color 
will not be changed. To import the new color from an embroidery if it is a My Threads 
color, use mySewnet™ Thread Cache. To check for the latest updates for the mySewnet™ 
Embroidery Software, use Smart Update in mySewnet™ Configure.

"Could not find xx in your database. Matching to closest thread in yy."
This message appears if the Thread Range of the selected color is not found in your thread 
database. This could happen if the design you are attempting to edit was supplied by 
someone with a later version of the thread database. If you click OK, the color will be 
replaced with the nearest match in the Import Thread Range you have set in mySewnet™ 
Configure. You can alter it to any other color if desired. If you click Cancel, the color will not 
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be changed. To import the new color from an embroidery if it is a MyThreads color, use 
mySewnet™ Thread Cache. To check for the latest updates for the mySewnet™ Embroidery 
Software, use Smart Update in mySewnet™ Configure.

"Error - thread range is corrupt or missing. Cannot change thread. Restore 
MySettings or reinstall the thread database."
This message appears if there is a problem with your thread database. You will be unable 
to choose a thread color. First close all the modules of the mySewnet™ Embroidery 
Software, close down your computer and restart. If this does not clear the problem, restore 
a backup with Restore MySettings, if you have created one using Backup MySettings in 
mySewnet™ Configure. Otherwise, you either need a new version of the thread database, 
or a repair install of your mySewnet™ Embroidery Software software. To check for the 
latest updates for the mySewnet™ Embroidery Software, use Smart Update in mySewnet™ 
Configure.

If the error still appears, then repair the installation. First, delete the following files from 
ProgramData\mySewnet\Embroidery1\\System:

■ User.sqlite
■ System_cdb2.sqlite

This assumes you have installed your mySewnet™ Embroidery Software software in the default location. If 
these files are not present then this is the reason for the error. The file names may be shown without their 
file extensions.
Put your mySewnet™ Embroidery Software software USB stick in your computer and re-
run the installation. When the choice appears, select the "Modify or remove" option and 
click Next. In the next screen, select Repair and click Next. Continue with the installation 
and follow the on-screen instructions. When the installation is complete, the thread 
database will be restored to its original installation state. This means that the My Threads 
database will have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check 
Smart Update in mySewnet™ Configure after repairing the installation.

"Error: Please select a valid thread."
This message appears if you attempt to click OK in the Color Selection dialog box when 
My Threads is selected as the thread range and My Threads is empty.

To prevent this message appearing again, use mySewnet™ Thread Cache to add at least 
one thread to My Threads.

Creating Lettering, SuperDesigns, Frames, Flourishes and 
Borders

"Please enter an integer between 3 and 200."
This message appears if the size entered in the Size Box on the Letter tab is below 3mm or 
above 200mm. The Size setting refers to the height in millimeters of an uppercase 'A' in the 
selected font. If you wish to increase lettering above this you could click and drag one of 
the corner boxes or alter the Height or Width proportions.
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"Error. Cannot open Font File."
This message appears if the font or SuperDesign set that you have selected is not 
available. The most likely reason is that it is already open in the optional mySewnet™ Font 
Digitizing module. Close mySewnet™ Font Digitizing, then try again. This could also 
happen if you opened the mySewnet™ Embroidery program, then accidentally moved or 
deleted the font from the relevant category folder in 
ProgramData\mySewnet\Embroidery1\Fonts, or the SuperDesign file from 
ProgramData\mySewnet\Embroidery1\SuperDesigns. Close mySewnet™ Embroidery, 
make sure the file is in the folder, then try again.

"Error. No SuperDesigns, Frames or Flourish files found."
This message appears if the SuperDesigns or Frames folder is empty or has been 
accidentally moved, deleted or renamed. Close mySewnet™ Embroidery, make sure the 
folder ProgramData\mySewnet\Embroidery1\SuperDesigns, or \Frames, is in the correct 
location and contains the SuperDesign or frames files, then try again.

If you are unable to restore or replace the SuperDesigns or Frames folder, repair the 
installation. Put your mySewnet™ Embroidery Software software USB stick in your 
computer and re-run the Components installation. When the choice appears, select the 
"Modify or remove" option and click Next. In the next screen, select Repair and click Next. 
Continue with the installation and follow the on-screen instructions. When the installation 
is complete, the SuperDesigns or Frames will be restored.

Check Smart Update in mySewnet™ Configure after repairing the installation.

"Error. Font file is corrupt."
This message appears when trying to select or use a lettering style if the file has corrupted. 
Reinstall the font.

This may also appear if a font is created in mySewnet™ Font Digitizing and has no 
characters defined. Use mySewnet™ Font Digitizing to define at least one character in the 
font.

"Error. Could not set up font data."
This message may appear at the end of font creation with the QuickFont Wizard if one or 
more characters is not properly defined in a font. That is, there is no data in the TrueType® 
or OpenType® font about the characters, so they have not been created in the embroidery 
font. This may happen with specialist or symbol fonts, which are not designed for general 
text usage. If desired, use mySewnet™ Font Digitizing to create any missing characters.

"Error. No letters in font file."
This message may appear if the font is corrupt, or if the character selected is not in that 
font. Reinstall the font, or use mySewnet™ Font Digitizing to add the character to the font.

"Error. Font is too thin to be filled."
This message may appear when trying to preview or create a font with the QuickFont 
Wizard. When some parts of characters have very narrow sections, they may not be large 
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enough to have fill areas created when the Stitch Type is set to Fill or Fill + Satin Border. If 
the font is created, it may have characters or parts of some characters missing. It is 
recommended to choose a different Stitch Type. Alternatively, create the font then use 
mySewnet™ Font Digitizing to create the missing parts and/or characters.

"Error - Shapes database is corrupt or missing."
This message appears if the database of Frames and Borders, or the database of shapes 
used for Encore shapes, shape fill, and creating border and appliqué shapes, has been 
corrupted or accidentally moved or deleted. 

This error does not prevent mySewnet™ Embroidery from starting. However, you will not be able to use the 
relevant functions until this is resolved.
To correct this, start the installation for your mySewnet™ Embroidery Software software, 
then choose the Repair option.

If the problem persists, delete the file named 'BorderShapes.bdr' from 
ProgramData\mySewnet\Embroidery1\\System, and then use the Repair option again.

This assumes you have installed your mySewnet™ Embroidery Software software in the default location. If 
the file is not present then this is the reason for the error.

Modifying Embroideries

"A group is selected. To modify one item, use Reveal Groups and then 
select the design you wish to modify."
This message is displayed if you click the Modify tab when a group is selected. Select the 
item within the group that you wish to edit individually after using Reveal Groups, then 
click the Modify tab again.

"Multiple items are selected. Please ensure only one item is selected."
This message is displayed if you click the Modify tab when several items are selected. Click 
the individual item that you wish to modify, or use the Tab key to step through the designs 
until the desired one is selected, then click the Modify tab again.

"A design must be selected to use the features of the Modify tab."
This message is displayed if you click the Modify tab when no item is selected. Select an 
item, then click the Modify tab again.

"This will fix your selected design as embroidery stitches. Do you wish to 
continue?"
This message is displayed if you click the Modify tab when a SuperDesign, Lettering, or 
frame is selected. When a design is fixed, the stitches are then created, and any further 
resizing may affect stitch density and length. The stitch properties, for example the 
density, pattern, angle or stitch length, may not be changed after it is fixed, and for 
lettering the font and text may not be changed. Only click OK if you wish that item to be 
fixed as stitches. 
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"Decorations cannot be edited using the features on the Modify tab."
This message is displayed if you click the Modify tab when decorations are selected. You 
cannot adjust decorations on the Modify tab.

"Pasting into the Modify tab will combine and fix as stitches all designs 
from the clipboard block."
This message is displayed if you copy designs to the clipboard block, and then attempt to 
paste them into the Modify tab. Only click OK if you wish the items to be fixed as stitches.

Exporting and Saving Files

"Embroidery is too large or is not in the hoop."
This message appears if an embroidery you are trying to Export or Print is outside the 
selected hoop or larger than will fit in it. For example, with the 100mm x 100mm hoop 
selected, an embroidery smaller than 100mm x 100mm might be placed partially outside 
the work area when you click Export or Print. This message would then appear. Move the 
embroidery completely within the four blue corners of the work area and try again.

"Embroidery too large for export format."
Certain formats are limited to the number of stitches they can save or the size of hoop 
used on their specific embroidery machine, for example .sew. If you attempt to save a file 
in this format that is bigger than the largest available hoop size or has more stitches than 
are allowed, this message would appear. 

"Unrecognized file extension."
This message appears if you type an incorrect extension that does not belong to any 
embroidery types in the File Name box when trying to save a file.

"You can’t save here. Please choose another location."
This message appears if, for instance, you have loaded an embroidery from a CD-ROM and 
then attempt to save the embroidery back to the CD. A CD-ROM is read only, therefore you 
will not be able to save the embroidery.

"Embroidery has too many stitches for file format."
There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff 
(.pcs) file format. This message appears if the embroidery you attempt to save to this 
format exceeds this limit.

"No stitch data to save."
This message appears on attempting to save when there is no embroidery on the current 
window.
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Printing Embroideries

"No embroideries available to print. Only embroideries that are inside the 
hoop can be printed."
This message appears if the embroidery on screen is partially outside the selected hoop. 
Move the embroidery completely within the four blue corners of the work area and try 
again.

Miscellaneous

"Not enough memory available to perform function."
This message will appear if system resources are low. Close other programs and try again. 
If this does not work, try restarting your computer.

"No apps are installed to open this type of link (file). Look for an app in the 
Store."
This message will appear if the file association for HTML (the Help file format) has become 
disassociated. Reset your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then 
select "Associate a file type or protocol with a program" (Set Associations). Browse down to 
.html, and ensure that your chosen browser is selected as the default program.
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Other Topics
Screen Appearance

"It seems to take a long time to redraw embroideries when I choose 
different functions or switch to a new embroidery."
The refresh rate of the screen is limited by the power of your computer's processor and 
RAM as well as the video card and its memory. To get the best performance from your 
system, try using 2D view as this requires less power than 3D view.

"Some of the icons in the Toolbar are 'grayed out'."
Certain icons (for example Save and Export on the Quick Access Toolbar) are only 
highlighted once an embroidery is shown on the screen.

"I have changed grid color and spacing and now I wish to return to the 
original settings."
Use mySewnet™ Configure to change the grid color. Follow the instructions in mySewnet™ 
Configure and select Blue Gray (RGB values 102, 102, 153) from the standard color drop-
down on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 10.

"I have changed the screen background color and now I wish to return to 
the original light blue."
Use mySewnet™ Configure to change the background color. Follow the instructions in 
mySewnet™ Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

Loading Embroideries

"I can't drag and drop embroideries from the Open dialog box."
To drag and drop embroideries onto the Work Area, in Windows® 10 and 11, click File 
Explorer on the Status Bar. Then follow the instructions under Drag and Drop. See “Load 
Embroideries with Drag and Drop” on page 17.

Working with Embroideries

"The embroidery I want to work with appears too small on the screen."
Make sure the mySewnet™ Embroidery window is maximized by clicking the Maximize 
icon on the title bar. Click Zoom To Fit to expand the hoop so it fills the work area. Also, 
choose a Hoop Size in Hoop Selection that is suitable to the embroidery size.

"When I hover the mouse pointer over a color in the color worksheet, part 
of the embroidery changes to an unusual color."
This is called "Highlight Selected Color". It allows you to see where each color is used in an 
embroidery. For example, if you have several color blocks using the same thread color and 
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you wish to change the color of a specific section, hover over each color in the worksheet 
in turn until the section you require is highlighted.

"I find it hard to select the part of the embroidery I wish to edit."
Many functions of mySewnet™ Embroidery can be used to help see sections of 
embroideries more easily. They include the Zoom Commands and the Draw Range. The 
different methods of selection (Box Select, Freehand Select, Point Select and Select All) are 
also useful for different situations.

"I've selected the wrong embroidery to move or manipulate."
To deselect an embroidery, click the mouse on another embroidery. To select the desired 
embroidery, click on it and an outline box will appear. If one embroidery or piece of 
lettering is overlapping another making it difficult to select, choose the desired 
embroidery in the FilmStrip. Alternatively, press the Tab key to select each embroidery in 
turn.

"The color worksheet appears blank."
If no design is selected, the worksheet will be blank. To view and change the threads in an 
embroidery, select the embroidery, then view the threads in the color worksheet.

"Certain features are always grayed out (unavailable)."
The functions available will depend on your software license. Those that are not available 
will be grayed out.

Choosing Thread Colors

"When I try to use Find Thread to select a thread number, the wrong 
thread shade is selected."
The Find Thread feature in Color Selection allows you to enter partial thread numbers. The 
first thread in the list matching the number is found, with priority given to an exact match. 
If you are attempting to find a thread with only part of the number, the first thread 
matched may not be the desired thread. To ensure you select the correct thread, enter the 
thread number as it appears in the list. Some thread ranges have prefix characters on the 
thread number. These must also be entered to obtain an exact match.

Using Groups and Multiple Selections

"How do I change a design within a group?"
If a design is within a group, you cannot initially select it individually for adjusting. Use 
Reveal Groups on the FilmStrip or context menu, and then select the desired design, 
lettering, SuperDesign or frame individually.

"When I try to resize a design, the resize is always proportional."
If a design is within a multiple selection or a group, resizing is always proportional. Either 
use Reveal Groups on the FilmStrip or context menu and select the desired designs 
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individually, or Ungroup and Combine all of the designs to resize them together in 
different proportions.

"Why can’t I mirror a selected design?"
If a design is within a multiple selection or a group, there is no flip handle, and you cannot 
mirror the multiple selection or group. Either use Reveal Groups on the FilmStrip or 
context menu and select the desired designs individually, or Ungroup and Combine all of 
the designs to mirror them together.

Modifying Embroideries

"When I pasted a decorated design into the Modify tab I could not see the 
decorations, but when I moved to the Home tab they appeared."
If you paste a design with decorations into the Modify tab, the decorations are not visible. 
They will reappear as separate subdesigns when you move to one of the other tabs. Retain 
or delete them as desired.

Importing Pictures

"The From Scanner or Camera option is not available, even though my 
scanner/camera is plugged in."
The From Scanner or Camera option may not be available, even though you have installed 
and connected a scanner/camera, if it does not support Windows Image Acquisition 
(WIA). If your scanner/camera supports a different image acquisition system, e.g. TWAIN, 
create a .PNG or .JPG file of the image in My Pictures, and load it from there.

Using the ExpressDesign Wizard

"My picture already has outlines, but some outlines are not traced 
properly when I create an Express Trace embroidery."
This can happen if the outlines in your original picture are only one pixel wide. For 
example, there may be gaps or missing sections of the outline. If this happens, select Find 
Outlines on the Outline Finder and Expander page and ensure Expand is set to 1. This will 
thicken all the outlines so that they are traced correctly.

"The preview picture is blank or almost blank on the Express Trace 
Options or Express Border Options page."
This may happen if the outlines in the picture are only one pixel wide after the 
Monochrome Threshold page.

For Express Trace, return to the Outline Finder and Expander page, select Find Outlines 
and ensure Expand is set to 1.

For Express Border, first click Picture Options and set the Area Sensitivity to High. If this 
does not have the desired effect, return to the Monochrome Threshold page and adjust 
the slider so that more of the picture within the desired areas turns black. If this also 
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selects unwanted parts of the picture, you may need to remove the unwanted areas in a 
picture editor.

mySewnet™ Digitizing and mySewnet™ PhotoStitch have picture editing functions that may be used to 
remove unwanted areas.

"My picture only makes a rectangular border when I create an Express 
Border."
This can happen with a picture that has a border or background that is black or very dark, 
especially if the background or border cannot be removed with Monochrome Threshold.

For pictures with a dark border, it should be possible to remove the border on the Rotate 
and Crop Picture page of the ExpressDesign Wizard. If this is not possible, edit the picture 
to remove the border or change the border color.

For pictures on a dark background, use an image editor to invert the colors in the picture 
or change the background color to a light color.

After editing the picture, load it again in the ExpressDesign Wizard.

"I made a change to my design in the ExpressDesign Wizard and now I 
can’t click Finish to load the design in the work area."
If you make a change to the options on the Fabric And Stitch Type Options page in the 
ExpressDesign Wizard, you must click Refresh Preview to view your changes before you 
can click Finish. Refresh the preview, then Finish.

Linear PhotoStitch Embroideries

"I would like to get rid of the lines created from the white background of 
my picture by Linear PhotoStitch embroidery."
After creating and saving an embroidery, use the Modify tab or open the file in 
mySewnet™ Stitch Editor and use the following instructions.

1 Use one of the selection tools to mark the stitches in the background.
2 Click Delete Stitches.
3 Save the adjusted embroidery.

PhotoStitch Embroideries

"I would like to get rid of the stray stitches in the background of my 
PhotoStitch embroidery."
It is best to clean the background of a picture so that there are no flecks, as they can cause 
stray stitches. If some remain in a saved PhotoStitch embroidery, remove them in the 
Modify tab or open the file in mySewnet™ Stitch Editor and use the following instructions.

1 Use one of the Select features to select the stray stitches.
2 Click Delete Stitches.
3 Save the adjusted embroidery.
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Using the ExpressMonogram Wizard

"Can I edit my monogram after placing it on the work area?"
When you have created a monogram and placed it in the work area, right-click it and 
select Properties to reopen the ExpressMonogram Wizard with the monogram loaded. 
The pale green handles indicate that the monogram has not been fixed as an embroidery, 
and can still be adjusted in the ExpressMonogram Wizard.

"How do I save my monogram so I can adjust it later?"
If your monogram in the work area has pale green handles (indicating that it has not been 
fixed as an embroidery), you can save it individually, or as part of a selection or group in a 
.vp4 file.

"I have used a motif as an envelope border and the results are 
unexpected."
If the selected motif width is larger than the size of the monogram or name, then only one 
motif may be created. Adjusting lettering or motif size or spacing may allow multiple 
motifs to be included in the border. If the selected motif shape is irregular it may overlap 
the monogram. Adjusting lettering or motif size or spacing may produce the desired 
results.

"How can I resize my monogram on the work area?"
When a monogram is resized on the work area, it is fixed as a group of embroideries and 
you will not be able to edit the text. To change the size of a monogram without fixing it, 
right-click and select Properties in the Context menu to open it in the ExpressMonogram 
Wizard. You can then resize the letters within the monogram, and the border around it.

Encore

"I want to change the design that has been used in the corners in Encore."
In Encore Shape and Encore Hoop, when two embroideries are selected, the embroidery 
that is first in the stitch-out order will be placed in the corners. If you want to use the other 
embroidery in the corners, use Stitch Order to change the order.

"Not all of my designs have been used in the Encore function."
A maximum of two designs can be used with Encore Shape and Encore Hoop. If more than 
two designs are selected, only the first two that were loaded will be used in the Encore. 
Either use Encore Circle or Line, or group some of the embroideries before using Encore.

"I have used an odd number of repeats and the center of rotation is not in 
the same place as the center of the circle after I right-click."
This is because the shape of an embroidery becomes a factor when there is an odd 
number of repeats. For an even number of repeats, the shape of an embroidery is 
cancelled out by the exact same shape on the opposite side of the circle. For an odd 
number of repeats, the circle is not 'balanced' in quite the same way, so the center point of 
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the final embroidery may not be in the same place as the original center of the circle after 
you right-click.

This may also happen with an even number of repeats when the Mirror option is chosen 
for Position and the embroidery is not horizontally symmetrical. If you regard each pair of 
mirrored embroideries as a single item, an odd number of pairs may cause the center of 
rotation to move.

"The Mirror option does not seem to have any effect."
If your embroidery is horizontally symmetrical before you use the Encore function, the 
Mirror option will have no apparent effect. However, it will affect stitch order of each 
alternate copy. For example, clockwise stitching will become counter-clockwise, and so 
on.

Endless Embroidery

"How can I change the marker positions in an endless embroidery?"
Load the embroidery in mySewnet™ Embroidery, click the Create tab, then click Endless. If 
the endless embroidery was created in the mySewnet™ Embroidery Software any markers 
(alignment stitches) are removed, so that alternative ones may be placed.

"I have loaded an embroidery that I made Endless some time ago. How do 
I know what Fabric Direction was used when I made it endless?"
Reload the embroidery in the Endless wizard, and view the Fabric Direction in the wizard. 
Alternatively, for an older embroidery use the slider bars on the Modify tab to find the 
locations of the start and end marker stitches. For example, if the start markers are at the 
top and the end markers are at the bottom, the original Fabric Direction was Up.

"The Endless function does not work."
The Endless function is not available in any of the following situations:

■ There is no embroidery loaded, so there is nothing that can be made endless: load an 
embroidery

■ The embroidery is too big for or is outside the current hoop: adjust the embroidery as 
needed or choose a larger hoop

Lettering, SuperDesigns and Frames

"I don’t remember which font I used when making an embroidery."
If lettering, a SuperDesign or frame has green handles it has not yet been fixed as stitches. 
Simply right-click and choose Properties or the desired stitch type from the context menu 
to see the font and stitch properties used to create it. Otherwise, view the settings; 
information on the font, SuperDesign, Motif or Frame used in an embroidery made in 
mySewnet™ Embroidery is stored in the Settings. Open the embroidery and click the 
Settings tab in the Home tab to view the settings. Alternatively, print a worksheet for the 
embroidery.
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"I want to change the size of the lettering, but the control boxes have no 
effect."
For the following Lettering Shapes, there are no control boxes to change the size of the 
characters in the lettering:

■ Circle Clockwise
■ Circle Clockwise
■ Full Circle
■ Fit To Straight Line
■ Fit To Wavy Line

Instead, use Size, Height and Width in Letter Properties to change the size of the 
characters.

"When I try to change the properties of the lettering or SuperDesign I 
cannot access the Properties dialog."
You cannot change letter properties (e.g. the font or text) or SuperDesign properties (e.g. 
stitch type settings) when lettering or a SuperDesign has been fixed as stitches. If lettering 
or a SuperDesign is fixed as stitches it will have white handles. This can happen when it is 
adjusted in the Modify tab, when Fix as Stitches is used.

"I want to change the appearance of the font stitching, but the Stitch Type 
drop-down is not available."
If the Stitch Type area is grayed out (unavailable), this means that the area was designed 
with properties cannot be edited. For example, this occurs with Foam fonts that have 
special settings to ensure the embroidery foam is cut, and it also occurs with a few very 
complex fonts that have many different fill patterns in different letters, or multigradient 
fills, such as Acorn 6C UC 35-60mm in the Floral category.

"When I try to change the stitch properties the Stitch Type drop-down is 
grayed out (unavailable)."
If the Stitch Type area is grayed out (unavailable), this means that the area was designed 
with properties cannot be edited. For example, this occurs with Foam fonts that have 
special settings to ensure the embroidery foam is cut, and it also occurs with a few very 
complex fonts that have many different fill patterns in different letters, or multigradient 
fills, such as Acorn 6C UC 35-60mm in the Floral category.

"I have increased the Gap setting, but the lowercase characters are still 
touching each other."
For script fonts, the Gap setting has no effect on adjacent lowercase characters. Script 
fonts use a special 'continuous' joining method, which places lowercase characters 
adjacent to each other to give the appearance of handwriting. All the fonts in the Script 
category use this joining method, and you may also create new fonts with the QuickFont 
Wizard or the optional mySewnet™ Font Digitizing module that use this joining method.
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"All the lettering appears in uppercase, even though I have typed 
lowercase characters in the Letters box."
You are using an uppercase font. In an uppercase font (with UC in the name), all the 
lowercase characters are identical to the uppercase characters.

"All the lettering appears in lowercase, even though I have typed 
uppercase characters in the Letters box."
You are using an lowercase font. In an lowercase font (with LC in the name), all the 
uppercase characters are identical to the lowercase characters.

"I have placed multiple lettering with different text in each item and I 
want to change the text that appears in some of them. However, the text 
in the Letters box stays the same when I select earlier pieces of lettering."
Select the desired lettering with green handles, then right-click on the lettering. The Letter 
Properties will appear and you may change the text.

Once lettering has been converted to embroidery (white or blue handles), no adjustments can be made 
with Letter Properties.

"When I use a Script font with the Full Circle line type, the characters are 
not arranged correctly."
Script fonts use a special connection method that allows adjacent lower case letters to be 
connected to each other, regardless of the Gap setting. This is not compatible with the 
way the characters are arranged by the Full Circle line type.

Circle Clockwise and Circle Counter-Clockwise are compatible with Script fonts.

"I have adjusted my lettering on the work area, but when I change the 
Letter Properties, the lettering changes shape a little."
The control boxes on blocks of lettering allow subtle adjustments directly to the shape of 
the lettering. However, the Letter Properties only allows the proportions of Height and 
Width to be adjusted. When the Letter Properties are changed, the previous adjustments 
may be partially lost when the Height and Width values are applied. Therefore, it is 
recommended to make all desired adjustments in Letter Properties before making final 
adjustments directly with the control boxes.

"In Letter Options I tried to edit the Stitch Type for my lettering, but the 
drop-down menu was grayed out."
If a font does not use an editable stitch type, the Stitch Type will not be available in Letter 
Options.

"In Letter Properties I tried to edit the Stitch Type for my lettering, but 
there was no drop-down menu."
Stitch types are not available in the Letter Properties dialog box. Right-click the lettering, 
and select the stitch type from the right-click menu.
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"In SuperDesign Options I tried to edit the stitch properties for my 
SuperDesign, but the drop-down list was grayed out."
If a SuperDesign does not include an editable stitch type, the Stitch Type drop-down list 
will not be available in the SuperDesign Options dialog box.

"The selected Frame or Flourish cannot be seen completely."
Frames and Flourishes with running stitch that is vertical or horizontal are not always 
completely visible at zoom to fit. This varies depending on the font, size of lettering and 
envelope. Use the Zoom In feature, if desired, to verify that the stitching exists.

"In Font Manager one of the fonts in My Fonts shows a Minimum and 
Maximum size of 0.0 mm."
In the Font Manager dialog box a font that was created in QuickFont Wizard in 
mySewnet™ Embroidery or in mySewnet™ Font Digitizing, and copied to your My Fonts 
folder, may show a minimum and maximum size of 0.0 mm. This does not affect the use of 
the font.

Using Import Font from Embroideries

"How do I create an apostrophe or quotes?"
If your set of letters includes a comma, load it as the apostrophe, then move the Baseline 
so that it is on or just below the red dashed top line. For quotes, copy and flip the comma 
before loading as single and double quotes.

You can also use mySewnet™ Stitch Editor to add accents to existing characters, and create 
other punctuation symbols.

"My apostrophe overlaps another letter when placed as lettering."
When loading letters for a font, the apostrophe and quotes may kern better if they are 
placed further down from the red dashed top line.

Alternatively, use Horizontal Block with the Individual option to be able to fully adjust the 
lettering after placing it in the work area.

Backgrounds and Appliqué

"When I moved a design, its appliqué did not move with it."
Appliqué is associated with the selected Color Change or Stop. If you add appliqué to a 
Color Change or Stop in a different design, the appliqué will be associated with the 
selected design, not the desired one. Make sure that you select a Color Change or Stop in 
the desired design before adding appliqué.
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Using Decorations

"When I resized a decoration design, some areas showed an increase in 
the numbers of beads, while others became more spaced out."
When a decoration line or shape is enlarged, the number of decorations increases; and 
when it is made smaller the number decreases. Where decorations are placed individually, 
the number of decorations does not change when the decoration subdesign is made 
larger or smaller.

Using Design Player

"Why is the stitch order of my embroidery different in Design Player from 
when I use the slider bars in the Modify tab?"
Design Player uses the Export settings in mySewnet™ Configure when displaying the 
stitching out of an embroidery. The slider bars in the Modify tab show the stitch order as 
displayed in the Color Select area of the Design Panel. If the embroidery is ColorSorted, 
some color blocks may be placed together. If ColorSort is selected in the Optimize for 
Sewing settings in the Export tab of mySewnet™ Configure, Design Player will then show 
different results from the slider bars.

Multipart Hoops

"The alignment stitches for the second part of a design seem to have 
disappeared."
Some multipart embroideries are created with alignment stitches that overlap exactly. 
When viewing these designs in mySewnet™ Embroidery, deselect Remove Overlap in 
mySewnet™ Configure, Export, before sending them to the embroidery machine.

Cancelling unwanted actions

"I used Box Select around an area, but selected some stitches I didn't 
want. Undo is grayed out so I can't click it."
To cancel a stitch block selection made using Box Select, Freehand Select, Point Select or 
Select All, click anywhere in the currently active embroidery, but outside the box showing 
the selected stitches. The stitches will no longer be selected.

ColorSorting Files

"When I ColorSort an embroidery the number of color blocks produced 
varies."
The ColorSort process does not just put the same color blocks together. It checks for 
overlap between areas, therefore depending on the overlaps, the final number of color 
blocks may vary, even if you are Combining a similar number of elements.
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"I ColorSorted my design. Why are there so many colors in the Color Select 
area for it?"
If you use ColorSort on a multiple selection or group, the number of colors seen in the 
Color Select area may be more than if the same embroideries were combined. This is 
because ColorSort looks at the embroideries within the selection or group separately. To 
keep embroidery elements editable in your project and minimize the number of colors 
when stitching out, use Export with ColorSort to create a version for stitching.

Use Design Player or Print Preview to see how many colors the exported embroidery will 
have, according to the current options.

Printing Embroideries

"When I print my embroideries the grid is not shown at the correct size"
If you select Hoop Zoom to Fit in the Print page, the grid will be proportional to the scaling 
used to fit the hoop to the printed page. If you select ’Garment/Quilt Block Zoom to Fit’ or 
’Garment/Quilt Block Real Size’ in the Print page, the grid will extend across the whole of 
the selected background, not just the hoop area. The grid will be proportional to the 
scaling used to fit the garment and hoop to the printed page.
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29Quick Reference Guide

Ribbon Tabs
File Tab/Menu 

New Window Open an additional mySewnet™ Embroidery window.
Ctrl + Shift + N

Open Open an existing embroidery, replacing the embroidery on the screen.
Ctrl + O

Insert Insert an existing embroidery into your current project.
Ctrl + I; Alt, 1

Save Save the embroidery as a multipart embroidery in.vp4 format.
Ctrl + S; Alt, 2

Save As Save the embroidery as a multipart embroidery in.vp4 format under a 
new name.
Ctrl + Shift + S; Alt, 3

Export Save the embroidery in the current window as a flattened .vp4 file or in 
an alternative embroidery format, optimized for stitching.
Ctrl+ E; Alt, 4

Export Appliqué 
Pieces

Save or print appliqué outlines ready for cutting by a fabric cutter or 
INSPIRA™ Cutwork Needles.
Ctrl + Shift + E

Export Decoration 
Template

Save a template for all your decorations in a format for your cutter, to 
create a crystal transfer template. 
Ctrl + Shift + D

Send Send the selected embroidery to the mySewnet™ Cloud, or to the 
connected machine or computer.
Ctrl + K

Print Set printing options, preview and print the selected embroidery(ies) 
and background.

Preferences Set overlap and spelling checker options.

Configure Open mySewnet™ Configure.

Exit Close the current window and prompt to save new and changed 
embroideries.
Alt + F4
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Home Tab

Clipboard
Copy Make a copy of the selected embroidery or block of stitches and place 

it on the clipboard.
Ctrl + C; Alt, H, CP

Paste Paste the clipboard block.
Ctrl + V; Alt, H, V, P

Paste into Center
Paste the Clipboard Block in the center of the hoop. 
Ctrl + Shift + V; Alt, H, V. C

Cut Delete the selected embroidery or block of stitches from the screen 
and place it on the clipboard.
Ctrl + X; Alt, H, X

Duplicate Make a copy of the selected embroidery, which is automatically pasted 
on the work area.
Ctrl + D; Alt, H, DU

Delete Delete the currently selected embroidery, block or stitch without 
moving it to the clipboard.
Delete; Alt, H, DE

Select
Box Select Select a number of embroideries by opening a square or rectangular 

box around them.
Alt, H, SS, B

Freehand Select
Select a number of embroideries within an area of any shape.
Alt, H, SS, F

Point Select
Select a block of embroideries within an area of any shape, defined by 
a series of points.
Alt, H, SS, P

Select All Select all embroideries.
Ctrl + A; Alt, H, SA

Select None Deselect all of the embroideries in the work area, including any 
outside the hoop.
Ctrl + Shift + A; Alt, H, SN

Replace 
Selection

Replace the currently selected designs with the new selection.
Alt, H, RS

Add To 
Selection

Add the new selection to the currently selected designs.
Alt, H, SA

Remove From 
Selection

Remove the new selection from the currently selected designs.
Alt, H, SD

Groups
Group Group selected designs together so they may be moved, resized or 

scaled and rotated together.
Alt, H, G
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Ungroup Ungroup a selected group permanently, so that each design may be 
edited independently.
Alt, H, U

Resize Switch between resize and scale for the selected embroidery(ies) or 
group.
Alt, H, R 

Tools
Combine

Combine All
Merge all embroideries on the work area into a single embroidery.
Alt, H, M, A

Combine Selected
Merge the selected embroideries into a single embroidery.
Alt, H, M, S

Fix As Stitches
Fix the selected subdesign or subdesigns as embroideries. Lettering 
properties such as font and stitch types are not adjustable after fixing.
Alt, H, M, F

ColorSort Reduce the embroidery(ies) or group to the minimum number of color 
blocks. Alternatively, you can use the ColorSort option in Export when 
creating an embroidery file optimized for stitching.
Alt, H, CS

Color Tone Convert all the threads in the selected embroidery(ies) or group to 
those of another manufacturer. Also adjust brightness and contrast, 
selecting new threads automatically.
Alt, H, CT

Layout
Rotate 45 Rotate the selected embroidery(ies) or group by 45 degrees.

Alt, H, OT

Modify Design Show and change the size and rotation of the currently selected 
embroidery(ies) or group. Designs within multiple selections and 
groups are always scaled or resized proportionally.
Alt, H, OD

Alignment

Horizontal Alignment

Align Left
Align all selected embroideries and groups on the left edge.
Alt, H, AL, H, L

Align Center
Center align all selected embroideries and groups horizontally.
Alt, H, AL, H, C

Align Right
Align all selected embroideries and groups on the right edge.
Alt, H, AL, H, R
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Distribute Horizontally
Align all selected embroideries and groups to be equally spaced 
horizontally.
Alt, H, AL, H, D

Vertical Alignment

Align Top
Align all selected embroideries and groups on the top edge.
Alt, H, AL, V, T

Align Middle
Center align all selected embroideries and groups vertically.
Alt, H, AL, V, M

Align Bottom
Align all selected embroideries and groups on the bottom edge.
Alt, H, AL, V, B

Distribute Vertically
Align all selected embroideries and groups to be equally spaced 
vertically.
Alt, H, AL, V, D

Center In Hoop Move the selected embroidery(ies) or group to the center of the hoop 
and ensure it starts in the center of the hoop.
Alt, H, AL, C

Move Into Hoop Move the selected embroidery(ies), groups or block of stitches within 
the hoop.
Alt, H, OV

Edit Design Edit the selected design using the appropriate editing tool.
Alt, H, E

Multi-hoop

Endless Wizard Add markers to an embroidery so it can be stitched out in a 
continuous, regularly spaced, sequence as many times as desired.
Alt, H, N 

Split Project Wizard Split the embroidery project for any single-part hoop.
Alt, H, SP

Hoop
Change Hoop Choose the hoop size you wish to use in mySewnet™ Embroidery.

Ctrl + H; Alt, 6; Alt, H, H; Alt, V, H

Life View Show how an embroidery exported from the project will look in 3D 
with real-world perspective. Create a picture or video of your design.
Ctrl + L; Alt, H, L; Alt, 9

Design Player Play through the stitches in the embroidery as if they were being 
stitched from an exported embroidery. Create a picture or video of 
your design.
Ctrl + J; Alt, H, J; Alt, 0
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Create tab

Wizards

ExpressMonogram Wizard Start the ExpressMonogram Wizard to add a one, two or three 
letter monogram.
Alt, C, M

ExpressDesign Wizard

ExpressDesign into Hoop
Create an embroidery automatically to fit the currently selected 
hoop.
Alt, C, E, H

ExpressDesign into Rectangle
Create an embroidery automatically that is a best fit to a 
rectangular selected area.
Alt, C, E, R

PhotoStitch Wizard

PhotoStitch Into Hoop
Create an embroidery automatically from a photo to fit the 
currently selected hoop. 
Alt, C, P, H

PhotoStitch Into Rectangle
Create an embroidery automatically from a photo that is a best-
fit to a rectangular selected area. 
Alt, C, P, R

Word Sculpt Wizard Create a word design automatically using your choice of outline, 
words, and fonts.
Alt, C, W

Quilt Block Wizard Create a filled or outline quilt block automatically, or create a 
quilting fill around an embroidery.
Alt, C, Q

Spiro Wizard Create intricate spiral designs in multiple colors, using Running, 
Double or Triple stitch lines.
Alt, C, S

Family Tree Wizard Create an embroidered chart from your family history.
Alt, C, F

Project-in-the-Hoop 
Wizard

Create an in-the-hoop design using your choice of project type, 
style and dimensions.
Alt, C, I

Insert

Digitizer Open mySewnet™ Digitizing to create a digitized design.
Alt, C, D

Cross Stitcher Open mySewnet™ Cross Stitcher to create a cross stitch design.
Alt, C, C

Open

Sketch Open mySewnet™ Sketch to draw an embroidery design as 
stitches.
Alt, C, K
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Encore Tab
Place repeated copies of embroideries in a circle, a line or a shape, or around the edge of 
the hoop.

Layout
Type Choose a circle, line, shape or hoop.

Alt, E, T

Circle
Place the embroideries in a circle.

Line
Place the embroideries in one of 8 line options from left to right.

Shape
Place up to two selected embroideries around the edge of a shape.

Hoop
Place up to two selected embroideries around the hoop edge.

Position Place the embroideries in the original orientation, or reflect 
alternate copies.
Alt, E, M

Standard
The copies of the embroidery use the original orientation.

Mirror
Each alternate copy of the embroidery is reflected. 

Line Options Select a line type.
Alt, E, L

Shape Options Select one of 28 shapes, and whether or not to include an 
embroidery in the corners.
Shape: Alt, E, SS; Remove Corners: Alt, E, SR

Hoop Options Set the Margin between the embroideries and the edge of the 
hoop, and choose whether or not to include an embroidery in the 
corners.
Remove Corners: Alt, E, HR; Margin: Alt, E, HM

Number of Repeats Set the number of repeats in the Encore by changing the gap, or 
setting the number of repeats.
Repeats: Alt, E, RE; Gap: Alt, E, GA

Arrangement Set options for Group and Arrange Similar (place individual designs 
together when using multiple embroideries that are overlapped).
Group: Alt, E, RG; Arrange Similar: Alt, E, RA

Preview View the repeated designs in the work area.
Alt, E, P

Cancel Cancel the preview.
Alt, E, X

Apply Create the repeated embroidery.
Alt, E, A
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Letter Tab

Font
Category Select desired font category and font name from the drop-down 

list.
Alt, L, F

Appliqué
Fonts for use with appliqué fabrics.

Children
Child–themed and "cute" fonts such as fonts similar to children’s 
writing and animal fonts.

Display
Decorative fonts using specialty and pattern fills, often used in large 
sizes.

Effects
Fonts using special thread colors and needles, such as needle 
felting, twin needle and wing needle.

Elegant
Stylish fonts with a heritage feeling, such as gothic and illuminated 
alphabets.

Floral
Fonts with leaves and flowers decorating the letters.

Foam
Fonts for use with puffy foam for a raised 3D effect.

Fun
Informal fonts, such as athletic or party fonts.

Future
Informal fonts with a hi-tech theme.

Modern
Fonts with 'clean' designs in modern styles.

Monogram
These fonts have most characters of equal width, designed for use 
in monograms. They are all upper case only.

My Fonts
My Fonts is the default category for fonts you create.

National
Fonts associated with particular cultures, or alternative alphabets 
such as Greek and Hebrew.

Nearest Point
Nearest point fonts use special logic to determine the best way to 
join characters together. There are four versions of each character 
to enable the special joining method. Nearest Point fonts are ideally 
used with Running Stitch connection.

Retro
Classic Art Nouveau and Art Deco style fonts.

Scary
Informal fonts with a spooky or horror theme.
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Script
Script fonts have a special joining method where all adjacent 
lowercase characters are directly joined together and are not 
affected by the Gap setting. This is used to give an appearance of 
handwriting in different styles.

Traditional
Old-fashioned fonts.

Wild West
Informal fonts with a cowboy theme.

Font Manager Search for fonts and to arrange, rename, create, duplicate and 
delete user fonts.
Alt, L, M

Name Changer Create a series of embroideries with varied lettering automatically 
from the same template design.
Alt, L, N

Letters Click in the Letters box and enter the desired characters. Press Enter 
to create more than one line of text.

Size Enter the Size in millimeters, from 3mm to 200mm. This is the 
height of the uppercase 'A' character in the font, and all other 
characters are sized in proportion to this.
Alt, L, S

Layout Set the relative width and height, and the gap between the letters.
Gap: Alt, L, G; Width: Alt, L, W; Height: Alt, L, H

Lettering Shapes Select a shape for your lettering.
Alt, L, T

Horizontal Block Place lines of lettering in straight lines.

Vertical Block Place lines of lettering in straight vertical lines.

Circle Clockwise Place one line of lettering clockwise around a circle.

Circle Counter-
Clockwise

Place one line of lettering counter-clockwise around a circle.

Full Circle Place two lines of text on opposite sides of a circle.

Fit To Straight 
Line

Place one line of lettering along a straight line.

Fit To Wavy Line Place one line of lettering along a curved line.

Rounded Place lettering in an envelope with an outwardly curving top and 
base.

Double Arch Place lines of lettering in a shape with an inwardly curving top and 
base.

Diamond Place lines of lettering in a diamond shape.

Italic Place lines of lettering in a shape that is slanted.

Freeform Place lettering in a fully adjustable straight envelope. 

Flag Place lettering in a curving envelope with 8 handles.
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Free Sculpt Place lettering in a fully adjustable curved envelope with 14 
handles.

Arch Over Place lines of lettering in a shape with an outwardly curving top 
and an inwardly curving base.

Arch Under Place lines of lettering in a shape with an inwardly curving top and 
an outwardly curving base.

Fan Place lettering in an envelope with an outwardly curving top and 
an inwardly curving base. 

Bowl Place lettering in an envelope with an inwardly curving top and an 
outwardly curving base.

Pennant Right Place lines of lettering in a shape that is larger on the right side.

Pennant Left Place lines of lettering in a shape that is larger on the left side.

Perspective Place lines of lettering in a shape that is narrower at the top.

Bridge Convex 
Down

Place lines of lettering in a shape with a flat top and an outwardly 
curving base.

Bridge Concave 
Down

Place lines of lettering in a shape with a flat top and an inwardly 
curving base.

Bridge Convex 
Up

Place lettering in an envelope with a flat base and an outwardly 
curving top.

Bridge Concave 
Up

Place lines of lettering in a shape with a flat base and an inwardly 
curving top.

Octagon Place lettering in a octagonal envelope. 

Zigzag Place lettering in angled line envelope. 

Chevron Place lettering in a peaked envelope.

Slope Place lettering in a curved slopingenvelope.

Butte Place lettering in a straight sided envelope with 8 handles.

Gem Place lettering in an envelope with 7 handles.

Slide Place lettering in a sloping rectangular envelope. 

Pentagon Place lettering in an envelope with a peaked top, a straight base, 
and sloping sides.

Ramp Place lettering in an envelope with a curved top, a straight base, 
and sloping sides.

Rocket Place lettering in an envelope with a peaked top and an arched 
base. 

Reverse Select Reverse so it is checked to reverse the order of letters 
entered in the Letters box.
Alt, L, YR

Individual Select Individual so you can move and resize the letters 
individually.
Alt, L, YI

Step Select Step so it is checked to rotate the letters independently from 
the angle of the line for Fit To Straight Line or Fit To Wavy Line.
Alt, L, YS
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Stitches
Connection The connection method selects how the characters are joined 

together.
Alt, L, C

Trim
The letters are joined with movement stitches.
Alt, L, CT

Running Stitch
The letters are joined with small stitches.
Alt, L, CR

ColorSort Reduce the lettering to the minimum number of color blocks. It is 
recommended to use the ColorSort checkbox unless you wish to 
vary the colors of specific characters.
Alt, L, O

Stitch Type Alter the appearance of the stitching used in the lettering.
Alt, L, I

Line Formatting
Align Left Align text to the left.

Alt, L, LL

Align Center Align text in the center.
Alt, L, LC

Align Right Align text to the right.
Alt, L, LR

Spacing Change the distance between multiple lines of text.
Alt, L, LS

Apply Place the lettering in the work area.
Alt, L, A
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SuperDesign Tab

Category
Search Enter one or more words to show all SuperDesigns that match.

Alt, S, E

Clear Search Clear all search text.
Alt, S, X

Category Click the drop-down arrow on the right of the SuperDesign set 
name and choose the desired SuperDesign set in the list. 
Thumbnails of the SuperDesigns in the set will be shown.
Alt, S, G

SuperDesign
SuperDesign Click the thumbnail of the desired SuperDesign to select and 

highlight it.
Alt, S, D

Select Style Select from a choice of alternative stitching styles for your selected 
design.
Alt, S, T

Size Set the height of the SuperDesign in millimeters, and set its width/
height proportions.
Size: Alt, S, S; Width: Alt, S, W; Height: Alt, S, H

Stitch Type Alter the appearance of the stitching used in the SuperDesign.
Alt, S, I

Apply Place the SuperDesign in the work area.
Alt, S, A
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Frame Tab

Category Alt, R, C

Frame Create a frame for your design.

Corners Place corners around your design.

Side-pieces Place side-pieces to either side of your design.

Flourish Place a flourish above or below your design.

Border Create a border around your design.

Motif Underline Place a single motif, or a line of motifs beneath your design.

Frame or Flourish Click the drop-down arrow to select the desired category of frame 
or flourish, then click the thumbnail of the desired frame or flourish 
to select and highlight it.
Alt, R, FF

Frame Options
Margin Set the margin between the embroidery and the frame.

Alt, R, RM; Margin Size: Alt, R, RA

Crop Crop the embroidery when placing the frame, so that no margin is 
visible.
Alt, R, RP

Group Group the embroidery and the frame or flourish together when you 
click Apply.
Alt, R, RG

Flourish Options Set the width of the flourish in millimeters, and its width/height 
proportions, and choose whether to Group the embroidery.

Position Place the flourish Above, Below, or as a Duo above and below the 
embroidery.
Above: Alt, R, LA; Below: Alt, R, LB; Duo: Alt, R, LD

Margin Set the margin between the flourish(es) and embroidery.
Alt, R, LM

Percentage Width Set the width of the flourish, proportional to the embroidery.
Alt, R, LW

Group Choose whether to Group the embroidery with the flourish.
Alt, R, LG

Border Options
Margin Set the space between the embroidery and the center of the border 

around it.
Alt, B, OM

Rounded Corners Use rounded or square corners for the border.
Alt, B, OR

Group Group the border with the embroidery(ies) when it is placed on the 
work area.
Alt, B, OG

Stitch Types Select the appearance of the stitching used in the border. 
Alt, B, S
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Satin Line Use a line of constant width satin stitch.

Motif Line Use a line of motifs.

Running Stitch Use a line of small stitches going forward.

Triple Stitch Use a row of small three-part stitches, each composed of one stitch 
going forward, one going backward then one going forward. 

Add Appliqué Add appliqué stitches and fabric to your border.
Alt, B, P

Motif Underline Options
Select Motif Open the Motif Line dialog box to set the stitch type and size for the 

motif.
Alt, B, MS

Length Length of the motif line.
Length: Alt, B, ML; Size: Alt, B, MN

Repeats Number of repeats in the motif line.
Repeats: Alt, B, MR; Number: Alt, B, MP

Group Group the line with the embroidery(ies) when it is placed on the 
work area.
Alt, R, MG

Stitch Type Alter the appearance of the stitching and appliqué used in the 
frame or border. 
Alt, R, I

Apply Place the frame, border or line of motifs on the work area around 
the selected embroidery, or at the default size if no embroidery is 
selected.
Alt, R, A
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Appliqué Tab

Create
Appliqué Outline

Freehand Appliqué Outline
Draw to define a line of any shape to create an appliqué outline.
Alt, A, A, T

Point Appliqué Outline
Place points to define a line of any shape to create an appliqué 
outline.
Alt, A, A, P

Appliqué Hole

Freehand Appliqué Hole
Draw to define a line of any shape to create a hole within the 
selected appliqué outline.
Alt, A, H, T

Point Appliqué Hole
Place points to define a line of any shape to create a hole within the 
selected appliqué outline.
Alt, A, H, P

Express Appliqué Automatically find appliqué stitches within an existing embroidery, 
and apply an appliqué fabric to them.
Alt, A, E

Select
Select Piece Select an Appliqué Piece to alter its shape and preview or adjust its 

fabric.
Alt, A, T

Next Piece Select the next Appliqué Piece in the stitchout order.
Alt, A, N

Previous Piece Select the previous Appliqué Piece in the stitchout order.
Alt, A, P

Edit
Insert Points Add new points into the currently selected Appliqué Piece.

Alt, A, I

Delete Points Delete points from the currently selected Appliqué Piece.
Alt, A, D

Delete Piece Delete the currently selected Appliqué Piece with its outline.
Alt, A, X

Select Fabric Audition a new fabric for the currently selected Appliqué Piece.
Alt, A, F
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Embellish Tab

Category Alt, D, T

Ribbon Place Ribbon in your project.

Yarn Place Yarn in your project.

String of Beads Place a String of Beads in your project.

Decoration Place Decorations to your project.

Add Embellishment
Place Individual Place decorations individually on your project. Placeholder stitches 

are created for each decoration.
Alt, D, P

Draw Line Place lines of embellishments on your project.

Freehand Line
Draw to define a line of embellishments on your project.
Alt, D, DL, F

Point Line
Place points to define a line of embellishments on your project.
Alt, D, DL, P

Place Shape Place a shaped embellishment line on your project.
Alt, D, DS

Insert from 
Gallery

Insert a Gallery design into your project.
Alt, D, RS

Edit Embellishment
Edit Points Select either Individual Decorations, or Lines of Embellishment for 

editing or deleting.
Alt, D, C

Insert Points Add new points into the currently selected Line of Embellishment.
Alt, D, R

Delete Points Delete points from the currently selected Line of Embellishment.
Alt, D, E

Delete Selection Delete the currently selected Individual or Line of Embellishment.
Alt, D, Y

Break Up Line Break up the currently selected Line of Decorations into a number of 
Individual Decorations for independent editing.
Alt, D, K

Properties Change the style, size or color of the currently selected Individual or 
Line of Embellishment.
Alt, D, O
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Modify Tab

Clipboard
Copy Make a copy of the selected embroidery or block of stitches and 

place it on the clipboard.
Ctrl + C; Alt, M, CP

Paste Paste the clipboard stitches and attach them to the last visible 
stitch.
Ctrl + V; Alt, M, V, P

Paste into 
Center

Paste the Clipboard Block in the center of the hoop. 
Alt, M, V, C

Cut Delete the selected embroidery or block of stitches from the screen 
and place it on the clipboard.
Ctrl + X; Alt, M, X

Duplicate Make a copy of the selected embroidery, which is automatically 
pasted on the work area.
Ctrl + D; Alt, M, DU

Delete Delete the currently selected embroidery, block or stitch without 
moving it to the clipboard.
Delete; Alt, M, DE

Select
Box Select Select an area of stitches by opening a square or rectangular box 

around it.
Alt, M, SB

Freehand Select Select an area of stitches by drawing an irregular outline around it.
Alt, M, SF

Point Select Select a block of stitches within an area of any shape made of 
straight and curved lines.
Alt, M, SP

Select Stitches Select and edit single stitches.
Alt, M, SS

Select All Visible Select all visible stitches. Use in combination with hidden colors 
and Draw Range.
Ctrl + A; Alt, M, SA

Select None Deselect all of the embroideries in the work area, including any 
outside the hoop.
Alt, M, SN

Replace 
Selection

Replace the currently selected designs with the new selection.
Alt, M, SR

Add To 
Selection

Add the new selection to the currently selected stitches.
Alt, M, SA

Remove From 
Selection

Remove the new selection from the currently selected stitches.
Alt, M, SD

Resize Switch between Resize and Scale modes.
Alt, M, R

Draw Stitches
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Draw Range The upper slider bar sets the Draw From Start stitch. The lower 
slider bar sets the Draw To End stitch. Move the appropriate slider 
bar to change the start or end stitch. Stitches are not displayed 
when the color block containing the stitches is hidden.

Draw All Stitches Display all stitches in the embroidery selected for editing.
Alt, M, DA

Get Length Measure the distance between any two points on an embroidery.
Alt, M, L

Insert
Insert Color 
Command

Add a new color change at the point where you click.
Alt, M, IC

Insert Stop 
Command

Insert a Stop command at the point where you click, displaying a 
message.
Alt, M, IP

Insert Stitches Add new stitches to an embroidery.
Alt, M, IS

Modify Block
Width % Show and change the width of the currently selected block. The 

width is scaled or resized according to the Resize mode.
Alt, M, MW

Height % Show and change the height of the currently selected block. The 
height is scaled or resized according to the Resize mode.
Alt, M, MH

Angle Show and change the angle of the currently selected block.
Alt, M, MR

Apply Apply the changes to the current block.
Alt, M, MA
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View Tab

Help Tab

Grid
Show Grid Show or hide the background grid, and set its size.

Show Grid: Alt, V, G
Size: Alt, V, S

Get Length Measure the distance between any two points on an embroidery.
Alt, V, L

Background*
Background Wizard Start the Background Wizard to preview embroideries on a garment, 

quilt block or fabric.
Alt, V, W

Move and Rotate 
Background

Click and drag to move and rotate the garment, quilt block or fabric 
background around the hoop or project area.
Alt, V, M

Fade Use the slider to Hide, Fade or Show the background garment, quilt 
block or fabric.

Remove 
Background

Remove the garment, quilt block or fabric background.
Alt, V, E

View Mode
3D View View embroideries and background in standard 3D mode.

Ctrl + T; Alt, V, 3

Realistic 3D View embroideries and background in 3D without the selection box.
Ctrl + R; Alt, V, R

2D View View embroideries in 2D.
Alt, V, 2

Hoop
Change Hoop Choose the hoop size you wish to use in mySewnet™ Embroidery.

Ctrl + H; Alt, 6; Alt, V, H

Design Panel
Show Design 
Panel

Show the Design Panel.
Alt, V, D

Show FilmStrip Show the FilmStrip
Alt, V, F

Help Topics List help topics.
F1; Alt, P, H

About mySewnet™ 
Embroidery

Display module information, version number and copyright.
Alt, P, A
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Context Menu
In addition to the options below, options for the stitch types (for SuperDesigns, lettering and frames), 
decorations and appliqué pieces may be present. For example, an appliqué SuperDesign may have options 
for Appliqué Fabric 1 and 2, and for Satin Line. These will open the Appliqué Selection dialog box and the 
Satin Line properties dialog box. 

Properties Alter the size or rotation of the selected embroidery. Alter text and size 
of the selected lettering. Alter the size of the selected SuperDesign.

Undo Reverse the last action.
Ctrl + Z

Redo Reverse the previously undone action.
Ctrl + Y

Cut Delete the selected embroidery or block of stitches from the screen and 
place it on the clipboard.
Ctrl + X

Copy Make a copy of the selected embroidery or block of stitches and place it 
on the clipboard.
Ctrl + C

Paste Paste the clipboard stitches and attach them to the last visible stitch.
Ctrl + V

Paste in Center Paste the Clipboard Block in the center of the hoop. 
Ctrl + Shift + V

Duplicate Make a copy of the selected embroidery, which is automatically pasted 
on the work area.
Ctrl + D

Delete Delete the currently selected embroidery, block or stitch without 
moving it to the clipboard.
Delete

Zoom

Zoom To Fit
Fit the work area to the screen.
Ctrl + 9

100%
Display at 100% magnification.
Ctrl + 1

200%
Display at 200% magnification.
Ctrl + 2

400%
Display at 400% magnification.
Ctrl + 3

800%
Display at 800% magnification.
Ctrl + 4

75%
Display at 75% magnification.
Ctrl + 5
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50%
Display at 50% magnification.
Ctrl + 6

25%
Display at 25% magnification.
Ctrl + 7

View Mode

3D View
View embroideries and background in standard 3D mode.
Ctrl + T

Realistic 3D
View embroideries and background in 3D without the selection box.
Ctrl + R

2D View
View embroideries in 2D.

Background

Move and Rotate Background
Click and drag to move the garment, quilt block or fabric background 
around the hoop or project area.

Remove Background
Remove the garment, quilt block or fabric background from the project.

Background Off

Fade to 10%

Fade to 20%

Fade to 30%

Fade to 40%

Fade to 50%

Fade to 60%

Fade to 70%

Fade to 80%

Fade to 90%

Background On

Send Send the selected embroidery to the mySewnet™ cloud or to the 
connected embroidery machine.
Ctrl + K
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Handles Menu

Straight Create a lettering block with a straight line for the top.

Diamond Create a lettering block with a point at the top.

Double 
Diamond

Create a lettering block with straight lines between the four handles at 
the top.

Arch Create a lettering block with a curve at the top.

Curve Create a lettering block with curved lines between the four handles at 
the top.

Add a point to 
curve

Add a single point to the right end of the selected curve.

Add 3 points to 
curve

Add three points to the right end of the selected curve.

Remove a point 
from curve

Remove a point from the right end of the selected curve.

Match Top and 
Bottom Lines

Use the same line type for the top and bottom lines in a block.

Bottom Line Type

Straight
Create a lettering block with a straight line for the bottom.

Diamond
Create a lettering block with curved lines between the four handles at 
the bottom.

Double Diamond
Create a lettering block with straight lines between the four handles at 
the bottom.

Arch
Create a lettering block with a curve at the bottom.

Curve
Create a lettering block with curved lines between the four handles at 
the bottom.

Add a point to curve
Add a single point to the right end of the selected curve.

Add 3 points to curve
Add three points to the right end of the selected curve.

Remove a point from curve
Remove a point from the right end of the selected curve.

Constraint - Size When used, the two corners adjacent to the corner that is dragged 
move the same distance, in the same direction.

Constraint - 
Pennant

When used, the corner above or below the corner that is dragged 
moves the same distance towards or away from the dragged corner 
vertically.

Constraint - 
Perspective

When used, the corner to the right or left of the corner that is dragged 
moves the same distance towards or away from the dragged corner 
horizontally.
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Constraint - 
Italic

When used, the corner to the right or left of the corner that is dragged 
moves the same distance, in the same direction.

Constraint - 
Free

When used, the corner handles can be dragged in any direction.

Force Even 
Distribution

Distribute the handles between the two corners evenly.
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Toolbars
Quick Access Toolbar

Insert Insert an existing embroidery into your current project.
Ctrl + I; Alt, 1

Save Save a multipart embroidery under the same name.
Ctrl + S; Alt, 2

Save As Save a multipart embroidery under a new name.
Alt, 3

Export Save the embroidery in the current window as a flattened .vp4 file, or 
in an alternative embroidery format.
Alt, 4

Print Print the selected embroidery(ies) and background. To set page 
options, use File, Print.
Ctrl + P; Alt, 5

Change Hoop Choose the hoop size you wish to use in mySewnet™ Embroidery.
Ctrl + H; Alt, 6

Undo Undo the last action.
Ctrl + Z; Alt, 7

Redo Redo the previously undone action.
Ctrl + Y; Alt, 8

Life View Show how an embroidery exported from the project will look in 3D 
with real-world perspective. 
Ctrl + L; Alt, 9

Design Player Play through the stitches in the embroidery as if they were being 
stitched from an exported embroidery.
Ctrl + J; Alt, 0
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Status Bar
Use the Zoom Commands on the Status Bar to navigate around embroideries.

Zoom To Rectangle Increase magnification of an area of the embroidery.
Ctrl + 0

Zoom To Fit Fit the work area to the screen.
Ctrl + 9

100%
Display at 100% magnification.
Ctrl + 1

200%
Display at 200% magnification.
Ctrl + 2

400%
Display at 400% magnification.
Ctrl + 3

800%
Display at 800% magnification.
Ctrl + 4

75%
Display at 75% magnification.
Ctrl + 5

50%
Display at 50% magnification.
Ctrl + 6

25%
Display at 25% magnification.
Ctrl + 7

Zoom Out Decrease magnification.
Ctrl + -

Zoom In Increase magnification.
Ctrl + =
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Design Panel
Design Information
Stitch Count : The Stitch Count of the embroidery.

Width : The Width of the embroidery.

Height : The Height of the embroidery.

Colors : The number of colors in the embroidery.

Color Select
A worksheet panel showing the color blocks in the embroidery. It is used to change the 
thread color, show which color blocks are visible and turn the display of color blocks on 
and off, move color blocks up  and down  the design, and merge  color blocks. 

The Move and Merge color functions are available only in the Modify tab.

The Draw Range may hide threads in a visible color block.

Clipboard Block
The Clipboard Block shows the current embroidery that can be pasted into the work area.

Overview Window
The overview window gives a small overview of the whole work area for the current 
embroideries and background.

Notes and Settings
Notes Display the Notes for the currently selected embroidery.

Settings Display the Settings for the currently selected embroidery.

Edit Edit the Notes or Settings for the currently selected embroidery.
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FilmStrip
View your design in the FilmStrip.

Stitch Order

Stitch Later
Bring the selected embroidery(ies) or group one step closer to the 
front.

Stitch Earlier
Bring the selected embroidery(ies) or group one step closer to the 
back.

Stitch Last
Place the selected embroidery(ies) or group at the front.

Stitch First
Place the selected embroidery(ies) or group at the back.

Reveal Groups Reveal the contents of Groups in the FilmStrip, and temporarily disable 
all groups in the work area. This allows any design within a group to be 
edited independently.
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Character Sets
The character set contains the following characters:

ABCDEFGHIJKLMNOPQRSTUVWXYZ

abcdefghijklmnopqrstuvwxyz

0123456789 spc

!"@$£€%&*()-+_=\/?';:,.

ÀÁÂÃÄÅÆÇÈÉÊËÌÍÎÏÐÑÒÓÔÕÖØÙÚÛÜÝÞß

àáâãäåæçèéêëìíîïðñòóôõöøùúûüýþÿ
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Alternative Alphabets
You can enter characters in other alphabets from the National font category, such as Greek 
and Hebrew. Use the key listed in the table to obtain the desired character.

Hebrew
On your keyboard, use the character below the Hebrew character to write that character. 
Numbers, symbols and punctuation use their usual keys.

! A B C D E F

G H I J K L M

N O P Q R S T

U V W X Y Z
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Greek
On your keyboard, use the character below the Greek character to write that character. 
Numbers, symbols and punctuation use their usual keys.

A B C D E F H

I J K L M N O

P Q R S T U V

W X Y Z a b c

d e f h i j k

l m n o p q r

s t u v w x y

z
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Index
Numerics
2 Cutwork Needles .......................................... 494
2D Template ....................................................... 244
2D View ...................................................................36

Thread Effects.............................................36
3D

Realistic.........................................................35
Standard.......................................................35

3D Background
Color ..............................................................92
Texture ..........................................................92

4 Cutwork Needles .......................................... 494
45

Rotate......................................................... 150
45 Degree Rotate ................................................75

A
Abbreviation .........................................................54
About......................................................................... 5
Acquire Picture........................................ 203, 263
Acrobat Reader® .................................................... 4
Add

Quick Color Theme...................................61
Add 3 points to curve ..................................... 366
Add a point to curve ....................................... 366
Add to Dictionary............................................. 510
Add To Selection........................................69, 107
Adding Decorations ........................................ 219
Adding Ribbon.................................................. 211
Adjust Embroidery

Quilt Block Wizard.................................. 148
Adjusting Monograms ................................... 342
Aids for Alignment........................................... 245
Align

Bottom..........................................................78
Center..................................................77, 394
Left .................................................................77
Middle...........................................................78
Right ..............................................................78
Split Project Sections............................ 244
To Previous Sections ............................. 246
Top..................................................................78
With Corner or Baste Alignment Stitches

246
With No Alignment Stitches............... 246

Alignment
General Considerations ....................... 244
Horizontal ....................................................77
Lettering.......................................... 357, 376
Other Aids................................................. 245
Stitch .......................................................... 246
Stitch Style...................................... 238, 248
Tools...............................................................77
Vertical ..........................................................78
With No Stitches........................... 238, 246

All
Combine.......................................................80
Select.............................................................67

Alternative Style
Small Letters ............................................ 337

Ancestors Chart ................................................ 298

Angle .................................................148, 456, 464
Background Picture .170, 173, 198, 204
Block Rotation.................................. 76, 107
Fill .................................................................456
Fill in Quilt Block......................................148
Fill Pattern .................................................456
Linear PhotoStitch..................................279
Modify Block.............................................548
Pattern Fill .................................................412
Tiles..............................................................284

Animals 1 — Patterns 37 to 48.....................501
Animated Demo.................................................. 49
Animation

Create Stitches.........................................277
Appliqué...........................................183–205, 408

Create..........................................................449
Express........................................................185
Method.............................................137, 206
Placement........................................137, 205

Appliqué Embroidery
Change Fabric ..........................................183

Appliqué Frame
Stitching Out ..............358, 359, 435, 440

Appliqué Hole ....................................................185
Appliqué Outline...............................................184
Appliqué Piece...................................................183

Margin.........................................................206
Appliqué Piece Margin138, 194, 206, 409, 510
Appliqué Pieces

Export ........................................................... 25
Appliqué Selection...........................................192
Appliqué Tab.......................................................545
Arch........................................................................366
Arch Over .............................................................369
Arch Under ..........................................................370
Area

Define with Eraser ..................................268
Deselect ...........................................105, 106
Focal ............................................................276
Get Length Of .................................. 39, 101
Group ............................................................ 69
Traveling Stitches Around Outside...458
Work .................................................................7

Area Sensitivity
Express Border .........................................136
Picture Options........................................130
Quick Trace................................................134

Arrows — Patterns 49 to 60 ..........................501
Artistic Effect ......................................................278
Autolevel..........................................252, 254, 270
Automatic

Crop .............................................................123
Ghost Mode ..............................................100
Kerning.............................................356, 375

Automatic Crop
Background Wizard................................170

Automatic Reset
Rotate and Crop Picture .......................265

B
Background
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Color ..............................................................92
Faded...................................................40, 162
Grid .................................................................. 8
Move....................................................40, 163
Name ................................................ 176, 201
Off.........................................................40, 162
On.........................................................40, 162
Removal..................................................... 252
Remove...................................................... 267
Remove Color.......................................... 139
Size .................................................... 175, 199
Texture ..........................................................92
Wizard ...........................162–177, 196–201

Background Color
ExpressDesign......................................... 129
Remove in ExpressDesign................... 129
Remove Multiple.................................... 129

Backgrounds .....................................11, 162, 192
Real Size .................................................... 164

Backwards
Move..............................................................42

Bar
Menu ............................................................... 6
Status............................................................... 8
Title .................................................................. 6
Zoom............. 38, 92, 333, 336, 338, 341

Baseline
QuickFont ....................................... 414, 421

Baste
Alignment Stitches...................... 239, 246

Bead ...................................................................... 208
Beads

String of..................................................... 216
Bells ..........................................................................17
Black Lines .......................................................... 130
Block ..................................................................... 364

Clipboard ................................... 8, 101, 147
Deselect..................................................... 105
Horizontally Flip ........................................77
Make From Visible Area ....................... 107
Modify...........................................................76
Paste ................................................. 102, 105
Rotation Angle.................................76, 107
Select.......................................................... 104
Vertically Flip ..............................................77

Block Templates ................................................ 368
Blocks

Change Order Of Color ........................ 109
Blue ..........................................................................63

Handles for Resize ................................. 104
Handles Resize ...........................................74

Border
Express....................................................... 113
Express Options...................................... 135
Individual Letter ........................... 340, 346
Monogram ............................................... 340
Monogram Adjust ................................. 346
Options.................................. 137, 205, 448
Type ............................................................ 135

Border Properties
Satin............................................................ 497

Both
Endless Marker...........................................91

Bottom
Align ..............................................................78

Bowl ...................................................................... 370

Box
Select................................................... 67, 105
Selection ...................................................... 65

Break Up Line .....................................................226
Bridge Concave Down ....................................371
Bridge Concave Up...........................................372
Bridge Convex Down.......................................371
Bridge Convex Up .............................................372
Brightness

Color Tone ................................................... 58
Butte ......................................................................373
Butterfly Motif Line ..........................................453

C
Camera........................................................203, 263
Category...........................................461, 463, 498

Curved Crosshatch Fill ..........................469
Font..............................................................354
Font Name.................................................417
Frame ..........................................................543
MultiWave Fill...........................................472
Shape Fill....................................................477
Tapered Motifs .........................................491

Center
Align .............................................................. 77
Cross .............................................................. 38
In Hoop......................................................... 79
Lines ............................................................245

Center Motifs 1 and 2 ......................................463
Center of

Embroidery ................................................. 38
Rotation........................................................ 75

Central Point .............................................498, 500
Change

All To ..................................................128, 275
Colors ......................................377, 434, 444
Existing Thread Color .............................. 53
Frame Properties.....................................444
Hoop............................................................237
Letter Properties .....................................376
Name...........................................................423
Order Of Color Blocks............................109
SuperDesign Properties .......................433
Thread...............................................128, 275

Character Set ............................................399, 558
Cyrillic 1 ......................................................401
Cyrillic 2 ......................................................401
Cyrillic 3 ......................................................401
Extended....................................................399
Greek 1........................................................402
Hebrew 1 ...................................................402
Hiragana 1 .................................................401
Hiragana 2 .................................................402
Latin 1 .........................................................400
Super-Extended ......................................399
Western 1...................................................400
Western 2...................................................400
Western 3...................................................400
Western 4...................................................400

Characters
Enter Special...................................360, 559
Keystrokes for Special ................................4
Not Available in Font .............................359

Chart
Ancestors ...................................................298

Check Spelling .........................................360, 510
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Chevron ............................................................... 372
Children ..................................................... 294, 296
Choose

Connection Method ............................. 301
Design Type ............................................. 119
Embroidery Type.................................... 261
Fabric.......................................................... 245
Monochrome Thread Color................ 278
New Thread Color .....................................63
Photographs for PhotoStitch Wizard252
Picture.................................... 120, 202, 262
Pictures for ExpressDesign Wizard... 115
Thread Colors ................................ 127, 274
Thread Colors Tiles ................................ 283

Choose Picture
Background Wizard ..................... 167, 196

Circle
Encore ...........................................................84

Circle Clockwise................................................ 361
Circle Counter-Clockwise .............................. 361
Circles 1 — Patterns 61 to 72 ....................... 501
Circles 2 — Patterns 73 to 84 ....................... 501
Circular

Rotate Handle ............................................65
Cleaning a Picture............................................ 115
Climate — Patterns 85 to 96 ........................ 501
Clipboard Block.................................. 8, 101, 147
Close

mySewnet Embroidery ............................. 5
Save On.........................................................19

Color
3D Background..........................................92
Change Existing Thread......53, 345, 346
Change Order of Blocks....................... 109
Choose New Thread.................................63
Edit .................................................................62
ExpressDesign Background ............... 129
Information .............................................. 506
Insert .......................................................... 109
Linear PhotoStitch................................. 278
List ..................................................... 128, 275
Match ......................................................... 331
Models ..........................................................63
Order .......................................................... 128
Paste ..............................................................62
Preview Thread ................... 130, 133, 276
Select.......................................................... 556
Selection ......................................... 127, 274
Thread.......................................63, 134, 136
Tone ...............................................................58
Worksheet .........................................53, 108

Color PhotoStitch
Creating..................................................... 259
Photographs............................................ 254

Color PhotoStitch Embroidery .......... 250, 261
Color Tile Embroidery ........................... 250, 262

Photos........................................................ 255
Colors.................................................................... 556

Change .................................. 377, 434, 444
Choose Thread.............................. 127, 274
Dialog Box ...................................................63
Edit .................................................................53
Lettering.......................................... 377, 444
Merge......................................................... 109
Move........................................................... 109
Number of ...................................... 127, 274

Remove Multiple Background ...........129
SuperDesigns ...........................................434
Thread........................................................... 53
View Selected...........................................108

ColorSort ................................................................ 57
After Combine ........................................... 80
Frame ..........................................................444
Lettering ......................357, 376, 377, 434

Combine................................................................. 80
All.................................................................... 80
Border .........................................................449
Remove Overlap .....................................510
Selected ....................................................... 81
Then ColorSort .......................................... 80

Compensation ...................................................248
Fill .................................................................457
Satin Area ..................................................484
Split Project...............................................239

Connected Outlines .........................................118
Connection

Lettering ....................................................376
Split Project.....................................239, 248
Types ...........................................................356

Connection Method.........................................301
Connector Type .................................................305
Constant

Density ......................................................... 73
Stitch Count................................................ 74

Constant Width Satin.......................................133
Constraint - Free ................................................367
Constraint - Italic ...............................................367
Constraint - Pennant........................................367
Constraint - Perspective .................................367
Constraint - Size.................................................366
Constraints ..........................................................366
Context Menu ....................................................550
Continuous

QuickFont ..................................................415
Contour Fill Options.........................................483
Contrast

Color Tone ................................................... 58
Picture.........................................................254

Control Panel .................................................8, 556
Convert

Lettering to Embroidery.............378, 444
SuperDesigns to Embroidery .............436
Thread Range............................................. 59

Copies
Print Number............................................509

Copy.............................................................101, 102
Color .............................................................. 62

Corner
Alignment Stitch...........................238, 246
Endless Marker .......................................... 90

Corners .................................................................438
Rounded Border......................................340

Create
Appliqué ....................................................449
Lettering ..........................................351, 352
Stitches Animation.................................277

Create a Family Tree Embroidery.................307
Create a Frame ...................................................439
Create New Chart..............................................294
Creating

Embroideries ............................................524
Creating Fonts....................................................395
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Crop
Picture for Background........................ 170
Picture for Fabric .......................... 173, 198
Picture for Garment .............................. 170
Picture for Quilt Block........................... 170

Crop Box .................................................... 204, 265
Crop Picture

Load Picture Wizard .............................. 204
Cross

Center............................................................38
Crosshatch

Curved ....................................................... 467
Crosshatch Fill Properties.............................. 465
Curve .................................................................... 366
Curved

QuiltStipple Fill ....................................... 482
Curved Crosshatch Fill .................................... 467

Properties ................................................. 467
Custom Color........................................................63
Cut ......................................................................... 101
Cut Line

Quilt Block ................................................ 145
Cut-out............................................. 137, 206, 409
Cutwork ............................................................... 494
Cutwork Needle.........................................56, 494
Cutwork Needle Line .........................................24
Cyrillic 1 Character Set ................................... 401
Cyrillic 2 Character Set ................................... 401
Cyrillic 3 Character Set ................................... 401

D
Dark Borders and Backgrounds .................. 119
Decide Stitch Out Order ................................ 244
Decorated Bells ................................................. 229
Decoration.......................................................... 208
Decoration Gallery Design............................ 222
Decoration Information................................. 507
Decoration Line

Point ........................................................... 209
Decoration Selection ...................................... 223
Decoration Tab.................................................. 546
Decoration Template .........................................27
Decorations...............................................208–233

Editing........................................................ 225
Export......................................................... 227

Define
Focal Area ................................................. 276

Delete ................................................................... 103
All Thread Colors .................................... 275
Font............................................................. 381
Quick Color Theme...................................62
Single Stitches......................................... 103
Thread Color .................................. 129, 275

Delete All
Thread Color ............................................ 129

Delete Piece ....................................................... 188
Delete Points............................................ 188, 226
Delete Selection ............................................... 226
Demo.......................................................................49
Density

Constant.......................................................73
Fill Properties........................................... 457
Gradient ................................ 457, 480, 486
MultiWave Fill .......................................... 471
Normal ............................................. 457, 480
Pattern Fill................................................. 411

Radial Fill....................................................479
Satin.............................................................413
Satin Area ..................................................485
Satin Border ..............................................497
Satin Columns..........................................405
Shape Fill....................................................476
Standard ....................................................457
Stitch Options ..........................................281
Stitching.....................................................279

Depth
Scan .............................................................279

Descendants Chart.................................294, 296
Description

Thread.........................................................389
Deselect

Block............................................................105
Wrong Area.....................................105, 106

Design
Choose Type .............................................119
Information8, 44, 48, 132, 134, 136, 280, 

282
Preview.......................................................281
Scale ............................................................506
Separator Animation .............................239

Design Information ..........................................556
Design Panel ......................................................... 43

Show.............................................................. 43
Design Player........................................................ 46

Video Speed................................................ 51
Design Underlay

Express Embroidery ...............................132
Designing with Ribbon...............211, 214, 217
Designs

Grouping...................................................... 69
Desktop Shortcuts.................................................5
Detail

Enhance .................................254, 279, 281
Detail Enhancement ........................................116
Diagonal Corners

Echo Fill ......................................................475
Diamond ....................................................365, 368

Curved Crosshatch Fill ..........................467
Tile Shape ..................................................283

Diamonds — Patterns 97 to 108 .................501
Dictionary

Spelling ......................................................510
Different Colors for Lettering..............377, 444
Different Colors for SuperDesigns ..............434
Digital Camera .........................................203, 263
Digitize New Font .............................................382
Dimensions

Page Setup ................................................506
Direct USB Connection ..................................... 29
Direct USB Settings ............................................ 31
Display Names As..............................................295
Distance

Between Secure Points .........................494
Distribute

Horizontally ................................................ 78
Vertically ...................................................... 78

Double Arch........................................................368
Double Diamond ..............................................365
Double Stitch

Appliqué ..........................................137, 206
Length ........................................................207
Properties ..................................................495
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Double Stitch - Stop - Satin ...... 137, 206, 409
Double with Zigzag Return .......................... 495
Double Zigzag................................................... 495
Drag and Drop Embroideries..........................17
Draw All Stitches............................................... 111
Draw Decoration Line..................................... 220
Draw Line ............................................................ 209
Draw Range.............................................. 111, 548
Draw Ribbon Line ............................................ 209
Draw Ribbon Shape ........................................ 210
Dual Thread...........................................................55
Duplicate

Font............................................................. 380

E
Echo Fill................................................................ 474
Echo Lines........................................................... 474
Edge Walk Underlay ........................................ 413

Express Border ........................................ 497
Satin Columns ......................................... 406

Edit
Color ..............................................................62
Colors and Stitches...................................53
Embroideries ........................................... 100
Frames and Borders .............................. 438
Page ............................................................ 547
Quick Color Theme...................................62
Select Embroidery ................................. 105
Single Stitches......................................... 103

Edit Design ............................................................79
Edit Individuals ................................................. 294
Editable Properties .......................................... 454
Editing Decorations......................................... 225
Effect

Artistic........................................................ 278
Effects ......................................................................55
Embellish............................................................. 208
Embellish Tab..................................................... 208
Embellishments ................................................ 208
Embroideries

Drag and Drop Load ................................17
Edit .............................................................. 100
Grouping......................................................69
Managing.....................................................14
Modifying ............................................ 65, 83
Open..............................................................14
Open Recently Used ................................17
Remove Overlap When Combining 510
Save................................................................18
View ...............................................................35

Embroidery
Center............................................................38
Choose Type ............................................ 261
Color PhotoStitch................................... 250
Create......................................................... 524
Endless..........................................................89
Express............................................. 113, 120
Express Options...................................... 127
File Formats.................................................11
Fix Lettering ................................... 378, 444
Fix SuperDesigns.................................... 436
Monochrome Linear ............................. 251
On Heavy Knit Fabric ........ 457, 480, 497
On Linen................................ 457, 480, 497
On Satin................................. 457, 480, 497
On Thick Fabric ................... 457, 480, 497

Open..................................................147, 312
Paste ............................................................102
Repeat....................................................83, 91
Select............................................................. 65
Select to Edit ............................................105
Sepia PhotoStitch ...................................250
Split..............................................................236
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